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Welcome to the 
Apple Support Training Library 

The Apple Support Training Library is an example of Apple's commitment to 
helping you provide better support to users of Apple® products. The 
Library's modules allow for both quick reference and customized training. 
The modules contained in this binder are part of three series: :rv1acintosh, 
Apple II, and Peripherals. 

Training. Because the library's modules are self-paced, individuals can 
learn and practice by themselves. Or the modules can be combined with other 
modules as a course. If given as a course, the self-paced modules allow 
students to progress at their own pace, freeing the instructor to answer 
questions and help students with problems. Each module lists any 
prerequisites and equipment required. 

Reference Catalog. To facilitate your search for information on Apple 
products, we developed the Support Training Reference Catalog, available on 
AppleLink™. The catalog references manuals, publications, courses, and 
training modules that provide information and instruction on a wide range of 
computer skills. For each skill listed, the catalog identifies training resources 
and tells how to sign up for the training, how to acquire the materials, and 
what the prerequisites are. 

Update Subscription. This binder contains the modules which have been 
released to date for this series. Along with this binder you receive a 
subscription to all additional modules produced for the series this year. 
(Modules are released quarterly.) At the end of the year, you will receive a 
renewal letter that you can use to order a subscription for the modules to be 
released the following year. 

Change of Address. If you change your address, please notify your local 
Apple Support Center. 



Recommendations when using this Library: 

• 
• 

• 

Read the modules thoroughly . 
Contact your Apple support representative if you have any questions or need additional 
information not covered in the modules. 
Back up your files as you follow the practice exercises to avoid losing important data . 

Copyright 
©1986 Apple Computer, Inc. All rights reserved. 
Apple Computer, Inc. 
20525 Mariani Avenue 
Cupertino, CA 95014 

Apple grants to its authorized dealers and other authorized customers the right to reproduce and 
distribute this material for use in training classes provided that there is no additionalfee charged for 
the material distributed in such classes, and that it is distributed only to bona fide participants of 
such classes. 

Apple does not endorse any of the third-party products mentioned in this module. They are 
included only to make you aware of their availability. 

Apple, the Apple logo, and the Macintosh logo are registered trademarks of Apple Computer, Inc. 
AppleLink is a trademark of Apple Computer, Inc. Macintosh is a trademark of Mcintosh 
Laboratory, Inc. and is being used with express permission of its owner. 

These modules were produced using the Apple LaserWriter printer. 



Apple Support Training Library 

Macintosh Vol. I 

II Table of Contents 

Section 1 Macintosh Product Overview 
Learn to identify the hardware components of the Macintosh, how to set 
up the system, and what accessory products are available. 

2 Learning to Use Macintosh 
Learn to use Macintosh, including basic Macintosh techniques 
such as using the mouse and menus, and how to work with documents, 
folders, and disks. 

3 Supporting the Macintosh Finder 
Learn to use and support the features of the Finder. Use the Finder 
utilities in different versions of the Finder to support Macintosh users. 

4 Supporting the Font/DA Mover 
The Font/DA Mover is a utility that helps you move fonts and desk 
accessories. You use it to add room to a crowded disk, or to addfonts 
or desk accessories that allow you to be more productive. A section on 
the original Font Mover is included. 

5 Managing Macintosh Files 
Macintosh uses a fl.at file structure with 400K disk drives and the 
Macintosh XL. Learn how to support this structure using folders and 
disks to organize your files, documents, and applications. Learn how 
to support the Document Directory dialog box (also called the "Standard 
File") by using it and the Save As command. · 

6 Fundamentals of the Macintosh Operating System 

7 

Learn how to explain some of the features and functions of the 
operating system and user interface. Learn how to respond to 
Macintosh users who have trouble starting up Macintosh, or who 
have lost a file or a document. 

Using MacDraw 
Learn to use MacDraw by completing the Guided Tour of 
MacDraw and specially designed practice exercises. 



8 Supporting MacDraw 
Information that will help you support MacDraw users, including 
technical specifications and answers to commonly asked questions 
about using MacDraw. 

9 Supporting MacProject 
Information that will help you support MacProject users, including 
hints on how to create, display, and work with project schedules, 
answers to commonly asked questions, and troubleshooting techniques. 

10 Supporting MacWrite 
Information that will help you support MacWrite users, including 
integration with other applications such as graphics programs, useful 
techniques, answers to commonly asked questions, and technical 
specifications. 

11 Using MacTerminal 
Learn to use MacTerminal, including configuring it to 
communicate with other computers, transferring files, integration with 
other applications, and practice exercises for connecting to another 
Macintosh, an Apple II, and a public information service. 

12 Using MacTerminal with IBM Computers 
How to use MacTerminal to communicate with IBM computers, 
including a description of the products involved, and the appropriate 
MacTerminal settings for each, practice using the AppleLine, and 
answers to commonly asked questions. 

13 Supporting MacTerminal 
Information that will help you support MacTerminal users, including 
answers to commonly asked questions, technical specifications, and 
pinouts. 
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Apple Support Training Library 

There are three binder series in the Apple Support Training Library: Macintosh, 
Apple II, and Peripherals. Here is a listing of the modules currently available for 
each series. 

Macintosh, Vol. I & II 
(Part No. 072-0186) 

Macintosh Product Overview 
Learn to identify the hardware components of the 
Macintosh, how to set up the system, and what 
accessory products are available. 

Learning to Use Macintosh 
Learn how to use Macintosh, including basic 
Macintosh techniques such as using the mouse and 
menus, and how to work with documents, folders, 
and disks. 

Supporting the Macintosh Finder 
Learn to use and support the features of the Finder. 
Use the Finder utilities in different versions of the 
Finder to support Macintosh users. 

Supporting the Font/DA Mover 
The Font/DA Mover is a utility that helps you move 
fonts and desk accessories. You use it to add room 
to a crowded disk, or to add fonts or desk 
accessories that allow you to be more productive. 
A section on the original Font Mover is included. 

Managing Macintosh Files 
Macintosh uses a flat file structure with 400K disk 
drives and the Macintosh XL. Learn how to support 
this structure using folders and disks to organize 
your files, documents, and applications. Learn how 
to support the Document Directory dialog box (also 
called the "Standard File") by using it and the Save 
As command. 

Fundamentals of the Macintosh 
Operating System 

Learn how to explain some of the features and 
functions of the operating system and user interface. 
Learn how to respond to Macintosh users who have 
trouble starting up Macintosh, or who have lost a 
file or a document. 

Using MacDraw 
Learn to use MacDraw by completing the Guided 
Tour of MacDraw and specially designed practice 
exercises. 

Supporting MacDraw 
Information that will help you support MacDraw 
users, including technical specifications and answers 
to commonly asked questions about using MacDraw. 

Supporting MacProject 
Information that will help you support MacProject 
users including hints on how to create, display, and 
work with project schedules, answers to commonly 
asked questions, and troubleshooting techniques. 

Supporting l\1ac"\Vrit€ 
Information that will help you support MacWrite 
users, including integration with other applications 
such as graphics programs, useful techniques, 
answers to commonly asked questions, and technical 
specifications. 

Using MacTerminal 
Learn how to use MacTerminal, including 
configuring it to communicate with other 
computers, transferring files, integration with other 
applications, and practice exercises for connecting 
to another Macintosh, an Apple II, and a public 
information service. 

Using MacTerminal with IBM 
Computers 

How to use MacTerminal to communicate with IBM 
computers, including a description of the products 
involved, and the appropriate MacTerminal settings 
for each, practice using the AppleLine, and answers 
to commonly asked questions. 

Supporting MacTerminal 
Information that will help you support MacTerminal 
users, including answers to commonly asked 
questions, technical specifications, and pinouts. 

Supporting the Macintosh Switcher 
Information that will help you support Switcher 
users, including installing and configuring several 
applications in a Switcher set to establish a desired 
set of integrated software. 

The Inside Story 
Learn the basic computer components and the flow 
of information through a computer. 

Using the Macintosh XL Migration Kit 
Follow the step-by-step procedures to convert all of 
your Lisa 717 documents into Macintosh documents. 
Learn how to prepare your Lisa 717 documents, 
install the migration software, and per/ orm the Lisa 
and Macintosh portions of the migration. 

October 1986 



Macintosh, Vol. I & II 
(continued) 

Using the Finder 5.3 Menus 
Learn to use the various features of the latest 
versions of the Finder and System. This module is 
an update to Supportin~ t~ Macintosh Finder. 
located in Macintosh Volwne I of the Apple Support 
Training Library. This module explains the new 
features and changes in the existing ones. 

Using the Installers 
Learn how to update your Startup disk using the 
latest version of the System Installer disk. The 
module discusses the System Installer and the 
dragging m£thod of updating, and explains how and 
when to use both. You will also learn to use the 
Printer Installation disk to update your printer 
drivers. 

Apple II, Vol. I 
(Part No. 072-0187) 

Apple II Product Overview, Rev 1 
Learn about the capabilities of the Apple JIGS, 
Apple Ile, and Apple Ile, including information on 
enhancements and upgrades. Also learn about the 
various Apple Memory Expansion Cards. 

The Inside Story 
Learn the basic computer components and the flow 
of information through a computer. 

Apple II System Utilities 
Learn to use the Apple JI System Utilities disk to 
perform basic operations, including its use with the 
Apple II Memory Expansion Card. 

Supporting ProDOS and DOS 
Compare ProDOS with DOS, and learn the basics 
needed to support programmers, including where to 
go for more information. 

Using Subdirectories with AppleWorks 
Learn about setting up subdirectories and using 
pathnames to identify and manage files. 

Color Printing with AppleWorks 
Learn how to print color documents on the 
ImageWriter II using all three AppleWorks 
applications. 

Access II Basics 
Learn why you'd use Access JI, how to set up a 
system-both hardware and software-for Access JI, 
and how to log on to an information service. 
Practice solving typical problems with Access II. 

Access II: Recording and Receiving 
Files 

Learn how to save to disk information that you 
receive from an electronic service. Learn the 
difference between recording and receiving, and 
how to solve related custom£r problems. 

Access II: Overview of Transmitting 
Files 

Learn the general principles for transmitting files 
by using an Apple II (with Access JI) to send a file 
to another Apple II user (who has Access II). 

Access II: Preparing Files for 
Transmission 

Before transmitting a file, you must know 
which type of file to send. Here, using quick 
reference guides, you learn how to determine 
this. You'll also learn to answer questions 
regarding different file types such as DJF, 
ASCII, and formatted text files. 

Using the Apple IIGS Control Panel 
Learn how to use the Control Panel when setting up 
your Apple JIGS system to provide peripherals 
information and set personal preferences. 

October 1986 



Peripherals, Vol. I 
(Part No. 072-0188) 

Image Writer II Basics 
Learn how to set up the /mageWriter II and the 
SheetFeeder, including how to set dip switches, how 
to run the printer self test, and how to test the 
connection. Also learn the basic software settings 
for Macintosh applications and AppleWorks. 

Using the LaserWriter, Rev 1 
Learn how to set up an AppleT alk network and use 
it to print a document on the LaserWriter; how to 
install LaserWriter software; and how to 
troubleshoot an AppleT alk network and the 
LaserWriter. Also learn about the added benefits of 
the LaserWriter Plus. 

Data Communications Terms 
A brief introduction to terms that will help you 
support Apple data communications products. A 
glossary of terms is provided. 

Interfaces and Cabling 
Introduces you to RS-232 communications. This 
module includes pin information, and brief exercises 
that help you speak knowledgeably with data 
communications professionals. 

Introduction to Supporting Desktop 
Communications 
Learn the process of qualifying des/aop 
communications customers and configuring 
solutions for them. Learn concepts and terms that 
are common to most desktop communications 
solutions. 

Supporting Desktop Communications 
Learn how to qualify a customer for a specific 
des/aop communications solution. Learn concepts 
and terms that are unique to information systems 
and electronic mail, local area networks, and large 
system communications. 

Apple II Peripherals Overview 
Learn about the various Apple II monitors, disk 
drives, printers, modems, and accessories. 

October 1986 





Macintosh Product Overview 
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2 Overview 
3 Objectives, Materials 
4 Hardware Overview and Setup 

A look at the hardware components of Macintosh and how to set 
up the system. 

9 Accessory Products 
Details all of the Apple Macintosh accessories, as well as various 
products available from third-party vendors for the Macintosh. 

16 Review 
17 Resources 



2 Overview 

II Overview 

This module identifies all the hardware features of the 
Macintosh™ computer and explains how to set up the system. 
Then there is a brief description of the accessory products 
available from Apple for the Macintosh and the key third-party 
accessory products. 

This is only an overview of the products available for the 
Macintosh, not an in-depth analysis or description of each. If 
you want to know more about <lfecific products that are 
mentioned, particularly Apple products, read additional 
modules from the Apple Support Training Library or ask your 
Apple support representative for the manual for you to review. 

If you aren't familiar with some of the terms used in this 
module ("byte," "baud," "128K," "modem," and so forth), or 
if you want to know more about how a computer works, read 
The Inside Story module. 

This module is designed for first-time Macintosh users. 

Prerequisites 

There are no prerequisites for this module. 

APPLE SUPPORT TRAINING LIBRARY 
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Ill Materials 
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Objectives 3 

• Identify the following Macintosh hardware components: 
accessory connectors, brightness control, clock battery 
compartment, On/Off switch, security kit connector, and 
sound jack. 

• Set up the Macintosh, including connecting the mouse, 
keyboard, and power cord. 

• Identify the accessory products currently available from 
Apple for the Macintosh, as well as certain key third-party 
products. 

To complete this module, you will need: 

• A Macintosh, keyboard, mouse, and power cord 
(All components should be disconnected, as if they were 
just taken out of the box.) 

• Apple Presents the Personal Computer: The Macintosh 
videotape (available as part of the ASC Training Kit: 
Macintosh Products-pin 076-8114-A) 

MACINTOSH PRODUCT OVERVIEW 



4 Hardware Overview and Setup 

II Hardware Overview and Setup 

Overview 

Watch the Videotape 

Examine the Front 
of the Macintosh 

This section identifies all of the Macintosh 
hardware components. 

You'll begin this section by watching a videotape that 
introduces the Macintosh. Then you'll learn about all of the 
system's hardware features. 

It's called Apple Presents the Personal 
Computer: The Macintosh. 

The video will introduce the Macintosh, some of the accessory 
products you can use with it, and some basic concepts for its 
use. Continue with this module when you have finished 
viewing the video. 

Here are the components you can see on the 
front of the Macintosh. 

As you read about each feature, be sure you can find it on your 
Macintosh. The features are the same for the Macintosh 128K 
and Macintosh 512K. The only difference between the two 
systems is the amount of memory. 

APPLE SUPPORT TRAINING LIBRARY 
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Hardware Overview and Setup 5 

--•-H-disk drive 

• Screen. The screen is a 9-inch video display, similar to a 
television set. This is where you will see everything you 
are working on. 

• Disk Drive. The disk drive is just below the screen, on the 
right side. It handles disks that can store as much as 400K 
(a "K" is equivalent to 1,024 characters) of information. 

The tiny, round hole to the right of the disk-drive slot 
enables you to eject a disk that can't be ejected in any other 
way. You simply insert a straightened paper clip into the 
hole and push. 

Warning: This method should only be used as a last resort. 
If used inappropriately, it may cause the loss of information. 

• Keyboard connector. The keyboard attaches to the 
connector below the disk drive. Notice that it uses the same 
type of connector as your phone. 

Warning: While the keyboard plug and a phone plug may 
look the same, they are quite different. If you insert a phone 
cord into the keyboard connector of your Macintosh, you could 
cause serious damage. 

• Serial Number. The serial number is under the screen, on 
the left side. (You'll have to tip the Macintosh back to see 
it.) It's important for warranty repairs and theft control. 

• Brightness Control. The brightness control is under the 
screen, on the left side-next to the serial number. 

MACINTOSH PRODUCT OVERVIEW 



6 Hardware Overview and Setup 

Examine the Back 
of the Macintosh 

These are the components that are on the 
back of the Macintosh. 

• On/Off Switch. Face the front of the Macintosh, and run 
your left hand along its left side. Toward the back, you'll 
find a smooth spot in the texture of the plastic. Just around 
the corner, on the back of the Macintosh, is the On/Off 
switch. 

Now turn the Macintosh around so its back faces you, and find 
each of the components as they are described. 

Vents--+-!!!!= 

Product 
Name -+t!::!!ililililil.I 

FCC label 

security kit 
connector 

ext emal disk print er 
drive connect or port 

modem 
port 

clock ba.tt ery 
door 

On/Ott s'Witc h 

power plug 

• Power Plug. The power cord connects to the socket just 
below the On/Off switch. 

• Clock Battery Door. The Macintosh clock runs on 
battery power when the Macintosh is turned off. The 
battery will last about two years. As the battery is wearing 
out, the clock will lose time. When this happens, remove 
the clock battery door and replace the battery. Use a 
4.5-volt battery (Eveready No. 523, or equivalent, which is 
available on the Apple price list, p/n 742-0003). 

• Accessory Connectors. The connectors along the 
bottom of the back of the Macintosh are labeled with an 
"icon," or symbolic representation, of the device that can be 
attached to each. From left to right, there is the mouse 
connector, external disk drive connector, the Printer port, 
and the Modem port. 

The Printer and Modem ports are RS-422 serial ports to 
which you can connect a variety of Apple and third-party 
products. 

APPLE SUPPORT TRAINING LIBRARY 
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and Sides 

Hardware Overview and Setup 7 

• Sound Jack. If you want to work (or play) without 
disturbing others around you, connect an earphone to this 
jack. You can also use it to connect to an amplifier. 

• Security Kit Connectors. A Macintosh security kit 
attaches to the back of the Macintosh case (just above the 
mouse connector) and to the keyboard (on the edge that 
faces the Macintosh). Once installed, the two security kit 
connectors are locked in place. A cable wrapped around an 
immovable object and through the eyelets in the connectors 
will lock the Macintosh into place. 

• Programmer's Switch. A programmer's switch (or 
interrupt/reset switch) is included for people who want to 
write their own applications programs. You'll find the 
switch in the plastic accessory kit that was in the top of 
your Macintosh box. To install the switch, snap it into place 
at the bottom of the left side, toward the back of the 
Macintosh. 

Interrupt Switch 

~l~~c; 
I 

The back part is an interrupt switch, which is useful to 
developers. The front part is a reset switch. If you want to 
start up from a different disk, pressing the reset button is like 
turning your Macintosh off and then on again. But care should 
be taken with the Programmer's Switch because using it in the 
wrong way could cause you to lose information. 

Avoid blocking the vents, or the Macintosh may 
overheat. 

Macintosh doesn't have an internal fan. The vents around its 
sides and on its top allow air to flow through the cabinet, 
keeping the components cool. If you block the vents, the 
Macintosh may overheat. 

MACINTOSH PRODUCT OVERVIEW 



8 Hardware Overview and Setup 

Set Up the Macintosh 

What to Do Next 

Attach the mouse, keyboard, and power cord. 

You don't need any tools to set up your Macintosh. 

To begin, connect the mouse to the mouse connector on the 
back of the Macintosh. The icons above the ports tell you what 
to connect where. The icon above the mouse connector is 
shown at the left. The connector only fits on one way so it's 
impossible to attach it wrong. Use the thumbscrews to hold 
the connector in place. 

Connect the keyboard to the Macintosh, just below the disk 
drive. The connector only fits in one way. 

Make sure the system is turned off, and then connect the 
power cord to the Macintosh and plug it into a 110-volt, 
three-hole plug. Don't use an adapter, or your Macintosh will 
not be properly grounded. 

Continue when you have connected the mouse, keyboard, and 
power cord to your Macintosh. 

After completing this module, learn how to use 
the Macintosh and available software. 

After you read the remainder of this module to learn about the 
accessory products available for Macintosh, you'll probably 
want to learn how to use the system. 

Complete the Learning to Use Macintosh module to learn basic 
Macintosh techniques, such as how to use the mouse and 
menus, and how to work with text. Then you'll be ready to 
begin one of the various applications training modules. 

APPLE SUPPORT TRAINING LIBRARY 



Accessory Products 9 

( II Accessory Products 

Overview 

Find Technical Detail 
Elsewhere 

Printers 

lmageWriter II Printer 

This section describes the accessory products 
available from Apple for the Macintosh. 

Key third-party accessory products are also mentioned. In 
addition, new products are constantly being introduced, both 
by Apple and by third-party developers. Check Macintosh 
publications such as Macworld, the Macintosh Buyer's Guide, 
Macintosh Connection, or A+, and AppleLi11J(™ for ongoing 
information about new products. 

(Note: AppleLink is a product developed by Apple to provide 
information and electronic mail capabilities to its Sales 
organization and dealers. If you don't have access to 
AppleLink, ask your Apple support representative for 
information referenced in this module that can be found there.) 

Check Applelink or other references for 
technical information. 

This section doesn't go into technical detail on the products 
mentioned. If you want more information, check AppleLink or 
one of the references listed at the end of this module. 

There are several printers you can use with 
Macintosh. 

This section includes a basic description of the various printers 
available for the Macintosh. If you want more information 
about the different printer technologies described and the 
trade-offs involved, read The Inside Story module from the 
Apple Support Training Library. 

The lmageWriter II is the printer most often 
purchased with a Macintosh. 

The Image Writer™ II is a serial, dot matrix printer that can 
print high-resolution graphics and text. It was introduced in 
September 1985 to replace the original Image Writer, which had 
been the most popular printer for use with Macintosh. The 
Image Writer II is faster than the original Image Writer, and can 
also print in color-with the right software. It's good for 
correspondence text and graphics, but the resolution is not high 

MACINTOSH PRODUCT OVERVIEW 



10 Accessory Products 

LaserWriter Printer 

Letter-Quality Printers 

enough for business correspondence that requires typewriter 
quality. 

Check the lmageWriter II switches. 

Every printer has switches that must be set correctly in order 
for it to function properly. The Image Writer II switches are 
inside the printer, on the left side, toward the front. On the 
original Image Writer, the switches are located inside the 
printer, on the right, under the track that the print head moves 
on. Refer to the printer's user's manual for the appropriate 
switch settings for use with Macintosh and other computers. 

Connect the lmageWriter cable. 

To connect the Image Writer or the Image Writer II to your 
Macintosh, plug the cable (which is included in the accessory 
kit) into the printer and into the Macintosh connector marked 
with a picture of a printer, like the one shown at the left ·The 
cables can only be connected one way. Secure the connection 
with the thumbscrews. 

The LaserWriter printer produces 
near-typeset-quality output. 

The LaserWrite!™ printer is at the top of Apple's printer line. 
It's a high-speed, high-resolution laser printer that can produce 
graphics and text output of such high quality that it looks 
typeset For increased cost-effectiveness, the LaserWriter can 
be shared by as many as 31 Macintosh users over the 
AppleTalk™ Personal Network-Apple's networking solution 
for small workgroups. (More information about AppleTalk 
appears later in this module. You can also refer to the Using 
the LaserWriter module from the Apple Support Training 
Library for more information on AppleTalk and the 
LaserWriter.) 

Software is available that enables you to use a 
letter-quality printer with Macintosh. 

Use a letter-quality printer (also known as a daisy wheel printer 
or impact printer) if you need typewriter-quality documents. 
However, such printers aren't good for printing graphics. 

The Mac Daisywheel Connection is a program that provides 
letter-quality printer support for Mac Write™. It's not a driver, 
(special code needed to use a printer with any application), but 

APPLE SUPPORT TRAINING LIBRARY 
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Accessory Products 11 

an application that prints Mac Write documents. The program 
supports character sizes of 10, 12, and 15 point, as well as 
proportional print wheels and various font styles. It also 
supports many different printers, including the Apple Daisy 
Wheel Printer. The Mac Daisywheel Connection is available 
from Assimilation, Inc. (AppleLink has additional 
information.) 

An external disk drive is available. 

Apple manufactures an external disk drive that's identical to the 
buiit-in drive. This drive can handie disks that store 400K of 
information. 

Connect the disk drive to the external disk-drive port on the 
back of the Macintosh. This port is identified by a picture of a 
disk drive, as shown at the left. Secure the connection with the 
thumbscrews. 

Warning: Place the external disk drive on the right side of the 
Macintosh to avoid potential ventilation and shielding 
problems. 

Hard disks provide greater storage capacity 
and faster access time. 

The Hard Disk 20 is Apple's 20-megabyte hard disk for the 
Macintosh. It attaches to the external disk-drive port and is 
designed to sit under the Macintosh, so it's out of the way and 
aesthetically pleasing. The Hard Disk 20 also allows you to 
daisy chain another hard disk, a floppy-disk drive, or a backup 
device such as a tape drive. (See the Third-Party Accessories 
section of this module for a list of hard disks available from 
third-party developers.) 

Apple makes two modems. 

A modem is a hardware device that enables you to 
communicate with another computer through a telephone line. 
The Apple Personal Modem (shown at left) and the Apple 
Modem 300 both work with the Macintosh. The Modem 300 
operates at 300 baud (which is a measure of how fast 
information is transmitted), and the Personal Modem operates 
at 300 or 1200 baud. (Note: The Apple Personal Modem is 
functionally identical to the Hayes Smart Modem 1200.) 

. MACINTOSH PRODUCT OVERVIEW 



12 Accessory Products 

A higher baud rate means information can be sent more quickly 
between computers. (See the Data Communications Terms 
module from the Apple Support Training Library for additional 
information about the data communications vocabulary used in 
the previous paragraph. See the Using MacTerminal module 
for more information about modems and their use with 
Macintosh.) 

Connect the modem to Macintosh and to a 
phone line. 

The modem accessory kit contains the cables, user's manual, 
and other documentation. 

Both Apple modems have two connectors for phone cables (as 
shown below on the Apple Modem 300). Connect the phone 
line to one port and your telephone to the other. When the 
modem is not in use, you can use the phone normally. 

Telephone 
Jacks 

Power Cable 
Connector 

Cable 
Connector Switches 

Apple Modem 300 

On-Off 
Switch 

Connect one end of the serial cable that's provided in the 
accessory kit to the modem's cable connector and the other end 
to the modem socket on the back panel of the Macintosh, which 
is identified by the icon shown at the left. There is only one 
way to attach the cable. Secure the connection with the 
thumbscrews. 

Check the owner's manual for the correct switch settings (the· 
switch settings shown above are correct for use with 
Macintosh). Then connect the power cord, and you're ready to 
go. 

There are no switches on the Personal Modem, and you plug it 
right into a power socket, so there isn't a power cord either. 
Just connect it to the phone line and to your Macintosh and its 
ready for use. 
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There are several accessories available to 
everyone connected to the AppleTalk network. 

AppleTalk is Apple's local interconnect system. It was 
designed to be easy to install, easy to use, and very 
inexpensive compared to other networking solutions. 

Macintoshes, LaserWriter printers, and third-party file servers 
can all be part of an AppleTalk network. Via AppleTalk, you 
can store and retrieve information using a file server, print your 
documents on the LaserWriter or other shared printers, and 
transfer documents to other workstations. 

Read the Using the LaserWriter module from the Apple 
Support Training Library, the LaserWriter owner's manual, or 
the AppleTalk Personal Network Installation Guide for more 
information about AppleTalk and the LaserWriter printer. 

Use the numeric keypad if you enter a lot of 
numbers. 

The numeric keypad is an optional addition to your Macintosh 
that enables you to enter numbers more quickly than using the 
numbers across the top of the standard keyboard. It also 
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Third-Party Accessories 

Disks 

includes several keys for special functions. (You can enter 
numbers and invoke all of the special functions using the 
standard Macintosh keyboard, but the numeric keypad lets you 
do both faster.) 

To connect the keypad: 

1. Unplug the keyboard cable from the keyboard. 
2. Insert it into the socket on the keypad marked with a 

picture representing the Macintosh. 
3. Plug the cable that comes with the keypad into the 

remaining socket on the keypad. 
4. Plug the other end of that cable into the socket on the 

keyboard. 

When you finish, the numeric keypad and keyboard should be 
connected to your Macintosh as shown below. 

0 

The Security Kit. 

DDDDDDDDDDDDDD 
DDDDDDDDDDDDDD 
CJODDDDDDDDDDCJ 
CJDDDDDDDDDDc:::::J 

DD CJD 

If your Macintosh is used in a public place, you can secure the 
main unit and the keyboard using the security kit. See the 
Macintosh owner's manual for instructions on its use. 

The following is a partial list of accessory 
products available from third-party developers. 

Check AppleLink and Macintosh publications for other 
products available for the Macintosh. 

HyperDrive by General Computer Company. 

HyperDrive is a 10-megabyte hard disk that fits inside the 
Macintosh cabinet. It's convenient because it doesn't occupy 
any additional desktop space. 
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Bernoulli Box by IOMEGA. 

The Bernoulli Box is a 5-megabyte removable hard-disk 
cartridge. 

OmniDrive by Corvus. 

OmniDrive is a line of hard disks that can be shared among 
several Macintosh computers connected via AppleTalk. Each 
user can have private storage space on disks which range in 
size from 5 to 126 megabytes. 

QC1 O and QC20 by Quark. 

The QClO and QC20 are 10- and 20-megabyte hard disks, 
respectively, that connect to the Macintosh external disk drive 
port. They can also be used with an Apple Il. 

ThunderScan by Thunderware. 

This is an optical reader that attaches to the Image Writer. 
ThunderScan will create a MacPaintTM document from any 
drawing or photograph you feed through your Image Writer. 
It's very accurate, but not very fast. 

MacVision by Koala. 

Mac Vision enables you to connect a video camera to Macintosh 
and create MacPaint documents from drawings, photographs, 
or live video images. It's quite fast but not as accurate as 
ThunderScan. 

MacTablet by Summagraphics. 

MacTablet is a drawing tablet that replaces the mouse as a 
graphics input device. It's very good for detailed drawing or 
tracing. 

Hayes has a 2400-baud modem available. 

MacCharlie will make your Macintosh 
compatible with an IBM PC. 

MacCharlie consists of a disk drive and a keyboard extender 
that enable you to run MS-DOS software on your Macintosh. 
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•Review 

Hardware Overview 

Hardware Setup 

Accessory Products 

The hardware components of a Macintosh are: 

• Screen 
• Brightness control 
• Keyboard connector 
• Disk drive 
• Security kit connector 
• Mouse connector 
• External disk drive, printer, and modem ports 
• Soundjack 
• Powerplug 
• On/Off switch 
• Clock battery 

If you're not sure where each of these components are, refer to 
the diagrams earlier in this module. 

To set up your Macintosh, connect the mouse, 
keyboard, and power cord. 

A large variety of accessory products are 
available for the Macintosh. 

Apple manufactures the following products that can be used 
with the Macintosh: 

Image Writer II printer 
LaserWriterprinter 
Daisy Wheel Printer 
External disk drive 
20-megabyte hard disk 
Modem 300 and Personal Modem 
Numeric Keypad 
Security Kit 

There are also many accessory products available from 
third-party developers including other disk drives, digitizers, 
modems, and optical scanners. 
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• Macintosh, the owner's manual 

• AppleLink (If you have access to AppleLink, use it to find 
information about all of Apple's products.) 

• Accessory product owner's manual (For more information 
about any of the Apple accessory products mentioned in this 
module, refer to that product's owner's manual.) 

• Macintosh periodicals (For more information about 
third-party accessory products, check Macintosh 
publications such as Macworld, The Macintosh Buyer's 
Guide, MACazine, and A+. They will have articles, 
reviews, or ads that will tell you who to contact for more 
information.) 

• Using the LaserWriter module from the Apple Support 
Training Library (Read this module for more information 
about the AppleTalk Personal Network and the LaserWriter 
printer, and for a comprehensive list of additional 
materials.) 

Apple does not endorse any of the third-party products mentioned in this module. They are included only to make you 
aware of their availability. 

Apple and the Apple logo are registered trademarks of Apple Computer, Inc. AppleLink, AppleTalk, ImageWriter, 
LaserWriter, MacPaint, and Mac Write are trademarks of Apple Computer, Inc. Macintosh is a trademark of Mcintosh 
Laboratory, Inc. and is being used with express permission of its owner. Bernoulli Box is a trademark of Iomega 
Corporation. HyperDrive is a trademark of General Computer Company. IBM is a registered trademark of International 
Business Machines Corporation. MacCharlie is a trademark of Dayna Communications. Mac Daisywheel Connection is a 
trademark of Assimilation, Inc. MacTablet is a trademark of Summagraphics Corporation. Mac Vision is a trademark of 
Koala Technologies Corporation. OmniDrive is a trademark of Corvus Systems, Inc. QCIO and QC20 are trademarks of 
Quark Peripherals, Inc. Smart Modem 1200 is a trademark of Hayes Microcomputer Products, Inc. Thunder Scan is a 
trademark ofThunderware, Inc. 
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2 Overview 

•Overview 

The Macintosh™ computer is designed to _be easy to learn and 
easy to use. The mouse and graphics-based interface enable 
even the most inexperienced person to do useful work in just a 
few hours. Macintosh even comes with its own self-paced 
training program called the Guided Tour of Macintosh. 

In this module, you will go through the Guided Tour, which 
· teaches you the basic techniques for using Macintosh. After 
each session of the Guided Tour, you are given an opportunity 
to practice what you have learned. 

Even with a computer as easy to use as a Macintosh, there are 
specific techniques you should learn. After going through the 
Guided Tour, you will learn how to work with disks, 
documents, and folders on the Macintosh, including how to 
copy and move documents and folders, and how to back up 
disks. 

These are basic techniques that everyone needs to know before 
learning how to use specific applications software. Investing a 
few hours now will save you many frustrating hours later. 

This module is designed for anyone who is using a Macintosh 
for the first time. 

Prerequisites 

You should already be familiar with the Macintosh hardware 
and how to set it up. If you can't identify the key hardware 
components of the Macintosh (disk drive, mouse, keyboard, 
On/Off switch, and accessory ports), complete the Macintosh 
Product Overview module from the Apple Support Training 
Library. 
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• Materials 

Objectives 3 

• Learn the basic techniques for using Macintosh, which 
include how to use the mouse, windows, menus, and icons. 

• Move and copy documents and folders. 

• Save your work on disks. 

• Use the Trash to throw away documents and folders. 

• Properly care for disks. 

• Initialize, back up, repair, and erase disks. 

• State the contents of, and create, a startup disk. 

To complete this module, you wlll need: 

• Macintosh 128K or Macintosh 512K 

• Guided Tour of Macintosh disk and cassette 

• Audiocassette player 

• Macintosh system disk 

• Mac Write™ disk 

• Blankdisk 

• Macintosh, the owner's manual 

If available, the following Is recommended: 

• External disk drive 
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• How to Use This Module 

Follow the Instructions Complete the Guided Tour, read the review, 
then practice the techniques. 

The first part of this module has you complete the Guided Tour 
of Macintosh and then practice what you have learned. During 
a Guided Tour session, you'll listen to a tape describing what's 
happening on your screen. But you won't actually do 
anything. After each session of the Guided Tour, there's a 
review of the techniques that were introduced (so don't feel 
you have to take notes on what you see during the Guided 
Tour). Read the review, but don't try to practice the techniques 
yet. Following each review, there is a practice exercise that 
will help you practice the skills you saw in the Guided Tour 
and read about in the review. 

In this module, it's very important to read everything and to 
follow instructions. You'll have plenty of time to practice, so 
don't jump the gun and practice during the reviews. 

If you want to complete this section more quickly, you can 
complete the entire Guided Tour without stopping. However, 
you will learn-and retain more-about using Macintosh by 
reading each of the reviews in this module and practicing each 
of the techniques taught. 

The other two main sections of the module are Documents and 
Folders, and Disks. In these two sections there is a description 
of the various techniques you will use when working with 
these items~ followed by clearly identified practice exercises. 
Read the descriptions, and then complete the practice exercises. 

Refer back to the reviews or descriptions 
during the practice exercises. 

If, as you are going through a practice exercise, you forget 
how to do something, refer back to the description or review 
given earlier in the module. 

After you complete this module, you can always refer back to 
its descriptions and reviews for quick reminders about specific 
techniques. 

If, at any time, you would like a reminder of the definitions of 
basic Macintosh terms, check the glossary in Appendix B of 
Macintosh, the owner's manual. 
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(- II Guided Tour of Macintosh 

Overview Use materials included with your Macintosh to 
learn the basic techniques. 

The Guided Tour of Macintosh disk and cassette, and the 
Macintosh owner's manual, which are packaged with your 
Macintosh, provide an excellent starting point for learning how 
to use the system. In completing this module, you will use the 
Guided Tour disk and cassette; and then read key partc; of the 
manual. 

After each Guided Tour session, there's a review of the 
techniques covered in that session. Read the review but don't 
try the techniques yet. After each review, there's an exercise 
that will enable you to practice what you saw in the Guided 
Tour. 

There are five Guided Tour sessions. To complete this section, 
do the following: 

1. Read the module section titled Mousing Around (up to the 
Guided Tour heading). 

2. Complete the mouse exercises (which are called Mousing 
Around). 

3. Complete the Guided Tour of Macintosh. Follow 
the instructions in this module (under the Guided Tour 
heading) to complete the first Guided Tour session, "Show 
me my Electronic Desk!" 

4. Read the review of the Guided Tour in this 
module. Read the review of the session starting with the 
Review of the Guided Tour heading. 

5. Practice what you saw in the Guided Tour. 
Do each step as it's described, beginning at the Practice 
heading that follows the review. 

6. Repeat Steps 3, 4, and 5 for the other four Guided Tour 
sessions. 
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Mousing Around Complete the mouse exercises.on the Guided.· 
Tour disk to learn how to use the mouse. 

The first part of the Guided Tour is an exercise called Mousing 
Around. It's a series of exercises designed to teach you how to 
use the mouse. 

To start the mouse exercises, do the following: 

1. Insert the Guided Tour disk, metal end first with the label 
facing up, into the built-in disk drive. Push the disk all the 
way in, until it clicks into place. 

2. Tum on the Macintosh. The On/Off switch is on the back, 
above where the power cord connects. 

The first time a Guided Tour of Macintosh disk is used, it will 
automatically start with Mousing Around. Subsequently, when 
you start up the Guided Tour disk, it will present the Guided 
Tour screen, which is shown below. 

Guided Tour of Macintosh 
Listen, Experiment, and Enjoy Learning 

What's the Finder? 

Why Do I Have Windows? 

What Else is in the Menus? 

If you see this screen before you complete Mousing Around, 
roll the mouse on the table top to position the arrow on the 
screen on top of the words Mousing Around. Then press 
and release the mouse button to begin the mouse exercises. 

Do the mouse exercises now. Continue when you have 
finished. 
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Complete the first Guided Tour session, "Show 
Me My Electronic Desk!" 

When you start the Guided Tour cassette, there will be a review 
of some of the material you just read. If you have not yet 
completed the mouse exercises (Mousing Around), follow the 
instructions on the tape to do so. 

As soon as you see the Guided Tour screen (shown on the 
facing page) after completing the first session, stop the cassette 
and read the Review of the Guided Tour below. 

Start the Guided Tour of Macintosh cassette now. It will teii 
you exactly what to do from here on. Continue with this 
module when you have finished the first session of the Guided 
Tour of Macintosh. 

Read this review of the first Guided Tour 
session, "Show Me My Electronic Desk!" 

Stop the cassette, if you have not already done so. 

Read the following review of what was covered in the Guided 
Tour before trying any of the techniques taught. Following the 
review, you will have an opportunity to practice what you have 
learned. 

The gray area on your screen is called the 
desktop. 

Your Macintosh desktop is like your own desk-it's the area 
where you do your work, and it holds the objects and 
information that you work with. On the desktop are various 
icons, each of which can be opened so you can view the 
information it contains. 

Some of the icons, such as disks and file folders, contain other 
icons. You can move icons anywhere on the desktop without 
affecting the information they contain. 
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Icons Each icon has a different function. 

Menus 

These are the most common icons you will see on your 
Macintosh. You may not see all of these icons your screen at 
one time, but at some point you will notice each of them. 

. 
. 

CJ 
rn 
~ 

Disk - To store information. 

Trash-To throw documents away. 

Application - To create new documents. 

Document- Information you have already 
entered . 

Folder- To group several documents 
together. 

System Files - Information Macintosh 
needs to function. 

Menus contain all of the capabilities available 
to you on the Macintosh. 

(Menu Bar )1----1 

Menu command that's 
not currently available 

Name of the 
menu that's 

currently open 

l'nl.ll~ Se1 up 
Print i: 11tn101,1 
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Each word in the menu bar across the top of the screen 
represents a different menu. Each menu contains several 
options, or commands, that are available to you. 

Some menu commands are black; others are 
gray. 

Menu comands that are in black type are currently available to 
you. If a particular command or menu title is gray, it's · 
inappropriate for your current selection or for the environment 
you're in. 

For example, if a window is not open, all of the View menu 
commands will be gray. They are inappropriate, because they 
only affect how information is displayed in an open window. 

There are four steps to choosing a menu 
command. 

To choose a command from a menu: 

1. Point to the menu you want to open. 
2. Hold down the mouse button. The menu name will 

become highlighted and the menu will open. 
3. While holding down the mouse button, point to the 

command you want. It will become highlighted. 
4. Release the mouse button. The command you chose 

will be implemented and the menu will disappear. 

"Select, then operate" is the normal pattern of 
operation. 

Use these two steps to perform most operations when using 
Macintosh. 

1. Select what you want to work with (for example, some text 
or an icon). 

2. Follow the four steps above to choose the appropriate 
command from a menu. 

For example, to open an icon, you would first select the icon, 
and then, choose Open from the File menu. 

If a menu command seems to have no effect, or is gray, you 
probably didn't remember to begin by selecting what you 
wanted to work with. 
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Selecting Information 

Opening and Closing 
Icons 

This indicates what you want to work with. 

To select an object means to indicate that you want to work 
with it. (For example, if you want to open an icon, first select 
it to indicate which icon you want to open.) 

There are several ways to select what you want to work with. 
To select an icon, point to it and click the mouse button once. 
To select some text, hold down the mouse button and drag the 
pointer through it. 

Everything you select will become highlighted in some way (so 
you can check to see that you selected it correctly, and as a 
reminder of what's selected. Most objects will become inverse 
images of themselves when selected (white dots turn black and 
black dots, white). 

I 
Icon that's not selected Selected Icon 

Regular Text Se lectE:>d Text 

Selecting an object doesn't actually change anything. It only 
indicates what will be affected by the change you're about to 
choose. So, if you make an incorrect selection, no harm is 
done. Just start again, and select what you meant to select in 
the first place. The most important thing to remember about 
selecting is a point made earlier: Before you can work with 
something, you must select it. 

Open an Icon to view its contents. 

Open an icon any time you want to see the information it 
represents. If the icon is a file folder, for example, the 
documents stored in the file folder will be displayed. If the 
icon is the Trash, the objects you recently threw away will be 
displayed. 

To open an icon, do the following: 

I. Select the icon. It will become highlighted. 
2. Choose Open from the File menu. 
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The icon will open and its contents will be displayed in a 
window. A window is a rectangle on your screen that has a 
title at the top and displays some information. There are many 
things you can do with windows, such as alter their size and 
move them around on the screen, which will be discussed in 
later Guided Tour sessions. 

You can also open an icon by pointing to the icon and clicking 
the mouse button twice in rapid succession (double-clicking). 
If nothing seems to happen when you double-click on an icon, 
try doing it faster. 

Close a window when you're finished working with the 
information in contains. You can have several windows open 
at once, but your desktop will get cluttered if you don't close 
unneeded windows. 

To close a window, choose Close from the File menu. The 
window will disappear as it returns to its icon form. 

You can organize your work better by grouping 
related icons. 

If you have several icons that are related-perhaps a report, the 
cover graphics, and the overhead transparencies you'll use 
when presenting the report-you may want to have those icons 
close to each other in the disk window, to remind you that they 
go together. Or you may want to organize your work still 
further, by moving the document icons into a file folder. 

Here's how to move an icon on the screen: 

1. Point to the icon you want to move. 
2. Hold down the mouse button. 
3. While holding down the mouse button, move the mouse. 

The icon will move to the location of the pointer. 
4. Release the mouse button when you get the icon where you 

want it. 

You can move several icons at the same time. 

To move several icons, you must first select all of them. You 
do this with a selection box. To draw a selection box: 

1. Imagine a rectangle completely enclosing the icons you 
want to select. 

2. Point to one corner of that imaginary rectangle, but not to 
any icon in particular. 
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D Guidec 
8 i~ems 319K in 

r···········~·····································i 

! ,,.,,;,, .,,,,, L.1 i 

I .Q. I 
cir···························································~-

Practice 

Practice Guided Tour 
Techniques 

open 
Duplicate 8€0 
Get Info 8€1 
Put Back 

Close 
Close Rll 
Print 
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3. Hold down the mouse button and move to the corner 
diagonally opposite. The rectangle you imagined will be 
drawn. 

4. When the rectangle completely encloses all of the icons you 
want to select, release the mouse button. Anything that's 
either completely or partially in the rectangle will be 
selected. 

To move the group of icons, move any one of the selected 
icons the same way you move a single icon. All of the other 
icons that are selected will follow. 

Another way to select several icons is to use the Shift-click 
technique. 

1. Select the first icon. 
2. Hold down the Shift key. 
3. Point to the next icon you want to select and click the 

mouse button. Both icons will now be selected. 
4. Continue Shift-clicking on icons until you have selected all 

of the icons you want to move. 

This is a particularly useful technique if the icons you want to 
select are interspersed with other icons. 

Practice what you saw in the first Guided Tour 
session, "Show me my Electronic Desk." 

Do each step as it's described. 

From the Guided tour screen, click Let Me Use my 
Macintosh! 

Open menus. 

1. Point to the word File at the top of the screen. This is the 
title of the File menu. 

2. Press the mouse button and hold it down to open the 
menu. 

3. Don't choose anything from the menu. 
4. Release the mouse button to close the File menu. 
5. Open the other menus (point to the title and hold down the 

mouse button) to see what's in each and to see which 
commands are gray and which are black. 
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Open and close icons. 

1. Select the Guided Tour disk icon by pointing to it and 
clicking the mouse button. 

2. Choose Open from the File menu to open it. 
3. Choose Close from the File menu to close it. 

4. Select the Trash icon. 
5. Choose Open from the File menu to open it. 
6. Choose Close from the File menu to close it. 

Move individual icons. 

1. Open the Guided Tour disk icon. 
2. Point to one of the icons in the Guided Tour window. 
3. Hold down the mouse button. 
4. Move the mouse to move the icon to a different part of the 

window. 
5. Release the mouse button to deposit the icon in its new 

location. 
6. Practice moving other individual icons. 

Move a group of icons. 

1. Imagine a rectangle completely surrounding all of the icons 
in the Guided Tour window. 

2. Point to one corner of the rectangle with the mouse, but 
don't point to any icon in particular. 

3. Hold the mouse button down. 
4. Move the mouse to the diagonally opposite comer of the 

rectangle. Be sure all of the icons are at least partially in 
the rectangle. 

5. Release the mouse button. All of the icons either partially 
or completely within the rectangle will be selected. 

6. Move one of the selected icons onto the gray part of your 
screen, and all of the icons will follow (as shown below) . 

.S File Edit u;ew Special Training 

§0 Guided Tour 
8 Hems 319K in disk 

•I 
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Practice (cont'd) 

Feedback 

Practice Guided Tour 
Techniques 

7. While the icons are still selected, move all of them back 
inside the Guided Tour window. 

8. Click anywhere within the window, but not on an icon, to 
deselect the icons. None of the icons will remain selected. 

Return to the Guided Tour screen. 

Choose Quit from the Training menu. 

If you had trouble, do one of the following: 

• Replay the first session of the Guided Tour, "Show me my 
Electronic Desk!" 

• Read the appropriate section of Macintosh, the owner's 
manual, which contains complete explanations of all of the 
techniques taught in this module. 

• Ask a colleague, your course manager, or your Apple 
support representative for help. 

Guided Tour of Macintosh (cont'd) 

Guided Tour Complete the second Guided Tour session, 
"What's the Finder?" 

You are now ready to learn the techniques taught in the second 
session of the Guided Tour of Macintosh. Do the following: 

1. Start the cassette again, and follow the instructions to 
listen to the second Guided Tour session. 

2. As soon as you see the Guided Tour screen, stop the 
cassette. 

3. Read the Review of the Guided Tour (on the next page). 
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4. Use the Practice exercise in this module practice the 
techniques you saw in the Guided Tour. 

Continue with this module when you have finished the second 
session of the Guided Tour. 

Read this review of the second Guided Tour 
session, "What's the Finder?" 

Stop the cassette, if you haven't already done so. 

Read the following review of what was covered in the Guided 
Tour. Following the review you'll have an opportunity to 
practice what you've learned. 

The Finder is a program that helps you 
organize other applications and documents. 

The Finder and the desktop are functionally identical. The 
Finder is the application that controls the desktop. Think of the 
Finder as a home base. It helps you keep track of what you 
have done and it's a starting point for running applications. 

Three versions of the Finder have been released. The Guided 
Tour of Macintosh uses Version 1.0. Version 1.1 is the 
version that was released with the Macintosh applications. And 
in May 1985, Version 4.1 of the Finder was released. The 
differences between Version 1.1 and Version 4.1 are 
mentioned throughout this module. (See the Supporting the 
Macintosh Finder module from the Apple Support Training 
Library for more information.) 

You can find out which version you have by choosing About 
the Finder from the Apple menu. 

Create a duplicate if you want to keep more 
than one version of a document. 

If you want to keep the original version of a document, and the 
revised version, first make a duplicate of the document. Make 
your revisions to one copy, and keep the other unchanged. 

You might also make duplicates of documents if you create 
templates of documents or forms that you use often. Creating a 
duplicate of a template is like tearing a sheet off of the top of a 
stack of forms. 
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····--1JL ...... . l...... I • I • ...... J 

To duplicate a document (or any icon), do the 
· following: 

1. Select the icon. 
2. Choose Duplicate from the File menu. A new icon will 

appear titled "Copy of <icon name>." 

Rename your revised version so you won't 
confuse it with the original. 

If you're working with templates, rename the duplicate to 
re:flect the true contents of that particular document 

To rename a document (or any icon), do the 
following: 

1. Select the icon. The icon and its name will become 
highlighted. 

2. Type a new name. Whatever you type will replace the 
existing name. 

Put several related documents into the same 
file folder. 

Just as you store related documents in the same file folder in 
your filing cabinet, you can store related Macintosh documents 
in the same file folder. This reduces the clutter in your 
windows, ·making it easier to find the document you're looking 
for. 

To put a document Into a folder, do the 
following: 

1. Point to the document to be moved . 
2. Hold down the mouse button. 
3. Move th~ mouse to move the icon so that it's on top of the 

folder into which you want to. put the documents. The 
folder should become highlighted (as the Opus Project 
folder is at the left). 

4. Release the mouse button. 

If the folder icon is not highlighted, the documents will not be 
deposited into the folder. Be sure the folder icon is highlighted 
before you release the mouse button. 
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Retrieve a Document 
From the Trash 

~D Trosh 
1 item 4K in Trash 

Empty Trash 

Erase Disk 
Set Startup 
Use Minifinder •.• 

Shut Down 

Open the Information 
Window 
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To throw a document away, move it onto the 
Trash icon • 

To throw away a document, you use the technique you just 
learned for putting a document into a folder-except that this 
time you put the document icon onto the Trash icon. Again, be 
sure the Trash icon is highlighted before you release the mouse 
button. Highlighting is how Macintosh tells you that you're in 
the correct place. Use this same technique to throw away 
folders, or any other icon. 

If you accidentally throw something away, you 
can reach into the Trash and pull it out. 

How many times have you thrown something in the 
wastebasket in your office, only to have to reach in and pull it 
out again. You can do the exact same thing on Macintosh, at 
least until the trash is emptied (just like in your office). 

Open the Trash and move the document to 
another location. 

1. Open the Trash the same way you would open any icon 
(select it and choose Open). 

2. You'll get a window displaying its contents. 
3. Move the document or folder you want to retrieve from the 

Trash to the desired location-a disk, file folder, or the 
desktop. 

There are three ways to empty the trash. 

• Choose Empty Trash from the Special menu. 
• Start up an application. 
• Eject the disk either by choosing Eject or by choosing 

Shut Down (Version 4.1 only). 

If the Empty Trash command is gray and will not highlight 
when you try to choose it, it means the Trash is already empty 
(in which case, the command is irrelevant). 

Use the Information window to determine the 
latest revision of a document. 

If you have several versions of the same document, and you 
aren't sure which is the latest, open the Information window 
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Working with Text 

for each document Check the Modified date to see which one 
is the most recently modified, and therefore the latest revision. 

Information about any icon on the desktop. 

To display the Information window for any icon on the 
desktop, do the following: 

1. Select the icon. 
2. Choose Get Info from the File menu. You'll get a 

screen similar to the one shown below. 

iiiD Information about System Disk 

Kind: 
Size: 
Where: 
Created: 
Modified: 

D Locked 

rLQf) 
System Disk OJ 

disk 
393216 bytes used for 11 files 
internal driue 
Wednesday, May 2, 1984 at 8:04 AM 
Wednesdoy, Morch 7, 1985 ot 3:20 PM 

The flashing vertical line is the insertion point. 

It indicates where anything you type will be added. To move 
the insertion point, do the following: 

1. Use the mouse to position the pointer where you want the 
insertion point to be. 

2. Click the mouse button. 

Click the mouse button to 
move the insertion point here 

~ 
INoti.ce the cunent location of the :insertion 

point and vhere it':s about to be moved.I 

t . 
Current location 
of insertion point 

Most of the time you can't make the insertion point go away. 
You can only move it. 
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12K info 

Guided Tour of Macintosh 19 

Select text before you work with it. 

To select text: 

1. Position the pointer at one end of the word, phrase, or 
passage you want to select. 

2. Hold the mouse button down. 
3. Move the pointer to the other end of what you want to 

select. 
4. Release the mouse button. 

Everything between where you pressed the mouse button and 
where you released it will be selected. It doesn't matte!" if you 
start at the beginning or the end of the text you want to select. 

Use Cut and Paste to move text. 

To move text using the cut-and-paste technique: 

1. Select the text you want to move. 
2. Choose Cut from the Edit menu. 
3. Use the mouse to place the text insertion point where you 

want to add the text. 
4. Choose Paste to insert the text you previously cut. 

The technique for cutting, or copying, and then pasting 
information is the same in all Macintosh applications, 
regardless of what is being moved. 

Click in the close box to close a window. 

The close box is the small box in the top left comer of an open 
window (as shown at the left). 

Click in the close box to close an open window. This is 
exactly the same as choosing Close from the File me~u. 
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Practice 

Practice Guided Tour 
Techniques 

.Q.1 
Co u of ex.~m le 

II 
New Example 

• H@fld$d 

Practice what you saw In the second Guided 
Tour session, "What's the Finder?" 

Do each step as it's described. 

Click Let Me Use my Macintosh! from the Guided Tour 
screen. 

Duplicate a document. 

1. Select the Example document 
2. Choose Duplicate from the File menu. 
3. Move the duplicate to an open area in the window. The 

duplicate will be called "Copy of Example." 

Rename the document. 

1. Select the "Copy of Example" document. The document 
and its name will become highlighted. 

2. Type a new name, such as New Example. Whatever 
you type will replace the existing name. 

File the document in a folder. 

1. If you're using Finder 1.1, make a duplicate of the empty 
folder. If you're using Finder 4.1, choose New Folder 
from the File menu. 

2. Rename it (perhaps, New Folder). 
3. Point to the New Example document you made earlier. 
4. Hold down the mouse button. 
5. Move the document so that it's on top of the New Folder 

you just created. The New Folder will become highlighted 
when you are in the right place. 

6. Release the mouse button. 

Throw the file folder away. 

1. Point to the New Folder file folder . 
2. Hold down the mouse button. 
3. Move the folder so that it's on top of the Trash icon. Be 

sure the pointer is on top of the Trash icon and the Trash 
icon is highlighted. 

4. Release the mouse button. 
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Retrieve the file folder from the Trash. 

1. Open the Trash. 
2. Move the New Folder back into the disk window. 
3. Close the Trash window. 

Empty the Trash. 

(Note: In order to practice emptying the Trash, there must be 
something in the Trash. Hence the first step, even though it 
seems repetitive.) 

1. Throw away the New Folder. 
2. Open the Trash (so you'll be able to see what happens; 

this is not necessary to empty the Trash). 
3. Choose Empty Trash from the Special menu. 
4. Close the Trash window. 

Open the Information window. 

1. Select the Example document icon. 
2. Choose Get Info from the File menu. Leave the 

Information window open on your screen. 

ID Information obout eH11mple 

eKample D 
Kind: document 
Size: 2048 bytes, accounts for 2K on disk 
Where: Guided Tour, eKtemal drlue 
Created: Saturday, February 4, 1984 at 4:22 RM 
Modified: Snturdny, Februnry 4, 1984 nt 5:21 RM 

D Locked 

I 
(insertion point for adding text) 

Enter some text, then move it. 

Notice the insertion point in the box in the bottom of the 
Information window. Anything you type will appear there. 

1. Type something that you might enter into the Information 
window, such as the revision date, a deadline, or a 
reminder. Type at least several words. 

2. Select the first half of the text you just entered. (Notice that 
the pointer on the screen has changed into a text pointer 
or I-beam pointer.) 
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Feedback 

Practice Guided Tour 
Techniques 

3. Choose Cut from the Edit menu. 
4. Move the insertion point to the end of the remaining text 

(position the pointer after the text, and click the mouse 
button). 

5. Choose Paste from the Edit menu. The text you cut will 
be pasted into its new location within the box. 

Close the Information window and return to the 
Guided Tour screen. 

1. Click in the close box to close the Information window. 
2. Choose Quit from the Training menu. 

If you had trouble, do one of the following: 

• Replay the second session of the Guided Tour. 

• Read the appropriate section of Macintosh, the owner's 
manual, which contains complete explanations of all of the 
techniques taught in this module. 

• Ask a colleague, your course manager, or your Apple 
support representative for help. 

Guided Tour of Macintosh (cont'd) 

Take a Break 

Guided Tour 

You've been working hard. Relax for 10 to 15 
minutes before continuing. 

Complete the third Guided Tour session, "Why 
Do I Have Windows?" 

Start the cassette and follow the instructions to complete the 
next Guided Tour session. As soon as you return to the 
Guided Tour screen, stop the cassette and read the review 
below. After the review, practice the techniques you saw in the 
Guided Tour. 
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Continue with this module when you have finished the third 
session of the Guided Tour. 

Review of the third Guided Tour session, "Why 
Do I Have Windows?" 

Read the following review of what was covered in the third 
session of the Guided Tour. Following the review you will 
have an opportunity to practice what you have learned. 

You can work in only one window at a 
time-the active window. 

You can have several windows open on your desktop at the 
same time, but you can only work in the active window. If 
you want to work in a different window, you must first select 
that window . 

. To select a window, point to any visible part of it and click the 
mouse button. If the window was partially obscured by 
another window, it will now be "on top of the stack" and fully 
visible. 

There are several ways to tell which window is the active 
window. 

M11cWrite Disk 

• The title bar (at the top of the window) is gray on both sides 
of the title. On other windows it will be white. 

• The close box is visible. 
• If the windows are overlapping, the active window will 

always be on top. 
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Resizing Windows 

Moving Windows 

Scroll Bars 

• The size box (the lower right comer of the window, which 
enables you to enlarge and shrink the window) is visible. 

Resize windows to view the contents of more 
than one window at a time. 

Most windows are initially only slightly smaller than the 
screen. If you want to view the contents of more than one 
window at a time, you must make the windows smaller. Then 
later, if you want to view more information in one particular 
window, enlarge it again. 

Use the size box to enlarge or shrink a 
window. 

1. Point to the size box in the extreme lower right comer of 
the window (as shown at the left). 

2. Hold the mouse button down. 
3. Move the mouse to resize the window. 
4. Release the mouse button when the window is the size you 

want. 

Move a window to view the contents of more 
than one window. 

If you want to view the contents of more than one window, 
you'll have to resize and move at least one of the windows. 

To move a window, grab the title bar. 

1. Point anywhere within the title bar (at the top of every 
window). 

2. Hold the mouse button down. 
3. Move the mouse to move the window. 
4. Release the mouse button when the window is where you 

want it. 

Use the scroll bars to view other parts of your 
document. 

Most of the documents you '11 create will be too large to fit 
entirely on the Macintosh screen. Spreadsheets, 
word-processing documents, and even graphics will usually be 
much wider and/or longer than the screen. Use the horizontal 
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and vertical scroll bars to view the portions of your documents 
that aren't initially visible. 

There are three components of the scroll bars: 

~D -- Empty Folder 
2 Hems 12K in folder 388K available 

Scroll Arrows ,__~ 

Scroll Bars 

• Scroll arrows. These enable you to slowly scroll up, 
down, left, or right Point to the appropriate arrow and 
click the mouse button to scroll once in that direction. Or 
hold the mouse button down to scroll continuously. 

• The scroll box. This indicates your relative position in 
the window. To quickly jump to any part of the window, 
use the mouse to drag the scroll box (point to it, hold the 
mouse button down, and move it) to the desired location, 
and release the mouse button. 

• The gray area around the scroll box. Click here to 
scroll through your document window by window. For 
example, what if you want to quickly scroll through a text 
document? Click in the gray area below the scroll box in the 
vertical scroll bar. The last line of text will become the first 
line of text and you will be able to see the next window of 
information below that line. 
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Practice 

Practice Guided Tour 
Techniques 

Practice what you saw In the Guided Tour and 
what you read about In the review. 

Do each step as it's described. 

1. Click Let Me Use my Macintosh! from the Guided 
Tour screen. 

2. Open the Guided Tour disk. 
3. Open the System Folder. 

Move a window on your screen. 

Notice that you can't see the bottom of the System Folder 
window. To move the window up the screen, do the 
following: 

1. Point to the title of the System Folder window. 
2. Hold the mouse button down. 
3. Move the mouse to move the System Folder window up 

the screen. 

I 
/ 

4. Release the mouse button when you get the window where _ _,, 
you want it. (It's okay to overlap the Guided Tour 
window.) 

Identify the active window. 

s File Edit Lliew Special 

Guided Tour 
e iltm• 31 9K in disk 

D 
example-

rn 
~ 
Notes 

rn 
~ 

~ 
/\mazing 

System Folder 
1 76K in fo ldor 

rn a a 
8 8 8 D 

Finder Noto Pad Filo Clipboard File lcrapbook Filo RealFinder 
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The System Folder window is now the active window. Notice 
that it differs from the Guided Tour window in the following 
ways: 

• Its title bar is highlighted. 
• It has a close box. 
• It has a size box. 
• If they originally overlapped, the active window now 

covers part of the other window. 

1. Select the Guided Tour disk window to make it the active 
window. Notice how the window changes when it 
becomes the active window. 

2. Select the System Folder window. 
3. Close the System Folder window. 

Use the size box. 

1. Point to the size box in the Guided Tour window. 
2. Hold the mouse button down. 
3. Move the mouse to shrink the Guided Tour window. 
4. Release the mouse button. 
5. Enlarge the Guided Tour window to its original size. 

Scroll through a window. 

1. Shrink the Guided Tour window. 
2. Click on the arrow that's pointing down, to scroll down 

through the window. 
3. Continue scrolling down until you can't scroll anymore; 

you're at the bottom of the window. 

4. Point to the up arrow. 
5. Hold the mouse button down to scroll continuously back 

to the top of the window. Watch the scroll box. 

6. Grab the scroll box in the horizontal scroll bar (across the 
bottom of the window). 

7. Move it to the right edge of the window. 
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Practice (cont'd) 

ED!! Guided Tour ~ 
a items 319K 1n disk SOK ava1 

Feedback 

Practice Guided Tour 
Techniques 

8. Point in the gray area to the left of the scroll box. 
9. Click the mouse button to scroll in window-size 

increments. 
10. Continue clicking in the gray area until you are back at 

the left side of the window. 
11. Enlarge the Guided Tour window to its original size. 

Return to the Guided Tour screen. 

1. Choose Close from the File menu or click in the close 
box to close the Guided Tour window. 

2. Choose Quit from the Training menu. 

If you had trouble, do one of the following: 

• Replay the Guided Tour session. 

• Read the appropriate section of Macintosh, the owner's 
manual, which contains complete explanations of all of the 
techniques taught in this module. 

• Ask a colleague, your course manager, or your Apple 
support representative for help. 
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Guided Tour of Macintosh (cont'd) 

Guided Tour 

Review of the Guided Tour 

Guided Tour 

Review of the Guided Tour 

Complete the fourth Guided Tour session, 
"What Else Is In The Menus?" 

Continue with this module when you have finished the fourth 
session of the Guided Tour. 

Read this review of the fourth Guided Tour 
session, "What Else Is In The Menus?" 

This session talked about the Finder menus. The Apple 
menu, the File menu, and the Edit menu are always available, 
even when you are running an application. The other two 
Finder menus, the View menu and the Special menu, are 
available only when you are using the Finder (when you're in 
the desktop environment and not running an application). The 
Training menu is available only on the Guided Tour disk. 

There is no practice exercise for this Guided 
Tour session. 

When you finish the entire Guided Tour of Macintosh, you'll 
read about the capabilities of each Finder menu in the 
Macintosh manual. So they won't be reviewed here, and there 
isn't a practice exercise. 

Continue with the fifth, and final, session of the Guided Tour. 

Complete the final Guided Tour session, "Time 
To Play The Maze." 

Continue with this module when you have finished the final 
session of the Guided Tour of Macintosh. 

Read this review of the fifth Guided Tour 
session, "Time To Play The Maze." 

Following the review you'll have an opportunity to practice 
what you have learned. 
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Dialog Boxes 

Running Applications 

~ ~ 
Mousing Around Amazing 

A dialog box Is Macintosh's way of asking for 
Information or telling you what's going on. 

Dialog boxes are windows that open on your screen to present 
or ask for additional information, or to inform you of the 
current situation. Sometimes they are the result of something 
you have done, such as choosing a menu option that ends with 
an ellipsis ( ... ). Sometimes they are unsolicited, informative 
comments from the Macintosh, for example, that you are 
running low on space on the disk and should remove some 
documents to make more room. 

If Macintosh is not responding, check for a dialog box and 
make the appropriate response-make a selection, click 0 K, 
press Return, or whatever is called for. The dialog box will 
not go away-nor will the Macintosh proceed-until you take 
some action. 

To run an application, open an Icon. 

There are two types of icons you can open to run an 
application. 

The icon that looks like a hand writing on paper is the 
application itself. Open it to create a new document using that 
application. There are two applications on the Guided Tour 
disk: Mousing Around and Amazing (which are shown at the 
left). 

If you save what you have already entered using an application, 
the information will be represented as a document on your 
screen (like the Mac Write document shown at the left). When 
you open the document, the application will be started 
automatically and the information you previously entered will 
be displayed on the screen. You 're now ready to revise your 
document. 

When you quit an application, you're returned to the Finder 
and your Macintosh desktop. 
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Practice Guided Tour 
Techniques 

Amazing 
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Practice what you saw in the Guided Tour and 
what you read about in the review. 

Do each step as it's described. 

Click Let Me Use my Macintosh! from the Guided Tour 
screen. 

Run an application. 

If you haven't already tried to solve a maze for yourself, go 
ahead and try it now. 

1. Click on Let Me Use my Macintosh!. 
2. Open the Amazing icon. 
3. Choose Skill from the Maze menu. 

Select the desired maze difficulty ••• 

~ [§)! II • 121 D D D 

New Game ) ( Cancel ) 

When you choose Skill from the Maze menu, you're 
presented with a dialog box of the different skill levels 
available. The first level isn't very difficult. Each level is 
harder than the previous one, and the fourth level is almost 
impossible. 

4. Select the level you want from the Skill dialog box. 

If you'd like to, take some time now to try to solve one or two 
of the mazes. Continue when you have finished running 
Amazing. 

5. Choose Quit from the Maze menu. 

Don't choose Quit from the Training menu, because there's 
one more practice exercise for which you'll need the Guided 
Tour disk. 
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Feedback 

Practice Guided Tour 
Techniques 

If you had trouble, do one of the following: 

• Replay the Guided Tour session. 

• Read the appropriate section of Macintosh, the owner's 
manual, which contains complete explanations of all of the 
techniques taught in this module. 

• . Ask a colleague, your course manager, or your Apple 
support representative for·help. 

Guided Tour of Macintosh (cont'd) 

Finder Menus Read the manual. to learn about all of the 
Finder menu commands. 

Read the Finder Menus section of Chapter 4 in Macintosh, the 
owner's manual to learn about each of the Finder menu 
commands. 

Continue with this module when you have finished reading 
about the Finder menus. 
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(-_ II Basic Macintosh Techniques 

Overview 

Mouse Techniques 

f,-- -- ~-..\ 

·.z .. 

This section explains skills that will make it 
easier to use the Macintosh. 

The Guided Tour of Macintosh taught you most of the skills 
needed to use Macintosh. There are a couple other subtle 
points, though, that are worth making because they will make it 
easier for you to use your Macintosh. 

There are practice exercises interspersed throughout the 
remainder of the module that will give you a chance to try out 
these techniques. 

There are only four ways to use the mouse. 

• Click. Press and immediately release the mouse button. 
Click to select an icon, close a window, or make a selection 
in a dialog box. 

• Press. Press and hold down the mouse button. Press to 
use the scroll arrows or to view the contents of a menu. 
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" ·~ 

~ 'l ~J: l 
• Drag. Press and hold down the mouse button, move the 

mouse, and then release the mouse button. Drag to choose 
a menu command, move an icon, select some text, or draw 
a selection rectangle (to select several icons). 

• Double-click. Click the mouse button twice in rapid 
succession. Double-click to open an icon or select a word. 

Variations on the theme. 

There are a couple of variations on these basic techniques, but 
you will recognize that they are indeed variations, and not new 
techniques. 

~JI ____ ,,. 

~r l ~J,.c=.: =====-d 
• Double-click, drag. Double-click, and hold down the 

mouse button on the second click. In other words, click the 
mouse button, and then immediately hold the mouse button 
down to start to drag. Use this technique to select multiple 
words of text (If you just drag through text you will select 
individual letters. Double-click, drag will select only 
complete words.) 
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c_sh_ift_) 
• Shift-click. Hold down the Shift key and click. 

Shift-click to select several icons or to deselect specific 
icons from a group of already-selected icons. 

These same techniques are used by all 
application programs. 

No matter which application you are using or what type of 
information you are working with, you'll always use the same 
mouse techniques. But each application uses the techniques to 
achieve results appropriate to that particular application. For 
example, in MacPaint™, double-clicking the eraser will erase 
the contents of the entire window. 

Because you can have several icons open at 
once, you might lose windows on the desktop. 

Think of a stack of papers on your desk. It's very easy to 
temporarily lose a particular piece of paper when things get 
cluttered. The same thing can happen on Macintosh when you 
have several windows open at once. 

There are three easy ways to find the window you are looking 
for: 

Double-click on the window's icon shadow. 

If you can see the window's icon shadow (see the next page 
for information about icon shadows), double-click on it, and 
that window will become the active window. 

Change the size of the top window, or move 
windows out of the way. 

It's possible that the top window is completely covering the 
one you are looking for. Use the size box to shrink the top 
window, revealing the window(s) under it. Or, move the top 
window to one side. 
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Icon Shadows 

Practice 

Mouse Techniques and 
Icon Shadows 

Close everything, then open the one you want. 

A final alternative is to close all of the windows (choose Close 
All from the File menu) and then open the one that was "lost." 

An icon shadow is a placeholder for a window. 

When you open an icon, an icon shadow is left behind to mark 
where the window will be filed when it is closed. If you see an 
icon shadow, it means that the icon has been moved onto the 
desktop, or that it's open. 

s File Edit Uiew Special 

System Disk 
4 items 288K in disk 

Font Mover Disk Copy Fonts 

6 items 

ITT 
~ 

System 

ITT 
~ 
Finder 

System Folder 
209K in folder 

ITT mo mo mo 
8 8 8 8 

lmagewriter Clipboard File Note Pad File Scrapbook File 

Select an icon shadow to change the name of the icon without 
closing the window. Double-click on an icon shadow to make 
an open window become the active window. 

Practice the mouse techniques and using icon 
shadows to find lost windows. 

You've already had a chance to practice most of the mouse 
techniques many times. This exercise provides the opportunity 
to practice two of the techniques, double-clicking and 
Shift-clicking, which can save you time, and be very useful. 
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You'll also practice using icon shadows to locate a lost 
window. 

Practice mouse techniques. 

The Guided Tour disk window should be open on your screen. 
If not, open it now. 

What if you want to select only the Notes, Example, and 
System Folder icons? There are two ways to do it: (1) select 
each icon individually, and (2) select all the icons and then 
deselect the ones you don't want. Perform each step below, as 
it's described, to practice both of these techniques. 

Select each icon individually. 

1. Select the Notes icon. 
2. Hold down the Shift key and click on the Example icon. 

Both icons should now be selected. 
3. Hold down the Shift key and click on the System Folder 

icon. All three icons should now be selected. 

Guided Tour 
8 items 320K in disk 79K ovoiloble 

Mousing Around Amazing 

Select all of the icons and then deselect the 
ones you don't want. 

1. Position the pointer away from all of the icons and click the 
mouse button to cancel the current selection. 

2. Draw a selection box around all of the icons in the Guided 
Tour window to select them. 

LEARNING TO USE MACINTOSH 



38 Basic Macintosh Techniques 

Practice (cont'd) 

3. Press the Shift key and click on the Amazing icon. It 
should become deselected while the other icons remain 
selected; 

4. Hold down the Shift key and click on the Mousing 
Around icon. It should become deselected while the other 
icons remain selected. 

Use the icon shadow to find a lost window. 

1. Position the pointer away from all of the icons and click the 
mouse button to deselect everything. 

2. Move the System Folder icon onto the desktop, just below 
the Guided Tour disk shadow. 

s File Edit Uiew Specllll Training 

Mo1Jsin9 Around 

D 
Exompl• 

Guided Tour 
344K in disk 

lifFil 
8 
Not•s 

~ 
Amazing 

3. Double-click on the System Folder to open it. (If it doesn't 
open, double-click faster.) 
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4. Move the System Folder window up the screen so that it 
covers most of the Guided Tour window. 

ei File Edit Uiew Special Training 

Guided Tour 
9 items 

iiO - System Folder 
176K in folder 

5. Shrink the System Folder so that it lies completely within 
the Guided Tour window. 

s File Edit Uiew Special Training 

Guided Tour 
10 items 335K in disk 

iiD System Folder 
6 items 

6. Click on any visible portion of the Guided Tour window to 
make it the active window. The System Folder window 
will be completely hidden behind the Guided Tour 
window. 

7. Double-click on the System Folder shadow (shown at left) 
to make the System Folder window the active window. 
The window will now be back on top of the Guided Tour 
window. 
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Practice (cont'd) 

Feedback 

Mouse Techniques and 
Icon Shadows 

8. Return the System Folder window to its original size and 
location on the desktop. 

* File Edit Uiew Special Training 

Guided Tour 
ms 327K in disk 

~ 
Mo1Js:ing Around 

D 
Example 
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System Folder 
177K in folder 
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Note Pad File Clipboard File Scrapbook File Re-alFinder 

9. Close the System Folder and place the icon back inside the 
Guided Tour window. 

Return to the Guided Tour screen and stop. 

1. Choose Quit from the Training menu. 
2. From the Guided Tour screen click I'm Ready to Stop! 

The Guided Tour disk will be ejected. 

If you had trouble, do one of the following: 

• Reread this section to be sure you understand the techniques 
covered. 

• Read the Summary of Mouse Techniques section of Chapter 
3 in Macintosh, the owner's manual. 

• Ask a colleague, your course manager, or your Apple 
support representative for help. 
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Guided Tour of Macintosh (cont'd) 

Command Key 

Take a Break 

Use the Command key to choose menu 
commands from the keyboard. 

Some people prefer to use the keyboard rather than the mouse. 
The commands that can be chosen either way are those which 
are listed in the menus followed by the Command-key symbol 
and a letter of the alphabet. To choose one of these comma..'1ds, 
hold down the Command key (just to the left of the spacebar) 
and type the appropriate letter. 

Here's a summary of the Finder menu commands that have 
keyboard equivalents. 

New Folder XN Undo XZ 
Get Info XI Cut XH 
Duplicate XO Copy XC 
Eject XE Poste XU 

Select All XR 

You've been working hard. Relax for 10 to 15 
minutes before continuing. 
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II Documents and Folders 

Overview 

Desktop Analogy 

This section describes techniques for working 
with documents and folders. 

The Macintosh desktop environment is very different from the 
operating environments of traditional personal computers. You 
do many things on the Macintosh desktop using pictures of 
documents, file folders, and trash cans, the same way you do 
those same tasks at a real desk with real documents, file 
folders, and trash cans. Therefore, many users will find using 
Macintosh intuitive and very easy to learn. 

However, despite its similarity to the real world, there are some 
differences, as well as some techniques unique to Macintosh 
that don't have a real-world analogy. For example, there's no 
task associated with a real desk that's comparable to viewing 
the contents of a folder by icon or by size. 

This section describes how to do the obvious tasks, as well as 
the not-so-obvious. You will learn how to move documents 
and folders, copy them, save your work, and throw away what 
you don't want anymore. 

Practice exercises are included to give you an opportunity to try 
each of the techniques. Read the description of each technique. 
Then practice each technique in the exercises provided. Have 
your Macintosh ready, along with the following: 

• A Macintosh System Disk 
• A Mac Write disk 
• A blank disk 

The desktop analogy encompases all phases 
of information management on your computer. 

Working on your Macintosh is, in many ways, like working at 
your desk. But it goes beyond piCtures of documents and 
folders on the screen. It's worth spending some more time 
drawing some parallels to help you understand what's going on 
both inside the computer and on the screen. 

So, let's go back to the precomputer office, and see how 
closely the two worlds correlate. 
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Computer memory is like a chalkboard. 

Writing notes on a chalkboard is similar to working with 
information in a computer's memory, commonly called RAM 
(Random Access Memory). The information on the chalkboard 
and the information in memory is easily removed or lost. A 
colleague can come in and erase the board, and a power failure 
can make the information in the Macintosh RAM disappear. 

Transferring information to paper is analogous 
to saving it on a disk. 

Transferring the information from the chalkboard to a sheet of 
paper is analogous to saving the information to a disk. A 
version of the information is safely on disk and can easily be 
referred to in the future. Also, both forms of storage are easily 
transportable. 

Duplicating some paper is similar to backing 
up a disk. 

Duplicating the sheet of paper and filing it in a different place 
from the original is a safety precaution similar to backing up a 
Macintosh document or disk. The information resides in two 
separate places, ensuring that the destruction of one copy does 
not result in the total loss of the information. 

A filing cabinet is analogous to a hard disk. 

A filing cabinet is used to store large amounts of information 
and the information tends to stay there for a long ti.me. A hard 
disk performs the same function when you are using a 
Macintosh. You can store your documents and file folders 
there and retrieve them at some time in the future. Also, both 
tend to be permanently located in one place. 

A hard disk is basically the same as a smaller disk in its ability 
to store information. It's different from a smaller disk in that it 
can store much more information; it can access that information 
more quickly; and it's not as portable. 

The techniques for copying and moving 
documents are similar. 

The techniques for storing and duplicating paper also have 
correlates in the Macintosh working environment. On the 
Macintosh, you can copy documents and move them between 
file folders and the hard disk (filing cabinet) just as you would 
with pieces of paper. 
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Moving Documents 
and Folders 

Throwing away documents is very similar, too. 

Throwing away your papers and file folders when they aren't 
needed anymore is the same as putting Macintosh documents 
and folders into the Trash and erasing disks when the 
information they contain is no longer needed. 

Throwing away a file folder throws away its contents, too. In 
Version 4.1 of the Finder, throwing away a disk actually ejects 
it and removes its shadow from the screen (you don't lose any 
information). 

The technique is different depending on 
the source and destination. 

The Guided Tour of Macintosh introduced you to these 
concepts and procedures. This section will show you the 
techniques used to copy and move documents and folders, and 
will clarify the difference between copying and moving 
documents on the same disk and between disks. 

Moving an icon from one place to another has 
different effects. 

Dragging an icon from one place to another moves that icon to 
a new location. The result of the move depends on where you 
move the icon. 

• Dragging an icon onto the desktop has no effect. 

• Dragging an icon from one place to another on the same 
disk (or to a folder on that disk) just moves the icon to a 
new location. No information is actually moved anywhere. 

• Dragging an icon to another disk (or to a folder on another 
disk) puts a copy of the document on the disk and leaves the 
original where it is. 

Choose Duplicate to place a copy on the same 
d~~ . 

Dragging an icon elsewhere on the same disk just moves the 
icon. Choosing Duplicate creates a copy of the document on 
the same disk as the original. The duplicate will be titled 
"Copy of <original name>." 
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Move a document onto another disk. 

Remember that if you drag an icon to another disk, a copy of 
that document or folder will be placed on the disk but the 
original will stay where it is. Moving a document, by 
definition, means that the document is in a new location, and 
that it no longer exists at the original location. 

For example, to create some room on a disk, move several 
documents onto a separate data disk. 

To move a document or folder to another disk: 

1. Drag the document or folder to the destination disk. 
2. Throw away the original. 

Here is a table that summarizes the techniques just described. 
The technique is the same for folders as it is for individual 
documents. 

SAME DISK DIFFERENT DISK 

Select Select 
COPY Duplicate Drag to other disk 

Drag to new location 

Select 
MOVE Select Drag to other disk 

Drag to new location Put original in Trash 

There are two ways to save the information in 
your document. 

To ensure that your work on the Macintosh will be around for 
modification in the future, save it on a disk. Use either of the 
two save commands in the File menu, Save and Save as, to 
preserve your work. 

(Note: These commands are available only when a document 
is open. They are not available when you're in the Finder.) 
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Choose Save to store the information under 
the same name. 

If the document is new, you will be asked to enter a name for 
the document. When you choose Save, you'll get the 
following dialog box: 

Saue Current Document Rs Disk Nome 

( Eject J 

( Soue ) ( Cancel J ( Driue ) 

Enter a name and choose which disk you want to save it to by 
clicking Drive. If the disk on which you want to save the 
document is not available, click Eject to eject the disk whose 
name is displayed in the dialog box above the Eject button, and 
then insert the appropriate one. This dialog box may vary 
slightly from application to application, but the basic content is 
the same. 

The Save command automatically stores the document you're 
currently working on under the same name it was stored under 
previously (no dialog box appears). It also leaves the 
document window open so you can continue entering 
information or making modifications. 

Choose Save As to store the information under 
a different name. 

The Save as command is similar to Save, except that it gives 
you the opportunity to save your document under a different 
name or on a different disk. Save as also leaves the window 
open so you can continue making modifications. 

Use Save as when you want to save a copy of a document to 
a different disk or when you want to keep the original in 
addition to the revised version. 

When you choose Save as, you'll get the dialog box 
described above. The name defaults to the original name of the 
document. Changing the name is optional, but if you're saving 
two versions of the document on the same disk, you can't use 
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the same name. Choose which disk you want to save your 
work on, and click Save. 

After you click Save, the document displayed on your screen 
is the one you just saved, not the original. For example, if you 
created your original on the internal disk and then used Save 
As to save a copy on a disk in the external disk drive, the 
document open on your screen is the one saved on the disk in 
the external drive. If you make changes and choose Save, the 
changes will be written to the disk in the external drive. 

Click Cancel if you want to ignore the Save command, close 
the window, and continue editing the document. 

Choose Close to close the document window. 

You have already used Close and the close box to close a disk 
or folder window while in the Finder. When you have a 
document open, you also choose Close to close the window. 

The Close command closes the document window that's 
currently active, but leaves you in the application that was used 
to open the document If you have made some changes to the 
document, the following dialog box will appear, asking you if 
you want to save your changes: 

Soue changes before closing? 

n Yes Il 

( No ) ( Concel ) 

Click Yes to save your changes. Click No to throw away all 
of your changes. Click Cancel to ignore the Close command 
and leave the window open so you can continue working on 
the document. This dialog box will vary slightly from 
application to application, but the message is the same. 

Choose Close, or click in the close box, when you want to 
close the document you're working on so you can open another 
document using the same application. This method is faster 
than quitting, returning to the Finder, and opening the next 
document. The technique for doing this is described in many 
of the applications modules. 
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Quit Quit closes the window and returns to the 
Finder. 

Practice 

Practice Working with 
Documents and Folders 

Choose Quit from the File menu when you are finished with 
the document you're working on and you want to stop using 
the application. If you choose Quit before saving your 
changes, the same dialog box that appears when you choose 
Close will appear. Click either Yes, No, or Cancel. 

Quit or Close? 

Quit and Close both close the active window and give you an 
opportunity to save your changes. The difference is that Quit 
returns you to the Finder, whereas Close keeps you in the 
application and allows you to quickly open another document. 

Do each step as it's described. 

This Practice provides a series of exercises to help you practice 
creating, saving, revising, and backing up documents. 

Create and save a document. 

1. Insert the Mac Write disk and tum on the Macintosh. 
2. Open the disk icon. 
3. Double-click on the Mac Write application icon (shown 

at the left) to create a new Mac Write document. 
4. When the window is open and you see the insertion point, 

type something. (Anything but "The quick brown fox ... " 
Be creative.) 

5. Save what you have done so far by choosing Save from 
the File menu. 

6. Enter a name for the document. 
7. Click Save. 

The work you've done so far has been saved. The window is 
still open on your desktop with the new name in its title bar. 

Modify the text, but don't save your changes. 

Sometimes you will be revising or experimenting with a 
document and will decide you liked the original better. Here's 
how to throw away all of your revisions and keep the original: 
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1. Enter some more text or change what you have already 
typed. (Remember how to move text? Select it, choose 
Cut, move your insertion point, and choose Paste.) 

2. Choose Close (or click in the close box) to close your 
document 

3. When asked if you want to save your changes, click No. 

The window will be closed without the changes being saved. 
But you are still in MacWrite--notice that the Mac Write menus 
are still visible and the desktop icons have not appeared. 

Save your changes and keep the original. 

What if, as you are revising a document, you decide you want 
to keep both the original and the revised version? Here's how 
to do it. · 

To create two versions of the document: 

1. Choose.Open from the File menu. You will be presented 
with the Document Directory dialog box. 

2. If you don't see the name of your document, scroll down 
through the list of names. 

3. Point to the name or your document and click the mouse 
button to select it (it will become highlighted). 

4. Click Open. 
5. Add some text to what you already have. 
6. Choose Save as from the File menu. 
7. Enter a new name for the document. 
8. Click Save. 

The original won't be affected and your changes will be saved 
under the new name. The window will remain open on your 
screen but the title will change to the name you just entered. 
Further changes are made to the copy, not to the original. 
When you choose Save, all changes will be made to the 
document whose name appears at the top of the window. 

Revise the original and keep the changes. 

This is probably the most common situation you'll encounter. 

1. Click in the close box to close the revised version. 
Because you just saved it, you will not be asked if you 
want to save changes. 

2. Choose Open to open the original document. 
3. If you don't see the name of your document, scroll down 

through the list of names. 
4. Double-click on the name of your document to open it. 

This is the same as selecting the name and clicking Open. 
5. Revise your document (change the text or add to it). 
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Practice (cont'd) 

6. Choose Quit from the File menu. You will be asked if 
you want to save your changes. 

7. Click Yes. 

You have just edited a document, saved your changes, quit the 
application, and returned to the Finder. 

Make some backup copies of your documents. 

Insert the blank disk into the external drive. If you are told the 
disk is not a Macintosh disk, .click Initialize in the dialog box. 
This will take a couple of minutes. When the initialization is 
complete, enter a name for the disk, and click OK (see the 
Disks section of this module for more information about 
initializing disks). 

For this part of the exercise, let's be sure you have the terms 
straight The MacWrite disk, where you created your original 
document and saved your revised document, is in the internal 
disk drive. You just inserted the backup disk into the external 
disk drive-and possibly initialized it. 

To practice moving and copying documents, do the following: 

1. Copy the original document onto the backup disk: 

• Drag the icon on the original document onto the icon of 
the backup disk. 

• Be sure the backup-disk icon is highlighted when you 
release the mouse button. 

2. Make a duplicate of the revised document on the Mac Write 
disk: 

• Select the revised document icon. 
• Choose Duplicate. 

3. Move the duplicate you just made to the backup disk 
(remember that moving something, unlike copying, by 
definition means that it's no longer in its original location): 

• Drag the icon for the duplicate you just made onto the 
backup-disk icon to put a copy on the backup disk. 

• Throw away the duplicate you just made to complete the 
move. 
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4. The Mac Write disk should contain the original document 
and the revised document Open the backup disk to 
confirm that it contains backup copies of each document. 

Often after creating documents, you'll want to move them onto 
another disk, on which you'll revise them at some later date. 
This last part of the practice exercise has you create a file folder 
for the documents on the data disk, which will make them 
easier to find, and then has you remove the documents from the 
Mac Write disk. 

1. The backup-disk icon should be open and it should be the 
active window. 

2. Choose New Folder from the File menu to create an 
Empty Folder on the backup disk. (If you don't see the 
New Folder command, you have an old version of the 
software. Instead, make a duplicate of the Empty File 
Folder.) 

3. Rename the folder (it's already selected, so just type a new 
name). 

4. Put the documents that are on the backup disk into the file 
folder. 

5. Make the Mac Write disk the active window (click on any 
visible portion of the window). 

6. Throw away the original document and the revised 
document from the Mac Write disk. 

7. Empty the Trash. 
8. Choose Shut Down from the Special menu. (If Shut 

Down isn't in theSpecial menu, you have an old version 
of the software. Instead, select each icon and choose 
Eject.) 

9. Tum off the Macintosh. 

If you had problems, try one of the following: 

• Reread the section of this module that pertains to the area 
with which you had difficulty. 

• Read the section of Macintosh, the owner's manual, that 
contains complete explanations of the techniques covered in 
this module. 

• Ask a colleague, your course manager, or your Apple 
support representative for help. 
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•Disks 

Overview 

Disk Care 

Learn what is on a disk, how to handle disks, 
and how to use them. 

Disks are one of the most important components of a computer. 
You run applications from disks and save all of your work on 
them. Because of the amount of handling involved, they're 
also the cause of most problems. Therefore, the more you 
know about disks, the fewer problems you'll have. 

This section covers how to handle and care for disks, what's 
on a disk, the difference between startup disks and data disks, 
and how to initialize, back up, erase, and repair disks. 

Exercises are included to help you practice the techniques 
described in this section. Read the descriptions of disk 
techniques in the first part of this section, and then complete the 
practice exercises when you get to them. 

(See the Supporting ProDOS and DOS module from the Apple 
Support Training Library for a more technical description of 

. how data is stored on a disk.) / , 

Take care of your disks, and you'll have fewer 
problems with them. 

Inside the disk's plastic shell is a small flat disk, made of 
material similar to that used in audiocassettes. Like the 
audiocassette, the disk must be treated with care. 

The cause of many personal-computer problems is lack of 
proper care for disks. If you adhere to these three rules, you 
will have very few problems. 
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Keep disks away from extreme heat. 

Just like record albums, disks can warp and become useless. 
Therefore, avoid leaving your disks in extreme heat or direct 
sunlight for an extended period of time. Don't leave them in a 
closed car on a hot day, or on top of something that gets very 
warm, such as your computer. 

Do not touch the surface of the disk. 

Oil from your fingers can attract dust, which will interfere with 
the computer's ability to read information from the disk. 
Fortunately, the Macintosh disks have a shutter that 
automatically closes over the disk surface to prevent you from 
accidentally touching it. Still, be careful when handling disks. 
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Keep disks away from magnets. 

Information is stored on disks magnetically. If a disk gets too 
close to a magnet, the information stored on that disk could be 
lost. 

This isn't as easy as you might think, because magnets are 
everywhere. Telephone bells have magnets. Televisions and 
video monitors have magnets that are used to align the picture. 
Fluorescent fixtures, stereo speakers, and headphones also 
have magnets. These magnets are usually quite small, but that 
doesn't mean they can't do some damage. 

Often, the damage to the disks is not immediate. However, 
after storing disks near a magnetic source for a period of time, 
noticeable damage may occur. 

If your disk is damaged, you may get an error 
message. 

If your disk becomes damaged, the Macintosh may display a 
message stating: "Disk has been damaged," "Disk needs 
repairs," "Can't read this paragraph," or something similar. 

This is one of the reasons for keeping backups of your disks. 
If you have a backup, you can copy the backup onto another 
disk and continue working. If you don't have a backup and 
your original disk becomes damaged, you may have just lost 
everything. (See the Managing Macintosh Files module from 
the Apple Support Training Library for techniques for 
salvaging documents and disks.) 
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A disk contains a directory and the information 
you have saved. 

Directory 

Documents 
Folders 
Applications 

l ro.::::::::::::::::i J 
The directory is like a table of contents for the disk. It contains 
the name, location, and size of each piece of information, and 
the size and location of any available space on the disk. 

The information consists of applications, documents, folders, 
operating systems, and so forth, that are stored on your disk. 

Hard disks and disk have the same two basic components. 

You must Initialize all disks before you can 
use them. 

Initializing prepares a disk so that information, such as startup 
information or documents, can be saved on it. A disk, before 
it's initialized, is like a newly paved parking lot-totally blank 
and without order. Initializing the disk is like painting the lines 
in the parking lot-it provides a framework for organization. 
Technically speaking, initializing a disk creates the directory. 

Manufacturers don't sell disks already initialized because disks 
usually can be used on a variety of computers and each 
computer has its own way of storing information. 

Initializing a disk erases all information previously stored on it. 
To prevent you from accidentally losing valuable information, 
initializing programs usually warn you just before they begin 
that you're about to erase information, so you can cancel the 
initialization if necessary. 
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Startup vs. Data Disks 

When you insert a disk that has not been initialized on a 
Macintosh, you will get the following message: 

This is not a Macintosh disk: 

Do you want to initialize it? 

( Eject ) (Initialize) 

Click Initialize to go ahead and initialize the disk, or click 
Eject to eject the disk, unchanged. 

After the disk has been initialized, you'll be asked to name it. 

A disk is either a startup disk or a data disk, 
depending on the information it contains. 

(Note: A startup disk is often called a boot disk in other 
computer systems.) 

Startup disks contain the information needed to start up your 
computer. When the Macintosh is first turned on, information 
is read from the startup disk that tells the computer what to do 
next. On the Macintosh, all of the startup information is in the 
System Folder. In addition to getting your Macintosh up and 
running, the System Folder also contains information that tells 
the computer how to print your documents and how to create 
the desktop screen display. 

You can't do much with just the System Folder, though. So, 
for most purposes, you will add an application, such as 
Mac Write or MacDraw™, to your startup disk. 

If a disk does not contain the startup information (the System 
Folder), it is a do.ta disk. This means that it's only used to store 
data, and can't be used to start up your Macintosh. But because 
you don't have the startup information on the disk, there is 
much more room for data. To use a data disk, start up the 
Macintosh using a startup disk, and then store information or 
retrieve it from the data disk. 

For example, the System Disk that comes with your Macintosh 
is a startup disk because it contains the necessary startup 
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information (in the System Folder). The blank disk that comes 
with your Macintosh is a data disk. 

Any disk can be used as either a startup disk or a data disk. 

You can make a data disk into a startup disk 
by moving the startup information onto it. 

To make a data disk into a startup disk, copy the System Folder 
onto a data disk. To make a startup disk into a data disk, throw 
away the System Folder. 

If you attempt to start up the Macintosh from a data disk, the 
Macintosh will eject the disk and display a disk icon with a 
flashing "X" to indicate that the disk is not a startup disk. 

Practice different techniques for creating a 
startup disk. 

To use disk space most efficiently, some disks should be 
startup disks and others should be data disks. An application 
can reside on either a startup disk or a data disk. Most people 
find it more effective to have the application on the startup disk. 

There are two ways to create a startup disk: 

• Copy the System Folder onto a data disk. 
• Duplicate a startup disk and throw away what you don't 

need. 

Depending on which Macintosh configuration you are using, 
one way of creating a startup disk may be easier or faster than 
the other. The following Practice section will help you to 
identify the best procedure to use on each Macintosh 
configuration. There's an exercise for each that outlines the 
steps used. 
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Practice (cont'd) 

Three Exercises 

Create a Startup Disk: 
Two-Drive System 
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Choose the exercise that's appropriate for the 
system you're using. 

There are three different practice exercises because the 
techniques are different for different Macintosh systems. The 
three exercises are for the following system configurations: 

• Macintosh 128K or 512K with two disk drives. 
• Macintosh 128K with one disk drive. 
• Macintosh 512K with one disk drive, or Macintosh XL. 

Do the exercise that is appropriate for your system, and read 
through the other two to become familiar with the alternative 
techniques. 

Copy the System Folder. 

If you have either a Macintosh 128K or a Macintosh 512K with 
two drives, create a startup disk by copying the System Folder 
from a startup disk to the data disk. 

Use the System Disk and a blank disk to practice this. The 
steps to create a startup disk are listed below. If you think you 
already know how to do it, try it without looking at the 
directions. 

To create a startup disk on a two-drive system, do the 
following: 

1. Start up from the System Disk. 
2. Insert the blank disk into the external drive. 
3. If you get a message saying the disk is not a Macintosh 

disk, click on Initialize. After initializing the disk, enter 
a name for it. 

4. Open the System Disk icon. 
5. Move the System Folder to the icon for the data disk. 

When the copying process is finished, your data disk will be a 
startup disk. 

Read through the other two exercises, and then follow the 
instructions to check your work. 
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Copy the disk, and then throw away what you 
don't want. 

(Note: It is possible to use the two-drive method for creating a 
startup disk on a one-drive system. But it takes longer than the 
method outlined below because you will have to swap disks.) 

On a Macintosh 128K with one disk drive, the fastest way to 
create a startup disk is to use the Disk Copy program to copy 
the original startup disk, and then throw away what you don't 
need. 

Disk Copy is designed/or the Macintosh 128K with a single 
disk drive. It does not take advantage of the external disk drive 
and won't work on a Macintosh 512K. 

Use the System Disk and a blank disk. If you think you 
already know how to complete the exercise, try it without 
looking at the directions. 

To create a startup disk on a Macintosh 128K with one disk 
drive, do the following: 

1. Start up from the System Disk. 
2. Open the disk icon. 
3. Select and open the Disk Copy icon. If you don't see Disk 

Copy, look in the System Folder. 
4. Follow the instructions on your screen to use the Disk 

Copy program. It will involve swapping the original and 
backup disks several times. 

When the Disk Copy program has finished, you will have an 
exact duplicate of the System Disk. The next step is to remove 
what you don't want on your new startup disk. 

5. Change the name of the destination disk, which is now a 
startup disk identical to the System Disk, to ensure that all 
of your disks have unique names. 

• Start up from the copy of the System Disk. (If the new 
startup disk doesn't work, go to the Feedback section 
following this exercise.) 

• Select the disk icon. 
• Type a new name for the disk. 

6. Open the disk and select all of the icons except the System 
Folder and put them in the Trash. (Either use the selection 
rectangle, or use the Shift-click technique to select the 
icons you want.) 
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Practice (cont'd) 

Create a Startup Disk: 
One-Drive 512K, or XL 
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Check Your Work 

You have now created a startup disk from your System Disk. 

Now read through the last exercise, or skip to the end of the 
practice exercises and continue with this module. 

Copy the System Folder. 

If you have a Macintosh 512K with one disk drive or a 
Macintosh XL, there is enough memory to be able to copy the 
entire System Folder with only two disk swaps (one to read the 
information from the original, and the other to write the 
information to the destination disk). 

Use the System Disk and a blank disk. If you think you 
already know how to complete the exercise, try it without 
looking at the directions. 

To create a startup disk on a Macintosh 512K with one disk 
drive, or on a Macintosh XL, do the following: 

1. Start up from the System Disk. 
2. Choose Eject to eject the System Disk. 
3. Insert the blank disk. Initialize it if you have not 

previously done so. 
4. Open the System Disk icon shadow (the gray image left 

behind when you ejected the disk). 
5. Move the System Folder to the blank disk. 
6. Swap disks when you are asked to do so. 

When the copy is finished, the System Folder will have been 
added to your blank dis~. If you already had other information 
on the destination disk, it would still be there. The System 
Folder was added to the existing contents of the disk. 

Start up from the newly created startup disk to 
be sure it works. 

If you are using a Macintosh 128K with one disk drive, you've 
already checked your work, so you can move on to the 
Feedback section. 

Otherwise, you should start up from the newly created startup 
disk to be sure you did everything correctly. Right now, your 
screen should be displaying the desktop. 
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To check your work, do the following: 

1. Choose Shut Down from the Special menu. If the 
Shut Down command isn't there, you have an old 
version of the Finder. Instead, do the following: 

• Eject both disks by first selecting the icon and then 
choosing Eject from the File menu. 

• Press the Reset button or tum the Macintosh off and 
then on again. 

2. Insert the newly created startup disk into the internal disk 
drive. 

If everything works as it should, you will see the desktop. If 
the Macintosh doesn't start up, repeat the exercise. 

3. Choose Shut Down again, or choose Eject to eject the 
disk. 

4. Tum off the Macintosh. 

You should now have two startup disks. 

You should have your original startup disk, and the one you 
just made and tested. If not, reread the exercise and complete 
the steps you missed. 

If you have problems, refer to the section on Creating a Startup 
Disk in Chapter 3 of the Macintosh manual, or ask a colleague, 
your course manager, or your Apple supJX)rt representative for 
help. 

Add applications so you can do more than just 
start up the Macintosh. 

You can't do much with a disk that has only the System Folder 
on it (except startup Macintosh). Most of the time, you will 
want to add an application to the startup disk to make it more 
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Make an Existing Data 
Disk into a Startup Disk 

useful. To add an application, you need to start up from your 
new startup disk, insert the application disk, and move the 
application icon to the disk icon. 

First check to be sure there's room. 

If you want to convert an existing data disk, one that already 
has information on it, into a startup disk, you must first check 
to be sure there's room. 

To see how much room a System Folder takes, open the 
startup disk from which you're going to copy the System 
Folder and choose by Size from the View menu. The first 
item in the list should be the System Folder, and the first 
column tells you how much room it needs. 

Then open the data disk that you want to make into a startup 
disk. The amount of free space is displayed at the right edge of 
the title bar. 

Add the System Folder to information already 
on the data disk. 

To convert a data disk into a startup disk on a two-drive 
system, a Macintosh 512K, or a Macintosh XL, use the same 
procedure you used to create a startup disk. Copy the System 
Folder onto the data disk by moving the System Folder icon. 
The information in the System Folder will be added to 
information already on the disk. 

What about a Macintosh 128K with one disk drive? 

The technique for creating a startup disk on a Macintosh 128K 
starts by completely erasing the contents of the destination 
disk. What if there is data on that disk that you want to save? 

If you want to add the startup information but don't want to 
lose existing documents on the disk, do the following: 

1. Start up from the System Disk. 
2. Eject the System Disk. 
3. Insert the data disk. 
4. Open the System disk's shadow. 
5. Move the System Folder from the System Disk window to 

the data disk. 

On a Macintosh 128K, you will be asked to swap disks many 
times, and you will end up with two startup disks: the System 
Disk and one containing the System Folder and all of your 
data. 
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Because this technique adds the startup information to existing 
documents on the disk, be sure there's enough room available. 
Otherwise, you'll get a message saying there is not enough 
room and you will have to start all over again. To create 
more room on a disk, transfer some documents to other disks 
or throw them away. 

Lock your disks to avoid accidentally erasing 
your information. 

(Note: The term locked is the same as write protected on other 
computer systems.) 

To be absolutely sure you won't accidentally write over 
information that you want to keep, lock the disk. To do this, 
slide the small red (or black) tab at the top right comer toward 
the top edge of the disk. This makes it impossible to write to 
the disk or erase existing information until you move the tab 
back into place. 

Here is an easy way to remember what each position of the tab 
means: Most disks have red tabs, and red generally means 
danger. When you are looking at the front of the disk, if you 
see the red tab, watch out! You are in danger of losing 
information. The disk is not locked. If you don't see the red 
tab (you see right through the disk), there is no danger. The 
disk is locked. 

Locking a disk doesn't interfere with reading information from it. 

You can't lock the disk you use to start up your Macintosh. 
This is because information regarding the desktop display and 
other system information is constantly being written on the 
startup disk. 

Back up your disks in case you lose the 
information on your original disk. 

In the original office analogy, disks corresponded to pieces of 
paper-a "somewhat" permanent, portable copy of your 
information. The reason it's only somewhat permanent is that 
it is always possible to lose a piece of paper, accidentally throw 
it away, or perhaps spill something on it that renders it 
unreadable. This is true for disks, too, except the 
consequences could be much worse. If you lose a disk or it 
becomes unreadable, you could lose not just a page or two, but 
hundreds of pages of work. That's why it's very important to 
keep backup copies of your disks. 
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A backup is an exact copy of your disk. If something happens 
to your original disk, just make a working copy of your 
backup, and in minutes, you're back on track. 

Depending on how much work you are generating, you should 
make a backup at least once a week, and possibly once every 
day. 

Back up either entire disks or individual 
documents. 

Creating a backup means saving a spare copy of the original in 
a separate place. The backup can be of an entire disk or of 
individual documents. The type of documents you're working 
with and the amount of information that's changed will 
determine which is appropriate. 

If you are making changes to only one document on the disk, 
it's necessary to back up just that document. If you are 
working with a large document that takes most of the disk, it is 
quicker to back up the entire disk. If the disk you are working 
with is a startup disk, doing a full-disk backup will save all of 
the startup information (which you don't really need to back 
up). So, it might be more efficient to hack up only individual 
documents. 

When you back up a disk, the directory and all 
of the information Is copied. 

Directory 

Documents +--+----H• Documents 
Folders --+---i---+-.- Folders .......... ~;.....;.._ ............ 
Applications -+---~ Applications 

D D 
Original Disk Backup Disk 

Remember what's on a disk: the directory and all of the 
information you have stored. When you do a disk backup, the 
directory and all the information is copied exactly as it appears 
on the original. 

It's important to remember that when you finish backing up a 
disk, the contents of the destination (backup) disk will be 
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identical to the contents of the original disk. (The name of the 
destination disk stays the same, though.) It's not a situation of 
adding documents to a disk, but of replacing everything on a 
disk with what is on the original. Therefore, be sure your 
destination disk doesn't have any information you will need 
later. 

Don't do it yet. 

Read this section. Then follow the instructions in the practice 
exercises to try these techniques. 

Macintosh 128K or 512K-two disk drives. 

If you have a two-drive system, insert both disks and drag the 
icon for the original disk onto the icon for the destination disk. 
You will be asked if you want to erase everything on the 
destination disk. Click Yes. 

Macintosh 128K-one disk drive. 

If you have a Macintosh 128K with one disk drive, use the 
Disk Copy program on your System Disk. To use the Disk 
Copy program, follow the instructions in the practice exercise 
at the end of this section. Or, follow the instructions that the 
program gives you (it tells you exactly what to do and is very 
easy to use). The Disk Copy program works only on a 
Macintosh 128K. 

Macintos'1512K with one disk drive, or a 
Macintosh XL. 

If you have a Macintosh 512K with one disk drive, or a 
Macintosh XL, do the following: 

1. Insert the original disk. 
2. Choose Eject to eject the original disk. 
3. Insert the backup disk. 
4. Drag the icon of the original disk onto the icon of the 

backup disk. 
5. When asked if you want to completely replace the contents 

of the disk, click OK. 

You will only need to swap disks twice. The name of the 
backup disk will remain the same, so you may want to 
change it. 
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Backing Up Individual 
Documents 

Erasing a Disk 

Use the Finder or the Save As command. 

Directory Directory 

Documents-t--+---~ Document 
Folders Document 
Applications Document 

D D 
Original Disk Backup Data Disk 

If you are going to back up individual documents, create a 
backup data disk. Don't put applications or startup 
information on it-you should already have copies of those, 
and they take up room you could otherwise use for backing up 
additional documents. 

If you are in the Finder, insert your backup disk and copy the 
document from the original disk to the backup disk. The 
document will be added to those already on the disk. 

If a document is open (you're running an application), you can 
make a backup copy by choosing Save as from the File 
menu. Keep the original name or enter a new one, such as 
"document-backup," and be sure you are saving it to your 
backup disk. (For detailed instructions, see the section earlier 
in this module about saving your work.) 

Erase disks containing unneeded information 
so you can reuse them. 

After you have had your Macintosh for a while, you will find 
yourself with quite a collection of disks. You may not even 
remember what is on many of them. Instead of letting those 
disks gather dust as you continue to open boxes of new disks, 
recycle any old ones that contain outdated information. 

Erasing a disk removes all of the old information and creates a 
disk identical to a brand-new disk that has just been initialized. 
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Here's the procedure for erasing a disk. 

Read the procedure below. Then continue on to the exercise to 
practice this and other techniques covered in this section. 

1. Start up from any startup disk. 
2. Insert the disk to be erased into the second disk drive. If 

you are using a one-drive system, eject the startup disk and 
insert the disk to be erased into the built-in drive. 

3. The disk you just inserted should already be selected 
(highlighted). If it isn't, select it (point to it and click the 
mouse button). 

4. Choose Erase Disk from the Special menu. 
5. When asked if you really want to erase the disk, click OK. 

An alternative is to open the disk, select all of the contents, and 
throw everything in the Trash. Be sure to empty the Trash to 
recover all of the space taken up by what you threw away. 

Here's how to erase a startup disk. 

You can't erase the disk from which you started up. If you 
want to erase a startup disk, start up from a different disk, and 
then insert the disk to be erased and erase it using either of the 
methods described above. 

Eject a disk to be sure you don't accidentally 
lose some information. 

You have already ejected a disk a couple of times, so you 
should know how to do it (select the disk icon and choose 
Eject from the File menu). But you may not know why it's 
important. 

When you eject a disk, Macintosh does some straightening up 
of the information on that disk before the disk is actually 
ejected. The directory is updated, the Trash is emptied, the 
location of icons in the window is recorded, and so forth. 

If you tum the Macintosh off without first ejecting the disk, 
you are preventing the Macintosh from doing this "house 
cleaning" and you may actually lose some information. 

You should always eject all disks before turning off the 
Macintosh. Version 4.1 of the Finder added a new command 
to the Special menu-Shut Down. Choosing this command 
ejects all disks, and restarts the Macintosh. A fast and safe 
way to tum your Macintosh off is to first choose Shut Down 
and then tum the On/Off switch to off. 
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Practice 

Back Up and Erase 

Three Exercises 

Create a Backup Disk: 
Two-Drive System 

Practice backing up and erasing disks. 

Now that you have read about how to back up and erase disks, 
here's a chance for you to practice those techniques. 

Choose the exercise that's appropriate for the 
system you're using. · 

There are three different practice exercises because the 
techniques for backing up disks are different for different 
Macintosh systems. The three exercises are for the following 
system configurations: 

• Macintosh 128K or 512K with two disk drives. 
• Macintosh 128K with one disk drive. 
• Macintosh 512K with one disk drive, or Macintosh XL. 

Do the backup ~xercise that is appropriate for your system, and 
read through the other two to become familiar with the 
alternative techniques. 

Then do the Erase exercise (which is the same for all 
Macintosh systems). 

Move one Icon on top of the other. 

If you have a Macintosh 128K or Macintosh 512K with two 
disk drives, back up a disk by dragging one icon on top of the 
other. Use the System Disk and a blank disk to practice. The 
steps to back up a disk are listed below. If you think you 
already know how to complete the exercise, try it without 
looking at the directions. 

To back up a disk on a two-drive system: 

1. Start up from the System Disk. 
2. Insert a blank disk into the external drive. 
3. Move the System disk icon onto the icon for the blank 

disk. Be sure the icon is highlighted so you know you are 
in the right place. 

4. When you are asked if you want to completely replace the 
contents of the disk, click 0 K 1 - , 

~f 
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5. Change the name of the backup disk so you can identify it 
later. 

Read through the other two techniques, or skip ahead to 
practice erasing a disk. 

Use the Disk Copy program. 

If you have a Macintosh 128K with one disk drive, back up a 
disk using the Disk Copy program. Use the System Disk and a 
blank disk to practice. The steps to back up a disk are below. 
lf you think you already know how to do it, try it without 
looking at the directions. 

To back up a disk on a Macintosh 128K with one disk drive: 

1. Start up from the System Disk. 
2. Open the disk icon. 
3. Open the Disk Copy icon. 
4. Click OK. (Follow the instructions at the bottom of the 

screen.) 
5. Reinsert the System Disk when requested to do so. 
6. Swap the System Disk and the backup disk as instructed 

(about eight times). 
7. Click Quit when the copy has finished. 
8. Change the name of the backup disk so you can identify it 

later. 

Now read through the third technique, or skip ahead to practice 
erasing a disk. 

Drag the original disk's icon onto the icon for 
the backup disk. 

If you have a Macintosh 512K with one disk drive, or a 
Macintosh XL, back up a disk by dragging the icon for the 
original disk onto the icon for the backup disk. Use the 
System disk and a blank disk to practice. The steps to back up 
a disk are below. If you think you already know how to do it, 
try it without looking at the directions. 

To back up a disk on a Macintosh 512K with one disk drive or 
a Macintosh XL: 

1. Start up from the System Disk. 
2. Eject the disk and insert a blank disk (or a disk whose 

contents you don't mind erasing). 
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Practice (cont'd) 

Erase a Disk 

Feedback 

Backup and Erase 

3. Drag the icon shadow of the original disk onto the icon for 
the backup disk. The icon will be highlighted. 

4. Swap disks as directed. 
5. Change the name of the backup disk so you can identify it 

later. 

Practice erasing a disk by erasing the backup 
you just made. 

You can't erase the startup disk, so regardless of what system 
you are using, start up from the System Disk and then erase the 
backup disk. 

To erase a disk: 

1. Be sure the backup disk is in the disk drive and the icon is 
selected. 

2. Choose Erase Disk from the Special menu. 
3. When asked if you really want to erase this disk, click 

OK. 

The disk is now just like a new disk that has just been 
intialized. 

You should end up with a System Disk and a 
blank disk. 

During the exercise you should have made a backup copy of 
the System Disk, and then erased it. If you didn't do that, 
reread the exercise and complete the parts you missed. 

If you had problems, read the Copying an Entire Disk section 
in Chapter 3 of the Macintosh manual, or the explanation of the 
Special menu in the Menus section of Chapter 4. Or ask a 
colleague, your course manager, or your Apple support 
representative for help. 
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The Guided Tour of Macintosh is a computer-based training 
program that teaches you the basic skills you will need for 
using Macintosh. After viewing all five sessions of the Guided 
Tour and completing the practice exercises included in this 
module. you should have mastered many of these techniques. 
Here is a quick summary of the major areas covered by the 
Guided Tour. 

The Macintosh desktop. 

The Finder maintains the desktop and enables you to keep track 
of where your information is stored and what you want to do 
next. 

Each icon on the desktop has a different function. The icons, 
in conjunction with the menu bar across the top of the screen, 
represent all of your information and capabilities on the 
Macintosh. To choose something from a menu, you just open 
the menu, point to what you want, and then release the mouse 
button. 

There are two steps to doing most things on the Macintosh: 
(1) Select what you want to work with, and (2) Choose the 
appropriate menu command. For example, to open an icon you 
should first select it, and then choose Open. 

The menu commands that are currently available and 
meaningful are shown in black type. The gray menu 
commands are inapplicable to your current selection. 

Working with icons. 

Select icons by pointing to them and clicking the mouse button. 
Select several icons by using either the selection rectangle or 
the Shift-click technique. Open and close icons by using the 
appropriate command from the File menu. 

You can use the mouse to move icons. You can also duplicate 
icons to create copies, and rename them by selecting the icon 
and then typing a new name. Organize icons by depositing 
them in the appropriate place. For example, you can deposit a 
document into a file folder, a file folder onto a disk, or 
anything into the Trash. 
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You can open the Trash and retrieve anything you have thrown '""__,; 
away, until you empty the Trash. There are three ways to 
empty the Trash: (1) Choose Empty Trash, (2) Start up an 
application, and (3) Eject the disk. 

Windows, and how to use them. 

Windows are rectangles on the screen that display information 
associated with specific icons. You can have several windows 
open at once. 

Across the top of a window is the title bar. Grab the title bar to 
move a window. In the top left corner is the close box. Click 
in the close box to close a ·window. In the bottom right comer 
is the size box. Grab the size box to resize a window. 

Down the right side and across the bottom are the scroll bars. 
Use the scroll bars to view other parts of your document. 

There are three ways to scroll through your documents: 

• Click on the arrows to scroll a little at a time. 
• Grab the scroll box to move anywhere within the document. 
• Click in the gray area above or below the scroll box to scroll 

window by window. 

To select a window, click in any visible portion. There are 
four ways to identify the active window: 

• ., Its title bar is highlighted 
• The close box is visible 
• The size box is visible 
• It's on top of all other windows. 

Entering text. 

The insertion point indicates where anything you type will be 
added. To move the insertion point, position the pointer where 
you want the insertion point to be, and click the mouse button. 

To select text, position the pointer at one end of the text to be 
selected, and hold down the mouse button. Then move the 
pointer to the other end of the text to be selected, and release 
the mouse button. 

To edit text, select the text and type-whatever you type will 
replace what was selected. This also works for icon names. 

To move text, select it, choose Cut, move the insertion point to 
the desired location, and choose Paste. 
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Dialog boxes and applications. 

Dialog boxes are windows that the Macintosh will periodically 
display on the screen. They inform you of the current 
situation, and enable you to enter some needed information or 
to make a choice between available options. Until you respond 
to them with the appropriate action, you can't do anything else. 

To run an application, either open the application icon (a hand 
on paper) or open a document that was originally created with 
that application. 

Mouse techniques and other skills. 

There are four techniques for using the mouse: 

• click 
• press 
• drag 
• double-click 

There are two variations: 

• double-click, drag 
• Shift-click 

To find a lost window, move the other windows that are 
covering it. Move the window, resize it, or close it. Or choose 
Close All to close all of the windows and then open the one 
you want. 

An icon shadow is a placeholder for a window. It's an 
indication that that icon is open on your desktop. Double-click 
on it to make the window the active window. 

The Command key enables you to perform :rnany menu 
commands from the keyboard. Hold down the Command key 
and type the appropriate letter. The letters are indicated on the 
right side of open menus. 

Working on a Macintosh is like working at your 
desk. 

Many of the images you see and the techniques you use are 
similar to the same activity without a computer. This is part of 
what makes Macintosh so easy to learn and use. The 
Macintosh environment in which you work is even called the 
desktop. 
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Copying and moving documents and folders. 

• To make a copy of a document on the same disk, select the 
document and choose Duplicate. 

• To place a copy of a document on another disk, move the 
document icon to the other disk's icon. 

• To move a document elsewhere on the same disk, move the 
icon (this doesn't actually move any information). 

• To move a document to another disk, copy the document 
and then throw away the original. 

The techniques are the same for folders. 

Saving your work. 

If the document has already been saved, choose Save to save 
your changes under the same name (without the Save dialog 
box). 

Choose Save as to save your work under a different name. 

If you're saving a document for the first time or using the 
Save as command, you can save the document to either disk 
drive. You can even choose to eject a disk to save the 
document on a disk that was not in either drive. 

Choose Close to close a window but stay in the application. 
Use this option if you want to open another document from the 
same application. To open another document, choose Open. 
When you choose Close, you have the opportunity to either 
save or ignore your changes. 

Choose Quit to quit an application and return to the Finder. 
Again, you have the option of either saving or ignoring your 
changes. 

Take care of your disks. 

• Keep disks away from extreme heat and direct sunlight 
• Never touch the surf ace of the disk. 
• Keep disks away from magnets. 

A disk contains a directory and information. 

The directory contains the name, location, and size of all of the 
information on the disk, and the size and location of all 
available space. The information includes all applications, 
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documents, startup information, and the operating system. 
The directory is first created when you initialize a disk. You 
can't use a disk until you initialize it. 

Startup disks vs. data disks. 

Startup disks contain specific information needed to start the 
Macintosh. This takes up a lot of room. Keep some of your 
disks as strictly data disks, containing nothing but information 
you have created and want to keep. You can only start up your 
Macintosh from a startup disk. 

To create a startup disk, move the System Folder to any data 
disk or new disk. 

Locking, backing up, and erasing disks. 

Lock disks to prevent accidental loss of stored information. To 
lock a disk, slide the red (or sometimes black) tab in the top 
right comer of the disk so that you can't see it from the front 
side (move it toward the top edge of the disk). 

Back up your disks as a precaution in case something happens 
to your original disk. 

Backing up an entire disk copies the directory and all of the 
information. Backing up an individual document backs up 
only that document and updates the existing directory (instead 
of replacing it). 

To back up an entire disk, use the Disk Copy program 
(Macintosh 128K with one disk drive) or drag one disk icon 
onto the other (Macintosh 512K, Macintosh XL, or Macintosh 
128K with two disk drives). 

Erase a disk to remove outdated information, so you can reuse 
the disk. To erase a disk, choose Erase Disk. Everything on 
the disk will be lost, so be sure there's nothing you want to 
save. The result is the same as initializing a disk. 
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II Resources 

• Macintosh, the owner's manual, Apple Computer, Inc. 

• Macintosh publications (The premier issue of Macworld, 
February 1984, has an entire section on the Macintosh 
desktop. Read Macworld and other Macintosh publications, 
such as MACazine, A+, Macintosh Buyer's Guide, and 
Macintosh Connection, for up-to-date information about 
Macintosh.) 

Books 

There are dozens of books about the Macintosh. Many of them 
are basic product overviews that contain little more than the 
manual. But sometimes a new perspective and a different 
author can clarify an area that was previously unclear to you. 

Here are a few of the product overview books that are 
particularly good: 

Macintosh! Complete, by Doug Clapp, Softalk Publishing. 

The Apple Macintosh Book, by Cary Lu, Microsoft. 

Macintosh: The Definitive User's Guide, by John M. 
Allswang, Brady Communications, Inc. 

Tips & Techniques/or the Macintosh Computer, by Susan 
Sutphin, Price-Waterhouse. 

MacGuide: The Complete Handbook to the Macintosh, by the 
Editors of Microtrend, Inc., New American Library. 

Apple Computer does not endorse any of the third-party products or publications mentioned in this module. They are 
included only to make you aware of their availability. 

Apple and the Apple logo are registered trademarks of Apple Computer, Inc. MacDraw, MacPaint, and MacWrite are 
trademarks of Apple Computer, Inc. Macintosh is a trademark of Mcintosh Laboratory, Inc. and is being used with 

express permission of its owner. 
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2 Overview 

•Overview 

The information and exercises presented in this module are 
designed to acquaint you with the Macintosh™ Finder. Finder 
Version 4.1 is highlighted in the first sections, while Finder 
Version 1. lg is discussed in later sections. Many of the 
differences between the two released versions of the Finder are 
noted throughout the text. A chart is provided at the end of the 
module to summarize the differences between the two. 

This module is intended for use by people who support the 
Macintosh computer and Macintosh software applications 
published by Apple Computer, Inc. 

Prerequisites 

Basic knowledge of Macintosh and the Macintosh Finder. This 
can be achieved by completing the Apple Support Training 
Library module, Learning to Use Macintosh. 
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Objectives 3 

• Use the About command in the Apple menu to display the 
amount of memory in your system. 

• Choose the commands in the Choose Printer desk 
accessory to print a document. 

• Use the New Folder option in the File menu to add a 
new folder to an active window. 

• Print a catalog of the files on a disk or in a folder using the 
Print Catalog and Page Setup commands. 

• Choose the commands in the View menu to manipulate 
documents and folders. 

• Install and remove the MiniFinder using the commands in 
the Special menu. 

• Shut Down Macintosh. 

• Use the MiniFinder commands to open applications, 
documents, and disks. 

• Use other features of the Finder to name icons, drag icons, 
and eject disks. 
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II Materials 

To complete this module, you wm need: 

• A Macintosh 128K, Macintosh 512K, or Macintosh XL 

• An external disk drive 

• A startup disk that includes the Finder Version 4.1, 
Choose Printer, and the Ima~Writer™ and/or 
Image Writer 15, and/or Apple LaserWriter™ printing 
resources with AppleTalk™ 

• A disk containing Mac Write™ Version 4.5, MacPaint™ 
Version 1.5, and the Font/DA Mover 

• Two blank disks 

If available, the following are recommended: 

• A startup disk that includes the Finder Version 1.lg 

• Macintosh Update (May 15, 1985), a written update 
distributed with the Macintosh System Update disk (It 
discusses the Finder Version 4.1 and the Font/DA Mover; 
Macintosh Update can be obtained by contacting your 
Apple support representative, or by using AppleLink™. If 
you use AppleLink, search the "Technical Info Library" for 
"Macintosh and Update and July and 1985.") 
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( II Using the Finder Menus 

The Five Finder Menus 

( 

Knowing these five menus is the key to using 
Macintosh. 

The Finder menus off er a great deal of power and flexibility. 
Knowing how to use their commands will help you use 
Macintosh, and will help you to support other users. These 
menus are from Version 4.1 of the Finder. They are only 
slightly different from the menus in Version 1. lg. 

Rbout the Finder ••• 

Choose Printer 
Scrapbook 
Rlorm Clock 
Note Pod 
Calculator 
Key Cops 
Control Panel 
Puzzle 

by Icon 
by Nome 
by Dote 
by Size 
by Kind 

Undo XZ 

Cut XH 
Copy XC 
Paste XU 
Clear 
Select All XA 

Show Clipboard 
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New Folder XN 
Open 
Print 
Close 

Get Info XI 
Duplicate XO 

Page Setup 
Print Catalog 

Eject 

Cleon Up 
Empty Trash 
Erase Disk 
Set Startup 
Use MiniFinder ... 

Shut Down 



6 Using- the Finder Menus 

The Apple Menu 

Read the Macintosh Update. 

Read the Macintosh Update that was released with the System 
Update disk (see the Materials section to locate this document). 
It discusses the updates to the Finder, and to the Font/DA 
Mover. 

Choose "About the Finder." 

The Finder 4.1 version of the About the Finder dialog box 
has a different look from the Finder 1. lg dialog box-the 
Finder 4.1 dialog box is very simple in appearance. Its 
function is only slightly changed, however, in that it displays 
the memory size of your Macintosh: either 128K, 512K, or 
about 900K for the XL (the actual size of the XL memory 
depends on which version ofMacWorksTM you're using). 

The Macintosh™ Finder 
Bruce Horn and Steve Capps 

· 128K Version 4.1 ©1985 Apple Computer 
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Using the Finder Menus 7 

The Choose Printer desk accessory expands 
your printing options. 

The Apple menu has been expanded to contain the Choose 
Printer option. 

I magewriter IQ Port: 

LaserWriter 

~ u II 
®Connected 

RppleTalk O Disconnected 

( OK ) ( Cancel ) 
u1.:i 

When you select this option, a dialog box appears. It allows 
you to choose the Printer port, or the Modern port to be used 
for printing, and to use any of the printing resources named on 
your system. In this example, you could choose the 
Image Writer or the LaserWriter. You could also choose to 
connect or disconnect AppleTalk . 

For additional information, see the Apple Support Training 
Library module, Using the LaserWriter, available from your 
Apple support representative. 

New Folder, Page Setup, and Print Catalog 
are File menu commands. 

The File menu contains these new commands: New Folder, 
Page Setup, and Print Catalog. Close All and Put 
Back are Finder 1. lg commands, but aren't included in 
Finder 4.1. 

Choose New Folder. 

When you open a disk window, you may notice that there isn't 
a folder titled "Empty Folder." The folder function has been 
replaced by using the File menu command, New Folder. 
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8 Using the Finder Menus 

Name 

111 H!Miidd 
Cl Font/DA Mover 

Cl MacPa;nt 

Cl P ageSetMenu 

D System Folder 

Cl Sy stem Update 

This command can be chosen either from the File menu, or by 
pressing Command-N (see the illustration on page 5 for this 
and other Finder 4.1 commands and Command-key 
equivalents). 

Use the Get Info command to lock a file. 

The ability to lock a file hasn't changed. The difference is that 
when you lock a file, the icon of a padlock appears in one of 
the following locations: 

• In the upper left-hand corner of an open window, when 
viewing the contents by Icon. 

• Next to the date when viewing the contents in any function 
other than by Icon. 

Update 
s;z• K;nd Last Mod;f;ed 

9K folder Fri, Jun 21, 1985 i 
25K app licaUon Tue, Apr 9, 1 985 ... 
60K app licat;on Thu, May 23, 1 985 

11 K MacPaint document Fr;, Jun 21, 1985 

145K folder Fr;, Jun 21, 1985 

99K application Tue, Apr 9, 1985 

Page Setup and Print Catalog are a pair. 

Choose Print Catalog to print out the catalog of an active 
disk or folder window. The documents and folders are listed 
according to the View menu command chosen, and in the 
order of their appearance in the window. " 

·~ 
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Practice 

Print Catalog 

---- --- -------

Using the Finder Menus 9 

Print Catalog uses the Page Setup dialog box to select 
various print options, as shown below: 

=lm=u=g=e=W-=r=it=er=(=S=tu=n=d=nr=d=o"O"r=W=id=e=)=----- l( OK J 
Paper: ®us Letter O R4 Letter 

O US Legal O I nternqtional Fnnfold 
O Computer Paper 

(Cancel ) 

Orientation: ®Tall O Tall Adjusted O Wide 
Paginntion: ® Normnl pnges O No breaks between pages 

Reduction: ® None O 50 percent 

See the Apple Support Training Library module, ImageWriter 
II Basics, for specific details on how to use this dialog box for 
printing. 

Practice printing the catalog using different 
View menu commands. 

1. Start up with your System Disk. 

2. Open the disk icon and choose the by Icon command 
from the View menu. 

3. Print a catalog of the disk by choosing the appropriate 
command from the File menu. 

4. After you've used the by Icon command, choose the by 
Name command and print the same catalog. Notice that the 
print function is formatted to the currently selected View 
menu command. 
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Feedback 

Print Catalog Print Catalog Is a useful command. 

If you have any questions about how to use this command, or 
about how it could be useful to you, ask a colleague, your 
Course Manager, or your Apple support representative. 

Using the Finder Menus (cont'd) 

The Edit Menu 

The View Menu 

The options In this menu haven't changed. 

The commands and the Command-key equivalents have 
remained the same. See the Finder 1.lg section at the end of 
this module, the Apple Support Training Library module, 
Learning to Use Macintosh, or Chapter 4 in Macintosh, the 
owner's manual, for more information about the Edit menu. 

The View menu Is a file-management tool. 

Each View menu command has the same file-management 
capabilities as the by Icon command. You can create new 
folders, place documents in folders, and throw them away. 
You can also duplicate documents and folders in any View 
menu command. 

The practice exercise will demonstrate some of these View 
menu functions. 
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Practice 

Use the View Menu 

Using the Finder Menus 11 

Select different views at the same time, and 
perform the same function in each view. 

1. Start up from your System Disk ( use a backup disk, not 
your original copy). 

2. Choose by Name from the View menu. 

3. Choose New Folder from the File menu, or by pressing 
Command-N. Notice that an Empty Folder appears in 
the by Name list. 

4. While still viewing by Name, drag a document or 
application into the Empty Folder. 

5. Open the Empty Folder. Notice that the icon inside is 
displayed by Icon (the preset View menu command). 

6. Drag the icon out of the folder, and place it back in the disk 
window. 

7. Close the Empty Folder window, and throw away the 
Empty Folder from the by Name listing. 

8. Change the view back to by Icon. 
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Feedback 

View Menu Options 

Name 

• li!idlllHll 
Cl Font/DA Mover ~ 
Cl MacPaint 

The results of this exercise demonstrate the 
flexibility of the View menu commands. 

The System Disk window and the Empty Folder window 
should look similar to the windows shown below. 

System Disk 
Size Kind Last Modified 

9K folder Fri, Jun 21, 1985 

2SK application Tue / Apr 9, 1 985 

60K application Thu, May 23, 1985 

Cl P ageSetMenu ~0§ Empty Folder tit document Fri, Jun 21, 1985 

D System Folder 

Cl Sy stem Update 
1 item 9K in folder 4 7~ 

Fri, Jun 21, 1985 

(Q] 

~ 
ion Tue, Apr 9, 1 985 

L:D 
TaUesin Font ~ 

IQ ~ 

The windows you see might be a different size, and the name 
of your System Disk might be different. But, as long as you 
can use the Empty Folder and the different commands in the 
View menu, you're doing fine. 

If you need some practice, or have some questions, another 
practice session is provided at the end of this module. Your 
Apple support representative is always available to answer any 
of your questions, so don't hesitate to ask. You can also check 

·with a colleague, or with your course manager. 
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Using the Finder Menus (cont'd) 

The Special Menu The Use MiniFinder and Shut Down commands 
are new to this menu. 

Clean Up, Empty Trash, Erase Disk, and Set Startup 
are the same in the Version 4.1 as in the Version 1.lg. Use 
MiniFinder and Shut Down are new. See the section 
"More of the Finder 1. lg Menus" at the end of this module for 
more about the Special menu. 

The Use MiniFinder command gives you a key 
to file management. 

The Use MiniFinder command allows you to establish 
another operating level on your Macintosh desktop. It is used 
to move quickly between applications without having to return 
to the Finder each time you quit an application. This command 
can be used on any disk that has an application on it, not just 
on startup disks. This command is explained in detail in the 
next section. 

Shut Down allows you to change startup disks 
quickly. 

The Shut Down command is a convenient way to eject the 
current startup disk and restart your Macintosh (128K or 
512K). Just choose the Shut Down option. When the"?" 
icon appears, insert a new startup disk, and begin working 
again (see the Apple Support Training Library module, 
Fundamentals of the Macintosh Operating System, for more on 
the"?" icon). 

If you're using a Macintosh XL, the Shut Down command 
will eject your disk and turn off the system. 
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• Installing the MiniFinder 

Overview 

Use Minifinder 

Choose Use MiniFlnder for faster response 
time when moving between applications. 

The MiniFinder's faster response time allows you to move into 
and out of applications quickly. When it's installed, it allows 
you to keep the documents and applications you use most often 
at your fingertips. This section provides some practice with the 
MiniFinder, and offers some suggestions for its use. The 
buttons you see in the screen shot below will be covered in the 
next section. 

The Minifinder can be used with any disk, and 
acts as an application. 

The MiniFinder is an application that resides on your disks. It 
provides quick access between applications and specific 
documents, significantly increasing the response of the 
software. Part of the reason for the increased speed is that the 
Finder doesn't have to reconstruct the desktop each time you 
quit an application. 

$ ~ ~ Write & Point 

MacPaint MocWrite WP&F 

( Finder ) 
( Open ) 
( Open Other ) 

( Eject ) 
( Driue ) 

( Shut Down ) 

It can be used on any Macintosh, and can have from 1 to 12 
documents or applications installed in it. 
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To install the MiniFinder, open a window. 

First, open a disk or a folder window. Use it to group the 
application and document icons (folder icons don't work) you 
want to install in the MiniFinder for use on this disk. 

Be sure that all of the documents and applications you want to 
install are selected. Your selection must include one 
application. 

~D To Be I nstolled 
3 items 139K in folder 261 K available 

When you choose the option, Use MiniFinder, a dialog box 
appears that looks like this: 

[Ii) 
Install the MiniFinder using the 
selected documents or applications, 
or remoue the MiniFinder. 

( Install ) ( Remoue) ( Cancel ) 

Click Install. Once the MiniFinder is installed, a Macintosh 
icon titled "MiniFinder" is displayed in the disk window. Open 
the icon. When you do, a screen that is similar to the 
MiniFinder screen shown on the previous page will appear. 
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Other Minlfinder 
Commands 

The MiniFinder icon is like any other document icon. It can be 
opened, duplicated, moved, or thrown away. 

You can change the icons in the MiniFinder, 
and you can remove it. 

The commands in the MiniFinder install dialog box allow you 
to change the icons in the MiiliFinder (using Install), to 
remove the MiniFinder, or to cancel the Use MiniFinder 
command. 

Click Install to add an icon to, or remove an 
icon from, the MiniFinder. 

If you want to add an icon to, or remove one from, an installed 
MiniFinder, follow the procedure for installation that was 
discussed on the previous page: 

1. Open a disk or folder window. ·~ _j 
2. ·Select the icons you want to install (use a selection box or 

use the Shift-click method of icon selection). 
3. Choose Use MiniFinder from the Special menu, and 

click Install. 

This process will install a new MiniFinder and replace the last 
one you installed on that disk. 

. Deleting a document or application from a disk 
doesn't automatically update the MiniFinder. 

The MiniFinder is a separate application from the Finder. So, 
when you delete a document or application from the Finder, 
you must also delete it from the MiniFinder. 

If you do delete a document or application from the Finder, and 
then try to open it from the MiniFinder, the MiniFinder will 
notify you that the document or application you've chosen can't 
be found. 

You would simply follow the installation process to reinstall 
the MiniFinder without the missing document or application. 
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Two other ways to remove the MiniFinder. 

In addition to reinstalling the MiniFinder (which removes one 
and replaces it with another), you can just throw the current 
MiniFinder icon into the Trash. Or you can choose Use 
MiniFinder from the Special menu, and click Remove. 

A MiniFinder startup disk can save room on a 
disk. 

You can create a disk that has a MiniFinder, a System file, and 
the icons you want to use, but no Finder: 

1. Start up Macintosh with a regular startup disk. 

2. Insert the disk you want to use as your MiniFinder startup 
disk. 

3. Copy the System file and the icon(s) you want to use onto 
the disk you just inserted. 

4. Select the icon(s) you want to install. 

5. Choose Use MiniFinder. 

6. When the Minif'inder icon appears, click it, and choose 
Set Startup from the Special menu. 

7. To use the new disk, choose Shut Dowµ and insert the 
MiniFinder startup disk you just created. 

8. Macintosh will start up from the MiniFinder screen. 

By following this procedure, you will create a startup disk that 
has roughly an extra 45K of disk space because it doesn't have 
a Finder. You can open any application on the disk from this 
screen. If you click Finder, though, you'll get the message, 
"Application not found" Just select another application and 
continue working. 

Change the disk back to a nonstartup (data) 
disk. 

If you decide you want to remove the MiniFinder, and use the 
disk as a nonstartup disk, eject the disk. Restart Macintosh 
from a regular startup disk (one that starts up from the Finder). 
Insert the MiniFinder startup disk, and throw away the System 
file and the MiniFinder icon from that disk. The disk is now a 
nonstartup, or data disk. 
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Practice 

Install the Minifinder 

Feedback 

Install the Minifinder 

Follow these steps to set up the MiniFinder: 

1. Open the disk you want to install the MiniFinder on. 

2. Place all the icons you want to access from the MiniFinder 
into an active disk or folder window and select them. 

3. Choose Use MiniFinder from the Special menu. 

4. When the dialog box appears, click Install. 

5. When the MiniFinder icon appears in the disk window, 
double-click on the MiniFinder icon to use the MiniFinder. 

The MiniFinder screen should look like the one 
in this module. 

When you've completed the steps in the practice exercise, you 
should see a MiniFinder screen similar to the one described 
earlier. 

More practice is provided at the end of this module. If you 
have any questions, discuss them with a colleague, your course 
manager, or your Apple support representative. 
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( II Using the MiniFinder Buttons 

Overview Use the MiniFinder buttons to help you 
manage your files. 

These buttons offer a convenient, speedy way to access 
documents and applications on the current startup disk, or on 
any other Macintosh disk. This section discusses how to use 
them. 

Write 4.5/Paint 

1.5 ~ 

( Finder ) 
( Open ) 
( Open Other ) 

( Eject ) 
( Driue ) 

( Shut Down ) 

Use the Finder button to access the desktop. 

Click Finder, or press the Enter key to go to the desktop. 

The Open button opens a selected document 
or application icon. 

This button works in the same way as the Open button in the 
Document Directory dialog box. Once you've selected the 
document or application you want to open, click Open to 
"launch" the application, or to open the document 
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Open a file from the Minifinder screen. 

Another way to open a document or file from the MiniFinder is 
to double-click the icon you want to open. If you've selected a 
document, the document will open within its correct 
application, whether or not that application is on the disk with 
the MiniFinder. If you open an application, it will open to an 
"Untitled" document, just as you would expect. You may 
begin working at that point, or you may close the document 
and open the document of your choice. 

If the application that will open the icon you've selected can't 
be found on either the internal or external disk, the message 
"Application not found'' will appear at the bottom of the 
MiniFinder screen. 

The Open Other button opens a Document 
Directory dialog box. 

The Open Other button opens a Document Directory dialog 
box that lists all of the applications residing on the disk 
identified above the buttons. This includes the applications 
visible in the MiniFinder window. When you're working with 
a two-drive system, click Drive to view the application(s) 
available on your other disk. 

Select an application from the dialog box. 

To select an application from the Document Directory dialog 
box, click the application. If you have a list of applications and 
would like to select an application that you can't see, scroll 
through the directory, or type the name of the application. The 
application will appear highlighted in the Document Directory 
window. 

If you type the name of the application, type fast, or simply 
type the first few letters of the name of the application. 

To open the application from the dialog box, double-click on 
the application name, or select the application and click Open. 

Click Eject to eject a disk. 

Click the Eject button to eject the disk whose name appears 
above the buttons, without having to return to the Finder. 
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Click Drive to select a disk. 

Click the Drive button to display the contents of the inactive 
drive (if there isn't a second drive, Drive will be dimmed). 

If a MiniFinder has been installed on the other disk, that 
MiniFinder's screen will be displayed. You will be alerted if 
there is no MiniFinder installed on the other disk. In that case, 
you can still open an application on that disk by choosing 
Open Other. 

Click Drive in conjunction with Eject to select files on other 
disks. When you click Eject (using a two-drive system), the 
disk in the active drive will eject. If there is a startup disk 
remaining in either drive, that disk will function as the current 
startup disk. 

The Shut Down button ejects your disks and 
resets your Macintosh. 

If you are using a Macintosh 128K or Macintosh 512K, 
choosing Shut Down ejects the disk(s), both internal and 
external, and resets Macintosh. A"?" icon should appear, 
indicating that the Macintosh is waiting for another startup 
disk. See the Apple Support Training Library module, 
Fundamentals of the Macintosh Operating System, for more on 
the"?'' icon. 

The Shut Down command, when used on a Macintosh XL, 
will eject the disk, and completely power down the Macintosh. 
To restart the system press the white On/Off button. 
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II Other Finder Features 

Overview 

Other Finder Features 

The Finder has several features not Included 
In the menus or in the MiniFinder. 

The Finder Version 4.1 has several features in addition to those 
provided by the menus and the MiniFinder. 

The Finder has a hard-disk orientation that 
facllltates Its overall operation. 

The Finder Version 4.1 is faster than its predecessor. That's 
one reason it's good for managing files on a hard disk. It races 
through file-management commands such as Open, Copy, 
and Close, and it opens and closes windows quickly. With 
this version, handling up to 500 files isn't a problem. Version 
1.lg gets bogged down after about 100 files. 

Rename your Icons. 

To rename a disk or folder icon, you must click the icon, even 
if it's highlighted. This makes it less likely that a disk or folder 
icon will be renamed accidentally. Other icons, such as those 
for a new folder, a document that has been moved, or a 
duplicated icon, can be renamed-while they're highlighted­
without being clicked. Press Enter after you type the name, to 
ensure that you don't accidentally rename the icon. 

Some methods for ejecting disks have been 
enhanced. 

• You can eject unhighlighted disks from both drives by 
choosing the command Eject from the File menu, or by 
using its Command-key equivalent. This will eject disks 
one at a time, beginning with the startup disk. 

• You can also eject disks (other than the startup disk) by 
moving them to the trash. This will eject the disk, and 
remove its icon from the screen. 

For other methods of ejecting disks, see the section "More of 
the Finder l.lg Menus." 

Drag Icons to Icon shadows to copy them. 

If you move the icon of a document, application, or folder to an 
icon shadow of a folder or disk, the Finder will copy the icon 
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to that folder or disk. The Finder will place the copied icon in 
the first available spot in the disk or folder window. 

This method can also be used for copying the contents of one 
disk to another disk on a Macintosh 512K, or a Macintosh XL. 

(Note: You can't use this to copy over the contents of the 
startup disk.) 

First level folders are kept during the repair 
function. 

When you use the repair function (hold down the Option and 
Command keys while starting up Macintosh), you lose all of 
your folders except for those at the first level. In other words, 
you'll lose all of the folders except for the ones that have at 
least one document or application residing in them. 

When a disk repair is done, the first level of folders will be 
renamed as Unnamed #1, Unnamed #2, and so on, as shown 
in the example below. 

-D System Disk 
5 items 305K in disk 95K available 

~ 
~ 

w CJ 
Font/DA Mover Unnamed • 1 MacPaint 

0 0 
Unnamed •2 Unnamed •3 

0 
lQ.l lQ 12:1 
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Select a Document 

Now That You've 
Reached This Point 

It's up to you to put the folders in their proper order and to give 
them their proper names-Macintosh won't do it for you. 

Open a dialog box, and type the characters of 
the document you want to open. 

Earlier you typed the name of an application to select it from the 
Document Directory dialog box. You can do this inside an 
application to select a document. When using this feature, be 
sure to type the name in quickly and correctly. Macintosh uses 
the typing speed you've selected in the Control Panel in the 
Apple menu to help you select the desired file. 

You can continue with the module, or skip to 
the Summary Exercise section. 

This completes the information on Finder Version 4.1. The 
information in the rest of the module was written to help 
support Finder Version 1.1 g; some of it is a repeat of 
information you've already read. However, it provides 
exercises and information that apply to both versions. Reading 
it will help you provide support for these two versions of the 
Macintosh Finder. 
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II Using Finder Version 1.1 g 

Overview 

The Finder 

The Apple Menu 

This section of this support module is optional. 

This section provides information and exercises specific to the 
Finder Version 1. lg. It also discusses Finder menu commands 
that are employed in both of these versions of the Finder. 

The Finder manages your Macintosh 
documents and applications. 

The Finder is an application that's always available on the 
desktop; in fact, it is often synonymous with the desktop. You 
use it to manage documents and applications, and to access 
disks. 

This application and its menus are your keys to working 
efficiently with Macintosh. Whether you're a Macintosh user, 
or you support other Macintosh users, you should be familiar 
with all of the functions of the Finder. 

Use the About function and the desk 
accessories to help you support Macintosh. 

You can use the Apple menu to: 

• Find out which version of the Finder you're using. (One of 
the first questions a support representative will ask is, 
"What version of the Finder (or software) are you using?") 

• Find out which version of the software you're using. You 
must know this to be able to answer questions about its 
capabilities and limitations, such as the number of pages a 
particular version of Mac Write can accommodate. 

• Use the desk accessories. Desk accessories contain 
information and resources such as a Clock, Note Pad, and 
Scrapbook that can help you become more productive with 
your Macintosh. 
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"About the Finder ... " Information about the Finder is available by 
choosing the "About ... " command~ 

Choose Printer 
Alarm Clock 
Scrapbook 
Note Pod 
Calculator 
Key Caps 
Control Panel 
Puzzle 

When you start up Macintosh, choose About the Finder 
from the Apple menu. It provides information about the 
version of the Finder that you're using. The example shown 
here is of Finder Version 1.lg, which was authored by Bruce 
Horn and Steve Capps. 

Different versions of the Finder have been 
released. 

Different versions of the Finder are available. Check with your 
Apple support representative for the latest version, and update 
your files to that version. 
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The Apple menu contains information about 
the application currently open on the desktop. 

Encore Systems 

MacWrite, the Macintosh Word Processor 

Written by Randy Wigginton, Ed Ruder, and 
Don Breuner of Encore S!Jstems. 

Version 4.5, April 4, 1 985. 

Document occupies 213K on disk, 
with 74K remaining. Saving the 
document may change these values. 

© 1985 Encore Systems 
© 1985 Apple Computer Inc. 

As shown above, choosing About Mac Write from the 
Apple menu while using Mac Write will produce a display of 
the following information: 

• The version ofMacWrite you are using. 
• The amount of disk space occupied by the document 

currently on the desktop. 
• The amount of space remaining on the disk. 

(Remember, it's important to know the software version in 
use, particularly if a problem occurs.) 

Other applications, such as MacProject™, use the" About ... " 
command to supply you with introductory information or help 
notes regarding the use of that application. 

All Macintosh applications from Apple use the Apple menu 
command, About •.• to display information about the version 
of software that's being used. This isn't necessarily done by 
other developers of Macintosh applications, so consult the 
documentation accompanying your software for the specific 
use of this command. 
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Practice 

Use "About. .. " the Finder 

"About ... " an Application 

"About ... " a Document 

Choose "About ... " to get information about the 
Finder. · 

1. Start up from a Mac Write disk. When the desktop 
appears, choose About the Finder from the Apple 
menu. 

2. Write down the version of the Finder you're using. Label 
your disk with this information after the exercise. It's 
useful to have this available if you have any questions 
regarding the Finder. 

3. Click the mouse button at any point on the screen to close 
the dialog box and return to the desktop. 

Choose "About. .. " to get information about an 
application. 

1. Open Mac Write and choose About MacWrite from the 
Apple menu. 

2. Write down the version of Mac Write you're using. It will 
be useful to have this available if you have any questions 
regarding Mac Write. Be sure to label your disk with this 
information. 

3. Close the dialog box and return to the desktop. 

Choose "About ••. " to get information about a 
document. 

1. Start up from a MacProject disk. Open a MacProject 
document and choose About MacProject from the 
Apple menu. 

2. Write down the version of MacProject you're using. 

3. Read the other information contained in About 
MacProject. 

4. Close the dialog box return to the desktop. 
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Remember this about "About ••• " 

Knowing the version of your software can be your key to 
answering many questions about it. When you call an Apple 
support representative, the first question you'll be asked is, 
"What software version are you using?" 

Always note the software version on the disk label for quick 
reference. If you have any questions about this, talk to a 
colleague, ask your course manager, or call your Apple support 
representative. 

Using Finder 1.1 g (cont'd) 

Desk Accessories The desk accessories can save you time, and 
serve as a valuable resource. 

Rbout the Finder ••• 

Choose Printer 
Rlorm Clock 
Scrapbook 
Note Pod 
Colculotor 
Key Cops 
Control Panel 
Puzzle 

As you can see from the Apple menu shown above, the 
Macintosh desktop comes with many of the desk accessories 
that you'd find on your own actual desktop. 
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Several Apple desk accessories can be on the 
desktop at once. 

Scrapbook 

Note Pad 

Key Caps Calculator 

As you can see here, all of the desk accessories except 
Choose Printer are on the desktop. This makes them 
convenient to use while working in most applications. There 
are a few applications, such as MacPaint, that require you to 
close the desk accessories before you can work on any 
documents. 

Try using some of these accessories. In particular, experiment 
with the elements on the Control Panel. These are explained in 
detail in Chapter 4 of Macintosh, the owner's manual. 

You can cut and paste between Macintosh applications and 
three Apple desk accessories: the Scrapbook, Note Pad, and 
Calculator. For example, if you're editing a report in Mac Write 
and notice that a few of the accounting numbers don't seem to 
add up properly, you can open the Calculator, do the addition 
again, copy the·correct sum from the Calculator, and insert it 
into your text-all without leaving the Mac Write document. 

To practice using Choose Printer, see the LaserWriter 
owner's manual or the Macintosh Office Quick Reference 
Guides. · 

(Note: A Desk Accessory Mover is part of the system update 
released with the Finder Version 4.1. It can be used like the 
Font Mover to add or delete desk accessories.) 
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Also, software is available from third-party developers that will 
allow you to manipulate your desk accessories, adding to or 
subtracting from them. A calendar, desktop text editor, and 
data communications application are some of the options 
available. Check recent issues of Macworld, The Macintosh 
Buyer's Guide, and other major computer publications for 
more information about the latest software available. 

A convenient application of the Note Pad and 
Calculator. 

For those who need to run and rerun the same calculations, the 
Calculator can be used as a programmable calculator. (You 
could try this now, but there's a practice exercise on the next 
page that covers this.) 

1. Open the Note Pad and the Calculator. 

2. Type a formula on the Note Pad (for example, 9*8-12/24) 
and choose Copy. 

3. Open the Calculator and choose Paste. 

4. The Calculator outputs the answer. 

5. For successive calculations, just repaste the formula into 
the Calculator. 

How to use multiple Note Pads. 

If you find that the Note Pad has too few pages, you can use 
the following procedure to create additional pads: 

1. When the Note Pad's eight pages are filled up, rename its 
icon (stored in the System Folder) to something like 
Notel. 

2. A new pad is created the next time you choose Note Pad 
from the Apple menu. 

3. If you need to look at something in the original pad, 
change the name of the second Note Pad to "Note2", or 
"Other Note," and rename the first Note Pad icon with the 
original name, "Note Pad File." 

4. You can continue to create storage files for notes until the 
disk is full. 
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As you have seen, the Apple menu provides excellent 
resources for saving notes and checking numbers you want to 
include in a document. Think of these Apple menu resources 
as you would the note pad and calculator you normally keep at 
your fingertips. 

Don't try to use the Puzzle for anything other 
than entertainment. 

If you try to use the Puzzle to cut or copy from, the results will 
be less than fruitful. The Puzzle is there to provide a break 
from your real work. Similarly, the Control Panel isn't a 
source of illustrations or text. It's there to help you get the 
most from your desktop environment. For more information 
on the Control Panel, see the Apple Support Training Library 
module, Learning to Use Macintosh. 

Use the Scrapbook and the Note Pad. 

You could fill an entire disk with illustrations and notes in the 
Scrapbook or the Note Pad. The only limit is the size of the 
disk. But remember, there are only 400K bytes of information 
available on a disk. So, if you need a lot of room on a disk for 
text or for data-base files, you might want to keep the 
Scrapbook and Note Pad clear of all but really important 
illustrations or truly brilliant ideas. 

Print the Note Pad periodically, and back up the Scrapbook to 
an archive disk. Then you won't overload working disks with 
these files. 
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Use a MacWrite document and the Note Pad. 

1. Start up from a Mac Write disk, and open a Mac Write 
document 

2. Choose Note Pad from the Apple menu, and type a few 
lines of text. 

3. Select the text you have just typed, and copy it. 

4. Close the Note Pad. 

5. Paste the text onto the Mac Write document. 

6. Once you've completed steps 1through5, try the same 
procedure with other desk accessories, such as the 
Calculator. 

Use the Note Pad and the Calculator. 

1. Start up from any startup disk that has the Calculator and 
Note Pad. From the desktop, or within any application, 
open the Note Pad. 

2. Type the formula, 9*8-12/24. Don't add any spaces or 
punctuation. 

3. Select the formula, and choose Copy. 

4. Open the Calculator. 

5. Choose Paste, to paste the formula onto the Calculator 
(watch the Calculator keys when you do this). 

6. Try this same exercise with another set of numbers such 
as, 52384/6548*4*2+8*7 /12. Type the numbers and the 
functions onto the Note Pad the same way you would enter 
them into the Calculator. 
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Feedback 

The Calculator and 
Note Pad 

The Apple menu provides additional 
resources. 

The answer to the first practice calculation is 2.5, and the 
answer to the final calculation is 42. The operation can also be 
performed using Mac Write instead of the Note Pad. 

If you have any questions, ask your course manager, a 
colleague who is familiar with the Macintosh, or your Apple 
support representative. 
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II More of the Finder 1.1 g Menus 

Overview 

Command-Key 
Equivalents 

This section reviews the File, Edit, View, and 
Special menus. 

In this section, you'll read more about the options and 
commands in each menu. You'll learn to use the 
Command-key equivalents as an alternative to using the 
pull-down menus. The Enter key can also be used as a 
shortcut. 

These equivalents can be used as shortcuts In 
place of the pull-down menus and the mouse. 

You'll learn the Command-key equivalents for some of the 
Finder commands. As you practice, you'll find that there are 
times when the mouse is easier to use than the Command-key 
equivalents to choose commands, and times when the opposite 
is true. A combination of these is often best 

As you develop these techniques, you'll find the combinations 
that are fastest and most comfortable for you. During this part 
of the module, experiment with the different techniques 
available. 
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The File Menu 

The Command Key 

The File menu has many useful commands. 

Edit Uiew Special 
Open 
Duplicate 
Get Info 
Put Back 

Close 
Close Rll 
Print 

XD 
XI 

Eject XE 

All of the commands in the File menu help you manage your 
documents, applications, and folders. For example, Open will 
open any selected icon. 

For more information about the File menu, review the "Finder 
Menus" section in Chapter 4 of Macintosh, the owner's 
manual. 

Use the Command-key equivalents as 
shortcuts to the menu commands .. 

One way to access some of the commands in many menus is to 
hold down the Command key and type the letter that 
corresponds to that command ("Command-key equivalents"). 
This way, you can select these commands from the keyboard 
without having to open the menu. 

Duplicate, Get Info, and Eject all have Command-key 
equivalents. To duplicate an icon, hold down the Command 
key and and type D (often shown simply as, Command-D). 
To get information about a specific icon, select that icon and 
press Command-I. And, to eject a highlighted disk, press 
Command-E. 

The Command key (also called the Apple key on the Macintosh 
XL, and the feature key or function key on the Macintosh) is 
the key just to the left of the space bar. 
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The Enter key can be used to respond to 
dialog boxes. 

The Enter key can be used as a shortcut to save a trip from the 
keyboard to the mouse. Most often, using the mouse to click 
command buttons is the quickest way to respond to a dialog 
box. However, there are times when pressing the Enter key is 
faster. For example, the Enter key will mean "OK" or "Yes" 
when a dialog box contains a "Do you want to continue" 
message. Also, if a specific button is highlighted, pressing 
Enter will initiate th~t action, as shown below: 

Saue changes before closing? 

n Yes D 
[ No ) ( Cancel ) 

In this example, pressing Enter will save the document and 
then close it. 
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Practice 

Use the Command Key Try using the Command-key equivalents, and 
the Enter key. 

1. Start up from a Mac Write disk. 

2. Open the disk icon and select the Mac Write icon (be careful 
not to open the application). 

3. Press Command-I (Get Info). 

4. Note the information available in the information window. 

5. Close the information window. 

6. Select the Mac Write icon again. 

7. Press Comritand-D (Duplicate). 

8. A duplicate file, called "Copy ofMacWrite," will appear. 

9. Press Command-I to Get Info on "Copy of Mac Write." 

10. Choose Close from the File menu to close the "Copy of 
MacWrite" information window. 

11. Throw away the "Copy ofMacWrite" icon. 

12. A dialog box will appear, asking you if you really want to 
throw away this application. Instead of clicking OK, 
press the Enter key to respond. 

Rre you sure you want to remoue the 
application "Copy of MacWrite"? 

( OK ) ( Cancel ) 

13. Choose Close All to close all of the open windows. 

14. Select the Mac Write disk icon, and press Command-E to 
eject the Mac Write disk. 
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These keys are listed in the menus for your 
convenience. 

As you can see, using the Command-key equivalents and the 
Enter key can be useful and fast. 

Don't worry about knowing all of these keys. They're all 
listed in the pull-down menus next to the command they 
initiate. You 11 become more familiar with their use as you 
progress through the Macintosh modules. 

If you have any questions, be sure to discuss them with a 
colleague, your course manager, or your Apple support 
representative. 
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More of the Finder 1.1g Menus (cont'd) 

The Edit Menu The Edit menu has several Command-key 
equivalents. 

S File 

Cut 
Copy 
Paste 
Clear 
Select Rll 

Special 
xz 

XH 
xc 
XU 

XR 

Show Clipboard 

The Edit menu uses more Command-key equivalents than any 
of the other Finder menus. Practice these commands using 
both the mouse and the Command-key equivalents. This 
practice exercise will demonstrate how even basic processes for 
managing and naming documents can be done faster using the 
Command-key equivalents. 
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Use the Edit menu on the desktop. 

1. Start up from a Mac Write disk. 

2. Open the Mac Write disk icon. 

3. Choose Show Clipboard from the Edit menu. 

4. Be sure that you can see all of the icons in the Mac Write 
startup disk window. 

5. Check the Clipboard window. Be sure it's open enough 
for you to see at least a few words of text, and that it isn't 
overlapping the Mac Write disk window (you'll want to 
watch all of your work as it appears on the screen). 

6. Select the Mac Write application icon. 

7. Press Command-C (Copy). Notice that the title, 
"Mac Write," .is all that appears in the Clipboard window. 
Copy copies only the name of the icon, not the entire file. 

8. Try this again, but this time, select the System Folder. 

9. Press Command-X (Cut). The text "MacWrite" has 
been replaced with "System Folder," and the System 
Folder title has been removed from under its icon. 

10. To replace the icon name, press Command-V (Paste). 
"System Folder" becomes the icon name, and it 
("System Folder") remains on the Clipboard. 

(Note: The text on the Clipboard can't be selec~ed.) 

11. Activate the Mac Write disk window. Press Command-A 
(Select All). All of the icons are selected. 

12. Click the mouse button once on the desktop or in the 
window to deselect the icons. · 

13. Close the Mac Write disk icon window and press 
Command-E (Eject). 
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Feedback 

The Edit Menu Use the Command key to Invoke Edit menu 
commands. 

If you have any questions about this exercise, ask your course 
manager, consult a colleague, or ask your Apple support 
representative. 

More of the Finder 1.1g Menus (cont'd) 

The View Menu 

Catalog or Directory 

This menu displays the ways you can view a 
catalog or directory of your files. 

S File Edit 

§0 

Special 
by Icon 
by Name 
by Date 
by Size 
by Kind 

Use the View menu to display document and 
folder information by the categories listed. 

By using the commands available in the View menu, it's easy 
to find the latest version of a document you've created. Or, if 
you've forgotten which document had all the latest information 
added to it, you can check the size of the documents, and select 
the largest 

The information is displayed in a format similar 
to those used by other operating systems. 

In the View menu, the information displayed is similar to that 
which is provided when you type the "catalog" or "directory" 
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Size Name 

60K MacPaint 

55K MacYrite 

7K Sample Memo 

223K System Folder 

20K Test Folder 

[QI 
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commands at the opening prompt in other operating systems 
such as ProDOS®, MS-DOS, PC DOS, or CP/M. 

So, if you're acquainted with these other systems, and would 
like to see what you would consider a "typical" directory of 
files, you can select the option that most closely resembles that 
of the system you're familiar with. 

View commands display specific information. 

You can read a lot about a file by using the commands in the 
View menu. For example, if you view the contents of a 
window using the by Name comma.-id (see example below), 
you'll see the size, name, and kind of document or folder, and 
the date it was last modified, displayed in alphabetical order by 
name. This same information is displayed when you use the 
other View menu commands (except by Icon), but it appears 
in a different order. 

Speciol Write 
Kind Last Modified 

app licatfon '\l'lfed, Aug 22, 1984 ~ 
application Mon, Sep 24, 1984 

Mac\rr'rite document Thu, Jan 1 0, 1 985 

folder Fri, Mar 22, 1985 

folder Fri, Mar 22, 1995 
~ 

IQ Q] 

Most Finder commands are available to you 
when using any viewing method. 

In Finder Version 1.lg, when you're displaying the contents 
of a window by name, date, size, or kind, you have access to 
many of the same commands as when you're using the by 
Icon command. 

In Version 4.1 of the Finder, all of the desktop operations are 
available in any view. 
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Viewing by Icon 

Viewing in Several Ways 

Name 

By Icon offers more Finder commands. 

Special Write 
8 items 369K in disk 30K av ail ab le 

CJ CJ 
System Folder Mac Write Empty Folder 

~ I I 
test print Sample Memo Test 1 Test 2 

The by Icon command allows you to do more than the View 
menu commands just mentioned. You can move documents 
and folders, name them and rename them, throw them away, or 
arrange them in any order on your desktop. 

You can view the contents of each disk or 
folder window using any of the methods. 

Hard Disk 
Size Kind Last Modified 

i;;; System Folder 

D Applications D 
2011 K folder Fri, Mar 22, 1985 

D SelfPaced 

Cl CB A Modulesi 

D App lelinks 

D MultiPln 

[j Screen 2 

[j Screen 0 

12 items 

System 

System Folder '385 

2011 K in folder 5398K available ~85 

~ 
Finder 

a 
~~85 
t--i~95 

~ 
Note Pad File Scrapbook FHe ~85 

ffif:i1l .__P85 
.~ 8 ~-

LaserWriter lmagewriter Laser Prep Clipboard File ~LI--""'__. 

~12:1 

In the example shown above, the Hard Disk window is being 
viewed by Size, and the System Folder is being viewed by 
Icon. 
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The options in the Special menu provide tools 
for effective file management. 

s File Edit Uiew 
Clean Up 
Empty Trash 
Erose Disk 
Set Startup 

Clean Up lets you organize your desktop. 

This command will move icons to the closest open space in a 
window. Even if the icons are already close to being in a 
straight line, the Clean Up command will make that row 
neater, as shown below. 

Step one: The icons are out of alignment. 

~D Special Write 
6 items 361 K in disk 38K available 

System Folder MacPaint 

Mac Write 

0 
[Q 

Icon/Name Sample Memo 

Test Folder 

You may have a disk that is arranged like this. If you choose 
Clean Up, your desktop would change to look like the one 
shown under Step two. 
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Step two: The icons are in a neat arrangement 
on your desktop. 

§0 Special Write 
6 items 369K in disk 30K available 

System Folder Mac'Write MacPaint 

Sample Memo Test Folder Icon /Name 

Now all of the icons are neatly arranged. If you keep your 
office desktop neat, it follows that you'd like to keep your 
Macintosh desktop neat. This is an easy way to do it. / , 

Another benefit of this command is that it may help you find a 
"lost" file. The file may just be buried under one or two other 
icons, in which case Clean Up may reveal it. Or if you're 
moving a disk window from the larger XL screen to the smaller 
Macintosh screen, you may seem to have lost an icon or two. 
They're probably still there. By choosing Clean Up, you 
may be able to find them. 

Set Startup lets you start up quickly. 

You can use Set Startup to start up Macintosh in a specific 
application, such as MacWrite. If you're a writer, you may use 
your Macintosh primarily for word processing. To save time, 
you can create a Mac Write disk that starts up from the 
Mac Write application, without bringing up the desktop. 

To create the special startup disk, select the Mac Write icon 
that's on the desktop, and choose Set Startup. The next time 
you start up from that disk, it will start up in Mac Write. 
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You can change the disk back, so it starts up 
from the Finder again. 

To start up from the Finder again, quit Mac Write. When you 
return to the Finder, select the Finder icon and choose Set 
Startup. Next time you use that startup disk, you'll start up 
from the Finder. To practice this, follow the instructions in the 
exercise that starts on the next page. 

Use this command to set up a disk that starts 
up from an application, and has no Finder. 

Can a startup disk have a System file only, and no Finder? 
Yes. See the Installing the MiniFinder section in this module. 
Using Set Startup works the same with an application as it 
does with the Finder, or the MiniFinder. When used without 
the Finder, it saves time and disk space, since the Finder 
consumes about 45K of disk space. 

Additional options are available using the 
Finder Version 4.1. 

The first sections of this module were written about the Finder 
Version 4.1. You'll notice many similarities between it and 
Version 1.lg, and several differences. The reference chart at 
the end of this module summarizes some of the differences 
between the two versions. 

If you have any questions about the Finder, talk to a colleague 
who is familiar with Macintosh, ask your course manager, or 
contact your Apple support representative. 
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Practice 

Use the Special Me11u Use each of the Finder 1.1 g Special menu 
commands. 

Choose Clean Up to arrange the documents and folders on 
your Mac Write disk. 

Throw away any unnecessary documents, or your Empty 
Folder, by choosing Empty Trash (if you need another 
Empty Folder, use the Finder to create one). 

Find a disk you don't need atiy more, and choose Erase Disk 
to erase it. 

Choose Set Startup. Follow the steps below to set up a disk 
to start up from Mac Write. Then return the startup function to 
the Finder. 

1. Insert your Mac Write startup disk, and open the Mac Write 
disk icon. 

2. Select the Mac Write application icon, and choose Set / · 
Startup from the Special menu. 

· 3. Press Enter when you see the dialog box that says, "Are 
you sure you want to make Mac Write' the startup 
application?' 

4. Close the Mac Write disk window, eject the disk, and tum 
off Macintosh. · 

5. Tum on Macintosh. Macintosh will start up immediately in 
Mac Write with an "Untitled" document on the desktop. 

6. To start up from the Finder again, choose Quit from the 
File menu. 

7. Open the System Folder and select the Finder. 

8. Choose Set Startup from the Special menu. 

9. Press Enter when you see the dialog box that says, "Are 
you sure you want to make 'Finder' the startup application?" 

10. Close the System Folder, eject the disk, and turn off 
Macintosh. 

11. Turn Macintosh on again. The Finder and its menus will 
appear on the desktop. 
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In this exercise you used all of the Special 
menu commands. 

If you have any questions about any of the commands in this 
exercise, ask a colleague who is familiar with Macintosh, ask 
your course manager, or contact your Apple support 
representative. 
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11 Summary Exercise 

Using Finder Commands Use most of the Finder Version 4.1 commands. 

Refer to the module or use any resources you need to complete 
this exercise. 

1. Use the disk that you set up in the first exercise of this 
module. 

2. Install a MiniFinder. Use the Mac Write, MacPaint, and at 
least one document. 

3. Open the MiniFinder, and open (launch) a Mac Write 
document. Make a few modifications to the document. 
Save the changes, and quit Mac Write. 

4. Choose Finder and create a new folder. Place the 
Mac Write document you just modified into the empty 
folder, and name the folder. 

5. Insert another disk into the external disk drive, and open it. 
Copy the folder onto the new disk by dragging the folder 
icon to the disk icon shadow. 

6. Rename the folder that you just copied to the other disk. 

7. Rename the disk in the external drive and eject it without 
using menu options or the Command key. 

8. Reinsert the disk into the external disk drive, and Shut 
Down Macintosh. 

10. When the"?" icon appears, insert the startup disk with the 
MiniFinder into the internal disk while holding down the 
Option and Command keys. 

11. Rename the folder(s ), and lock one of them. 

12. Use Choose Printer to verify your printing resource, 
then use Page Setup and Print Catalog to print a 
catalog of your disk. Use a View menu option other than 
by Icon when you print the catalog of your files. 

13. Remove the MiniFinder. 

14. Shut Down the Macintosh, and tum it off. 
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This exercise covered most of the Finder 4.1 
menu commands. 

If you have any questions about any of the functions presented 
in this exercise, consult a colleague, ask your course manager, 
or contact your Apple support representative. 

SUPPORTING THE MACINTOSH FINDER 



52 Questions and Answers 

11 Questions and Answers 

Startup Disks 

Startup-Disk Icons 

Folders 

What is a startup disk? 

It's a disk that you can use to start up Macintosh. 

What must be on a disk to make it a startup disk? 

A startup disk usually has a System Folder on it However, it 
really only needs to have a System file and one application (for 
example, the Finder) that has been designated as a startup 
application. For an example and an exercise, see the Installing 
the MiniFinder section in this module. 

I started Macintosh with my MacWrite startup disk. I quit 
MacWrite, and opened MacPaint (it's also a startup disk) from 
the external disk drive. When I quit MacPaint, I noticed that 
the two icons had switched positions on the screen. The 
MacPaint icon was in the top right corner, and the MacWrite 
icon was underneath. What happened? 

Macintosh keeps track of the current startup disk by keeping it 
in the upper right comer of your screen. In this case, both 
disks are startup disks, so Macintosh assumes that MacPaint is 
the current one, since it was the last to be used. If you opened 
Mac Write again, you'd notice that the two icons would switch 
positions again. 

I understand that you can select your current startup disk by 
opening the Finder on the preferred disk. How is this done? 

Press and hold the Option and Command keys while you 
double-click on the icon of the Finder you want to start up 
from. 

What files must be in a System Folder? 

None. Macintosh doesn't require a System Folder to operate 
properly. Typically, however, you will have a System Folder, 
containing a System file, Finder, Note Pad file, Clipboard file, 
Scrapbook file, and your printing resources, such as an 
Image Writer file or a LaserWriter file or both. 
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I've updated my startup disks with the Finder 4 .1. How can I 
be sure they're all updated? 

First, check the menus to see if they contain any new 
commands, such as Shut Down. If they do you're in good 
shape. If an Empty Folder keeps appearing when you don't 
want it to, even when you keep throwing it away, it's a good 
indication that you need to update at least one more disk. 

How can I restart my Macintosh XL without turning it off? 

Using Mac Works 3.0, press the Command key and hold it 
while you press the white On/Off switch. 

You can also start up from the internal disk. Press the Option 
key while you press the white On/Off switch. 

Can I use Shut Down even if there aren't any disks in my 
disk drives? 

Yes. If you're using a Macintosh 128K or 512K, Shut 
Down will restart Macintosh and a "?" icon will appear. Of 
course, if you use Shut Down on a Macintosh XL, it will 
shut down and tum off. 

I've heard of a Standard file on Macintosh. What is it? 

It appears while you are in an application. If you close one 
window, and choose Open from the File menu, the dialog 
box that appears is called the Standard file. It's often just 
called a dialog box. In these modules, it's referred to as the 
Document Directory dialog box. 
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Features Version 4.1 Version 1.1g 

Menu Options 
Apple Menu 

Choose Printer Yes No 
File Menu 

New Folder Yes No 
Get Info Yes (lock feature) Yes 
Put Back No Yes 
Close All No Yes 
Page Setup Yes No 
Print Catalog Yes No 

Edit Menu 
No Changes 

View Menu 
Available Options were expanded Options 

expanded 

Special Menu 
Use MiniFinder Yes No 
Shut Down Yes No 

Finder Features 
Enhanced speed management Yes No 

Increased file-management About 500 files About 1 00 files / 

··~j 

MiniFinder to open applications and Yes No 
documents 

Click on icons to name them Yes No 

Duplicate names in Trash emptied Yes No 

Move disk icon to Trash to eject Yes No 

Eject unhighlighted disks Yes No 

Drag icons to hollow icons to copy Yes No 

Folders kept during "Repair'' function Yes (first-level No 
folders kept and. 

renamed) 

Type file name to open document or Yes No 
application 
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( II Finder Features Comparison Chart 

( 

Each Feature Is 
Reviewed 

The features listed on the opposite page 
compare the Finder Versions 4.1and1.1g. 

Use the chart on the opposite page to compare some of the 
features of the Finder l. lg that have been enhanced or deleted 
in Version 4.1. 

The list is a long one, and it will continue to grow as the Fi.Tlder 
is enhanced. Be sure to ask your Apple support representative 
for the latest version of the Finder, and for a list of its 
enhancements. 
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•Review 

Using the Finder Menus 

Installing the MlniFinder 

The MiniFinder Buttons 

Other Finder Features 

Using Finder 
Version 1.1 g 

More of the Finder 1.1 g 
Menus 

Knowing the Finder menus Is fundamental to 
using Macintosh. 

The Finder menus offer information about the software you are 
using, and help control the Macintosh processing environment. 
The menus are the keys to managing Macintosh files, 
documents, and applications. 

The MlnlFlnder commands provide quick 
access to documents and applications. 

Click these buttons to move quickly between 
disks, documents, and applications. 

Finder utlllty functions are provided on the 
desktop to facilitate file management. 

The Finder desktop utilities perform vital functions to handle 
disks, files, documents, and applications, such as Copy, 
Move, Duplicate, and Repair. 

This was the first Finder released with 
Macintosh, and Is still widely used. 

The Apple menu provides you with many valuable 
commands. You can work with the Calculator, Scrapbook, or 
Note Pad, and control a lot of your Macintosh operating 
environment-or play with the Puzzle. 

Many people still use Version 1. lg of the Finder. Users 
should be encouraged to upgrade to the most recent version 
that's appropriate for their needs, because it's more powerful 
and offers more commands. 

The Finder 1.1 g Fiie, Edit, View, and Special 
menus still provide powerful tools. 

Even though there are more recent versions of the Finder, 
many commands haven't changed at all. Much of the 
information remains the same from a support point of view. 
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( ~ II Resources 

( 

• Apple Support Training Library modules: Fundamentals of 
the Macintosh Operating System, ImageWriter II Basics, 
Learning to Use Macintosh, and Using the LaserWriter. 

• AppleLink Technical Info Library (available to Apple 
support personnel) 

• LaserWriter, the owner's manual 

• Macintosh, the owner's manual 

• Macintosh 68000 Development System User's Manual and 
Inside Macintosh (included with the Macintosh 68000 
Development System), Apple Computer, Inc. 

• The Macintosh Buyer's Guide, Redgate Publishing 
Company, Vero Beach, Florida 32963 

• Macintosh Update (5/15/85), a written update distributed 
with the Macintosh System Update disk. Also available on 
AppleLink. 

• Macwor/d, PC World Communications, Inc., San 
Francisco, CA 94107 

Apple, the Apple logo, and ProDOS are registered trademarks of Apple Computer, Inc. AppleLink, AppleTalk, 
ImageWriter, LaserWriter, MacPaint, MacProject, MacWorks, and MacWrite are trademarks of Apple Computer, Inc. 
Macintosh is a trademark of Mcintosh Laboratory, Inc. and is being used with the express permission of its owner. CP!M 
is a registered trademark of Digital Research, Inc. MS-DOS is a trademark of Microsoft Corporation. 
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Supporting the Font/DA Mover 

11 Contents 

2 Overview, Objectives 
3 Materials 
4 Overview of the Font/DA Mover 

The features of this application allow you a great amount of 
flexibility in designing your system environment. 

8 The Font Mover 
Use the Font Mover to copy, move, and remove fonts from the 
System file. 

17 The DA (Desk Accessory) Mover 
Use the Desk Accessory Mover to copy, move, and remove desk 
accessories from the System file. 

22 Using the Original Font Mover 
This section discusses the original Font Mover. Complete this 
section only if you actively support the product. 

31 Questions and Answers 
33 Review 
34 Resources 



2 Overview 

II Overview 

11 Objectives 

This module is designed to acquaint you with the Font/DA 
Mover. The first section describes the Font/DA Mover and its 
features. The second section discusses how to use the 
Font/DA Mover to copy, move, and remove fonts from the 
System file. The third section details how to copy, move, and 
remove desk accessories from the System file. 

Included in this module is a brief section on the original Font 
Mover. It's provided to help you support that product, and to 
demonstrate some of the differences between the original and 
current products. Completing the section is optional. Most of 
the information in it is also discussed in the first three sections. 

This module is intended for use by people who support the 
Macintosh TM computer and the software applications for 
Macintosh published by Apple Computer, Inc. 

Prerequisites 

• You should know how to use Macintosh and MacWriteTM. 
This can be achieved by completing the Guided Tours of 
Macintosh and Mac Write, or by reading Chapter 3 in 
Macintosh, the owner's manual. 

• Add a font or a desk accessory to the System file on a disk. 

• Create more room on a disk by removing fonts and desk 
accessories from the System file. 

• Create special font and desk accessory files, such as a 
"fonts only" or "desk accessory only" file to move and store 
groups of fonts and desk accessories. 
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Materials 3 

To complete this module you will need: 

• A Macintosh 512K (with external disk drive), or a 
Macintosh XL (A Macintosh 128K may be used. 
However, a font other than Taliesin 18 must be used during 
the practice exercise in the Font Mover section) 

• A disk containing these applications: 

Font/DA Mover (Version 1.2) 
MacWrite (Version 4.5) 
MacPaint™ (Version 1.5) 

• A startup disk containing Finder (Version 4.1 ), 
ImageWriter™, Image Writer 15, and/or Apple® 
LaserWriter™ printer resources 

• A blank disk 
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11 Overview of the Font/DA Mover 

Overview 

Managing with the 
Font/DA Mover 

The Font/DA Mover application is a useful 
Macintosh utility. 

The Font/DA Mover can be one of your most useful 
applications. This section describes its purpose, and provides 
an overview of its functions. 

Use the Font/DA Mover to manage the fonts 
and desk accessories in your System files. 

By using the Font/DA Mover, you can tailor your System files 
to meet your data-processing needs. The commands within 
this application allow you to move the fonts and desk 
accessories that you need into the System file on a startup disk. 
The Font/DA Mover also lets you move them off the disk to 
free up space, maximizing the disk space available for use with 
other applications, to create large documents, or to 
accommodate printing resources. 

Macintosh uses the fonts and desk accessories 
in your System file. 

• Macintosh uses the fonts in your System file to take the 
information that you're typing and put it on the screen, or to 
print that information on your Image Writer or LaserWriter 
printer. 

• Desk accessories, such as the Calculator, Note Pad, and 
Scrapbook, are handy desktop tools, as functional as their 
counterparts on your desk. You can use the Control Panel, 
another desk accessory, to control some of the Macintosh 
processing environment. Then, you can take a break and 
use the Puzzle for some recreation. 

However, before you can use any fonts or desk accessories, 
they must already be in your System file, or else loaded into the 
System file using the Font/DA Mover. 

(Note: There are some desk accessories that require special 
installation software, such as Choose Printer, and some 
third-party accessories. Still others have special backup files 
that must be copied to your startup disk before they can be 
used. Carefully read the instructions that come with these 
accessories before you install them.) 
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Font Mover Update 

Overview of the Font/DA Mover 5 

The Font/DA Mover handles fonts and desk 
accessories in the same way. 

Operationally, fonts and desk accessories are handled in the 
same way. But because of some of the functional differences 
between font files and desk accessory files, this module is 
divided into three sections: the Overview (this section), the 
Font Mover, and the Desk Accessory Mover. 

The original version of Font Mover should be 
updated to the Font/DA Mover. 

You may be familiar with the icon of the Font Mover 
application (it's shown below on the left). That original Font 
Mover is no longer in use. If you find it, update it to the 
Font/DA Mover (the icon shown below on the right). 

Ap plicali ons ~ w 
Font Mover Font/DA Mover 

Corresponding ~ en LiJJ File Icons 
Fonts DA Fonts DA Accessories 

The original Font Mover could move fonts into a System file. 
It could be used to create storage files to archive fonts for 
future use, or to remove fonts to create more room on a disk. 
The Font/DA Mover can do all of these things with fonts, and 
with desk accessories. For more information on the original 
Font Mover, see the optional section near the end of this 
module. 
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Font/DA Mover and 
Disk Space 

The System Fi le 

Operating 
System 

Fonts 

Desk 
Accessories 

The Font/DA Mover helps manage disk space. 

Fonts and desk accessories are necessary to the operation of 
Macintosh. They also take up disk space. One font in your 
system can consume from 4K to 14K of disk space. Desk 
accessories (such as the ones on your Macintosh system disk) 
need from lK to 8K each. The fonts and the desk accessories 
supplied with Macintosh occupy about 160K. That's a lot of 
disk space on a startup disk. 

The Start up D isle 

S stem File 
Finder 

Clipboard 
Printing Resources 
Desk Accessories 
(Scrapbook and 

Note Pad) 

Other Documents 
and 

Applications 

You can use the Font/DA Mover to add the fonts and desk 
accessories that you want to use right away, to remove the ones 
that you don't want, and to store the rest on another disk for 
use at another time. This helps you to maximize your available 
disk space. 
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Overview of the Font/DA Mover 7 

The disk-space management process begins 
with the Font/DA Mover window. 

When you open the Font/DA Mover, you're opening a window 
into your System file. The window is preset to open to the 
Font Mover, and to display the fonts in your startup disk's 
System file. 

CI ick here for Font Mover-€) Font 
II Mouer Click here for DA Mover-€> Desk Accessory 

( Copy ) 

( Remoue ) 

Click here for basic instructions [ ____ H_e_IP __ ) 

The Operations are the 
Same 

As the module continues, you'll look closely at each of the 
commands available in the application window, and see how 
these commands affect the use of fonts and desk accessories. 

The same operations are used by both the 
Font Mover and the DA Mover. 

The Font Mover and DA Mover use the same operations to 
manipulate fonts and desk accessories, and to create storage 
files. Therefore, the practice exercises in the Font Mover 
section can apply to the DA Mover section. If you would like 
more practice with the DA Mover after you have completed the 
module, use the practice exercises in the Font Mover section 
substituting a desk accessory wherever a font is indicated. 
You'll see how similar the operations are. 
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11 The Font Mover 

Overview 

Copy, Move, and Remove 

The Font Mover accesses the fonts in your 
System files and in special font files. 

In this section, you'll learn how to use the Font Mover to add 
more working space to your disk, and how to store fonts for 
future use. 

Choose the Font Mover section of the Font/DA 
Mover. 

By selecting the Font Mover, you can move fonts between any 
combination of System and storage files. 

Chicago 12 
Geneua 9 
Geneua 12 
Monaco 9 

®Font 
O Desk Accessory 

Copy 

Remoue 

Mauer 

When you open the application, the fonts in the System file of 
your startup disk are displayed in the box on the left. Several 
fonts are displayed, including the four basic fonts that the 
System file requires: Chicago - 12, Geneva - 9, Geneva - 12, 
and Monaco - 9. The fonts are used on the screen in menus, in 
icon names, and in other places where system- or software­
generated text appears on the screen. These fonts are also 
available for your use whenever you need them. Don't try to 
remove them, though-the system won't let you. 

Copy, move, and remove fonts to maximize 
disk space. 

Since fonts take up space on a disk, you'll want to remove any 
you aren't using, and store them where they can be easily 
accessed. Fonts that you use for word processing aren't 
necessarily the same as fonts you might want to use for the 
overhead slides in a sales presentation. But you still want them 
to be accessible. 
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Print Quality 

Use Your Old Font Files 

c-

The Font Mover 9 

Create a fonts-only disk. 

One way to archive fonts is to create a fonts-only disk. Use the 
Font Mover to move as many fonts as you can to a specific 
disk. (It won't take long to fill a disk with fonts, unless you're 
using a hard disk, in which case you can have as many fonts as 
you like on your disk.) There are a few limitations: Some 
applications can use as many as 15 different fonts, while others 
are limited to only a few. To be sure you haven't added too 
many fonts, look at the Font menu. If you can see all of your 
fonts, great. If not, remove the fonts you don't need until you 
can see all of the fonts available in your Font menu. 

If you want to create a fonts-only disk, there is 
a practice exercise that can help. 

There are two practice exercises in the section of this module, 
Using the Original Font Mover. Use the second exercise to 
create a fonts-only disk. 

Standard-resolution print quality requires one 
font size; high-resolution output requires two. 

If you're using an ImageWriter as your primary printer, you 
need to have only one font size for each font to be able to print 
in standard print mode. To print text in high-resolution mode 
requires a larger font size. For example, with text input using 
12-point Geneva, you must have 24-point Geneva for 
high-resolution printing. The Image Writer takes the 24-point 
Geneva and shrinks it to produce the higher-quality printed 
text. 

The Font/DA Mover can use any font file. 

You can use the Font/DA Mover to open font files created with 
the Font Mover. However, font files created using the 
Font/DA Mover aren't compatible with the original Font 
Mover. 

Though the Font/DA Mover can open original Font Mover 
files, it won't upgrade or "convert" them. This means that 
Font Mover files that are opened using Font/DA Mover can still 
be opened by the original Font Mover. 

The best thing to do is to throw away any copies of the old 
Font Mover, and upgrade to the Font/DA Mover. 
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File Names 

Practice 

Use the Font Mover 
Portion 

Font file names do not have to be changed to 
be used by the Font/DA Mover. 

The Font/DA Mover can use any font file on a disk, regardless 
of its name. This is unlike the situation with files created using 
the original Font Mover, in which the name of the file must be 
"fonts." If you want to create more than one font-storage file 
on the same disk (with the original Font Mover), you must 
change the name of the font file to something like "Fonts 1 ". 
Only one file per disk can be called "Fonts" and be used by the 
Font Mover. 

Remove a font from the System file on one 
disk, and add it to the System file on another. 

1. Create a "Font Disk" that contains these files: a System 
file, Finder Version 4.1, and the Font/DA Mover. 

-0 Font Disk 
3 items 164K in disk 235K available 

l9J l9J 
IQ 

w 
System Finder Font/DA Mover jQ 

~ E '2J 

2. Open the Font/DA Mover on your new Font Disk. When 
the Font/DA Mover dialog box appears, it should look 
similar to the one on the next page. 
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®Font 
Mouer ODesk Accessory 

Chicogo 12 ~ ( l:opq ) ~ 
Geneuo 9 
Geneuo 12 ( B~~moo~~ ) 
Monoco 9 
Mono co 12 
New York 9 
New York 12 o1 ~ 

System 

I on Font Disk ( Help ) 
236K free 

( Close ) ( Quit ) ' 
! ( Open •.• ) 

.................................................................................................................................................................................................... 

3. Click Open on the lower right side of the dialog box. This 
should open another dialog box that has a directory of the 
font files that includes the System file. 

G 
M 
M 
N 
N 

@Font 
0 Desk Accessory 

System ~ 
Taliesin Font Open 

New 

Cancel 

Close Quit 

Mou er 

Font Disk 

Drim~ 

) i Open ... 

4. Open the Taliesin Font file (if you're using a Macintosh 
128K, use a font other than the Taliesin 18). 

5. When the document directory disappears, select the 
Taliesin 18 font (as you select a font, you'll notice that the 
Copy and Remove buttons are highlighted). 
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Practice (cont'd) 

I 

®Font 
0 Desk Accessory 

...----------'"~~ 
Chicago 12 
Geneuo 9 
Geneuo 12 
Monaco 9 
Monoco 12 

( «Copy« 

( Remoue 

New York 9 8074 bytes 
New York 12 selected 

Mouer 

System ·• •• ,i [ i Taliesin Font 
on Font Disk . Help ) j on Font Disk 

( 23~~!:ee ) I ( Quit ) I ( 23~1~:~ee ) 
............................ - .................................................................................... u ................................................... - .......................... . 

rauesin 18: I,~ ii:::=P<=>i) {CI01~@ ~ 

(Note: So far the operation of the software is very similar to 
that of the Font Mover. But the similarity ends quickly. Now, 
you can use either side of the dialog box for System files, or 
for storage files. The options aren't as limited as in the old ·. j 

Font Mover.) 

6. Click Close at the bottom of the screen. The screen 
should look almost blank (compared with a moment ago). 

7. Click Open on the lower left side of the screen. The 
document directory dialog box should appear. 

8. When it does, open the Taliesin Font file. The Taliesin 18 
font should now be showing in the upper left comer of the 
directory window on the left side of the dialog box. 

9. Click Open on the lower right side of the screen. When 
the dialog box appears, open the System file. The 
directory window on the right side should display the fonts 
contained in the System file. 
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10. Copy the Taliesin 18 font to the System file on the Font 
Disk. Notice that two things happen: 

• The elevator bar on the right side of the window should 
be highlighted. Scroll it down to view all of the fonts. 

®Font Mouer 
O Desk Accessory 

( » l:opy » J l:hicogo 12 
"" Geneua 9 

.__ _____ __._U:w ( 8;;~;;;:. 1 ~~~~~~} :2 ~ 
Taliesin Font · System 
on Font Disk I ( Help ] I on Font Disk 

22~~o!:ee ) I [ Quit ) I ( 22~1~:~ee ) 
.................................................................................................................................................................................................... 

Taliesin 18: I,® =i=:=l'<=>i) {C!Ci1~@ ~ 

• The amount of free space on the disk is reduced by 
about 9K (as indicated by the number just above the 
Close button). 

11. Scroll the System file down. You can see that the Taliesin 
18 font has been copied to that file. 

12. Click Close to close the Taliesin Font file. 

13. Click Open. 

14. Insert a startup disk in the external disk drive. Use 
the Font/DA Mover buttons to open the System file on 
the disk in the external drive. 
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Practice (cont'd) 

System ~ 
Taliesin Font ( Open System Update 

( New ( Eject 

( Cancel ) ( Dri1Je ) 

15. Now, copy the Taliesin 18 font from the System file on the 
internal drive to the System file on the external drive. 

®Font Mouer 
O Desk Accessory 

.-C-h-ic_a_g_o_1_2 __ __,...,...., [ «Copy« ) Geneua 9 

Geneua 9 ~ Geneua 12 
Geneua 12 [ Remoue ) Monaco 9 
Monaco 9 Monaco 12 
New York 9 New York 9 
New York 12 8074 bytes New York 12 

System 
on System Update 

98K free 

selected 

Help 
System 

on Font Disk 
227K free 

Close ) ( Quit ) ( Close ) 

illll 

.................................................................................................................................................................................................... 

Taliesin 18: I'-® ~E::::PcsiJ ~CIOl~@ ~ 

16. While the Taliesin 18 font is highlighted on the internal 
disk, click Remove. 
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®Font Mover 
O Desk Accessory 

r:C:"'.'.'"h-:-i C_li_g_o"'"'.1:-:2:----"TA'I ( « C 0 p y « 
Geneue 9 
Genevli 12 ( Remove ) 
MonliCO 9 It 
New York 9 
New York 12 8074 bytes 

selected 

Geneuli 9 
Geneue 12 
MonBco 9 
MonBco 12 
New York 9 
New York 12 

System ) i ... · System 
on system UpdBte Help on Font Disk 

98K free i 227K free 
Close ) ( Quit ) I ( Close ) 

.................................................................................................................................................................................................... 

TBliesin 18: I,@ $~c=>i) ~C!Ol~@ ~ 

(Note: By removing the Taliesin 18 font from the 
System file, you have increased the amount of available 
space on the disk by about 9K.) 

17. Your final Font/DA Mover screen should look like the one 
on the next page. 
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Feedback 

Using Font Mover Your final screen should resemble this one: 

@Font 
Mo11er O Desk Accessory 

Chicago 12 ~ ( Copy ) Chicago 12 Q 
Gene11a 9 Gene11a 9 
Gene11a 12 ( Re moue ) Gene11a 12 
Monaco 9 Monaco 9 
New York 9 Monoco 12 
New York 12 New York 9 
Tnliesin 18 to New York 12 ~ 

system 

I 
l system 

on system Updote ( Help ) on Font Disk 
! 

90K free I 236K free 
( Close ) ( Quit ) ( Close ) I I . ........... -.................... _,_ ......... -.-· .......................................................................................... -.... __ .... , ................................. 

Both System files should be showing. You should have a ··~. / 
copy of the Taliesin 18 font in the external disk, and copies of 
the seven fonts in the System file on the Font Disk that you 
started out with. 

In this practice, you should have been able to move a font 
between two System files, remove a font from a System file, 
and use the Document Directories in the application dialog box 
to help maximize free disk space. 

You also practiced moving font files between disks and using 
the buttons to manage files on two disks at once. It is also 
possible to use the buttons to help cycle a number of disks 
through the Font/DA Mover application. 

If you need any help, or require further assistance, ask a 
colleague, check with your course manager, or contact your 
Apple support representative. 
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( II The DA (Desk Accessory) Mover 

Overview 

Desk Accessories 

( 

The Desk Accessory Mover is similar to the 
Font Mover in function. 

The Desk Accessory Mover portion of the Font/DA Mover can 
be used to move desk accessory files into and out of System 
files. 

0 Font 
Mouer @ Desk Accessory 

Alarm Clock Qj ( » Copy» ) Key Caps \Q 
Calculator Puzzle 

~ 
Choose Printer [ Remoue ) 
Control Panel 

Desk accessories are accessed through the Apple menu. See 
Chapter 4 in Macintosh, the owner's manual, for more on the 
desk accessories. 

About the Finder ••. 

Choose Printer 
Scrapbook 
Alarm Clock 
Note Pad 
Calculator 
Key Caps 
Control Panel 
Puzzle 

You can have as many as 15 desk accessories 
on a disk. 

Although the Apple menu can hold up to 15 desk accessories, 
you won't necessarily want to keep all of your desk accessories 
in your System file, where they can be accessed from the 
Apple menu. Desk accessories, like fonts, take up disk space. 
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That space can be used for other things, such as 
word-processing documents or high-resolution graphics. 

The standard Apple-supported accessories are shown on the 
previous page, in the illustration of the Apple menu. These 
accessories are supplied with most Apple-supported Macintosh 
applications. 

Not all of them are necessary to run applications. So, to create 
more disk space, you can remove some accessories, or move 
them to another disk for storage. Do not, however, remove all 
of the accessories from the System file. If you try to, you'll 
get a dialog box with the following message: 

Please don't remoue RLL of the desk 
accessories on that disk! This will destroy 
the disk! 

( OK J 

In addition, all of the standard Apple desk accessories, 
combined, require less than 30K of disk space. The Puzzle, 
for example, requires less than lK, Choose Printer requires 
6K, and the Control Panel, which helps control much of the 
Macintosh user environment, needs about 8K. You're not 
going to gain much space by removing them (but you may need 
that extra bit of room some time). 

The Scrapbook, Note Pad, and Clipboard are 
unusual. 

You can throw away the icons for these files. As long as the 
Scrapbook and the Note Pad are in the System file, they can 
always be used, whether their icons appear or not. The icons 
will reappear when you choose them from the Apple menu. 
The same is true for the Clipboard icon. It can be thrown 
away, but it will reappear when you use Cut or Copy. 

Third-party applications use the desk 
accessories, and add some of their own. 

Third-party vendors use the Apple-supported desk accessories, 
and have created many of their own. Some software is written 
to run exclusively as desk accessories, serving as 
"mini-applications." These mini-applications can provide very 
creative solutions to everyday processing needs. You can 
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customize your own desktop options by adding some of this 
third-party software using the Font/DA Mover. 

There is an advantage to running small 
applications as desk accessories. 

A popular data communications package that's available as 
public-domain software is used on the desktop at the same time 
you're running an application such as Mac Write. It isn't as 
powerful as MacTerminal™, but you don't have to quit your 
application to use it. 

Appointment calendars, telephone/address books, and 
spreadsheets are a few of the many desk accessory offerings 
that are currently available. 

Apple supports only the desk accessories it supplies with its 
Macintosh system disks. 

(Note: Some of these third-party accessories work very well. 
Others may not be completely compatible.) 

Use the Desk Accessory Mover to remove a 
desk accessory from the System Folder. 

1. Use a backup of the System Update disk, or create a 
startup disk that contains the Font/DA Mover. 

2. Check the startup disk to be sure that the Apple menu has 
all of the standard Apple-supported desk accessories (see 
page 14 for the list). 

3. Open the System Folder on your backup disk. Throw 
away the Scrapbook and the Note Pad icons. 

(Note: You're only throwing away the icons. If you open 
the Apple menu you'll see the Scrapbook and Note Pad 
still listed (even if you use Empty Trash). Don't worry, 
you'll have a chance to clear them out of the system.) 

4. Close the System Folder, and open the Apple menu. 
Compare the list of accessories, and notice which 
accessories are still there. 
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Practice (cont'd) 

Try This 

5. Now, open the Font/DA Mover. Notice which part of the 
application opens first (Font or DA), and which file opens 
first (it should be the System file on the startup disk). 

6. Click the Desk Accessory Mover button. Note the names 
of the files that are displayed in the Document Directory 
window of the System file, and write down the amount of 
space remaining on the disk. 

7. Close the System file on the external disk, and click Open. 

8. Create a new file called "For DAs Only." 

9. Select the Scrapbook and the Note Pad. 

(Note: You threw away just the icons in Step 3; you 
didn't throw away the files held in the System file itself. 
The icons hold information not the actual Scrapbook and 
Note Pad files held by the System file.) 

10. Copy the Scrapbook and Note Pad files into the "For DAs 
Only" file. 

11. Remove the Scrapbook and Note Pad files from the 
System file on the internal disk. When that operation is 
complete, note how much space is free on the disk in the 
internal drive. It should be about 6K more than the amount 
you noted in Step 6. 

12. Click Quit. 

13. When you have returned to the Finder, select the Apple 
menu, and notice that the Scrapbook and Note Pad are no 
longer there. 

14. Check the System Folder, and notice that the icons aren't 
there either. You have succeeded in throwing them away. 

Throw away the icons. 

To experiment further, try this with another disk: 

1. Throw away the icons of the Scrapbook and Note Pad, and 
empty the Trash. 

2. Open the Apple menu, and choose the Scrapbook and 
then the Note Pad. 

APPLE SUPPORT TRAINING LIBRARY 



( 

Feedback 

The DA Mover 

More Practice 

The DA (Desk Accessory) Mover 21 

3. Check the disk window. The icons should appear. 

4. Place them back in the System Folder, or else throw them 
away. 

Use the information in this exercise to back up 
your desk accessories. 

The other Apple menu desk accessories don't have icons on 
the desktop. The only way to access them is through Font/DA 
Mover. 

Since they can't be copied using icons, use what you've 
learned in this practice exercise, and create a "DAs Only" disk 
that'll be a backup file for your accessories. Then they'll 
always be available when you need them. 

The Scrapbook and Note Pad don't act like the 
other desk accessories. 

When you threw away the Scrapbook and Note Pad icons, 
only the icons were deleted, and not the files. One of the ways 
to remove those files completely is to remove them using 
Font/DA Mover, as you just did. 

Creating a backup DA file. 

If you create a backup desk accessory file, you have some 
insurance against the unexpected. 

To get more practice using the Desk Accessory 
Mover, use the Font Mover practice. 

As you've seen, the Font Mover and Desk Accessory Mover 
are the same operationally. So if you would like more practice 
using the DA Mover, use the Font Mover practice exercise, just 
substitute desk accessories for the fonts. 

If you have any questions, or need some help with this 
exercise, ask a colleague, your course manager, or contact your 
Apple support representative. 
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II Using the Original Font Mover 

Overview 

The Original Font Mover 

Review this section only if you support the 
original Font Mover. 

This section of the module was written prior to the release of 
the Font/DA Mover (Version 1.2). There are people who still 
use the original Font Mover, this section was included to help 
you support those people. 

Much of the information in this section is repeated from the 
earlier part of the module. You don't need to complete this part 
of the module if you aren't supporting the original Font Mover. 

When you're asked about the Font Mover, suggest that the user 
upgrade to the latest version of the application. 

The Font Mover can be an effective 
file-management tool. 

Review the section about the Font Mover in Chapter 3 of 
Macintosh, the owner's manual, and read the Font Mover "help 
notes" contained within the application. The notes are available 
when you open Font Mover and select "Help" from the Font 
Mover menu. 

Use the Font Mover to manage disk space. 

One of the advantages of word processing on the Macintosh is 
that you can use various fonts, font sizes, and type styles. The 
Font Mover and the Fonts file help keep track of the various 
fonts that are available, and can help to manage fonts efficiently 
on your disks. 

Don't use too much of a good thing. 

Fonts are maintained in files that average from 4K to 6K in 
size; 52 of the most commonly available fonts for the 
Macintosh require a total of about 230K of disk space. 
However, some fonts can require up to 14K. For example, the 
four basic fonts used by the system each require a total of 1 lK 
on a disk. Slightly less than 100 fonts can fill a disk. With all 
the various fonts available from Apple and third-party 
developers, it's tempting to load your disks with a multitude. 
Try to resist this temptation. 
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Create a master font disk. 

To maximize the amount of space available on your disks for 
applications and documents, use Font Mover to create a master 
font disk. The fonts on this disk will be available to all of your 
other disks through Font Mover. By creating a separate disk to 
hold all of your fonts, you are assured of having all the fonts 
you need, when you need them. 

Fonts reside in the System file or Fonts file. 

The System file holds fonts and font sizes you can use with 
each application; each System file has its own set of fonts. 
You can customize your System files to hold the fonts you use 
the most Fonts can be stored in a Fonts file when they are not 
being used by the System file. 

Fonts can't be used within an application until 
they are moved into the System file. 

The only time a font can be used by Macintosh is when that 
font has been moved into the System file by Font Mover. Each 
application can use a very wide variety of fonts. However, the 
actual number of fonts that can be used is limited by the size of 
the Font menu within each application. 

Font Mover is like a moving van~ 

Disks are like houses that have rooms (files). The System file 
and the Fonts file are like rooms of furniture that store the fonts 
for current and future use. Font Mover is a vehicle used for 
moving and removing fonts. 

The Fonts moving van is used to move furniture (fonts) from a 
fonts room in one house (disk) to a fonts room in another 
house (disk). The Fonts moving van is unique in that it can 
both move furniture from house to house, and also from room 
to room within a house. 

The furniture can be either stored for future use, or moved into 
the System file for immediate use. 

Font Mover is simply a vehicle to move fonts from one disk 
file to another, and from a Fonts file on a disk to the System 
file and back again. 
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Some fonts are reserved for system use. 

Chicago-12, Geneva-9, Geneva-12, and Monaco-9 are the four 
fonts reserved for system use. You see them displayed on the 
screen in menus, icon names, and other places where system­
or software-generated text appears on the screen. These fonts 
can't be removed from the System file. 

Font Mouer 

in system file in Fonts file 
*Chicago-12 ~ ( Help ) 
*Geneua- 9 
*Geneua-12 ( Copy ) 
*Monaco- 9 

( Remoue ) 

to ( Quit ) 
Name: 
Point size: 
Disk Space: 

* reserued for system use 

Basic fonts, the System file, the Finder, and 
the Font Mover require about 130K. 

~ 

RJ 

To create a master font startup disk, start with the basic file 
configuration shown below. You need to have the System 
file, Finder, and Font Mover on the disk. Those three files and 
the four basic fonts (shown above) take up about 130K. 

§0 Basic Fonts 
3 items 

n 
~ 

System 

n 
8 

Font Mover 
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The disk used in the illustration below has 52 fonts and uses 
about 200K for fonts only. It has the 4 fonts needed by the 
system, and 48 other fonts from Apple and third-party 
developers. 

3 items 

n 
~ 

System 

52 Fonts 
334K in disk 65K availab 

~~ 
Finder Font Mover 

Fonts can crowd a disk. 

As you can see, 52 fonts plus the System file, the Font Mover, 
and the Finder, nearly fill a disk. Below is an example of a 
disk that has no System file or Finder, just 52 fonts and the 
Font Mover-yet more than half the disk is full. 

~D~ For Fonts Only ~ 
2 items 228K in disk 1 72K 

~ ~ 
Fonts (52) Font Mover 

Create a fonts-only disk. 

To create a fonts-only disk, simply use Font Mover to copy as 
many fonts as you have into one Fonts file. After you have 
done this, move the Fonts file and Font Mover onto a disk that 
contains no other files. There is a practice exercise at the end 
of this section to help you do this. 
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Print Quality 

(Note: If you are working on a Macintosh XL, you can load 
up the disk with all the fonts you think you will be using on a 
regular basis. Remember, though, the more files you have on 
your hard disk, the more the Finder has to work to keep track 
of them.) 

How many fonts do you need on a disk? 

The best Mac Write startup disk is one that has the smallest 
number of fonts on it, thus providing the maximum available 
space for your documents. Using Font Mover, you can create 
a Mac Write disk that contains only those fonts and resources 
you will need for a particular document or set of documents. 

To do this, you need to determine what font and font sizes you 
plan to use, and then decide on the type of printing: 
Image Writer (standard or high-resolution), LaserWriter, or 
another printer such as a daisy wheel printer. Making these 
decisions and selecting your fonts ahead of time will help 
minimize the number of "Disk full" messages you'll get. 

Standard resolution print quality requires one 
point size. 

Most of this document was created using Helvetica TM 12-point 
font. That font had to be available to the application from the 
startup disk's System file. No other font (except the required 
system fonts) was needed on this disk to create it or to print it 
in standard-resolution print on an Image Writer. 
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High-resolution print quality requires two point 
sizes. 

High-resolution printing uses the point size that is twice the 
size you see on the screen, and compresses it to produce 
higher-quality printed letters. For example, to print 
high-resolution 12-point Geneva output, 24-point Geneva must 
be available. 

in System file 
Cairo-1 B 

*Chicago -12 
*Geneva - 9 
Geneua-10 

*Geneua-12 
Geneua-18 
Geneua-20 

Name: 
Point size: 
Disk Space: 

Font Mouer 

Help 

I! l,..._R_e_c m-
0

-:Y_u_e ___ ) 

( Quit ) 

in Fonts file 
Geneua-12 
Geneua-24 

* reserved for system use 

Once a font is no longer needed on a disk, remove it. 
Otherwise you'll be wasting disk space. 

How much room do fonts consume? 

1. Tum on your Macintosh and insert your Mac Write 
application disk. 

2. Do Mt use your original MacWrite disk for this exercise. 
Back it up onto a "clean" disk (either initialize, erase, or 
copy over a disk). Label your new disk, and set aside 
your original Mac Write disk. 
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Practice (cont'd) 

3. Be sure there's a Font Mover file on the Mac Write disk 
you've just created. If there isn't, find a disk that has Font 
Mover on it and move it to your new backup Mac Write 
disk. 

4. You should now have a new startup disk with Mac Write 
and Font Mover on it. 

5. Turn off your Macintosh and start it up from your new 
Mac Write startup disk. 

6. Open the disk window. 

7. Write down the amount of space on your disk. 

8. Open the Font Mover. 

9. Count the number of fonts in the System file. In the 
example on the previous page, there are about eight fonts 
available (only seven are showing). 

10. Follow the directions in Chapter 3 of Macintosh, the 
owner's manual. Use Font Mover to remove all of the 
fonts except those required by the System file. Remove 
any fonts in the Fonts file, also. 

11. Choose Quit from the Font Mover menu. 

12. Once you're back to the desktop, write down the amount 
of space you now have on your disk. You should have 
more space now as a result of removing the fonts from 
your disk. You also now have a Mac Write disk that isn't 
cluttered with unnecessary fonts. 
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Create a fonts-only disk using Font Mover. 

(Note: This exercise is for use with the original version of 
Font Mover, not the Font/DA Mover.) 

1. Get a recycled or erased disk (an initialized disk). 

2. Insert the disk into your external drive and name it "Fonts 
Only." 

3. Copy Font Mover onto the disk. 

4. Open Font Mover, select all of the fonts in the System fiie 
and copy them to the Fonts file. If there isn't a Fonts file 
on your disk, Font Mover will create a new one. 

5. Choose Quit from the Font Mover menu. 

6. Since your new Mac Write startup disk has so few fonts (in 
the previous exercise we removed all of the fonts except 
the ones required by the System file), you'll need to get 
your Macintosh system disk. This will have several more 
fonts on it. 

7. Eject the MacWrite disk. Tum off Macintosh. Insert the 
System disk and tum on Macintosh. 

8. Open Font Mover on your fonts-only disk. 

9. You'll see that there are more fonts available to you. Select 
all of the fonts you want to move. 

(Note: If you try to copy fonts from the System file to the 
Fonts file, and they are already there, a dialog box will 
appear and state which fonts are already present. Click 
OK, or press Enter to continue.) 

10. Continue the process of copying fonts from other System 
files until you either fill the disk or have as many fonts on 
the fonts-only disk as you feel you might use (be sure to 
save space for some of the exotic fonts such as Cairo and 
Symbol font-they're fun to use). 

11. Eject the fonts-only disk and label it. Store it where it's 
safe and easily accessible. 
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Feedback 

Fonts-Only Disk 

If You Have a Question 

Using a fonts-only disk saves disk space and 
time. 

Now that you have a fonts-only disk, you don't need to worry 
about removing fonts from different disks to free up more 
space for documents. All of your fonts are on one disk. Since 
you don't have to hunt through several disks to find them, 
you'll save time. 

Use the fonts-only Fonts file to supply the System file with the 
fonts you need for a particular document or application. To use 
it open the Font Mover on the fonts-only disk. 

If you had any trouble with this exercise, ask 
questions. 

Your course manager, a colleague, or your Apple support 
representative will help you with any questions you might have 
about the Font Mover. 
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(m II Questions and Answers 

Font Mover 

Select Multiple Fonts 

MacDraw Fonts 

Desk Accessories 

I tried copying the Taliesin 18 font with my Macintosh 128K. 
All I got was a Finder error. How can I copy this font? It has 
afew characters on it I would like to use. 

Due to a system enhancement, you can't use the Font/DA 
Mover (Version 1.2) to copy the Taliesin 18 font on your 
Macintosh 128K. 

How do I select multiple fonts (to copy, or to remove)? 

There are two methods: 

• If you're selecting multiple fonts that follow each other in 
succession in the directory window, click the first font, and 
drag to the last font you want to select. 

• Shift-click, as if you were selecting documents or files. 

(Note: These same methods apply to selecting desk 
accessories.) 

I installed a few more fonts in my System file, but now when I 
open MacDraw™ I can't use some of the fonts. In fact they 
don't even appear in the Font menu. How can I correct this? 

To correct this, you must: 

1. Copy the font(s) you want to use from the System file. 
2. Remove the font(s) from the System file. 
3. Then copy the font(s) back into the System file. 

This will change their position in the Font menu and allow you 
to access them. 

For example, you want to use the Taliesin font. Since you've 
just installed the LaserWriter fonts, the Taliesin font no longer 
appears in your MacDraw Font menu. To change its order in 
the Font menu, you must follow the steps shown above. 

Are all desk accessories compatible all the time? 

All Apple desk accessories are compatible with all Apple 
applications. This isn't necessarily true for all third-party 
applications. 
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New System File 

New Accessories 

When I installed a new System file, I lost a lot of my desk 
accessories. What happened? 

When you replaced your System file with another System file, 
all of the desk accessories and fonts in the new file replaced the 
old ones. Always back up your files, including your System 
files so that you have copies of your desk accessories. If you 
have to replace a special System file, it's always easier to do 
from a backup file. 

I tried to install a desk accessory using the installation disk 
supplied with the application. All I got were errors, and now 
my System file doesn't work at all. What should I do? 

Start up Macintosh from another startup disk. Replace the 
damaged System file with the one on the current startup disk 
(use your backup System file in place of the damaged file). 

The error you encountered could have been because there 
wasn't enough room on the disk for the new desk accessory. 
Some desk accessories can require up to 35K of disk space. 
Use the Font/DA Mover to free some space on the disk, and try 
the operation again. If you are still unsuccessful, call your 
support representative for that application. 

I used the Font/DA Mover to install a desk accessory, but it 
doesn't work. Why? 

There could be several reasons. A common situation with 
third-party desk accessories is that they require backup files on 
the disk. For example, one popular calendar program uses a 
document in the System Folder to hold its text files. If that 
backup file isn't present, the desk accessory won't work 
properly. 

Check the installation disk for a file or a document other than 
the desk accessory file. Copy that file or document onto the 
startup disk, and try the desk accessory again. If that doesn't 
work, read through the instructions again; if you still have a 
problem, call the support representative for that product. 
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The Font/Da Mover is one application that can 
manage two types of files. 

The features of this application allow you a great deal of 
flexibility. The functions of fonts and desk accessories are 
different, but this application handles both of them to create a 
specialized and personalized processing environment 

Font Mover moves, removes, and copies fonts 
for use and for storage. 

Font Mover has been enhanced to include the ability to move 
fonts between several files of different names, including the 
System file. You can create your own Font files, and name 
them anything you wish. 

Font Mover is used primarily to save disk space; however, its 
use also saves a lot of time. You don't have to look far to find 
your favorite fonts, and since you are managing your disk 
space, you don't have as many "Disk full" messages. 

Operationally it's the same as the Font Mover. 

The greatest advantage of this application is its ability to move 
desk accessories into and out of the System file (the same way 
you can move Font files). 

You can remove desk accessories from a disk to create more 
space for truly great documents, and fascinating illustrations. 
Any desk accessories that you remove can be stored for future 
~. . 

This section is a review of the original Font 
Mover application. 

The original application is still used by many people. 
However, users should be encouraged to upgrade to the 
Font/DA Mover. 

SUPPORTING THE FONT/DA MOVER 
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Resources 

• 

• 

AppleLink™ Technichal Info Library, (available to Apple 
support personnel from Apple Computer, Inc.) 

Macintosh, the owner's manual 

Apple and the Apple logo are registered trademarks of Apple Computer, Inc. AppleLink, lmageWriter, LaserWriter, 
MacDraw, MacPaint, MacTerminal, and MacWrite are trademarks of Apple Computer, Inc. Macintosh is a trademark of 
Mcintosh Laboratory, inc. and is being used with the express permission of its owner. Helvetica is a trademark of the 
Allied Corporation and is used by Apple under license. 
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Managing Macintosh Files 

Ill Contents 

II Overview 

2 Objectives, Materials 
3 Folders and File Structure 

Folders can define a file structure or file hierarchy. 
15 Lock an Icon 

The Get Info information window can be used to lock an icon, 
and to make notes about the information in that icon. 

18 The Document Directory Dialog Box 
Learn more of the uses of the Document Directory and the Save 
As dialog boxes. 

26 Review 
27 Resources 

This module is an overview of techniques you can use to 
manage Macintosh TM computer documents, applications, and 
files. It discusses how to use dialog boxes and other 
Macintosh desktop features to organize your documents and 
folders. 

This module is designed for everyone who uses Macintosh or 
who supports other users. 

Prerequisites. 

• Before beginning this module you must know how to use 
Macintosh, the Macintosh Finder, Font/DA Mover, and 
MacWriteTM. To achieve this level of knowledge, complete 
the Apple Support Training Library modules, Supporting 
the Macintosh Finder, Supporting the Font/DA Mover, and 
their prerequisites. 



2 Objectives 

II Objectives 

• Materials 

• Define what's meant by a Macintosh file, document, and 
application. 

• Define the difference between a startup disk and a data 
(nonstartup) disk. 

• Use folders, and describe why they help to define file 
structure. 

• Use the Finder to effectively manage the system and 
minimize disk swapping. 

• Lock an icon. Describe what that does, and use other 
information window features to help keep track of the 
information in your documents and files. 

• Open, name, and save documents to the current startup 
disk, or to another disk, using the Document Directory 
dialog box. 

• Use the Document Directory dialog box to cut and paste 
information within an application. 

To complete this module, you will need: 

• A Macintosh 128K, a Macintosh 512K, or a Macintosh XL 

• An external disk drive 

• Macintosh, the owner's manual 

• A startup disk that includes the Finder Version 4.1, the 
Font/DA Mover, and Mac Write 
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C' II Folders and File Structure 

( 

Overview 

Files, Documents, and 
Applications 

Macintosh uses folders to help you organize 
your files, documents, and applications. 

The Macintosh Finder uses a flat file structure with 400K disk 
drives and the Macintosh XL. It uses a hierarchical file 
structure with other Macintosh disk drives, such as the Hard 
Disk 20. 

This section discusses how to use folders to organize your 
files, documents, and applications within a tlat file structure. lt 
tells how a flat file structure differs from a hierarchical file 
structure. 

Organize files, documents, and applications in 
folders on disks. 

Macintosh has three designations for icons (files): System files, 
working documents, and applications. 

• System files are normally found in the System Folder. 
They typically include the System file, Finder, printer 
resource files (such as the Image Writer™), Scrapbook file, 
Note Pad file, and the Clipboard file. 

• Working documents can be Mac Write word-processing 
documents, MacPaint'™ graphics documents, or any other 
working file created by an application. Often they are 
referred to as data documents, or data files. 

• Applications are the programs used to create documents. 
Mac Write and MacPaint are examples of applications. 

During this module, the term "file," as in "file-management," 
will be used generically. 

For more information on these designations, see the Disks, 
Documents, and Folders section in the Apple Support Training 
Library module, Learning to Use Macintosh. 

MANAGING MACINTOSH FILES 
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Macintosh and File 
Structure 

Directory 

Subdirectories 
and Files 

Files 

Macintosh uses a flat file structure rather than 
a hierarchical file structure. 

All Macintosh disk files (except those using the HFS Finder) 
are maintained at one level on the disk directory in a flat file 
structure. That means that Macintosh looks at all of the files on 
the directory at one time. 

Some operating systems, such as ProDos®, MS-DOS, PC 
DOS, and CP/M, have a hierarchical filing system. The object 
of hierarchical file structure is to group files in a logical order 
within a directory and subdirectories on a disk. 

Directories and subdirectories are used to 
access files. 

When a disk (or volume) is first formatted, it gets a name and a 
directory. Anything you save on that volume is accessed 
through its directory. The directory is a file that keeps track of 
where other files on the disk are stored. You could say that a 
directory file is like an address :)ook. 

At some point, you'll want to organize your files (especially if 
you're using a hard disk) so you won't have to shuffle through 
your financial reports to get to your incentive plan. To do this, 
you'll need to establish a "hierarchical" file structure. 

In the example shown above, the file structure starts with a 
directory file named "Your Directory." It has subdirectories 
titled "Spreadsheets" and "Ops System." The subdirectories 
contain the documents "EOM" and "Incentives," in addition to 
the System and Printer files. Financial, Forecast, and Memos 
are files (or documents), not subdirectories. 
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Folders and Flat File 
Structure 

Name 

Folders and File Structure 5 

So, "Your Directory" knows the addresses for Spreadsheets, 
Financial, Forecast, Memos, and Ops System. "Spreadsheets" 
knows where to find the EOM and Incentives documents. 
"Ops System" knows the location of the System and Printer 
files. This kind of arrangement is called a hierarchical file 
structure because files are organized into successive levels. 

Folders create the illusion of a hierarchy. 

Folders were developed to allow Macintosh icons (files) to 
appear in a hierarchical display on the screen. 

By placing one or more icons and/or folders into another 
folder, Macintosh icons can be grouped logically. The System 
Folder, shown below in a screen shot (from a Macintosh XL), 
is like the Ops System subdirectory in the previous example. 

The files you see (System, Finder, Note Pad File, and so on), 
are organized in the System Folder (subdirectory), just as 
System and Printer were found in the Ops System 
subdirectory. 

Hard Disk 
Size Kind Last Modified 

llJll @MM1i$d 1720K folder Tue, Mar 26. 19XX J 
0 Applications ~D~iiiiiii~sMy~s!t~e~m~F~o~l~d~e~rjiiiiiii~ 
0 SelfPaced 

0 Game file 

0 Co Info 

0 Applelink 

0 MultiPln 

12 items 1 720K in folder 5341K available 

System Finder Note Pad File Scrapbook File Calndr File 

.~ [9J 
Laser'w'riter lmage'w'riter Laser Prep Clipboard File tn: Specia 1 Ace IV 

The directories, subdirectories, and files (folders and 
documents) are displayed as icons that can themselves be 
placed within icons of folders. You can create multiple levels 
of folders, similar to a hierarchical structure with directories 
and subdirectories, by putting folders within folders. 
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Create a Series of 
Folders 

Folders and File Structure 7 

Use folders to organize your files, documents 
and applications. 

1. Choose New Folder, and name it "The Directory." 

2. Open The Directory and put all of the documents and 
folders on your Mac Write disk in it (don't include the 
applications). 

3. Choose New Folder and name the empty folder 
"Applications." 

4. Place all of your applications, such as MacWrite, in that 
folder, and place it inside The Directory. 

5. Create another folder named "Mac Write Docs," and place 
all of your Mac Write documents in it Place that folder in 
The Directory. 

6. Stop here, or continue to add new folders until you've 
arranged all of your icons (files, documents, and 
applications) in folders. 
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Feedback 

Folder Review Organize your files, documents, and 
applications by using folders. 

At the beginning of the exercise, your desktop may have 
shown icons of many files, documents, applications, and 
folders, similar to the screen shot below. 

Write Disk 
12 items 352K in disk 48K av ail ab le 

CJ ~ ~ 
System Files Mac Write Staff Meeting Map 

~ ~ ~ ~ 
MacPaint Equipment Step 3 

~ ~ I 
Font/DA Mover Memo Pie Screen 1 

No matter how many icons you started with, your final screen 
should look similar to the screen shot below. 

4 items 352K in disk 48K avail 

CJ CJ 
Sy stem Files Applications 

CJ CJ 
MacWrite Docs MacPaint Docs 
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Open each folder. Your organization should look like this. 

Write Disk 
2 items 352K in disk 48K available 

3 items 

MacWritE 
3 items 9K in fold• 

I . 
Meeti~Memo E_g_u 

The Directory 
191 Kin folder 48K available 

D 
3 items 

"' i:,I'_ 
~ 

Mac Write 

~I 

Rpplications 
Docs 

145K in folder 48K available 

lri 
der 48K available 

~ w lQ MacPaint Font/DA Mover to Step 3 
IQ Q] 

1 

The folders on the Write Disk form a hierarchy. 

The folders shown above, when illustrated as a hierarchy, have 
the structure shown below. 

Directory 

Subdirectories 
and Files 

Files 

Write Disk 

Discuss the use of folders with a colleague, your course 
manager, or your Apple support representative. Since 
everyone has a different method, ask these people how they 
use folders. Do they organize documents by date, by subject, 
or by project? Choose a method that works for you. 
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Folders and File Structure (cont'd) 

Managing Files on a Disk 

System Folders and 
Startup Disks 

Disk Swapping on a 
Two-Drive System 

Review your icons and their organization 
regularly. 

As you can see, the effective use of folders to organize your 
files, documents, and applications is very important. It is even 
more critical if you're using a hard disk for storage. You 
should monitor all of your icons regularly. Since documents 
on your disks can become outdated very quickly, it's helpful to 
review them once a month and remove any that are unneeded. 
The fewer icons the Finder has to manage, the faster it will 
perform its functions. 

The Finder can, however, keep track of a large number of 
icons. Version 1.lg, for example, can keep track of over 100 
files, documents, and applications. Newer versions of the 
Finder can manage increasingly larger numbers of icons 
quickly and efficiently. For example, Version 4.1 manages up 
to 500 icons. 

Keep track of your startup disks. 

Most startup disks have a System Folder that contains a System 
file and a Finder. Nonstartup disks, or data disks, don't 
contain the System file or Finder. They therefore have more 
room for applications and documents. For more information 
on startup vs. nonstartup disks, see the Installing the 
MiniFinder section of the Supporting the Macintosh Finder 
module. 

Disk swapping might be necessary even with a 
multidrive system. 

A frequent complaint is as follows: "I tried to copy a document 
onto this disk, and the system keeps prompting me to swap 
disks. I thought that since I have a second disk drive I 
wouldn't have to swap disks again." 

If you copy your internal startup disk to your external disk by 
moving the icon (disk copy on the 512K), you usually won't 
have to swap disks. 
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A Startup Disk in Each 
Drive 

Folders and File Structure 11 

Completely replace contents of "EHternal 
Disk B" (eHternal driue) with contents of 
"Internal Disk R" (internal driue)? 

( OK ) ( Cancel ) 

However, if you're copying a disk other than your startup disk 
to your external disk, the Finder will ask you to swap disks. 

Completely replace contents of "Another 
Disk C" (not in any driue) with contents of 
"Internal Disk R" (internal driue)? 

( OK ) ( Cancel ) 

The startup disk uses its Finder to keep track 
of your disks during the copy sequence. 

When you start up a disk, its Finder keeps track of your files. 
If you start up your two-drive Macintosh with a startup disk in 
each drive (insert them both before you tum it on), the 
Macintosh will use the Finder and System files in the internal 
drive to keep track of the files on both disks. 

Macintosh will default to the System file and 
Finder on the application disk. 

As soon as you start up from an application that's on the 
external disk drive, Macintosh will use the Finder and System 
file on that disk instead of those on the original startup disk. 
Until you change it, the startup disk is now the one located in 
the external drive. · 
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The Macintosh Xl's icons reflect any changes. 

One of the easiest ways to see this change in startup disks 
occur is by using a Macintosh XL. When the Macintosh is 
started up and the desktop appears, the icon in the upper right 
comer of the screen is usually the hard-disk icon. 

Insert a startup disk that has an application on it-for example, 
a Mac Write or MacPaint startup disk. Open the icon for that 
disk and double-click on an application icon in the disk 
window. 

Once the application's "Untitled" document appears on the 
screen, quit the application. As you return to the desktop, the 
internal-disk icon will appear in the upper right comer. 

The hard-disk icon will appear below the internal-disk icon for 
the smaller disk. Sometimes (depending on the version of the 
System file you're using) the hard disk may have the 3.5-inch 
icon image. 
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Other File Management 
Hints 
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Documents use the startup disk applications. 

If you open a document from the second disk, and that 
document's application is on the first disk, the first disk will 
remain the current startup disk (even if the application is also 
on the second disk)-see example, below. 

Special 

§0~ EHternal Disk B § 
3 ;tems 248K in disk 

CJ 
System Folder Mac'w'rite 

·~ ll®ilid'l·A 

Make the second disk in a two-drive system 
the startup disk. 

Another way to change the startup disk in a two-drive system 
with two startup disks is to: 

1. Open the System Folder on the disk that isn't the current 
startup disk. 

2. Double-click on the Finder icon while holding down the 
Command and Option keys. 

This is handy if you want to keep one disk as your startup 
disk, and change either disk quickly, without restarting 
Macintosh. 

Maximum number of windows open on the 
desktop. 

Generally, you can have up to seven windows open on your 
desktop at one time. This allows for easy visual file 
management, and offers flexibility in moving files from one 
folder or disk to another. 
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But be careful: Trying to open more than seven windows at 
once will bring up a dialog box that will warn you not to open 
any more. You won't lose any files, however. Just click OK 
and close a few windows before you continue. 

Restart a Macintosh XL without turning it off. 

Beginning with Mac Works'™ Version 3.0, you can restart your 
Macintosh XL, or change your startup disk from the hard disk 
to the internal disk, without turning the system off. 

• To restart the Macintosh XL, hold down the Command key 
while you press the white On/Off switch. You will restart 
the Macintosh XL from the hard disk, and return to the 
desktop. 

• To restart the Macintosh XL from the internal disk drive, 
hold down the Option and Command keys while you press 
the white On/Off switch. You'll restart from the disk in the 
internal drive. If you have neglected to insert a startup disk 
in the internal dirve, a"?" icon will appear until you do 
insert one. 

Additional techniques are available. 

Other helpful techniques are available from resources such as 
Macworld and other Macintosh publications. Also, see the 
Apple Support Training Library modules that cover each 
application. 
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Overview 

( 

Lock an Icon 15 

Lock an icon to help you keep track of what's 
in it, and to protect information. 

People often assume that when a document, application, folder, 
or disk is locked, it's completely protected. This isn't always 
true. This section discusses locking, and describes the handy 
information box that helps you keep track of what's in a locked 
icon. 

Lock an icon to keep it from being renamed or 
thrown away. 

To lock an icon, choose Get Info from the File menu. 

New Folder XN 
Open 
Print 
Close 

Page Setup 
Print Catalog 

Eject XE 

When you do, a window such as the one on the next page will 
appear. Read the note at the bottom of the window. 
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!D 

Kind: 
Size: 
Where: 
Created: 
Modified: 

181 Locked 

lnformBtion Bbout MBcWrite 

Mac Write 

application 
69314 bytes, Bccounts for 73K on disk 
Hard Disk, AppleBus 
Wednesday, February 27, 1935 at 4:53 PM 
Wednesday, February 27, 1935 at 4:53 PM 

What can be done to a locked Icon, anyway? 
Anything ... 

EHcept chsnge its name or throw it away. 

You can cut, copy, and paste to and from a locked icon, just as 
you would with any other file. Some operating systems have 
"write protect" or "read only" functions available that won't 
allow a specific file or document to be edited. A locked 
document, System file, application, or folder isn't a "write 
protect" or "read only" icon-it can be changed. 

But you can't change the name of a locked icon, and you can't 
throw it away. You can remove an icon from a locked folder, 
but you can't put it back without unlocking the folder. 

If you want to lock a document so that parts of it can't be 
removed or destroyed, you must lock (or "write protect") the 
disk that the document is on. 
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Use the Get Info window for notes about icons. 

When you lock an icon, be sure to use the box that's provided 
for notes. You can use it to record brief notes about the 
contents of the icon, or to explain why you've locked it. That 
way you never have to leave the Finder to know what you've 
put in a document. For example, see the notes on the 
Switcher™ document below. 

Kind: 
Size: 
Where: 
Created: 
Modified: 

D Locked 

Finder 
MacWrite 
MacPaint 

Information about WP&F 

tuP&r I~ 
Switcher document 
1 56 bytes, accounts for 4K on disk 
Hard Disk, Internal Hard Disk 
Friday, September 6, 1985 at 9:1 O AM 
Friday, September 6, 1985 ot 9:1 o AM 

128K Saue Screen - Off 
512K Saue Screen - Off 
128K Saue Screen - On 

If you use the Switcher regularly and have several Switcher 
documents, the names of the documents can't tell you very 
much. But, you can use the box to record notes that tell you 
about the applications you've installed, the options you've 
selected, and the amount of space allocated for each. 
Otherwise, you must open the document and watch Switcher 
install it to find out what it contains. 

For more information about how to use Get Info, see 
Chapters 1 and 4 in Macintosh, the owner's manual, or see the 
Apple Support Training Library module, Learning to Use 
Macintosh. 

MANAGING MACINTOSH FILES 



18 The Document Directory Dialog Box 

• The Document Directory Dialog Box 

Overview The Document Directory dialog box resides 
inside each application. 

A convenient way of managing documents within an 
application is by using the Document Directory dialog box. 

Close 
Saue 
Saue As ••• 
Page Setup ••• 
Print ••• 
Quit 

The Document Directory dialog box appears 
on the screen when you choose Open. 

When a document is closed and you choose Open, a dialog 
box similar to the one shown below will appear. The 
documents shown on the left side of this dialog box are 
Mac Write documents that are available on the disk titled 
"Write." 

Apple 32 Oper ... 
Equipment 
Meeting lnuite 

Document Directory 

Write 

Eject 

Cancel Driue 
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Sometimes the Document Directory dialog box 
is referred to as the Standard File. 

Occasionally you'll hear the term "Standard File." This is a 
technical reference to the Document Directory dialog box. 

The Document Directory and Save As dialog 
boxes are available in most applications. 

Within most applications, there's a Save As dialog box that 
appears the first time you save an "Untitled" document, or 
when Save As is chosen from the File menu. 

There are two ways to save an entire document or text from the 
Save As dialog box. The first way is to type in the name of the 
file and click.Save. The document will be saved to the disk 
displayed in the upper right corner of the dialog box. If you 
want to display the documents that are on the other drive, click 
Drive, and you'll see the name of the other disk appear, along 
with the display of its documents. 

The colon in the document name box can be 
used to save files. 

Another way to save a document to a specific disk is to type the 
name of the disk you want to save the document to, followed 
by a colon(:) and the name that you want to use for that 
document, as shown in the example below. 

Saue Current Document Rs 

I Write Data Disk:Document I 
Soue Concel 

@Entire Document 

Write 

( Eject 

( Driue 

0 TeHt Only 

Macintosh, the owner's manual, states that you can use any 
character on the keyboard except the colon when naming a 
document. This is because the colon is used by the Macintosh 
to separate the name of the disk from the name of the individual 
documents on that disk. If you use this command, be sure the 
icon name appears exactly as it's spelled. 
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Save Time When Saving 
Documents 

Other buttons extend your Save As options. 

In the example above, you can see the Entire Document and 
Text Only commands. These commands change with 
different applications. Also, some Save As dialog boxes have 
a different look. See the manual for each application for the 
specific meaning of each of the options available. 

Save files by choosing either Close or Quit. 

An easy way to save time is to choose Close or Quit from the 
File menu before choosing Save from the File menu. This 
reduces the number of keystrokes it takes to Save and Close a 
document. 

When you choose Close or Quit after making changes to a 
document, and before you choose Save, you'll get the 
following dialog box: 

Saue changes before quitting? 

Yes 

[ No ) [ Cancel ) 

Click Yes to save your changes. Click No to close or quit 
without saving the changes (the document will revert to the 
previously saved version). Click Cancel to ignore the Quit or 
Close command you just issued, and to return to the current 
document. 

Although this method isn't recommended, it can be used 
occasionally. It's also a "safety net" in case you forget to save 
your work. 
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Save As 

The Document Directory Dialog Box 21 

Use the Document Directory and Save As 
dialog boxes as file-management tools. 

In this exercise, you'll use the functions of the Document 
Directory and Save As dialog boxes to: 

• Open, name, and eject disks. 
• Copy and paste within an application using multiple disks. 
• Save documents to disks using a colon(:) in the 

document-name field. 

Open a disk, name it, and eject it. 

1. Start up your Macintosh from a Mac Write startup disk. 

2. Insert a blank, initialized disk into your external disk drive. 

3. Name the disk in the external drive "Write Data Disk." 

4. Eject the disk in the external drive (remove its shadow, 
too). 

Copy data from a document on one disk, and 
paste it into a document on another disk. 

1. Insert a disk that has a Mac Write document on it into the 
external drive. 

2. Open the disk icon and the icon of the Mac Write document. 

3. Select a few lines of text, and copy them to your 
Clipboard. 

4. Click on the close box, to close the document. 

5. Choose Open from the File menu. Be sure the disk name 
displayed in the Document Directory dialog box 
corresponds to the disk that's in the external disk drive. If 
not, click Drive to change the disk. 

6. Eject the disk in the external drive by choosing Eject from 
the Document Directory dialog box. Then insert the Write 
Data Disk. 

7. Choose Cancel and open a new Mac Write document by 
choosing New from the File menu. 
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Practice (cont'd) 

8. Paste the contents of the Clipboard into the new "Untitled" 
document, and choose Save from the File menu. 

9. When the dialog box appears, type Document 1 as the 
name of the document, and press Enter to continue. 

10. When "Document l 11 appears in the title bar on the screen, 
choose Save As from the File menu. 

11. After the dialog box appears, click on Drive. The name of 
the disk in the internal drive will appear as your cuITent 
disk. 

12. Type Write Data Disk:Document 2. 

(Note: Part of the name will disappear from the screen, 
but once the new copy of the document is loaded, the name 
of the disk and the new document name will appear in the 
title bar.) 

13. Save Write Data Disk:Document 2 by pressing Enter to 
continue. 

14. Close the document you just saved, and choose Open 
from the File menu. When the Document Directory dialog 
box appears, you'll notice that the current disk is your 
Mac Write applications disk. 

Verity that all the documents have been saved 
to the proper disks before you Quit. 

1. Click Drive. The current disk will change to the Write 
Data Disk where you saved the Document 1 and 
Document 2 files. 

2. Double-click the Document 1 title to open it. Don't click 
Open. 

3. Close Document 1 and return to the Document Directory 
dialog box by choosing Open from the File menu. 

4. Choose Eject from the dialog box to eject the Write Data 
Disk. 

5. Choose Cancel from the dialog box and Quit from the 
File menu to return to the desktop. 
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Using the Document Directory dialog box to 
manage files. 

When you choose Open from the File menu, this dialog box 
appears on your screen: 

Apple 32 Op er •.• b2 i t-=-
( ) Equipment Open l Write 

I 
Meeting lnuite 

( Eject 
! 

( Cancel ) I ( Driue 
[QJ 

You can double-click to open a document. 

To open files from this dialog box, you can highlight the 
document name and choose Open from the menu ... 

Apple 32 Op er ... :'B 
Equipment 
Meeting lnuite 
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Feedback (cont'd) 

... or you can double-click on the document name. 

BQue ( Open ) 
Equipment 
Meeting lnuite ( 

( Cancel ( 

You can eject disks using the Document 
Directory dialog box. 

Write 

Eject ) 

Driue ) 

Use the Document Directory dialog box menu as you'd use the 
File menu. Eject is an example of a Finder command that 
works well within an application to help manage files on 
various disks. While in an application, you can look at the files / \ 
on different disks and load the documents from each disk 
without continually returning to the Finder. 

Apple 32 Op er ... :B 
Equipment ( Open ) Write 
Meeting lnuite 

( Eject ~ 
[ Cancel ) ( Driue ) 
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Select the disk drive. 

Selecting the drive and juggling disks from the Document 
Directory dialog box can be a shortcut to saving documents, 
copying files, and ejecting disks while remaining in an 
application. For some Copy and Save routines that involve 
more than one disk, some disk swapping may be involved. 

m'J/fu''l•J.1§411101 Equipment Open Write 
Meeting I nuite 

( Eject ) 

Cancel ) ( Driue ~ IO 
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II Review 

Folders and File Structure 

Lock an Icon 

The Document Directory 
Dialog Box 

Use folders to create your own hierarchical 
filing system. 

You can structure your Macintosh files, documents, and 
applications for easy access by using folders like you'd use 
folders in your desk to store documents. 

Locking an Icon keeps you from renaming It or 
throwing it away unintentionally. 

Use Get Info to lock an icon. When you do, be sure to 
record informational notes about that icon. That way, you 
won't have to open the document to find out what's in it. 

The Document Directory dialog box Is used to 
manage documents. 

Use the Document Directory dialog box within an application to 
avoid going to the Finder when you want either to save, copy, 
or name documents, or to eject disks. 

Use the Save As command to rename documents, or to name 
them and save them to the current startup disk or to another 
disk. 
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Resources 27 

• Apple Support Training Library modules: Learning to Use 
Macintosh, Supporting the Font/DA Mover, Supporting the 
Macintosh Finder. 

• AppleLink™ Technical Info Library (available to Apple 
support personnel) 

• Macintosh, the owner's manual 

• Macintosh 68000 Deveiopment System User's Manuai and 
Inside Macintosh (included with the Macintosh 68000 
Development System), Apple Computer, Inc. 

• Macworld, PC World Communications, Inc., San 
Francisco, CA 94107 

Apple, the Apple logo, and ProDOS are registered trademarks of Apple Computer, Inc. AppleLink, ImageWriter, 
MacPaint, MacWorks, MacWrite, and Switcher are trademarks of Apple Computer, Inc. Macintosh is a trademark of 
Mcintosh Laboratory, Inc. and is being used with the express permission of its owner. CP!M is a registered trademark of 
Digital Research, Inc. MS-DOS is a trademark of Microsoft Corporation. 
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2 Overview 

•Overview 

II Objectives 

Some of the support questions you'll frequently be asked 
require a knowledge of the Macintosh™ computer operating 
system, and its utilities. This module discusses the 
fundamentals of the operating system and the user interface 
contained in Macintosh ROM. It provides some solutions and 
suggestions on how to use the Macintosh system utilities to 
recover lost documents and to avoid many disk full messages. 

Who should complete this module? Anyone who hasn't taken 
the Macintosh technical training course and who supports 
people who use Macintosh. 

Prerequisites 

• The material presented in this module assumes that you have 
read Macintosh (the owner's manual), and have a working 
knowledge of Macintosh. 

• Identify the elements of the Macintosh operating system and 
user interface. Explain how they work together to form the 
Macintosh operating environment 

• Describe how the elements of ROM work with the disk 
operating system to drive printers and other peripheral 
devices. 

• Describe what a "Happy Macintosh" indicates. 

• Describe what a "Sad Macintosh" indicates, and recommend 
a response. 

• Identify the "Question" and "X" icons, state what they 
indicate, and state how to respond. 

• Demonstrate how to handle a "Disk full" message or a 
message that indicates there's not enough room on the 
disk to print a document. 

• Detail various ways to repair a crashed disk. 
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( 11 Materials 

Materials 

To complete this module, you will need: 

• A Macintosh 128K or a Macintosh 512K with an external 
disk drive, or a Macintosh XL 

• A system disk that includes Finder Version 4.1 

If available, the following Is recommended: 

• A crashed disk and/or a disk with a "lost" file 

FUNDAMENTALS OF THE MACINTOSH OPERATING SYSTEM 
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· m An Overview of Macintosh ROM 

Overview 

One Basic Similarity 

Macintosh ROM contains the elements of the 
operating system and the user Interface. 

Programmed into the Macintosh ROM (read-only memory) is 
the heart of what makes Macintosh work, the operating system 
and the user interface. 

The user Interface forms a buffer between the 
operating system and the Macintosh user. 

Macintosh is dynamic and different because a buffer called the 
user interface has been placed over the operating system. 

Macintosh ROM 

User Interface 

Operating System 

The user interface has been placed over the operating system to 
act as a "shell." This frees users from having to deal with the 
operating system directly allowing them to concentrate on 
productivity instead of on coping with the many different file 
commands (slashes, spaces, and colons) that are common to 
most other operating systems. 

The operating system is a traffic cop. 

Even though it includes the user interface, the Macintosh 
operating system is basically the same as other microcomputer 
operating systems. It's the traffic cop of the computer. It tells 
information that's being fed into it where to go, and tells the 
other parts of the computer what to do with it. The user 
interface masks almost all of these operations from the user. 
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( The Big Question 

First Consideration 

Second Consideration 

An Overview of Macintosh ROM 5 

How do you access the Macintosh operating 
system? 

This question can be posed in several ways, such as, "I want to 
get into the operating system to write a simple program. How 
can I do this?" Other frequent questions are those regarding 
recovering lost data, or accessing system utilities. Many 
people are simply curious, or use operating systems that don't 
have a user interlace similar to that of the Macintosh. A few 
others are interested in developing major applications for 
Macintosh. 

Macintosh Pascal, and several other programming languages 
are available to write programs to run on Macintosh. To write 
major applications in the Macintosh development environment, 
there are two considerations about Macintosh and the 
Macintosh operating environment that must be understood. 

Macintosh is designed to be easy to learn and 
to use. 

Macintosh was designed for people who want to set up their 
computers and begin working with a minimum of instruction. 

The operating system is protected by the user 
interface. 

To accomplish this desired ease of learning and use, the 
designers of Macintosh placed the shell called the user interface 
over the operating system. Nearly everything that happens 
between the Macintosh user and Macintosh goes through this 
shell. 

The television is an example of a simplified 
user interface. 

If it's working properly, a television will carry information into 
your home with very little effort on your part. You can use it 
with very little information about how it works, switching from 
program to program, without any effort. But dispite this ease 
of use, the television, like Macintosh, is a very sophisticated 
machine. 

There are few advanced television users (no matter how many 
hours they watch it). There aren't many advanced Macintosh 
users either, and that's just the point. 
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Consistent Commands 

Developing Macintosh 
Applications 

Alan Kay, Apple Fellow, once summed up the net effect of the 
user interface to a group from Apple Technical Support with 
the following words: 

" ... The Macintosh user interface is a very simple design. It 
was designed so that the average user could be familiar with 
how to use it within 20 minutes. To become an intermediate 
user doesn't take much longer .... This has some trade-offs in 
that there's no room for the advanced user .... " 

However, an applications developer may be considered one 
example of an advanced Macintosh user. One way to become 
an advanced Macintosh user is to learn to use the applications 
development tools. 

Even if you don't plan to become a developer, there's a lot to 
be learned about Macintosh to help you support it. But the 
simplified user interface also simplifies the amount of 
information you need to know, and makes your job as a 
technical support person much easier. 

Some commands are the same in almost all 
Macintosh software. 

Because of the user interface, many of the commands and basic 
techniques, such as Cut and Paste, are the same in every 
application. The same commands in different programs are 
invoked the same way: using a double-click of the mouse 
button to issue a command, pressing and dragging to move 
icons, or placing the insertion point to insert text. This 
consistency, along with the graphics and the mouse, makes the 
Macintosh easy to use, and simplifies the development process. 

One way to learn to access the Macintosh 
operating system is to become a developer. 

An applications developer needs to become thoroughly 
knowledgeable about the Macintosh user interface. To do that, 
the developer must attend the "Macintosh Technical Training," 
(also known as "Macintosh High School") presented by Apple 
Support Programs, and/or attend "Macintosh College," 
presented by Apple Software Development. 

Macintosh 68000 Development System and 
Inside Macintosh are the tools. 

The Macintosh 68000 Development System is a complete 
programmer's tool for developing Macintosh applications. 
This development system, when used with the Apple 
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Macintosh ROM User 
Interface 

Elements of ROM 

An Overview of Macintosh ROM 7 

publication Inside Macintosh, is all that the experienced 
applications programmer needs to begin creating programs for 
Macintosh. 

The user interface is the higher of the two 
levels of ROM. 

The user interface, (or User Interface Toolbox), is provided to 
facilitate the use of Macintosh applications. It is the most 
visible and accessible part of Macintosh ROM. 

This high-level user interface provides windows, menus, and 
the desktop, as well as text and utility functions. It also 
provides an element called "QuickDraw" that underlies all of 
the graphics. 

Programmers should notice that the user interface is called 
"high level." This is because the interface is positioned a level 
above the operating system and is in constant use by the user 
(or user application). The user interface seldom works directly 
with the hardware. So don't confuse this use of the term "high 
level" with traditional high-level machine language. 

The operating system is the lower level. 

The lower level of Macintosh ROM works directly with the 
Macintosh hardware. This part of the system supplies the 
elements of what is generally thought of as an operating 
system. Drivers, direct system managers, and 
memory-management and event-management routines are 
handled at this level. 

To summarize from Inside Macintosh ... 

"The User Interface Toolbox is a level above the operating 
system; it helps .. .implement the standard Macintosh user 
interface.... The Toolbox calls the operating system to do 
low-level operations.... The operatin~ system is at the lowest 
level; it does basic tasks such as input and output, memory 
management, and interrupt handling." 

The ROM is composed of a number of elements 
with specific functions. 

The chart on the next page, and the definitions that follow, 
briefly illustrate the function or operation performed by each of 
the elements of Macintosh ROM. For complete definitions of 
these elements, read the sections that discuss each element in 
Inside Macintosh. 
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Macintosh ROM Overview 

Dialog Manager 

Control Manager Menu Manager 

Window Manager 

Toolbox Utilities 

Toolbox Event Manager 

Text Edit 

Disk Manager Scrap Manager 

Package Manager 
QuickDraw 

Resource Manager 

Memory Manager 

Segment Loader 

Font Manager 

Operating System Event Manager 

File Manager 

Device Manager 

Disk Driver 

Sound Driver Serial Driver 

Vertical Retrace Manager 

System Error Handler 

Operating System Utilities 
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The User Interface Toolbox contains the 
following elements: 

Resource Manager. The part of the Toolbox that reads and 
writes resources, such as data used by an application, or the 
application code itself. 

QuickDraw. Performs all graphics operations on Macintosh. 
QuickDraw is often called the "heart of the Macintosh User 
Interface Toolbox routines." 

Font Manager. Supports the use of various character fonts 
for QuickDraw when it draws text. 

Toolbox Event Manager. Allows an application to monitor 
the user's actions with the mouse, keyboard, and keypad. 

Window Manager. Provides routines for creating and 
manipulating windows and menus. 

Control Manager. Provides routines for creating and 
manipulating controls, such as buttons, check boxes, and 
scroll bars (see Operating System Utilities). 

Menu Manager. Deals with setting up menus and letting the 
user choose from them. 

TextEdit. Supports basic text entry and editing capabilities. 

Dialog Manager. Provides routines for implementing dialog 
and alert boxes. 

Desk Manager. Supports the use of desk accessories from 
an application. 

Scrap Manager. Enables cutting and pasting between 
applications and desk accessories, or between windows. 

Toolbox Utilities. Performs generally useful operations 
such as fixed-point arithmetic, string manipulation, and logical 
operations on bits. 

Package Manager. Lets you access Macintosh RAM-based 
packages. 
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Macintosh ROM Overview 
Macintosh User Application 

. ·. . :. ·.~. 
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User Interface Toolbox 

Dialog Manager 

Control Manager Menu Manager 

Window. Manager· 

Toolbox Utilities 

Toolbox Event Manager 

Text Edit 

Disk Manager Scrap Manager 

Package Manager 
QulckDraw 

Resource Manager 

Memory Manager 

Segment Loader. 

Font Manager 

Operating System Event Manager 

Fiie Manager 

Device Manager 

Disk Driver 

Sound Driver Serial Driver 

Vertical Retrace Manager 

System Error Handler 

Operating System Utilities 
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The operating system is the lowest level of 
ROM, and interfaces with the hardware. 

It contains the following elements: 

Memory Manager. The part of the operating system that 
dynamically allocates and releases memory space in the heap. 
The heap is an area of memory in which space can be allocated 
and released on demand. 

Segment Loader. Loads the code of an application into 
memory, either as a single unit or divided into dynamically 
ioaded segments. 

Operating System Event Manager. Reports 
hardware-related events such as mouse-button presses and 
keystrokes. 

File Manager. Supports file input and output (I/O). 

Device Manager. Supports device 1/0. 

Disk Driver. The device driver that controls storage and 
retrieval on 3 1/2-inch disks. 

Sound Driver. The device driver that controls sound 
generation in an application. 

Serial Driver. The device driver that controls 
communication, via serial ports, between applications and 
serial peripheral devices. 

Vertical Retrace Interrupt. An interrupt generated 60 
times per second by the Macintosh video circuitry while the 
display tube beam returns from the bottom of the screen to the 
top. The Vertical Retrace Manager schedules and 
executes it. 

System Error Handler. Assumes control when a fatal error 
(such as running out of memory) occurs. 

Operating System Utilities. Operating-system routines 
that perform miscellaneous tasks such as getting the date and 
time, finding out the user's preferred speaker volume and other 
preferences, and doing simple string comparison. 
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. A Key Graphic Element 

Managing Macintosh 

QulckDraw Is key to Macintosh graphics. 

Macintosh depends on graphics. For example, the screen, 
printers, and software are all graphics oriented. MacPaint™ 
and MacDraw™ are examples of graphics applications that 
have been written specifically for Macintosh. They take 
advantage of most of the Macintosh graphics capabilities. Even 
Mac Write™, a word-processing software package, depends on 
graphics. 

Briefly stated, QuickDraw does it all! 

Whenever an object is placed on the Macintosh screen, 
QuickDraw draws a rectangle. If a circle is being drawn, 
QuickDraw first draws a rectangle, and then fills it with a 
circle. When a letter is typed on the screen, QuickDraw draws 
a rectangle, and the Font Manager supplies the size, font style, 
and letter to be placed on the screen. QuickDraw gets the letter 
from the Font Manager and puts it in the rectangle. 

Managers work together as a group to manage 
Macintosh. 

A "Manager,. in the Macintosh user interface and operating 
system is a group of subroutines, a library, a convenient way 
to group routines that are used to manage the same type of data 
objects (text or graphics). 

Managers such as Quickdraw, the Control Manager, the 
Toolbox Event Manager, and Resource Manager, don't 
perform any functions by themselves. They perform as a 
group to coordinate and complete related tasks, like putting 
letters on the screen, or responding to the click of the mouse. 

The good news is that half of the programmer's 
work has been done. 

There are about 500 calls to the Macintosh user interface and 
operating system, as compared to 50 calls to ROM in 
ProDOS®, and 100 calls to MS-DOS. In other words, half of 
the programming has been done for the programmer. It's there 
in Macintosh ROM. That's the good news. The other news is 
that the programmer has to understand that half. 
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( II Macintosh Drivers and the Elements of ROM 

( 

Overview 

ROM Needs Software to 
Run 1/0 Devices 

The elements of the operating system work to 
control various peripheral devices. 

Macintosh ROM contains a number of drivers. The Device 
Manager, Disk Driver, and the Serial Driver control the 
peripheral devices that are necessary to all Macintosh users. 
Disk drives, video output, sound from the Macintosh speaker, 
and output to all printers and modems are each controlled by 
their respective elements in ROM. Input via the mouse, 
keyboard, and serial ports (from a modem or digitizer), is also 
controlled from the programs resident in Macintosh ROM. 

But the elements in ROM depend on information from the 
software to coordinate such tasks as receiving input from the 
mouse or printing on an lmageWriter1M printer. 

The correct software must be used to drive the 
input and output devices used by Macintosh. 

The elements of Macintosh ROM need instructions to help them 
drive the input/output (110) devices that are used by Macintosh. 
These instructions come from the corresponding drivers in the 
information contained on the Macintosh startup, system, and 
application disks. 

Open the System Folder on any Macintosh System Disk, or on 
most startup disks. The folder will contain at least a System 
file, and a Finder, and may also contain a printer driver file (for 
example, the Image Writer) as shown in the following System 
folder window~ 

~D System Folder 
3 ;tems 210K m folder 112K available 

rn 
~ 

System 

rn 
~ 
f;nder 

~ s 
Image 'v(r;ter 
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Chances are you'll have the icon of the ImageWrit.er in your 
System Folder. This icon represents the file that contairis the 
printing instructions to drive this print.er. This file works with 
the Device Manager and the Serial Driver to send your files to 
the Image Writer. 

Macintosh needs the operating system and the 
software drivers to print files. 

To print a file, the Macintosh operating system and the System 
file on the Macintosh disk must talk to each other. When you 
start up Macintosh,· the elements of the operating system and 
user interface get instructions from the disk (for example, from 
the Image Writ.er Driver) and load those instructions into RAM. 

Macintosh checks the printing resources on the disk and uses 
the resources you have chosen along with the resources in 
ROM. The document is printed, based on those instructions. 

Macintosh 
Operating 

System in ROM 

Device Manager 
and 

Serial Driver 
• • CJ 

D 
Startup Disk 

Image Writer 
Driver 

Some of these instructions come from the System file and the 
application, but without the specific information provided by 
the Image Writer Driver, the selected document won't print. 
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( 

Macintosh Serial Ports 

------ ---------------- -----------
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You may have a few printer drivers on your 
disk. 

In addition to the Image Writer Driver file, you may have 
software that allows you to use a variety of printers, for 
example the Apple® LaserWriter™. If so, you may have a 
group of files that look similar to the ones shown in the 
following picture. 

Printers 
131 K in folder 4403K available 

D D D 
~ 

Diablo630 AppleDaisy NEC7710 

D D D 
Typewriter Brother Another? K5 

T~ ~ 

If the appropriate printer driver file for the printer you have 
choosen isn't on your disk, then you can't print your 
documents on that printer. 

The Modem and Printer ports support the 
serial interface for Macintosh. 

Macintosh has two RS-232/RS-422 serial ports. These are a 
Modem port and a Printer port. Macintosh assumes that you 
will use each port as it is labeled. Unless you have software 
that allows you to use the ports differently, always be sure that 
devices are plugged into the proper ports. 
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AppleTalk Driver 

Some Apple and third-party products have 
expanded connection capabilities. 

Apple products such as the LaserWriter can use either port once 
the software is installed. The LaserWriter uses the 
AppleTalk™ Network Driver to make this possible. 
Third-party hardware and software manufactures use the two 
serial ports and the mouse port for many different input and 
output devices. For example, bar-code readers, digitizers, and 
optical scanners take advantage of the advanced graphics 
capabilities of Macintosh. 

The AppleTalk Driver and software allow you 
to use both serial ports for printing. 

If you have several serial devices available to you (such as an 
Image Writer, AppleTalk, and a modem), you may need to use 
your serial ports differently from the way they originally were 
labeled. For example, you can use MacTenninal to connect a 
modem to either port. Also, if you choose Choose Printer 
from the Apple menu, you can connect your Image Writer to 
either port. 

When you select Choose Printer, a dialog box will appear: 

Port: 

@Connected 
RppleTolk O Disconnected 

( OK ) ( Cancel ) 
111.:i 

From Choose Printer you can opt to use either the Modem 
port or the Printer port for printing. In this illustration, the 
LaserWriter is using the Printer port, AppleTalk is connected, 
and the Image Writer is available. 
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If you have other printer drivers available, the names of those 
printers appear in the dialog box. Without this special 
software, the standard lmageWriterprinter file uses the Printer 
port for printing. 

Macintosh has several programs, such as the 
Desk Accessories, that are considered drivers. 

Each Apple Desk Accessory in the Macintosh system file is 
labeled as a driver. This includes the alarm clock, keyboard, 
control panel, and other devices. Some of them help run the 
Macintosh hardware, and are controlled by the user from the 
Control Panel, Font/DA Mover, or from Choose Printer. 

The fact that these accessories are referred to as drivers, 
doesn't mean they're drivers. Some are called drivers for 
programming convience. For example, the alarm clock and 
calculator aren't drivers, but have a DRVR (driver) application 
type. Applications developers and some users need to be 
aware of this designation. 

Many new products become available for the 
Macintosh every day. 

Macworld and the Macintosh Buyer's Guide, as well as many 
other publications on the market announce new products in 
each issue. Consult these to discover the growing number of 
ways to use your Macintosh more effectively and productively. 
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( II Macintosh Startup Icons 

Overview 

The "Happy Macintosh" 

(-

The Macintosh startup icons provide important 
support information. 

Often the opening Macintosh screen provides an important clue 
to a Macintosh support question. This section discusses the 
startup icons, and provides answers to the support questions 
involved. 

What does a Happy Macintosh indicate? When 
does this icon appear? 

This icon appears on the Macintosh screen when Macintosh is 
turned on and a startup disk is inserted into in one of the disk 
drives. 

What message is conveyed? 

The Happy Macintosh appears on the screen to let you know 
that: 

• Macintosh is working and has completed the first part of its 
self-test. 

• The disk that has been inserted has started to load part of the 
Macintosh operating-system software. 

Is a solution needed? 

No. So far, so good. As long as the system continues to 
function, the portion of the operating system contained in the 
software will continue to be loaded into RAM. As the 
operating system is properly loaded, Macintosh will progress 
to the "Welcome to Macintosh" screen, and on to the desktop 
environment. 
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"Question Icon" What does a Question icon Indicate? When 
does this icon appear? 

This icon appears on the Macintosh screen when Macintosh is 
turned on and is waiting for a working startup disk to be 
inserted into either of the disk drives. 

What message is conveyed? 

The Question icon appears on the screen to let you know that: 

• Macintosh is working and is waiting for a startup disk. 
This could be due to either of two reasons: 

• There wasn't a disk in Macintosh when it was turned on. 

• You've just used Shut Down. 

Is a solution needed? 

Yes. 

Possible solutions are: 

• Insert a working Macintosh startup disk, or simply tum off 
Macintosh. 
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What does the X icon indicate? When does 
this icon appear? 

This icon appears on the Macintosh screen when Macintosh is 
turned on and the disk it tries to start up from is an uninitialized 
disk, or a non-Macintosh disk. Macintosh ejects the disk and 
displays this icon. This icon can also appear when a disk ejects 
from a working Macintosh as it's turned on (because the user is 
holding down the mouse button). 

What message is conveyed? 

The X icon appears on the screen to let you know that: 

• Macintosh is working. 

• The disk that was in the disk drive when Macintosh was 
turned on isn't a startup disk (so, it's ejected). 

Is a solution needed? 

Yes. 

Possible solutions are: 

• Insert a working Macintosh startup disk, ot simply tum off 
Macintosh. 
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"Sad Macintosh" What does the Sad Macintosh indicate? When 
does this icon appear? 

This icon appears on the Macintosh screen when Macintosh is 
turned on and isn't working (it can't read the disk, and won't 
~tart up). Sometimes when a startup disk is inserted, Happy 
Macintosh will appear on the screen, but before the "Welcome 
to Macintosh" screen can appear, a Sad Macintosh take its 
place, and the disk will be ejected. 

What message is conveyed? 

The Sad Macintosh appears on the screen to let you know that: 

• The startup disk began to load the operating system and then 
a problem occurred, such as an address error, a bad System 
file, or no System file, and Macintosh was unable to 
continue (Macintosh probably also ejected the disk). 

• Macintosh isn't working. It may be a hardware problem. 

Is a solution needed? 

Yes. 

Possible solutions are: 

• Turn off Macintosh, insert a working Macintosh startup 
disk, and turn on Macintosh again. 

• Turn off Macintosh and follow the instructions in the "How 
to Repair a Crashed Disk" section. 

• Call your service representative. It might be a hardware 
error. 
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( II Reference Chart for Startup Icons 

( 

ICONS 

When does 
each icon 
appear? 

Messflge 
conveyed 
by each 
icon. 

Solution 
needed? 

Possible 
solutions 
fire: 

Keep this chart as a reference. 

When a Macintosh 
is started with a 
startup disk, or 
when a disk is 
inserted in 
response to a ? 
or)( icon. 

Macintosh is 
working and a 
good startup 
disk is in the 
disk drive. 

No 

When a working 
Macintosh is 
turned on without 
a disk in the 
drive. 

Macintosh is 
working, no disk 
in drive, (X icon 
may have appear-
ed), Macintosh is 
waiting for a good 
startup disk. 

Yes 

Insert a good 
startup disk or 
turn off the 
Macintosh. 

When a disk is 
ejected from the 
disk drive while 
starting up a 
Macintosh, either 
manually or by 
the system. 

Macintosh is 
working, but the 
disk is ejected 
due to damaged 
software. 

Yes 

Insert a good 
startup disk or 
turn off the 
Macintosh. 

When Macintosh 
is turned on, or a 
Happy Macintosh 
appears, but the 
disk then ejects 
due to a software 
system error. 

Macintosh is not 
working, it may 
be a hardware 
error or you 
didn't use a good 
startup disk. 

Yes 

Insert a good 
startup disk or 
turn off the 
Macintosh. If 
Macintosh does 
not work, ca 11 
your service rep. 
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• How to Handle "Disk Full" Messages 

Overview 

Some Causes 

This section explains how to handle "Disk full" 
messages. 

"Disk full" messages occur at various ti.mes while you're using 
Macintosh. But, all these occurances have a very similar 
message: There isn't enough room on your disk or in memory 
to complete the operation just initiated. For example, if you 
want to copy a section of text, you might get a message that 
3.lerts you that the disk is out of space a:nd you can't Or, you 
might try to I)rint a file, only "to be interupted by a dialog box 
that says that there isn't enough room Qn the disk. 

What can you do about this? 

Good file-management habits can keep the number of 
occurrences to an acceptable level. However, even the most 
conscientious of file managers can't.always avoid these 

. messages. So, before looking at some of the ways to avoid 
"Disk full" messages, lets take a quick look at some of their 
causes. 

Here are a few causes of "Disk full" messages: 

• The disk contains unnecessary documents. 

• The System file has more fonts or desk accessories than 
necessary. 

• The Scrapbook contains a lot of information. 

• The disk has more than one application on it, and/or more 
than one printing source (both lmageWriter and 
LaserWriter). 

• The disk has bad or damaged sectors that cause I/O 
messages (this may cause the entire disk or some of your 
documents to be unusable). 
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Some Solutions 

Fonts and Desk 
Accessories 

Scrapbook and Note Pad 

Printing Resources 

How to Handle "Disk Full" Messages 

Archive unused but necessary files on disks in 
a safe place, and delete the others. 

25 

Setting up a library of files is one solution. No matter how 
careful you may be, it's easy to begin collecting files that are no 
longer useful. If this seems to be an issue, create an archive 
file. Use a filing cabinet, or a series of disk holders or boxes 
that can be labeled and organized. This file could include 
copies of backup applications disks, old spreadsheets or 
data-base files that are important for payroll accounting, or last 
year's Christmas card cross-reference list. 

Once you've archived your important documents, delete the 
originals and other unused files. Also, check their creation and 
modification dates. Delete the ones you know aren't going to 
be used Keeping files current is important to efficient file 
maintenance, and reducing the number of "Disk full" 
messages. 

Maintain a minimum number of fonts and desk 
accessories in your System file. 

Keep the number of fonts stored in the System file to a 
minimum. Use the Font/DA Mover to create a "For Fonts 
Only" disk (see the Support Programs Library module 
Supporting the Font/DA Mover for instructions). That way, 
you can move them into the system when you need them, and 
they can stay out of your way the rest of the time. 

Limit the amount of information In your 
Scrapbook and Note Pad. 

Use the Scrapbook only for necessary or important 
illustrations; for example, a corporate logo that can be used in 
memos or letters. Remember to clear the Note Pad once 
you've used the notes, or transferred them into another 
document. These files take up a lot of disk space that could be 
used for word-processing documents or spreadsheets. 

Limit the number of printing resources that 
share a disk with an application. 

Keep only one application per disk for applications that have a 
lot of files, or very large files. For example, spreadsheets and 
data-base files can consume disk space very quickly. When 
you limit the number of applications and printing resources on 
a disk, you '11 have more room for data, and you can minimize 
disk swapping and "Disk full" messages. 
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Other Causes 

Room to Print 

When you use an Image Writer as your primary printer, there is 
no need to have the LaserWriter print file on your application "-j 
startup disk. When you want to use the LaserWriter, copy the 
document you want printed to an application disk that has the 
LaserWriter print file installed. 

One way to limit your printing resources on a disk is to keep 
them on different disks. For example, keep the Image Writer 
file on your primary application disks, and the LaserWriter files 
on your backup application disks. Be sure that the disks are 
clearly labeled 

Damaged disks or disks with bad sectors can 
cause "Disk full" messages. 

To avoid some"Disk full" messages, all you have to do is to 
maintain your disks properly. There are many causes of 
damaged disks, such as heat, breakage, or just plain overuse. 
Keep your disks in disk carriers in cool, safe places. This will 
help prolong their life. 

To protect yourself against bad disks, always back up your 
documents daily, and when you're working on a document, 
save your work every 10 minutes. If you back up your files, 
and you get a "Disk full" error -- or a disk error that's more 
serious -- you won't lose all that time or information. There 
are several ways of reclaiming files that you may think have 
been lost. 

If you find that you continue to get "Disk full" messages, and 
you know that you don't have many files on that disk, you may 
have a bad disk. Often if you copy that disk to another disk, 
the error will be "fixed" on the new disk. Initialize the old 
disk, or erase it and try to use it again. This simple routine 
may save your file, and your disk (and your sanity!). 

"Not enough room to print" may appear even 
when you think there's enough room. 

If this message appears when you begin to print a document, 
and you know there's plenty of room on the data disk, it means 
there isn't enough room on the startup disk. Your application 
may need this room to create a print file. 

One remedy is to move the application to your data disk. Your 
first disk will remain the startup disk and will contain the 
printing resources. It'll now have room for the print file. The 
second disk will be your data disk and will contain your 
application and the document you want to print 
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Another way to do this is to always keep the application and the 
data on the same disk. Have two startup disks: one that 
contains the Image Writer software, and another that has the 
LaserWriter software. This will free up more room on the 
application disk, and on the startup disk for large documents. 

For more information on "Disk full" messages and document 
organization, see the Managing Macintosh Files module. 
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II How to Repair a Crashed· Disk 

Overview 

Rule Number One 

Repair a Disk 

Some lost documents can be recovered. 

One of the most common crises faced by technical support 
people is recovering the information on a crashed disk. Here 
are a few methods that have been successful in many cases. 
Since there are many ways to blow up disk directories, though, 
these methods are not always 100 percent effective. 

The first rule for every computer user is 
backup your work, and use Save often. 

Now that the primary means of disk (or document) recovery 
has been established, please continue reading. 

Method 1: Repairing a startup disk. 

1. If possible, make a backup copy of the bad disk. 

2. With the Macintosh turned off, put the copy of the bad disk 
into the internal drive. 

3. Before you turn on the Macintosh, hold down the Option 
and Command keys. 

4. Turn on the Macintosh. Continue holding down the 
Option and Command keys until the disk icon appears. 

5. If this works with the copy of your original disk, you may 
want to use it as your new disk. If not, follow the same 
procedure with your original disk. 

This method sometimes requires several attempts. It recreates 
the desktop file and the disk directory. One of these files may 
have been the cause of the problem. 

This process restores your documents, but your folders (except 
for the first level) are lost. This first level of folders is placed 
on your desktop. The system names them "Unnamed #1," 
"Unnamed #2," and so forth. You must re-create your folders, 
and put back the recovered documents and files manually. 

This method is especially useful if your Macintosh ever 
displays a bomb and the message, "A serious system error has 
occurred." 
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Method 2: Recovering from Error: ID = 02. 

To repair a data disk (or if Method 1 doesn't work): 

1. Start up with a disk that you know is good. Then eject the 
disk. Do not use Shut Down. 

2. Hold down the Option and Command keys and insert the 
problem disk. 

3. You'll lose your folders, so replace them as described 
above. 

(Note: This method also works on a Macintosh XL. Start up 
from the Mac Works TM program. Hold down the Option and 
Command keys and insert the bad 3.5-inch disk.) 

(Note: The repair function for the hard disk isn't available at 
the time of this printing.) 

Method 3: Recovering the information on a bad 
startup disk by replacing the System file. 

This method has been known to work with disks that fail to 
start up, and exhibit a Sad Macintosh with the address OF0028, 
orOF0064. 

1. Attempt Method 1. 

2. If that doesn't work, start up Macintosh using a good 
startup disk and then insert the bad disk. 

3. If the icon of the bad startup disk appears on the desktop, 
replace the System file with a working copy of the System 
file from the good disk. 

(Note: This last method doesn't seem to work with disks that 
exhibit a Sad Macintosh with the address 2F0064.) 

Try this with a Macintosh XL. 

If you're using a Macintosh XL, start with Step 2 above. Start 
up with Mac Works from the internal disk drive. When the 
system is ready, insert a startup disk. After the startup disk 
icon and the hard-disk icon appear, replace the System file 
and/or the Finder on the hard disk with the System file and/or 
Finder on the internal disk. 
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Back Up a Disk to 
Recover Lost Files 

Recover a Document 

Method 4: Backing up the disk to a clean disk. 

A method that often helps to recover a "lost" disk is to use a 
backup utility to move the data, applications file(s) and the disk 
directory to another disk (there might be a bad sector or other 
problem with the disk that has rendered it unreadable). This 
method might take several tries to work. 

If you can, try to open the disk on a different Macintosh, or use 
a different Macintosh to copy the disk. If you keep getting disk 
messages, it might be evidence of difficulties with the 
hardware. 

Method 5: Recovering documents that won't 
open. 

1. Make a copy of the disk that contains the document(s) you 
want to recover. 

2. Tum on Macintosh with a good copy of the application 
needed to read the document(s) you wish to recover. 

3. Open the application. 

4. Once the application is open, close the document called 
"Untitled." 

5. Choose Open from the File menu. 

6. If you're using a two-drive system, insert the bad disk. If 
you're using a one-drive system, click Eject and insert the 
bad disk. 

7. Select the disk by clicking Drive (if the disk isn't already 
selected), and open the desired document(s) from the 
Document Directory dialog box. 

8. If this works, save the document(s) to a good disk, back 
up your work, and continue. 
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To practice any of these routines, you must 
have a crashed disk. 

Try each of the methods listed above. Use disks that you 
previously thought were lost. If you don't have any of these 
disks, ask a colleague, or just wait. The opportunity to practice 
these techniques is bound to occur. Refer to this module when 
you get a problem disk. 

Rule number one should always be practiced. 

You should be in the habit of backing up your documents 
regularly, at least once a day. You may even want to keep 
backups of your backups, and archive some of your work 
away from your work area. 

Method 1 can be practiced with any disk. 

To practice method 1, be sure to use a disk that has a few 
folders on it. You'll lose the folders, but you'll see what the 
operation looks like and how much time it takes. 
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Feedback 

Crashed Disks and 
Documents 

There are other methods available via third 
party products~ 

Your Apple support representative or authorized Apple dealer 
can help you with any of the methods that were addressed. 
Discuss other ideas you may have with your course manager, 
or a colleague. 

In addition to the recovery systems that were mentioned, there 
are many third~party applications available through user's 
groups. Check with your Apple support representative for 
'1pplications that might be available, or check the resources 
listed at the end of this module. 
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Macintosh ROM has two levels: the operating 
system and the user interface. 

Device drivers are needed for each 110 device, 
such as the mouse, printers, and digitizers. 

Macintosh drivers work to support a wide variety of peripheral 
devices. These devices work in conjunction with the drivers 
contained in ROM, the drivers that are part of the software, and 
information provided by the System file and the application. 

There are four icons that can appear when you 
start up Macintosh. 

The Happy Macintosh, Question icon, X icon and the Sad 
Macintosh. 

Use good file-management techniques to 
avoid frequent "Disk full" messages. 

There are a number of causes for these 
messages, and there is usually a solution. 

Back up your files. Then when messages such 
as Error= 02 appear, you have alternatives. 

Five methods of error recovery (such as recovering bad disk 
files by using the Option and Command key function) were 
discussed. Of course, the best method of avoiding a lost-file 
disaster, is to back up your files often, and save them to disk 
every 10 minutes. 
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•Resources 

• AppleLink, Available to Apple support personnel, Apple 
Computer, Inc. 

• Inside Macintosh, Apple Computer, Inc., Addison-Wesley 
Publishing Company, Inc., Reading, MA 01867, 1985 

• Macintosh (the owner's manual), Apple Computer, Inc. 

• Macintosh 68000 Development System User's Manual, and 
Inside Macintosh, Apple Computer, Inc. 

• Macintosh Technical Training, available through Apple 
Support Training, Apple Computer, Inc. 

Apple, the Apple logo, and the Macintosh logo are registered trademarks of Apple Computer, Inc. AppleLink, AppleTalk, 
ImageWriter, LaserWriter, MacDraw, MacPaint, MacWor/cs, and MacWrite are trademarks of Apple Computer, Inc. 
Macintosh is a trademark of Mdntosh l.Aboratory, Inc. and is being used with the express permission of its owner. 
MS-DOS is a trademark of Microsoft Corporation. 
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2 Overview 

11 Overview 

Read this module to learn how to use MacDraw TM. The 
module includes basic product training, information about 
integrating MacDraw with other Macintosh TM computer 
applications, and a collection of tips and techniques to make 
MacDraw more useful and powerful. 

If you have never used MacDraw, you should complete the 
entire module. If you already know how to use MacDraw, you 
may still benefit from the Useful Techniques, and Integrating 
MacDraw with Other Applications sections. 

Prerequisites 

• The basic techniques for using Macintosh, including how 
to use the mouse and menus, how to open and close 
documents, and how to work with text. You can learn these 
by completing the Learning to Use Macintosh module or the 
Guided Tour of Macintosh, or by reading Chapters 1 and 2 
of Macintosh, the owner's manual. 
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11 Materials 

Objectives 3 

• Use all of the features of MacDraw as described in the 
Guided Tour of MacDraw. 

• State the function of each of the menu commands. 

• Describe the specific information that can be moved between 
MacDraw and other applications distributed by Apple® for 
the Macintosh. Also describe, in general, the information 
that can be moved between MacDraw and spreadsheets or 
data bases. 

To complete this module, you will need: 

• Macintosh 128K or Macintosh 512K 

• MacDraw disk 

• MacDraw, the owner's manual 

• Guided Tour of MacDraw disk and cassette 

• Audiocassette player 

• A blank disk 

If available, the following is recommended: 

• An external disk drive 

USING MACDRAW 



4 Overview of MacDraw 

• Overview of MacDraw 

What Is MacDraw? 

MacDraw Benefits 

MacDraw is a professional graphics solution 
for presentations, drafting, and design. 

MacDraw is a structured graphics editor. Components of.your 
drawings are stored as independent graphic elements, or 
"objects," which may be freely moved and changed. You 
create your drawing by combining many of these basic graphic 
elements, which include circles, rectangles, lines, curves, and 
text. 

MacDraw is different from MacPaint™, which is a 
pixel-oriented graphics editor. MacPaint lets you manipulate 
dots on the screen, while MacDraw lets you manipulate fully 
formed graphics objects. 

These are the key benefits of MacDraw. 

More effective communication. Graphically represent 
concepts that would be impossible to describe with words 
alone.· 

Accurate. Its a precision tool that can be used by architects, 
engineers, and others who draw to scale. 

Integrated with other applications. Enhance other 
Macintosh documents through the addition of graphics, and use 
MacDraw to enhance graphics pasted in from other 
applications. 

High quality output. Use MacDraw with the Apple 
LaserWriter™ printer to produce publication-quality graphics 
output. 

Easy to learn. Eliminate time spent learning to use 
graphics-design tools. 

Economical. Using MacDraw to produce high-quality 
graphics is much less expensive than hiring a professional 
graphics designer. 
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( II Learning How to Use MacDraw 

Overview 

Practice Exercises 

<~ 

Use existing materials to get started using 
MacDraw. 

The Guided Tour of MacDraw disk and cassette, and the 
MacDraw manual, which are packaged with MacDraw, are an 
excellent starting point for learning how to use the application. 
You'll start with the Guided Tour, and then read key parts of 
the manual. 

(Note: Be sure you have a Macintosh 128K or a 
Macintosh 512K because the Guided Tour of MacDraw 
doesn't work on a Macintosh XL.) 

After each Guided Tour session, complete the appropriate 
practice exercise in this module. In each exercise, you '11 
practice the techniques covered in the portion of the Guided 
Tour that you just completed. 

If you have questions that are not answered in this module or in 
the Guided Tour, refer to MacDraw, the owner's manual, or 
ask a colleague, your course manager, or your Apple support 
representative. 

Use the actual MacDraw disk (not the Guided 
Tour) to complete the practice exercises. 

After each Guided Tour session, eject the Guided Tour disk 
and start up from the MacDraw application disk to complete the 
practice exercise. Don't use the Guided Tour disk for the 
exercise because you can't save your work onto it. 

In several of the practice exercises that follow the four Guided 
Tour sessions, you'll work on the same drawing. Be sure to 
save your work when instructed to do so. 

The exercises include screen shots that reflect what your screen 
should look like at various stages in the exercise. It's not 
necessary to match these screen shots exactly. 

Following each practice exercise, there's a Feedback section 
you should read to confirm that you have completed the 
exercise correctly. The Feedback section will also suggest 
what to do if you have trouble. 
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Guided Tour 

Practice 

Fixing Mistakes 

Start Up MacDraw 

If you want to finish the Learning How to Use MacDraw 
section more quickly, you could go through the entire Guided 
Tour without stopping and then complete the Practice Using 
MacDraw section. However, you will learn-and retain-more 
about MacDraw if you complete all of the practice exercises in 
this module. 

Complete the first session of the Guided Tour 
of MacDraw, "What Is MacDraw?". 

Continue with the following practice exercise when you have 
finished the first session of the Guided Tour of MacDraw. 

Use the Clear, Undo, or Revert commands. 

As you work on this practice exercise, you'll probably make 
some mistakes. Correcting them is easy with the help of the 
Clear, Undo, and Revert commands. 

Whenever you don't like the last thing you drew, just choose 
Clear from the Edit menu while the object is still selected. 
The object will be removed and you can try drawing it again. 
Or choose Undo from the Edit menu to undo the last addition 
or change to your drawing. For example, if you change the 
size of a rectangle, choose Undo to change it back to its 
original size. You can also choose Revert from the File 
menu to undo all of your changes since you last saved the 
document. (If you never saved your work, your document will 
revert to a blank document.) 

All of these options are explained in more detail in the Guided 
Tour and the manual. 

Use the MacDraw disk to complete the practice 
exercise. 

1. Click I'm Ready to Stop from the Guided Tour screen. 
The Guided Tour disk will be ejected automatically. 

2. Insert the MacDraw disk. 
3. Open the MacDraw disk icon. 
4. Open the MacDraw application icon, either by selecting it 

and choosing Open, or by double-clicking on the icon. 
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Learning How to Use MacDraw 7 

Use the techniques introduced in the Guided 
Tour to draw a picture of a Macintosh. 

This section contains step-by-step instructions to complete your 
drawing of a Macintosh, and screen shots showing 
approximately what your screen should look like. Complete 
each step as it is explained. It's not necessary to match the 
screen shots exactly. 

As you create the various parts of your drawing, the tool you 
should use is identified on the screen shot with a hollow 
arrow ( Q ). This arrow will not appear on your screen. 

Draw the outine of the Macintosh. 

1. Click on the rectangle tool in the palette. 
2. Position the pointer where you want one comer of the 

outline of the Macintosh to be. 
3. Hold down the mouse button and move the pointer to the 

opposite comer. 

a File Edit Style Font Layout Rrr11nge Fill Lines Pen 
Untitled 
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4. Release the mouse button. Notice that your rectangle now 
has handles and the selection pointer (the arrow at the top 
of the palette) is now selected. You'll always return to the 
selection pointer after drawing something. 

If necessary, move or resize the rectangle. 

If you need to reposition the rectangle, point anywhere inside 
it, and while holding the mouse button down, move it to the 
desired location. 
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Practice (cont'd) 

If you need to resize the rectangle, position the tip of the 
pointer on one of the handles, and, while holding down the 
mouse button, move the mouse to change the rectangle to the 
desired size. 

Or use the Clear command to remove the rectangle completely, 
and then redraw it. 

Draw the screen. 

1. While the rectangle, which is the outline of your 
Macintosh, is still selected (the handles are showing), 
choose Duplicate from the Edit menu. 

2. To resize the duplicate, first point to the lower right handle. 

File Edit style Font L11yout Rrr11nge Fill Lines Pen 
Untitled 
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3. Hold the mouse button down. The handle should 
disappear. If it doesn't, release the mouse button and try 
again. If all of the handles disappear, reselect the rectangle 
by clicking anywhere within its borders. 

4. Move the mouse to resize the rectangle. Make it smaller 
than the original rectangle, as shown in the next screen 
shot. 

5. Release the mouse button when the rectangle is the desired 
size. 

6. While the small rectangle (the screen) is still selected, 
choose an appropriate shading from the Fill menu. 
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Add the disk drive. 

Leaming How to Use MacDraw 9 

3 

1. Choose the perpendicular lines tool from the palette. This 
enables you to draw horizontal and vertical lines. 

2. Draw a line representing the disk drive. 
3. While the line is still selected, choose a thicker line from 

the Lines menu. 

File Edit Style Font L11yout Rrr11nge Fill Lines Pen 
M11cintosh 
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Practice (cont'd) 

Round the corners of the cabinet and the 
screen. 

1. Select the large rectangle (the outline of the Macintosh) by 
pointing to it and clicking the mouse button. 

2. Choose Round Corners from the Edit menu. 
3. Click on 1/8" and click OK. 
4. Use the same technique to round off the corners of the 

screen (the small rectangle). 
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Draw the mouse. 

1. Choose the rectangle tool from the palette and draw the 
outline of the mouse. 

2. Duplicate the outline to create the rectangle that will 
become the mouse button. 

3. Grab the lower right handle and shrink the duplicate to the 
appropriate size. 
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Add the mouse cable. 

1. Choose the freehand shape tool from the palette and draw a 
line connecting the mouse to the back of the Macintosh. 

2. While the line is still selected (there are handles in the 
shape of a rectangle surrounding the line), choose a thicker 
line width from the Lines menu. 
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Practice (cont'd) 

Feedback 

Draw a Macintosh 

Quit MacDraw. 

1. Choose Quit from the File menu to quit MacDraw and 
return to the Finder. 

2. You won't be saving your changes, so click No when 
you're asked if you want to save changes before closing. 

3. Choose Shut Down from the Special menu, which will 
eject the MacDraw disk and restart your Macintosh. 

4. Insert the Guided Tour of MacDraw disk. 

If, after inserting the Guided Tour disk, you get the Macintosh 
desktop with a disk icon instead of the Guided Tour screen, 
tern the Macintosh off, and then on again. 

Be sure you understand the techniques 
covered in this section before continuing. 

When you have finished, your entire drawing should resemble 
the last screen shot, shown on page 11. If it doesn't, and you 
don't understand why, reread this section to be sure you 
understand all of the techniques taught. 

If you don't understand a particular aspect of MacDraw, you 
have several options: 

• Listen to the first Guided Tour session again. 
• Refer to MacDraw, the owner's manual. 
• Ask a colleague, your course manager, or your Apple 

support representative. 

Continue when you are comfortable with all of the techniques 
taught so far. 

APPLE SUPPORT TRAINING LIBRARY 



( 

( 

Learning How to Use MacDraw 13 

Learning How to Use MacDraw (cont'd) 

Guided Tour 

Practice 

Fixing Mistakes 

Start Up MacDraw 

Draw an Organization 
Chart 

Complete the second session of the Guided 
Tour of MacDraw, "More Drawing!". 

Continue with the following practice exercise when you have 
finished the second session of the Guided Tour of MacDraw. 

Use Clear, Undo, or Revert. 

If at any time you don't like the last thing you drew, just 
choose Clear from the Edit menu while the object is still 
selected. Or choose Undo to undo any addition or change to 
your drawing (for example, move, resize, or fill). You can 
also choose Revert from the File menu to undo all of your 
changes since you last saved your document 

Use the MacDraw disk to complete the practice 
exercise. 

Be sure to use the MacDraw disk for this exercise. At the end 
of the exercise, save your drawing, because in the next exercise 
you'll add to it. 

1. Click I'm Ready to Stop from the Guided Tour screen. 
The Guided Tour disk will be ejected automatically. 

2. Insert the MacDraw disk. 
3. Open the MacDraw disk icon. 
4. Open the MacDraw application icon. 

Use the techniques introduced in the Guided 
Tour to draw an organization chart. 

This section contains step-by-step instructions to complete your 
drawing, and screen shots showing approximately what your 
screen should look like. Complete each step as it's described. 
It's not necessary to match the screen shots exactly. 
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Practice (cont'd) 

Draw the first box of the organization chart. 

Draw a rectangle, similar to the one shown below, in 
approximately the same location. If you aren't satisfied with it, 
either resize it, move it, or choose Clear and start again. 
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Make it a round-corner rectangle. 

1. While the box is still selected, choose Round Corners 
from the Edit menu. 

2. Click on 1/8" and click 0 K. 

Make three duplicates, which you'll use to 
make the rest of your organization chart. 

1. Select the first box (if it's not already selected). 
2. Hold down the Command key and press D. A duplicate of 

the rectangle will be made. 
3. Press Command-D twice more to make two more 

duplicates. 
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4. Move the boxes into the positions shown in the screen shot 
below. 
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Add text. 

1. Choose the text tool from the palette. 
2. Position the pointer in the top box and click the mouse 

button to set an insertion point. 
3. Type President. 
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Practice (cont'd) 

4. In the next three boxes, starting with the one on the left, 
type VP Sales, VP Distribution, and 
VP Manufacturing. 

5. Click on the selection pointer (the arrow). 
6. Move the text to the center of the boxes. 
7. Resize the boxes if the text doesn't fit. 

s File Edit Style Font Layout Arrange Fill lines Pen 

Untitled 

Pres1dent 

... : .... ' ... ~ ........ : ........ ; ........ : . . . . . ........... : ........ : .•...... : .....••. ~ •••..••. : ........ ~ . . . . . . . ili:!: 

Add lines to show the structure of the 
organization. 

If you hold down the Command key, you can draw several of 
the same type of object without having to return to the palette. 
Use that technique, and follow the instructions below to draw 
the lines to connect the boxes together. 

1. Choose the perpendicular lines tool from the palette. 
2. Draw one of the lines shown in the screen shot below. 
3. Hold down the Command key to draw another line. 
4. Continue to hold down the Command key as you draw all 

of the lines shown below. 

If you have trouble lining up the boxes and the lines, don't 
worry about it right now. Later, you'll learn about the grid and 
how to align objects. 
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Fill Lines Pen 

Change the type style of a word. 

1. Choose the selection pointer and point to the word 
"President." Click the mouse button to select it. 

2. Choose 18 point from the Font menu. 
3. Choose Bold from the Style menu. 
4. Reposition the text to keep it in the center of the rectangle. 

Make the boxes bolder. 

1. Select one of the boxes. 
2. Hold down the Shift key and click on the second box. 

Both boxes should now be selected. 
3. Use the Shift-click technique to select all four boxes. 
4. Choose a slightly bolder line from the Lines menu. 
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Practice (cont'd) 

Make room for a title. 

Before you can add a title, you must make some room at the 
top of your drawing. 

1. Choose Select All from the Edit menu to select 
everything in your drawing. (Select All selects 
everything in the entire document. So when you use 
Select All, be careful not to move objects that you don't 
really want to move-for example, objects that aren't 
currently visible in the window.) 

2. Move any part of the drawing down the screen. The rest 
will follow. 

Add a title. 

1. At the top of the screen, type Organization Chart. 
2. Use the Font and Style menus to change the type style of 

the title to New York, 18 point, and Shadow. 
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Highlight the title by drawing two polygons 
around it, as shown below. 

1. Choose the polygon tool from the palette. 
2. Click where you want to start the polygon. 
3. Move the mouse to the second vertex, or comer, and 

click again. Each time you click the mouse button, you 
will establish a new vertex. 

4. Continue clicking the mouse button to set each vertex until 
your polygon is finished. 

5. Double-click on the last vertex of the polygon. 
6. Either hold down the Command key or click on the 

polygon tool again to start the second polygon. 
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Quit MacDraw and save your work. 

1. Choose Quit from the File menu. You will be asked if 
you want to save the changes. 

2. Click Yes. 
3. Type a name for your document, such as "Org Chart." 

(Henceforth, this document will be referred to as the Org 
Chart document.) 

4. Click Save. 
5. Choose Shut Down from the Special menu. 
6. Insert the Guided Tour disk. 

If you don't see the Guided Tour screen, tum the Macintosh 
off and then on again. 
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Feedback 

Draw an Organization 
Chart 

Be sure you understand the techniques 
covered In this section before continuing. 

When you have finished, your drawing should resemble the 
last screen shot If it doesn't, and you don't understand why, 
reread this section to be sure you understand all of the 
techniques taught 

If you don't understand a particular aspect of MacDraw, you 
have several options: 

• Listen to the second Guided Tour session again. 
• Refer to MacDraw, the owner's manual. 
• Ask a colleague, your course manager, or your Apple 

support representative. 

Continue with this module when you are comfortable with all 
of the techniques taught so far. 

Learning How to Use MacDraw (cont'd) 

Guided Tour 

Practice 

Fixing Mistakes Review 

Complete the third Guided Tour segment, 
"What Can I Do with MacDraw?". 

Continue with the following practice exercise when you have 
finished the third session of the Guided Tour of MacDraw. 

Use Clear, Undo, or Revert. 

Remember, if you don't like the last object you drew, you can 
use the Clear command to remove it. Or choose Undo to 
undo any addition or change to your drawing. You can also 
use the Revert command to undo all of your changes since 
you last saved your document. 
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Use the MacDraw disk to complete the practice 
exercise. 

1. Click I'm Ready to Stop from the Guided Tour screen. 
2. Insert the MacDraw disk. 
3. Open the Org Chart document. 

Use the techniques introduced in the Guided 
Tour to enhance your chart. 

This section contains step-by-step instructions to complete your 
drawing, and screen shots showing approximately what your 
screen should look like. It's not necessary to match the screen 
shots exactly. 

Center the text in the boxes. 

Upon choosing the Align Objects command from the 
Arrange menu (don't do it yet), you will get several choices 
for how you want to line up the selected objects. The Top, 
Bottom, Left, and Right options are straightforward. The 
L/R Centers (Left/Right) option relocates the objects left and 
right until they are centered vertically. The T/B Centers 
(Top/Bottom) option moves the objects up and down until they 
are centered horizontally. 

1. Use either the selection rectangle or the Shift-click 
technique to select the top box and the text it contains. 

2. Choose Align Objects from the Arrange menu. 
3. Click L/R Centers and T/B Centers, and then click 

OK. The text will now be centered in the box, both 
horizontally and vertically. 

4. Deselect the box and text by clicking on an empty part of 
your drawing. The handles will all disappear. 

5. Repeat the process for the other three boxes. 
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Practice (cont'd) 

Add shadows to the boxes. 

1. Use the Shift-click technique to select all four boxes, but 
not the text. 

2. Choose Duplicate from the Edit menu. 
3. Choose Send To Back from the Arrange menu. 
4. Choose the black fill pattern from the Fill menu. 
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Draw a round-corner rectangle of a specific 
size. 

1. Choose Show Rulers from the Layout menu. 
2. Choose the round-comer rectangle tool from the palette 

(#1 in the following screen shot). 
3. Just below the title, on the right side of your chart, draw a 

rectangle 1 1/2 inches long and 1/2 inch high. (See the next 
screen shot.) 
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Add text centered in the box. 

1. Choose the text tool in the palette (#2 in the screen shot 
below). 

2. Choose Center from the Style menu. 
3. Position the text-insertion point in the middle of the box. 
4. Type Effective 1/86. 
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Change the lines to arrows. 

1. Select the three vertical lines that lead to the bottom boxes. 
2. From the Lines menu, choose the first line that has a 

single arrowhead. 
3. If the arrows in your drawing are pointing up instead of 

down, choose the other single-headed arrow from the 
Lines menu while the lines are still selected. 
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Practice (cont'd) 

Feedback 

Enhance Your 
Organization Chart 

Quit MacDraw. 

1. Choose Quit from the File menu. 
2. When asked if you want to save changes, click Yes. 

MacDraw will automatically save your changes under the same 
name as you saved the document earlier, and on the same disk. 
If you had wanted to keep both versions of your document, 
you would have chosen Save As and then entered a new name 
for the current version of your drawing. This would have left 
the original untouched. 

3. Choose Shut Down. 

Be sure you understand the techniques 
covered in this section before continuing. 

When you have finished, your entire drawing should resemble 
the last screen shot, shown on page 23. If it doesn't, and you 
don't understand why, reread this section to be sure you 
understand all of the techniques taught. 

If you don't understand a particular aspect of MacDraw, you 
have several options: 

• Listen to the third Guided Tour session again. 
• Refer to MacDraw, the owner's manual. 
• Ask a colleague, your course manager, or your Apple 

support representative. 

Continue with this module when you are comfortable with all 
of the techniques taught so far. 
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Learning How to Use MacDraw (cont'd) 

Guided Tour 

Practice 

Start Up MacDraw 

Add to the 
Organization Chart 

Complete the fourth Guided Tour session, "Big 
Drawing!". 

Continue with the following practice exercise when you have 
finished the fourth session of the MacDraw Guided Tour. 

Use the MacDraw disk to complete the practice 
exercise. 

1. Click I'm Ready to Stop from the Guided Tour screen. 
2. Insert the MacDraw disk. 
3. Open the "Org Chart" document 

Use the techniques introduced in the Guided 
Tour to create a large chart. 

This section contains step-by-step instructions to complete your 
drawing and screen shots showing approximately what)'our 
screen should look like. Complete each step as it's described. 
It's not necessary to match the screen shots exactly. 
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Practice (cont'd) 

Give yourself more room to work. 

1. Choose Reduce to Fit from the Layout menu. Notice 
how large your drawing is, where it is on the paper, and 
how many pages you have available (one). 

2. Choose Drawing Size from the Layout menu. 
3. Click in the box next to the black one to indicate that you 

want the size of your drawing increased to two pages. 

s File Edit Fiii Lines Pen 

Dr11wlng Size: Im 
16.00 H I 0.00 

[ OK ) [ Cancel ) 

..... ,[6======= . . ......................................... 

111.·.·················· 

4. ClickOK. 

APPLE SUPPORT TRAINING LIBRARY 



( 

Learning How to Use MacDraw 27 

Create a "building block" for making the chart 
larger. 

Read this paragraph, and then follow the numbered 
step-by-step instructions to actually make the changes to your 
document. The next step is to select various parts of your chart 
and group them so they will be treated as a single object. 
You'll select only the boxes, their shadows, and the lines 
connectimg them. Once these objects are grouped, you can 
easily copy, paste, and move entire sections of your 
organization chart. 

1. Use the selection box or the Shift-click technique to select 
the boxes, their shadows, and the lines (not the text, 
heading, or the "Effective 1/86" box). If you use a 
selection box, use the Shift-click technique to deselect all 
of the text. 
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2. Choose Group from the Arrange menu to group all the 
boxes and lines. 

3. If your text disappears, Choose Send to Back from the 
Arrange menu. 

4. Choose Copy. 
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Practice (cont'd) 

Add to the Organization Chart. 

1. Move the pointer to the middle of the second page, and 
click the mouse button (notice that a hand briefly appears 
pointing to the spot where you just clicked). 

2. Choose Paste. The "building block" will be pasted where 
you clicked the mouse button. 

3. Move it so that the top box is level with the three boxes on 
the left page. 

Fill Lines Pen 

4. Draw the two lines indicated below to connect the new part 
of the chart to the existing part .. 
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Enlarge your chart some more. 

1. Click the mouse button in the lower half of the first page. 
2. Choose Paste to add another branch of your organization 

chart below the original part. 
3. Move the new addition to the desired location, centered 

below the middle box. 
4. Draw a straight line down from the "VP Distribution" box 

to connect the new branch to the rest of the chart. 

See what the chart will look like when it's 
printed. 

1. Choose Hide Rulers from the Layout menu. 
2. Choose Hide Ruler Lines from the Layout menu 

(this removes the reference lines from your drawing). 
3. Choose Hide Page Breaks from the Layout menu. 

s File Edit Style Font Lnyout Rrrnnge Fill Lines Pen 

ii!D Org Chnrt 

USING MACDRAW 



30 Learning How to Use MacDraw 

Practice (cont'd) 

Get ready to add text to the new part of the 
chart. 

1. Select the right branch of the chart. 
2. Choose Normal Size from the Layout menu. Notice 

that the part you selected is now centered on your screen. 
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You are now ready to add text to complete your organization 
chart. Since you already know how to add text, this exercise 
won't guide you through it. If you want the practice, add some 
text on your own and center it in the boxes. 

You may want to ungroup these objects so you can align text in 
a box or so you can enlarge or shrink an individual box to fit 
the text. · 

Quit MacDraw. 

1. Choose Quit from the File menu to return to the Guided 
Tour menu screen. 

2. When asked if you want to save changes, click No. 
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Be sure you understand the techniques 
covered in this section before continuing. 

When you have finished, your entire drawing should resemble 
the next-to-last screen shot, shown at the top of page 30. And 
your screen should resemble the screen shot at the bottom of 
page 30. If either isn't true, and you don't understand why, 
reread this section to be sure you understand all of the 
techniques taught. 

If you don't understand a particular aspect of MacDraw, you 
have several options: 

• Listen to the fourth Guided Tour session again. 
• Refer to MacDraw, the owner's manual. 
• Ask a colleague, your course manager, or your Apple 

support representative. 

Continue with this module when you are comfortable with all 
of the MacDraw techniques taught so far. 

You've been doing great! It's time for a break. 
Relax for 10 to 15 minutes before continuing. 

Learning How to Use MacDraw (cont'd) 

Learn All of the 
Menu Commands 

The function of each menu command is 
explained in the manual. 

Read the section of the manual that explains the function of 
each of the menu commands, not only to learn the information, 
but also to become familiar with the manual as a valuable 
reference tool. Read the MacDraw Menus section in Chapter 3 
of MacDraw, the owner's manual. 

Continue with this module when you have finished reading 
about the MacDraw menus. 
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North American Distribution System 
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(n II Practice Using MacDraw 

Overview 

( 

Practice what you learned in the Guided Tours, 
and learn a few more features. 

This exercise is designed to give you an opportunity to practice 
using many of the features you were introduced to in the 
Guided Tour. You will also learn how to use additional 
features that the Guided Tour didn't cover. You will not, 
however, learn everything there is to know about using 
MacDraw. The best way to learn everything is to thoroughly 
read the manual and then simply use the product. 

Draw a distribution diagram. 

Let's say you've been asked to prepare a presentation 
explaining how your company distributes its products, from 
the factory all the way to the customer. A drawing showing the 
overall picture is a great way to start the presentation-and 
MacDraw is just the tool you need to create it. 

In this final practice exercise, you'll draw the diagram shown 
on the facing page. The exercise includes step-by-step 
instructions and screen shots so you can check your work. 
Perf orrn each step as it is described. It's not necessary to 
match the screen shots exactly. In this exercise, the screen shot 
showing the effect of a particular change to your drawing is 
placed before the instructions on how to make that change to 
provide an example of what you're about to draw. 

As with earlier practices, the drawing tools you will use are 
identified in the screen shots by hollow arrows cc::>), which 
won't appear on your screen. 

Remember, if you make a mistake, or you don't like the last 
object you drew, use the Undo, Clear, and Revert 
commands. 

If you forget how to use a particular feature, or you don't 
understand what to do, refer to MacDraw, the owner's manual, 
or ask a colleague, your course manager, or your Apple 
support representative. 
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Practice 

Draw Your Company's 
Distribution System 

Start up from the MacDraw disk. 

Insert the actual MacDraw application disk (not the Guided 
Tour disk) and open the MacDraw icon to start up the 
application. 

The open document covers most of the screen, but there's 
about half an inch of desktop all the way around it. Move the 
window to the top left comer of the screen and then expand it 
to fill the entire screen. 

Draw a factory, like the one shown below. 
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1. Choose the polygon tool from the palette and draw the 
outline of the factory. 

2. Choose the rectangle and draw the first smokestack. 
3. Hold down the Command key to draw the second 

smokestack without having to click in the palette again. 
4. Draw the first window and fill it with black. 
5. Press Command-D to duplicate the window. 
6. Position the duplicate next to the original, as shown above. 
7. Press Command-D two more times to add two more 

windows. The third and fourth windows will retain the 
spacing you established between the first two. 
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Shrink the factory. 

1. Choose Select All from the Edit menu. 
2. Choose Group from the Arrange menu (or press 

Command-G. 
3. Grab the lower right handle and shrink the factory (see the 

screen shot below for the approximate size). 

Draw the first distribution center, like the one 
shown below. 

s File Edit Style Font Layout Arrange Fill Lines Pen 

=o • T '"+. 
I-:-'--

_...~ [ D ... 

to 
i-=-o · · 
~ 
~···· 
~ 
i-=-1 

Untitled 

•rrilih·. ·. ·· ··········· ················· mm 

. : ·:··. ··,· .. ·:·· : . ................... .................. ;,\[,i 

: ~~· ~: !,::.' .• 1.::.:1:., . : ... ·:.·. . :.· ... : ......... . 
jjHH 

,,,;,,, ..... \.... . ..... \ ........ ;.,,, ···:·················:··· .... : ........ : ........ 111111 

.......... ~. ... . . ... . . .. : ......... : .... !!!Iii 

Er ~ T::t::::::::::::::::::::::::::::::::::::::::::::::::::m:mm:mrnm:m:m:m:mmmmmrnmrnmmmm:::. . · ;.'; ;, ... ,,:' .;::: ,,\::' :::::;;1;,1{. ;:<:;:.,:;:,E~ 

1. Draw a rectangle for the outline. 
2. Draw a small square for the first window in the top right 

comer of the rectangle. 
3. Press Command-D to duplicate the first window. Move it 

next to (and adjoining) the original, and then press 
Command-D three more times to line up five windows. 
(Remember, each time you press Command-D, a duplicate 
is created with the same spacing relative to the previous 
object as that established between the first and second 
objects.) 

4. Draw a rectangle for the small door and then add a vertical 
line to make it look like a double door. 

5. Draw a large rectangle for the first shipping door, and fill it 
with a pattern from the Fill menu. 

6. Duplicate it to make the second shipping door. 
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Practice (cont'd) 

Add two more distribution centers. 
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1. Use the selection box to select the distribution center. 
2. Group the objects together. 
3. Duplicate the grouped objects and place the duplicated 

distribution center next to the original. 
4. Choose Duplicate again to create a third distribution 

center. 

Add labels to your drawing. 
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1. Type FACTORY below the factory and move the text so 
it's centered beneath the picture. 

2. Type DISTRIBUTION CENTERS, and center it 
above the three distribution centers. 

3. Type the following below the three distribution centers: 
Eastern Region, Central Region, and Pacific 
Region. 

Center the text below the distribution centers. 

1. Select the first distribution center. 
2. Use Shift-click to select the text beneath it. 
3. Choose Align Objects from the Arrange menu. 
4. Click on L/R Center and then click OK. 
5. Do the same for the other two distribution centers. For the 

Central Region, also select "DISTRIBUTION CENTERS" 
so that it will be centered above the middle drawing, and 
therefore above all three distribution centers. 

Choose Save to save what you have done so far. 

You should save your work regularly, every 10 to 15 minutes, 
to minimize the loss of work should there be an accident, such 
as someone tripping over your power cord. 

1. Choose Save from the File menu. 
2. If you have an external disk drive, insert your blank data 

disk. If you don't have an external disk drive, click Eject 
to eject the MacDraw disk and then insert the blank data 
disk. 

3. Enter a name for your document, such as Distr System. 
4. Click Save. 
5. If you don't have an external disk drive, you need to 

reinsert the MacDraw application disk. Press 
Command-Shift-1 to eject the data disk. Then insert the 
MacDraw application disk. 
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Practice (cont'd) 

Continue with 
Your Drawing 

Add arrows pointing to the distribution centers. 
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Choose the arc tool from the palette and draw three arcs as the 
first part of the arrows. Stop the arcs short of the distribution 
centers to save room for the arrowheads. You can't 
automatically make arcs into arrows, so you'll have to add 
short, straight-line arrows to each arc. 

Add arrow heads. 
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1. Choose the perpendicular lines tool and add a short line to 
the bottom of the first arc. 

2. Choose the first line that has a single arrowhead from the 
Lines menu. If an arrow doesn't appear, the line is too 
short. The line must be at least 1/4 inch long for an arrow 
to appear. 

3. Duplicate the arrow and add it to the other two arcs. 

Draw the large arrow pointing back to the 
factory. 

The Show Size command helps you draw objects of exact 
sizes. When resizing arcs, it measures them in degrees. Use 
arcs and the Show Size feature to draw a large arrow pointing 
back to the factory. Screen shots are included to show you 
what the arrow should look like at interim stages. 

1. Choose the arc tool. 
2. Choose Show Size from the Layout menu. 
3. Start the arc to the left of the Eastern Regions distribution 

center. Draw an arc whose size is 0.62 inches by 0.62 
inches in the shape shown in the screen shot below. 

4. While the arc is still selected, choose Reshape Arc from 
the Edit menu. 

5. Grab the top handle and move it around the circle until the 
size reads 307 degrees. 

6. Start another arc 114 inch above the first. Its size should be 
0.50 inches by 0.50 inches. 

7. Choose Reshape Arc. 
8. Grab the top handle and move it around the circle until the 

size reads 296 degrees. 
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Practice (cont'd) 

9. While the smaller arc is still selected, choose the white fill 
pattern from the Fill menu. 

10. Select the larger arc and choose the black fill pattern from 
the Fill menu. 

11. Choose Hide Size from the Layout menu. 

s File Edit Style Font Layout Arrange Fill Lines Pen 
Distr System 

., ····. · [ii~fra"~ I 
........ ; ........ ;... . . . ..... . : .···· : . : """iii!!! 

. ~ Eilste~ Reg1<in ~ Ceiltral ~egiori P~cific: Regitjn ilmi .... : ... ·'.· ... : .. · t · .. : ... t ... : .. · t · .. : .. · t · .. : ... '!' ... ~'JI 

mii~!!m1miimm1i1~n11m1i111UHummmmirummmmmnmm~mmmmm~mimihm1mnmmmmnmmmmmmmmmm1111iiimil!!m!ii!i1hmmn~li1r 121 

Add an arrowhead to the two arcs. 
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Try drawing an arrowhead as shown. It will be difficult to get 
it the right size and at the correct angle. This is because of the 
grid. The grid is an invisible gravitational force that limits 
mouse movements to the smallest increment of the ruler, 
regardless of whether you are creating something or moving an 
existing object. For example, if the smallest increment of the 
ruler is 118 inch (as it is now), you can only move or change 
the size of objects in 118-inch increments. (There is additional 
information about the grid in the Useful Techniques section of 
this module.) 

1. Choose Turn Grid Off from the Layout menu. 
2. Choose the polygon tool and draw a triangle for the 

arrowhead (see the previous screen shot or the one below). 
3. Choose the black fill pattern. 

Add text to the arrows. 
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1. Tum the grid back on by choosing Turn Grid On from 
the Layout menu. 

2. Next to the three arrows, type Product. 
3. Next to the large arrow, type Orders. 

Get in the habit of saving your changes 
regularly. 

Choose Save from the File menu to save your changes. If 
you have an external disk drive, all of your changes will be 
saved to the data disk (which should still be in the drive). 
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Practice (cont'd) 

Continue with 
Your Work 

If you don't have an external disk drive, when you choose 
Save, you'll be asked to insert the data disk. When you've 
finished saving your work, press Command-Shift-1 to eject the 
data disk, and then insert the MacDraw application disk. 

Either way, notice how quick and easy it is to save your 
changes. It's strongly recommended that you do this often. A 
good habit to get into is to save your work every 10 to 15 
minutes as well as whenever you're not working on the 
documents, for example, when you leave for lunch or when 
you're interrupted by a visitor or a phone call. 

Add six retail outlets. 
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1. Scroll down the page. 
2. Draw the outline of the first retail outlet 
3. Add a door and a picture window. Fill them. 
4. Group the three objects together. 
5. Press Command-D to duplicate the retail outlet. 
6. Position the duplicate next to the original. 
7. Press Command-D four more times to add four more 

outlets. 
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Add arrows from the distribution centers to the 
retail outlets. 
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1. Choose the diagonal lines tool. 
2. Choose the first line that has a single arrowhead from 

the Lines menu. 
3. Draw all six arrows starting at the distribution centers. 

Hold down the Command key to draw the lines without 
having to reselect the tool. If the arrows are pointing the 
wrong way, choose the other line with a single arrowhead 
from the Lines menu. 

4. Type RETAIL OUTLETS below the six outlets you just 
drew. 

5. Position the text so it's centered under the retail outlets. 

Draw the large rectangle representing the 
customers. 
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Practice (cont'd) 

Save Your Work 

1. Scroll down the page until there's enough room to draw 
the rectangle shown in the last screen shot. 

2. Choose the round-comer rectangle tool from the palette. 
3. Draw the white rectangle (shown above) below the retail 

outlets. 
4. Choose Round Corners from the Edit menu. 
5. Click on 1/8" and click OK. 
6. Duplicate the rectangle. 
7. Grab the top left handle and stretch the rectangle until it's 

slightly larger than the original all the way around. 
8. Choose Send To Back from the Arrange menu. 
9. Choose a pattern from the Fill menu. 

Add text to the new rectangle. 
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1. Type CUSTOMERS in the rectangle. 
2. Change the type style to 24 Point and Shadow. 
3. To center the text in the rectangle, first select the text and 

the two boxes. 
4. Choose Align Objects from the Arrange menu. 
5. Click on T/B Centers and L/R Centers and click OK. 

Choose Save from the File menu. Insert your 
data disk, if necessary. 
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Add arrows from the retail outlets to the 
customers. 
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The last time you drew arrows, you changed the lines to 
arrows before drawing the first line. This changes the palette 
so all subsequent lines will also be arrows. Therefore, you 
don't have to use the Lines menu to indicate that you want 
arrows this time. Every straight line you draw will continue to 
be an arrow until you change the palette again. 

1. Choose the perpendicular lines tool. 
2. Draw an arrow from the first retail outlet to the customers. 
3. Duplicate the arrow and move it so that it's correctly 

positioned under the second retail outlet 
4. Press Command-D four more times. 

Notice that the middle two lines go right over "RETAIL 
OUTLETS." With MacDraw, objects are drawn on top of 
other objects, just as pieces of paper can overlap on your desk. 
You can rearrange the objects using Bring to Front and 
Send to Back commands in the Arrange menu. Follow the 
instructions on the next page to rearrange the text and lines in 
your drawing. 
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Practice (cont'd) 

5. Select the text, "RETAIL OU1LETS.". 
6. Choose the white fill pattern from the Fill menu. 
7. Choose Bring to Front from the Arrange menu. 
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Reposition the entire drawing on the page. 

1. Choose Reduce to Fit from the Layout menu. 
2. Choose Select All from the Edit menu (or press 

Command-A). 
3. Grab any part of your drawing and move it so it's centered 

horizontally on the page and there's room at the top for a 
title. If you accidentally grab a handle, your drawing may 
change drastically. Just release the mouse button and 
choose Undo. Then try again. (See the screen shot below.) 
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Add a title. 

1. Click at the top of the page. This does two things: ( 1) it 
deselects everything, and (2) it indicates where you want to 
work when you return your drawing to normal size. 

2. Choose Normal Size from the Layout menu. 
3. At the top of the drawing, type North American 

Distribution System. 
4. Change the type style to 18 point, Bold, Underlined, 

and New York font. 
5. Move the title so that it's centered over your drawing. 
6. To see what it will look like when printed, choose Hide 

Ruler Lines from the Layout menu. 
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Feedback 

Draw Your Company's 
Distribution System 

Be sure you understand the techniques 
covered in this section before continuing. 

When you have finished, your entire drawing should resemble 
the drawing on page 28 and your screen should look like the 
screen shot above. If either isn't true, and you don't 
understand why, reread this section to be sure you understand 
all of the techniques taught. 

If you don't understand a particular aspect of MacDraw, refer 
to the MacDraw manual, or ask a colleague, your course 
manager, or your Apple support representative for assistance. 

Continue when you are comfortable with using all of the 
MacDraw features that were covered. 
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II Integrating MacDraw with Other Applications 

Overview 

How to ... 

What is possible, and how is it done? 

One of the key benefits of the Macintosh is being able to copy 
and paste information from one application to another. For 
example, you can make a Mac Write™ document more 
meaningful by including a drawing from MacDraw or 
MacPaint 

This section begins with a reminder of how to move 
information from one document to another. Then there is a 
description of what integration is possible between MacDraw 
and other Macintosh applications. 

Use Copy and Paste. 

To move information between any two documents, use the 
following technique: 

1. Select what you want to move. 
2. Copy it. 
3. Open the second document. 
4. Indicate where you want to add the information. 
5. Choose Paste. 

Your ability to do this will depend on what types of 
information each application is able to handle. 
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Pasting Into MacDraw Here's a brief summary of what can be pasted 
into MacDraw from other applications. 

MacDraw can accept text and graphics from any application. 
However, there are limitations (explained below) on the 
amount of text that can be received. Here's some additional 
information regarding pasting information into MacDraw. 

MacDraw. You can paste anything from one MacDraw 
document into another. 

MacPaint. You can paste any MacPaint picture into 
MacDraw. But once the MacPaint picture is in MacDraw, all 
you can do with it is resize it (be careful not to distort the 
image) and move it around. You can't edit it in any way. 

MacProject. You can paste the Schedule Chart or either of 
the time lines from MacProject™ into MacDraw. The 
components of the chart will be pasted in as individual graphics 
objects, each of which can be modified. You can't paste the 
tables, though. If the chart or time line is larger than the 
current size of your document, MacDraw will add pages as 
needed. 

MacTerminal. You can paste any text from MacTerminaI™ 
into MacDraw. It will be pasted in either as paragraph text or 
as caption text (see the "Useful Technique" about Putting Text 
into Objects which explains caption and paragraph text). 
MacDraw will add pages to the right as needed (up to 12). 
Caption text that still falls off the right side will be lost 

MacWrite. You can paste anything from Mac Write into 
MacDraw. Text can be pasted in either as paragraph text or as 
caption text (see MacTerminal paragraph above), and MacPaint 
pictures are pasted as if they were pasted directly from 
MacPaint. MacDraw graphics that were previously pasted into 
Mac Write are pasted back into MacDraw as MacDraw graphics. 
Therefore, you can edit them, just as you could the originals. 

Business Graphics. You can paste charts from business 
graphics programs, such as Microsoft Chart, into MacDraw. 
The components of the graph are pasted in as individual 
graphic objects, each of which can be modified. 
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Pasting MacDraw Data 
into Other Applications 
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Here's a summary of what information can 
be pasted into other applications. 

You can paste MacDraw information into any application that 
can handle graphics. Here's some specific information 
regarding each application. 

MacDraw. You can paste anything from one MacDraw 
document into another. 

MacPaint. You can paste anything from MacDraw into 
MacPaint, as long as it fits into the MacPaint window. The 
drawing will be pasted in as a bitmap, just as if you created it in 
MacPaint. If you paste something larger than the window into 
MacPaint, the center of the object will appear in the window 
and the edges will be cropped. Once the drawing is in 
MacPaint you can edit it with all of MacPaint's features. 

MacProject. You can paste small amounts of text (a few 
words) from MacDraw into Mac Project. You can't paste 
MacDraw graphics into MacProject. 

MacTerminal. You can paste any text from MacDraw into 
MacTerminal, but all font and type style information is lost. 
You can't paste graphics into Mac Terminal, but you can use 
MacTerminal to send an entire MacDraw document to another 
Macintosh (see the Using MacTerminal module). 

Mac Write. You can paste anything from MacDraw into 
Mac Write, as long as it fits between MacWrite's margins. If the 
margins are too narrow, the drawing will be shrunk to fit. 
(See the Adding Graphics section of the Supporting Mac Write 
module.) 
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Ill Useful Techniques 

Overview 

Have MacDraw Available 

Moving Between 
MacDraw Documents 

This section explains techniques that will help 
you get the most out of MacDraw. 

Reading a manual and doing some practice exercises is only 
part of learning how to use an application. When you start 
using an application, you 11 discover additional techniques to 
help you produce higher-quality work-and produce it more 
efficiently. 

This section describes many of those techniques to help you 
become more productive on MacDraw more quickly. At the 
end of the module, there are some resources you should check 
regularly for more information on how to get the most out of 
your Macintosh and MacDraw. 

Practice exercises are not included, but you 
are encouraged to try each technique. 

In this section, and for the remainder of the module, you are 
not directed to complete specific practice exercises. However, 
it would be valuable for you to have a Macintosh equipped with 
MacDraw available as you read this section, and to try the 
various techniques as you read about them. 

Use the Document Directory. 

You can have up to four MacDraw documents open on your 
screen at the same time. To move from one document to the 
next, click on any visible portion of the document you want to 
work with. 

If you already have four MacDraw documents open and you 
want to open a different MacDraw document; here's what to 
do: 

1. Select the document to be closed. 
2. Choose Close from the File menu or click in the close 

box. 
3. Choose Open from the File menu. You will get a list of 

all the MacDraw documents on that disk in the Document 
Directory dialog box. 
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Command Key 

Option Key 
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4. If you want to open a document on another disk, either 
click Drive to display the documents on the disk inserted 
in the other drive, or click Eject to eject the data disk, and 
then insert the disk containing the document you want. 

5. Double-click on the name of the document you want to 
open. 

Use it to invoke menu commands. 

Use the Command key in combination with the appropriate 
letter to invoke many of the menu commands. For example, 
holding down the Command key and pressing N will open a 
new document. Here is a summary of the menu commands 
that have Command-key equivalents. 

New XN Undo X2 
Open ... XO Cut XH 
Saue XS Copy xc 
Quit XQ Paste XU 

Duplicate XO 
Select All XR 

Plain TeHt XP Reshape XR 

Bold XB 

~; ilfl ""' 
Italic XI 
Underline XU XG l Group 

Hold down the Option key to display objects as 
you move them. 

If you're moving a group of objects, only the object you were 
pointing to when you started the move will be displayed 
(sometimes only the boundary of the entire group of objects is 
displayed). 

Hold down the Option key to display all the objects as you 
move them. The same technique holds for text-holding down 
the option key as you move the text allows you to see every 
character. 

This technique makes it much easier to position objects exactly 
where you want them. 
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The Grid 

Document Layout 

Complex Drawings 

What is it and how do you affect it? 

There are two grids-the visible lines, ruler lines, and the 
invisible gravitational force to which objects cling, the grid. 
Each can be turned on and off independently from the Layout 
menu. 

The increment of the ruler lines and the grid is determined by 
the rulers. The ruler lines appear at every major division of the 
ruler and are only for reference. They don't affect any of the 
objects you draw and are not printed. 

If the grid is on, any object you draw will change size in the 
smallest increment of the ruler. If you want to draw or edit in 
smaller increments, turn the grid off or increase the number of 
minor divisions on the ruler. 

For example, if the grid is on and you're using the standard 
ruler, every object will change size and move in increments of 
1/8 inch. 

Choose Reduce to Fit to do your rough 
document layout. 

Since you can draw, move, and edit objects while in 
reduce-to-fit mode, do your "rough cut" document design and 
layout while the document is reduced. Then return the 
drawing to normal size and do the detailed work. 

Using MacDraw in reduced mode enables you to lay out entire 
documents, much as you can using some third-party desktop 
publishing applications. You can place boxes where you will 
later place text, enter headings, and place your graphics just 
where you want them. Then work with your document in 
normal size to add the actual text into the boxes (see the later 
comment on Putting Text into Objects) and fine-tune your 
drawings. 

Use many overlapping objects. 

New objects are always drawn on top of existing objects. Use 
Bring to Front and Send to Back to change the order of 
the overlapping objects you have created. 

Once a component of your drawing is complete, group the 
independent objects so you don't inadvertently change them. 
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Here are several techniques to keep in mind 
when aligning objects. 

• When aligning text, watch for blank spaces before or after 
the text Select the text with the selection pointer (not with 
the Text tool) to see its actual size. 

• If you're aligning the left sides of a group of objects, all 
the objects will align to the leftmost object. Similarly, 
everything will be aligned to the topmost, rightmost, or 
bottommost object when you choose to align the top, 
right, or bottom of the objects, respectively. 

• If you want to center one object exactly inside another, 
align on L/R Centers and T/B Centers. 

• If you want to align objects that cover too large of an area 
to fit on the screen, select and align them while your 
drawing is reduced to fit in the window. 

There are three techniques for selecting more 
than one object. 

The Shift-click technique: 

1. Select the first object. 
2. Hold down the Shift key and click the mouse button to 

select additional objects. 

The Select All command: 

1. Choose Select All from the Edit menu to select 
everything in your drawing. 

2. Shift-click to deselect specific object (other selected objects 
will remain selected). 

The selection box technique: 

1. Point to a blank part of your drawing. 
2. Draw a selection box around several objects. (All the 

objects completely within the selection box will be 
selected. If there is no place to start the selection box, that 
is, if the drawing completely covers the screen, hold down 
the Shift key as you draw the selection box. Then only the 
objects in the selection box will be selected and the object 
the mouse was actually on when you clicked the mouse 
button will not be affected.) 
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Experiment with Duplicates 

Drawing Dotted Lines 

3. Shift-click either to deselect specific objects or to select 
additional objects. 

If you want to select more than what is visible on the screen 
(for example, you want to use Align Objects to line up all the 
text on the entire page), first choose Reduce to Fit and then 
select the objects you want to work with using any of the three 
selection techniques. 

Don't risk ruining your original. 

If you're halfway through your drawing and you're not sure 
how to proceed, don't experiment with the original. Use one 
of the following techniques to protect the original as you 
experiment. And then, if the experiment works, keep the 
duplicate. If the experiment doesn't work, go back to the 
original. 

• Create a duplicate of the object you're working with and 
then experiment with the duplicate. 

• Copy the object, paste it into a new MacDraw document 
(remember that you can have four documents open at 
once), and then paste it back into the original document if 
the experiment works. 

• Choose Save, and then if the experiment doesn't 
work, choose Revert. 

• If you're in the Finder, duplicate the entire document. 

Use an appropriate pen pattern to get a dotted 
or dashed line. 

The dotted line in the Lines menu is not really a dotted line-it 
represents a line of zero width, or "no border." To get dotted 
lines, do the following: 

1. Draw a line or object. 
2. While the object is still selected, choose one of the pen 

styles that achieves the desired effect, such as one of 
the striped patterns. 

j- - - - - - - - - f 
j j 

j 

j ---------..i 
A rectangle ......... with this pen pattern ... produces this effect. 
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Rotating Filled Objects 
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Draw a new object as background and choose 
Send to Back. 

If you want to fill around an object, instead of the inside of an 
object, do the following: 

1. Choose the dotted line from the Lines menu (no border). 
2. Draw a circle or rectangle around the object, completely 

enclosing it. 
3. Fill the new object with the desired background pattern. 
4. Choose Send to Back from the Layout menu. 

If you want to rotate the fill pattern, paste the 
object into MacPaint first. 

In MacDraw, when you rotate a filled object, only the object 
rotates, not the fill pattern. In the example below, notice that 
the orientation of the fill pattern hasn't changed. 

Rotated in MacDraw 

If you want to rotate the fill pattern, too, do the following: 

1. Paste the object into MacPaint. 
2. Rotate it 
3. Paste it back into MacDraw. 

In this example, notice that the fill pattern rotated with the 
object. 

R otal e d in Mac Paint 
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Symmetric Objects 

Multiple, Equally Spaced, 
Objects 

Use Drawing Aids 

Here's an easy way to draw symmetrical 
objects. 

1. Draw one half of the object. 
2. Duplicate it. 
3. Flip it horizontally (or vertically, as appropriate). 
4. Put the two halves together. 
5. Group the objects. 

--+ 
The Duplicate command preserves relative 
spacing between objects. 

(Note: You have already used this technique several times in 
the practice exercises. It is included here for easy reference.) 

1. Draw the original object. 
2. Duplicate it. 
3. Move the duplicate to the correct location relative to the 

original. 
4. Choose Duplicate again-the third object will have the 

same location relative to the second that the second object 
had relative to the first. 

5. Continue to choose Duplicate to create any number of 
objects all equally spaced. 

Draw temporary objects to make drawing, 
aligning, and spacing objects easier. 

Draw temporary alignment aids to help you create your 
drawing. For example, draw a vertical line where you want 
several lines of text to begin to be sure they line up, or draw a 
small box as a spacer to check the spacing between objects. 

If you want to enlarge an object and keep its exact proportions, 
use a small square as a drawing aid. 

1. If you're enlarging several objects, group them together. 
2. Tum the grid on, and draw a 112-inch square. 
3. Place the square close to the object you want to enlarge. 
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4. Select both of them, and enlarge the square to 1 inch. 
The object will exactly double in size in both dimensions. 

D 
You can use the reverse technique for shrinking something 
without losing its proportions. If you only want to enlarge or 
shrink the object a small amount (less than the minimum 
increment of the ruler), turn off the grid and choose Show 
Size from the Layout menu. Then use the size to stretch or 
shrink the square the same amount in each direction. 

When you enlarge objects, work in the middle of a page, or 
even in the middle of several pages, to avoid bumping into the 
edge of the document with the enlarged object 

Create your own rulers. 

Another drawing aid that may be helpful is custom rulers that 
you draw yourself. If you want to establish spacing within 
your drawing that is difficult with the built-in rulers, create 
your own rulers. Draw the outline of the ruler and then use 
the technique described earlier for creating many equally spaced 
objects to draw the tick marks. Be sure to group the 
components of the ruler. 

Once you have drawn your ruler, you can move it to where it 
will be most helpful, or you can rotate it to establish the same 
spacing vertically. You can even shrink it to create another 
ruler with a similar, but smaller, scale. 
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Concentric Circles 

111 11 I 11 I 11 11 I I 11 I 11 111 I 11 I I 
shrXk it 

111111111111111111111111111 J-t Ro~ate_. 

When you're finished using them, remove the drawing aids by 
selecting them and then choosing Cut or Clear, or by pressing 
the Backspace key. 

Use a line as a drawing aid, or use the Align 
Objects capability. 

1. Draw a line at a 45-degree angle (hold down the Shift key 
as you draw the line to draw it at exactly 45 degrees). 

2. Use the Duplicate command to draw a series of equally 
spaced lines along the 45-degree line. 

3. Group the components of your drawing aid. 
4. Set the fill pattern to None. 
5. Start and end every circle on the 45-degree line where one 

of the short lines intersects. (The circles themselves will 
not intersect the line at that point-the boundaries will.) 

6. When you're finished, remove the 45-degree line. 
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The following is another technique for drawing concentric 
circles: 

1. Draw a series of circles with a fill pattern of None. 
2. Select all of them. 
3. Choose Align Objects from Layout menu. 
4. Click on L/R Centers and T/B Centers, and click OK. 

Configure the custom ruler to draw to scale. 

For example, if you want 1 inch to equal 3 feet, do the 
following: 

1. Choose Custom Rulers from the Layout menu. 
2. Click in the box next to Custom. 
3. Leave Major Division Spacing at 1. 
4. Set the Number of Minor Divisions to 3 to see minor 

divisions every 1 foot, to 6 for minor divisions every 112 
foot, and so forth. 

5. Set Numbering Increments to 3, so every major 
division will be the next multiple of 3 feet; that is, the 
1-inch line will have a 3 next to it, the 2-inch line a 6, and 
so forth. 

Custom Rulers: OK 
Ruler: @On corr 

®Inch .. O Centimeter 

ostend11rd ®Custom C11ncel 
Zero Point: O Locked ®Unlocked 

M11jor Oiuision Spacing: 

01/2 ®1 01 1/2 02 
Number of Minor Dlulslons: 

01 02 03 04 05 ®6 

OB 010 012 016 024 032 

Numbering Increments: 

01 02 ®3 04 05 06 

08 010 012 016 024 032 

If you choose Show Size, the size will be shown in 
increments consistent with the ruler. 

To measure a distance, choose Show Size and draw a line 
along the area you want to measure. The size will be the actual 
distance, for example, if the line is actually 2 1/2 inches long, 
the size will be shown on the screen as 7 112 (feet). 
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Smoothing Polygons 

3 6 
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Approximate the shape of an object with a 
polygon, then smooth it. 

A very effective technique for drawing curved objects, 
especially if you want part of the object straight and part 
curved, is to approximate the object's shape with a polygon 
and then smooth the object (the alternative is a combination of 
arcs and lines). 

Draw a polygon that approximates the shape of the object 
you're after. Then use Smooth and Reshape to fine-tune 
your drawing. (See the profile drawing on the next page for an 
example.) 

To smooth a polygon, select the polygon and choose Smooth 
from the Edit menu. All vertices of the polygon will be 
smoothed (see comment on Cusps below for the exception). 
The degree of smoothing depends on the degree of the angle 
and the proximity of the next vertex. You can also choose 
Unsmooth to return the polygon to its original shape. 

When you choose Reshape, you get one handle for each of 
the original vertices. You can also resize the smoothed 
polygon by grabbing one of the eight handles that normally 
surround a selected object. 

The only drawback to this method is that smoothed polygons 
take a lot of memory, and they are slow to move. 

APPLE SUPPORT TRAINING LIBRARY 



( 

( 

Cusps 

Keeping Detail in 
Smoothed Objects 
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Cusps allow you to smooth part of a polygon 
and not smooth other parts. 

A cusp is a vertex of a polygon that will not be smoothed when 
you choose Smooth. To draw a polygon with cusps: 

1. Hold down the Option key and douple-click on each vertex 
that is to be a cusp (not smoothable). 

2. Single click on each regular vertex (smoothable). 
3. To finish the polygon, double-click without the Option 

key, or click on your starting point. 

See the example below and read the MacDraw manual for more 
information about cusps and additional examples. 

Regular Vertices 

Original object After smoothing 

Smoothing very large objects keeps more 
detail than smoothing small objects. 

As was just explained, good technique for drawing freehand 
objects is to approximate the object with a polygon or freehand 
curve and then smooth the object. When you do this, though, 
you lose much of the detail (see example below). 

Original Smoothed 
freehand curve 
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Poster Fonts 

If you fust enlarge.the object, and then smooth it, more of the 
·detail remains (the larger the object, the greater the detail). 

Use a drawing aid to help you enlarge your object and then 
shrink it again after it has been smoothed (see earlier technique 
for using drawing aids). Here is the procedure: 

1. Enlarge the size of your drawing (to 4-9 pages), and move 
the object to the middle of your drawing area to give 
yourself room to work. 

2. Turn the grid on and draw a small square next to the 
object. 

3. Select both objects. 
4. Enlarge the square to two or three times its original size. 
5. While both objects are still selected, choose Smooth from 

the Edit menu. 
6. Shrink the square back to its original size. 

Here is the result of using this technique on the example shown 
earlier. 

Original 
freehand curve 

Smoothed Enlarged 2X 
and smoothed 

Enlarged3X 
and smoothed 

Here's how to create very large characters. 

The numbers in the illustration that follows refer to the step in 
which that phase of the procedure is explained. 

1. Type the character in MacPaint. Choose the largest 
fully formed size available (the size is shown in hollow 
type). 

2. Copy it and paste it into MacDraw-it will be pasted in as 
a bit-mapped character, not as text. 

3. Duplicate the let~r and enlarge the duplicate to the desired 
size for use a~ a drawing guide (see the hint on using · 
drawing aids to enlarge objects). Keep the original for 
reference. The enlarged duplicate will look very blocky 

( ~ .. 

because it is an enlarged bit map. . · ...... 
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4. Tum the grid off and trace the enlarged letter with a 
polygon. Use cusps where you want to keep very sharp 
comers. 

5. Remove the enlarged bit-mapped character. 
6. Smooth and fill the polygon and add anything else that's 

needed, such as the vertical line in the example below. 
7. Choose Reshape Polygon to fine-tune the letter. 

0 
The text will conform to the shape of the 
object, even if you change the object's size. 

There are two kinds of text in MacDraw, "caption" text and 
"paragraph" text. Caption text is entered by choosing the text 
tool and typing. It will continue on one line, adding pages to 
the right if necessary, until you press Return. Most of the text 
you enter in MacDraw is caption text. 

Paragraph text is formed by selecting an object-usually a 
rectangle-and typing. All the text will automatically stay 
within the left and right boundaries of the object. Paragraph 
text will insert its own Return characters to stay within the 
object If you enter more text than will fit in the object, it will 
spill out the bottom, but it will always stay within the left and 
right boundaries. You can't enter paragraph text by choosing 
the text tool from the palette. You must first select an object, 
and then just type. 

The handles that surround an object when it's selected form the 
"boundary." The boundary is always the smallest rectangle 
that can completely enclose an object. 

USING MACDRAW 



66 Useful Techniques 

Paragraph text does not conform to the shape of the object 
itself, but to the shape of the boundary. Therefore, you can't 
automatically have paragraph text conform to the shape of a 
circle or polygon. It will always be in the shape of a rectangle. 

If you select both the text and the object it's in, or group the 
text and the object together, and then reshape the object, the 
text will continue to conform to the shape of the object's shape. 

When grouped with 
the rectangle 
surrounding it, 
paragraph text will 
always conform to 
the shape of the 
rectangle, even if 
the rectangle is 
changed. 

When grouped with the 
rectangle surrounding it, 
paragraph text will always 
conform to the shape of the 
rectangle, even if the 
rectangle is changed. 

You can also change the shape of paragraph text by selecting 
just the text and then moving one of the handles, just as you 
reshape any object. 

Use paragraph text to create columns of text. 

1. Draw a rectangle the width of the column. 
2. Select the object and start typing to create paragraph text. 
3. When you finish typing, cut the rectangle. 
4. The text will keep its shape when you edit it, even after 

you remove the rectangle. 

If you want to keep the rectangle (so you can later change the 
width of the column), but you don't want to see it, change the 
pen pattern to white. This will make the surrounding rectangle 
invisible. 

Converting caption text to paragraph text: 

1. Choose the text tool and triple-click to select the entire 
caption you want to convert to paragraph text (don't use 
the selection arrow). 

2. Choose Copy. 
3. Create some paragraph text by drawing a rectangle the 

approximate width you want the paragraph to be. While 
the rectangle is selected, type two or more letters. 

4. Select the text tool and triple-click on the paragraph text 
(the letters you just typed). 

5. Choose Paste to replace the selected text with the caption 
you copied earlier. It will be pasted as a paragraph of text 
that will word wrap within the confines of the rectangle. 
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Changing the Typestyle 
of a Single Word 

White Text on a 
Black Background 
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6. Remove the original caption text and the rectangle. 

Changing caption text to paragraph text does not remove 
Return characters that were added to make a multi-line caption. 

Enter a highlighted word as a separate text 
object. 

Text entered together is always treated the same. So after 
typing a line of text, if you choose Bold, all the text will 
become bold. If vou're not sure which text was entered 
together, do one of the following: 

• Select the text with the selection pointer. All of the text 
that's within the handles was probably entered at the same 
time, and therefore, will be affected by any type-style 
change. 

• Select the text and change the type style to italic, shadow, 
or some other style that's particularly noticeable. Then, 
once you've identified the text that was entered together, 
choose Undo to change it back to its original type style. 

To change the type style or size of only a single word, do the 
following: 

1. Type that word separately. 
2. Change it to the desired type style. 
3. Leave space in the main body of text for the highlighted 

word. 
4. Move the highlighted word into place in the middle of the 

main body of text. 
5. Add or remove spaces in the main body of text so the 

highlighted word fits correctly. 

Use the Outline option to produce reverse 
type. 

1. Type the text. 
2. Change the type sty le to Outline. 
3. You can also use Bold to make the text more noticeable. 
4. Draw a rectangle (or any other shape) that completely 

encloses the text. 
5. Choose Send to Back. 
6. Choose the black fill pattern. 
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Masks 

Printing Large Drawings 

Use the outline type style for 
white text on a black background. 

A mask Is something you draw over something 
else to hide part of your drawing. 

Masks are the best alternative to erasing only part of an object, 
which is not possible with MacDraw. Instead of erasing, draw 
another object to hide part of your drawing. Here are some 
things to keep in mind when using a mask: 

• Choose no border (dotted line in Lines menu) and choose 
a fill pattern to match the background (usually white). 

• You can use any MacDraw object as a mask. 
• Since masks are meant to be invisible, you may forget they 

are there, so group them with the object they are partially 
covering. 

Here is the order in which the pages print. 

When you print a multipage document, the first column of 
pages is printed first, followed by the second column, and so 
forth. The order in which the pages are printed is shown 
below. 

1 3 

2 4 
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Ill Review 

Overview of MacDraw 

Learn How to Use 
MacDraw 

Practice Using MacDraw 

Integrating MacDraw 
with Other Applications 

Useful Techniques 

MacDraw is a structured graphics editor, 
unlike MacPaint. 

Review 69 

MacDraw graphics consist of independent graphic objects that 
can be moved, edited, and combined to create your drawing. 
The key benefits of MacDraw are as follows: 

• It provides more effective communication. 
• It's accurate. 
• It's integrated with other applications. 
• It produces very high-quality output on the LaserWriter. 
• It's easy to learn. 
• It's much less expensive than a graphic artist. 

Do the Guided Tour and complete the 
practice exercises. 

Refer back to the manual if you have questions on how to use 
specific menu commands. 

Do this exercise to practice many of the 
techniques you learned. 

Use the standard copy-and-paste technique 
to move Information between documents. 

Basically, MacDraw can accept any text or graphics 
information from any application. It doesn't properly display 
tables copied from MacProject, spreadsheets, or data bases. 

You can paste MacDraw graphics into any application that 
understands graphics, including Mac Write and MacPaint You 
can paste MacDraw text into any application that deals with 
text, including MacWrite andMacTerminal. 

These will help you become more productive 
with MacDraw more quickly. 

Refer back to them and distribute them to others so they, too, 
may become more efficient MacDraw users. 
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II ·Resources 

• MacDraw, the owner's manual, Apple Computer, Inc. 

• Becoming a Mac Artist, by V ahe Guzelimian, 
Compute! Publications, Inc. 

• AppleLlnk™ (If you have access to AppleLink, check it 
regularly for additonal information about MacDraw.) 

• Macintosh publications, such as Macworld, 
MACazine, Macintosh Connection, and A+ (Check these 
regularly for additional information and techniques for using 
MacDraw.) 

Apple and the Apple logo are registered trademarks of Apple Computer, Inc. AppleLink, LaserWriter, MacDraw, MacPaint, 
MacProject, MacTermi.nal, and MacWrite are trademarks of Apple Computer, Inc. Macintosh is a trademark of Mcintosh 
Laboratory, Inc. and is being used with express permission of its owner. Microsoft Chart is a trademark of Microsoft 
Corpor(ltion. 
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Supporting MacDraw 

2 Objectives, Materials 
3 Questions and Answers 

Prepare yourself for the questions most commonly asked by 

MacDraw users. 
12 Using the Manual 

Learn how to use the manual as a reference tool. 
15 MacDraw Specifications 

Learn the capabilities and limitations of MacDraw. 
17 Review 
18 Resources 

Read this module to gain knowledge that will help you to 
support users of MacDraw™ software. The module includes 
answers to commonly asked questions, an exercise to help you 
become more familiar with the manual, and product 
specifications. 

Anyone who will supporting MacDraw users will benefit from 
this module. 

Prerequisites 

• Basic techniques for using MacDraw including the use of 
all of the tools in the palette, and each of the menu 
commands. This can be acquired by completing the Using 
MacDraw module and its prerequisites, by completing the 
Guided Tour of MacDraw, or by reading Chapters 1and2 
of MacDraw, the owner's manual. 



2 Objectives 

11 Objectives 

11 Materials 

• Answer questions about how to use MacDraw. 

• State the. product specifications for MacDraw. 

To complete this module, you will need: 

• MacDraw, the owner's manual 
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f II Questions and Answers 

Overview 

Disk Full 

1.'' ... \~ 

( 

Here are the questions most commonly asked 
by MacDraw users, and the correct answers. 

As a support person, you'll be called upon to answer many 
questions about MacDraw. This next section is a summary of 
the questions most commonly asked by users about MacDraw. 

This material does not go into technical detail about the 
product. It only covers what most users will need to know in 
order to use it. 

When printing to an Apple® ImageWriter™ printer, I get a 
message saying that my disk is full. How do I print the 
document? 

The amount of room needed on your startup disk to print a 
document has changed with different versions of the software. 
If you're using Version 1.0 of the Finder and an early version 
of the Image Writer resource file (see icons below), you should 
have space on the startup disk equal to two times the size of the 
document you want to print. If you 're using Version 4.1 or 
later of the Finder and the Image Writer II resource file, you 
only need space on the startup disk equal to the size of the 
document you want to print. 

New Image Writer Resource 

~ 
~ 

lmageWr;ter 

Old Image Writer Resources 

~ er 
lmagewriter 

n 
~ 

lmagewriter 

The solution to this problem is to create more room on the 
startup disk. Here are some suggestions for creating additional 
room. (See the Managing Macintosh Files module from the 
Apple Support Training Library for more information about 
creating additional room on your disk.) 

• Move the document onto a data disk and then remove it 
from the startup disk. 

• If you're using a one-drive system, close the document and 
remove as much as possible from startup disk-all you 
need is System and Finder files, the Image Writer resource, 
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Run Out of Room for 
Your Drawing 

Cut but Can't Paste 

and MacDraw itself. Remove documents, fonts, and desk 
accessories, if necessary. 

• On a two-drive system, copy the application file to the 
data disk and remove it from the startup disk, to make more 
room for the print file on the startup disk. 

• Copy part of the document and paste it into a new 
document. Print each document separately. 

• Print the document from a hard disk. 

• Print the document one page at a time. 

I seem to run out of room very quickly when running 
MacDraw on a Macintosh™ 128K. How can I conserve 
memory? 

The size (complexity) of your drawing is only limited by the 
amount of memory available. Here are some tips for limiting 
the amount of memory needed by your drawing. 

• Simple objects (arcs, circles, boxes), take up very little 
room. 

• Grouping objects takes up a lot of extra room, so don't 
group objects unless necessary. 

• Freehand curves, text, and smoothed polygons also take up 
a lot of memory, so try to use these sparingly. 

Appendix B of MacDraw, the owner's manual, details exactly 
how much memory each object takes. 

I want to consolidate two drawings (or at least move a part of 
my drawing) using Cut and Paste. When I cut the selected 
objects and then try to paste, I get a message saying there's not 
enough memory. What should I do? 

It's too late, you can't do anything. But you can prevent this 
problem in the future! 

When you cut something and then paste it, two copies are 
created: one on the Clipboard, created when you cut the 
drawing, and one in your document, created when you pasted 
it. If your drawing takes up more than 50 percent of available 
memory, there's not enough room for two copies of it. When 
you cut it, there's still only one copy, the one on the Clipboard. 
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Invisible Handles 

Round-Corner Rectangles 
vs. Square Rectangles 

Questions and Answers 5 

When you choose Paste, MacDraw tries to create a second 
copy, but there isn't enough room. Therefore, after you cut it, 
it can't be pasted. 

If you try to copy the drawing before you cut it, there will also 
need to be the same two copies, the original in your document 
and the copy on the Clipboard. So, if you have a large or 
complex drawing you want to cut and paste, first try to copy it. 
If there's not enough memory to copy it, don't cut it or you 
won't be able to paste it back in. 

I have an even number of identical objects exactly on top of 
each other (I selected the objects and then aligned UR 
Middles and T/B Middles). If I select all of them, it looks 
like nothing is selected; I can't see the handles that are normally 
present when something is selected. How do I know whether 
anything is selected? 

Two handles exactly overlapping will cancel each other out, 
and you won't be able to see either. But, they are actually 
there. Work with the objects the same way you would with 
any other selected object. To reshape the objects, simply click 
where you would expect a handle to be. 

What's the difference between a round-corner rectangle 
without any roundi.ng, and a regular rectangle? 

You can create a round-corner rectangle and then take away the 
rounding to make it a regular rectangle. Or you can draw a 
square rectangle and then round the corners. Both are included 
in the palette for convenience. 

The only difference between a round-corner rectangle that has 
been squared off, and a regular rectangle is that the corners of 
the former will print incorrectly (see the example below). 

Made with 
round-corner 
rectangle tool 
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Moving Grouped Objects 

Object Lost Behind 
Another Object 

Superscript and Subscript 

Text Doesn't Line Up 

When I move a group of objects, I can't see all of the objects as 
I move them. How can I tell if the objects are in the correct 
place? 

To solve this problem, try one of the following: 

• Hold down the Option key as you move the object. Every 
object, including text, will be displayed as you move it. 

• Point to a component of the group of objects that will 
enable you to determine whether everything is correctly 
placed. As you move the object, the outline of that 
component will remain visible. 

How can I select an object that I can't see because it's 
completely hidden behind a larger object? 

Try one of the following: 

• Change the fill pattern of the larger object to None so you 
can "see through it" and therefore select the lost object. 

• Select the larger object and choose Send To Back, which 
will send it behind the smaller object. 

• Move or resize the larger object to reveal the smaller object. 

How do I use superscript and subscript? 

MacDraw does not automatically support superscript and 
subscript. To achieve the same effect, type the superscript or 
subscript as a separate text object and leave space in the main 
body of text. Then move the superscript or subscript to the 
desired location. (See the technique titled "Changing the 
Typestyle of a Single Word" in the Useful Techniques section 
of the Using MacDraw module.) 

My document contains several columns of text. The left edge 
of the second and subsequent columns never quite line up. It's 
either a little to the left or a little to the right of the previous line. 
Why can't I line them up? 

There are basically two kinds of fonts: "fixed pitch" and 
"proportionally spaced." Fixed pitch fonts allow exactly the 
same amount of space for every letter, punctuation, and space. 
So an "m" gets just as much space as an "i" or a space. 
Proportionally spaced fonts allow different amounts of space 
for each letter, as needed. So an "m" would get considerably 
more room than an "i" which gets more room than a space. 
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Questions and Answers 7 

Proportionally spaced fonts look better because there is a more 
natural spacing between letters (see the following example ). 

Among the Apple LaserWriter™ printer fonts, Helvetica and 
Times are proportionally spaced fonts, and Courier is a fixed 
pitch font. 

Example of fixed pitch ys. prQpOrtionally spaced fonts. 
Look at each letter and how much room it takes. 

Fixed pitch vs. proportionally spaced. (Helvetica) 
Fixed pitch vs. proportionally spaced. 
(Courier) 

If you use a proportionally spaced font to create columns of 
text, each group of words will take up a different amount of 
space, depending upon the exact combination of letters used. 
So if you then space over to the next column, each line of that 
column will begin in a different place, because each line of the 
previous column ended in a different place. 

There are two solutions to this problem: 

• Use the Courier font, which is fixed pitch. 
• Create your columns as separate text objects, and then place 

them appropriately on the page relative to each other. 

I created my drawing at home and then brought it into the office 
to print it on the LaserWriter. When I opened the document, the 
text was in the wrong font. What happened? 

If the font you actually used is not on startup disk from which 
you're printing, MacDraw will display your text in a different 
font. To avoid this, be sure the font you used to create the 
document is available when you print it 

What is the difference between Tall and Tall Adjusted in the 
Page Setup window, and when should I use each? 

When you print after choosing Tall from the Page Setup 
window, text in a MacDraw document prints the same as it 
looks on the screen. However, it may not be placed correctly 
in relation to graphic objects and the word wraparound of 
paragraphs may be different than it appears on the screen. 

With Tall Adjusted, text is placed correctly in relation to 
objects, and the word wraparound is as it appears on 
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PICT Format 

Width of Printed Page 

Plotter Support 

the screen. However, text looks more "squat" than when /~~ 
printed Tall. .· 

When exact text placement and word wraparound of 
paragraphs are important, use Tall Adjusted. If a document 
is mostly text, or if the appearance of the text is important, 
use Tall. 

What's the difference between saving a document in 
MacDraw format vs. PICT format? 

The file format of MacDraw documents is proprietary 
information. The PICT format is a public, graphics-oriented, 
data format that should be supported by any developer who 
wants open MacDraw documents. (For example, MacPlot uses 
the PICT format to print MacDraw documents on a variety of 
plotters.) If, as a Macintosh user, you want to be able to open 
a MacDraw document from a third-party application that 
supports the PICT format, you must save the MacDraw 
document in the PICT format. (Use the Save as command to 
save the document in both PICT format and MacDraw format.) 

(Note: This does not affect the copying and pas.ting of 
MacDraw graphics between applications.) 

I opened a new MacDraw document, created a one-page 
drawing, and then printed it on the LaserWriter. Why was the 
right edge of my drawing printed on a second page? 

When using a LaserWriter, each page is actually 7 112 inches 
wide. But if the document was created using a disk that 
doesn't have a LaserWriter driver, or was created while the 
Image Writer was the active printer, the window on your 

· screen is 8 inches wide. So anything you draw between 7 1/2 
and 8 inches will be printed on a second page. Once you print 
the document or choose Page Setup, the window on your 
screen will be the correct width. 

Does MacDraw suppon a plotter? 

Yes, with the help of third-party software. One program is 
called MacPlot by Microspot. Listed below are a few of the 
standard plotters it supports: 

• Apple Plotter 
• Calcomp81 
• EpsonH180 
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Pasting into MacWrite 

Pasting Text from 
Other Applications 

Questions and Answers 9 

• Graphtec MPl000-01 and FP5301 
• Hewlett Packard HP7470A, HP7475A, HP7550A, 

HP7220, and HP7221A 

MacPlot also supports the following professional plotters (AO 
or 'E' size): 

• Calcomp 1040 Series 
• Graphtec GP9101 
• Hewlett Packard HP7580B, HP7585B, HP7586B 
• Houston Instruments DMP42/DMP52 

Another program that supports plotters on Macintosh is 
MacPlots II from Computer Shoppe in Greensboro, North 
Carolina. It supports a full range of Hewlett-Packard and 
Houston Instruments standard and professional plotters. 

My drawing is out of proportion when I paste it into 
MacWrite™. It looks like the sides have been squeezed in. 
What happened? 

If the document is wider than the space between the Mac Write 
margins, the document will shrink to fit Sometimes text 
pasted into Mac Write, usually as part of an organization chart 
or flow chart, will look OK on the screen but the placement of 
the margins will cause the text to overlap when printed. 

To avoid distortion, don't paste a drawing into Mac Write that is 
larger than the margins will accommodate. (For more 
information about pasting graphics into Mac Write, see the 
Adding Graphics section of the Supporting MacWrite module 
from the Apple Support Training Library.) 

When I paste a paragraph of text into MacDraw from 
another application, it appears as one long string instead of a 
paragraph. How can I make it into a paragraph? 

Text is pasted into MacDraw either as caption text or paragraph 
text. Caption text is text to be used as a caption under a 
drawing and is always on a single line. Paragraph text will 
word wrap into a paragraph. 

If you first create some paragraph text in MacDraw, and select 
it with the text tool, then when you choose Paste, the text 
you're inserting will be added as paragraph text If you just 
choose Paste without first creating and selecing some 
paragraph text, the text will be inserted as caption text If the 
text is wider than the document, pages will be added to the 
right, as needed. 
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Undocumented Features 

If text is pasted in as caption text, do one of the following: 

Choose the text tool and insert Return characters. 
This makes the text into a paragraph, although the text is really 
just multiple lines of caption text. 

Convert the caption text to paragraph text. Here's 
how: 

1. Choose the text tool and triple-click to select the entire 
caption you want to convert to paragraph text (don't use 
the selection arrow). 

2. Copy the caption. 
3. Create a paragraph 

• Draw a rectangle the approximate width you want the 
paragraph to be. 

• While the rectangle is selected, type two or more letters 
to create a paragraph within it. 

4. Select the text tool from the palette and triple-click on the 
paragraph to select it. 

5. Choose Paste to replace the selected text with the caption 
you copied earlier. It will be pasted as a paragraph of text 
that will word wrap within the confines of the rectangle. 

6. Cut the original caption and the rectangle. 

I've lzeard that tlzere are features of MacDraw not documented 
in tile manual. What are they? 

• There is a new graphics font called Taliesin (Tally-ES-in). 
The guide on the next page shows all the different characters 
that are available. Taliesin characters look best in 18-point 
type, which is the size shown on the next page. 

• A 50 percent reduction option has been added to the Page 
Setup window when printing to the Image Writer. You can 
reduce a document down to 25 percent and enlarge it up to 
400 percent when printing to the LaserWriter. 

• A new desk accessory in the Apple menu, Choose 
Printer (also known as the Chooser), has been added. 
Choose Printer allows you to use your Image Writer from 
either serial port. If you are connected to a LaserWriter 
through an AppleTalk™ Personal Network and you have an 
Image Writer, use the Chooser to identify the connections 
and the printer you want to use. 
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• Using the Manual 

Overview 
. -' .--· 

·This section gives you practice finding.specific 
information in the manual. 

Frequently you'll be asked a question that you won't be able to 
answer immediately. The next best thing is to know where to 
find the answer or how to find it quickly. In orderto do this, 
you must be familiar \Vith the various manuals (and other 
documentation) that c(>ntain the answers. 

This section gives you a chance to familiarize yourself with the 
Mac Write manual·by fmding the answers to specific questions. 

Use the table of contents. and the index. 

This section will ask questions similar to those you can expect 
to get from users. Use the table of contents and the index to 
loca~ the information; then write down the answer and where 
you found it. ' 

When you're fmished, check the Feedback section, which will 
give the answer and the ·chaptet and section in which it w.as 
found. Specific page numb~rs won't be given because they 
might change with manual revisions. · 
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Using the Manual 13 

How can I easily draw a line that's at a 
45-degree angle? 

I want the middle of the ruler to be zero with 
positive and negative numbers. How can I do 

this? ----------------

What can I do to a locked object? 
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Feedback 

Use the Manual to 
Answer These Questions 

How can I easily draw a line that's at a 
45-degree angle? 

Select the diagonal lines tool and hold down the Shift key as 
you draw the line. This will constrain the line to only 45 or 90 
degrees. 

The answer is in the Drawing Lines, Polygons, Freehand 
Shapes, and Arcs section of Chapter 2. 

I want the middle of the ruler to be zero with 
positive and negative numbers. How can I do 
this? 

Move what is called the zero poim. To do this, click on a ruler 
where you want the zero point to be. Or press the mouse 
button on a ruler and then drag it into the window. This will 
set both the horizontal and vertical zero points. (If nothing 
happens when you click on a ruler, choose Custom Rulers 
from the Layout menu and click on Unlocked for the zero 
point.) 

The answer is in the Using Rulers section of Chapter 2. 

What can I do to a locked object? 

You can select it, copy it, and group it. If it's text, you can edit 
it. 

You can't move, cut, clear, duplicate, rotate, or flip it; change 
its size, appearance, or stacking order; or align it to the grid. If 
the object it text, you can't resize or move it, or change its font 
or type sty le. 

The answer is in the Arrange Menu section of Chapter 3. 
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Cc II MacDraw Specifications 

Overview This section covers MacDraw's capabilities 
and limitations. 

In addition to the questions answered in the last section, you 
will receive many questions regarding the capabilities and 
limitations of MacDraw, or topics such as the maximum 
number of pages or objects. This section details the 
specifications for MacDraw that will enable you to answer 
these questions. 

If you want to know the limit for a particular aspect of 
MacDraw and it's not identified below, then no limit has been 
set. See Appendix A of MacDraw, the owner's manual, for 
more information on specifications and preset options. 

Version. The current version of MacDraw is 1.9. The only 
difference between Version 1. 9 and the earlier release, Version 
1. 7, is that a critical problem was fixed. The functionality is 
exactly the same. 

Drawing Size. The maximum drawing size is 96 inches by 
48 inches (54 pages of 8 1/2 by 11 inch paper). 

Number of Active Documents. The number of active 
documents depends on how much memory you have. On a 
Macintosh 512K or a Macintosh XL, you can have four 
documents open at one time. On a Macintosh 128K, you can 
only have one document open at a time (even if you're 
connected to a Hard Disk 20). 

Complexity of the Drawing. The number of objects in a 
drawing is limited only by the amount of memory available. 
Some objects take more room than others. So the maximum 
number of objects is also determined by which objects you 
draw. Apendix B of MacDraw, the owner's manual, details 
exactly how many bytes certain objects take. 

Maximum Number of Fonts . You can have up to 11 
fonts per document. You can have any number of type styles 
and sizes of each font, but no more than 11 different fonts. 

If you have more than 11 fonts in the Sys tern file, only 11 will 
be displayed in the Fonts menu. The fonts available are the 
ones most recently added. 
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Complexity of a Polygon. There is no limit on the 
number of points in a polygon. 

Paper Sizes. MacDraw supports the following sizes of 
paper: 

US letter-8 1/2 inches wide, 11 inches tall 
US legal-8 1/2 inches wide, 14 inches tall 
A4 letter-210 mm wide, 11 2/3 inches tall 
International Fanfold-210 mm wide, 12 inches tall 
Computer paper -14 inches wide, 11 inches tall 

You can also print horizontally on any of these sizes. And, 
with the help of third-party software, you can print on E-size 
and larger plotter paper (see the Questions and Answers section 
for information on plotter support for MacDraw). 

Space Taken per Object. Appendix B of MacDraw, the 
owner's manual contains a table detailing exactly how much 
memory certain objects take. 
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Review 17 

These are the questions you can expect to get 
from users of MacDraw. 

Explanations and solutions are included so you can quickly 
help users with their problems. Refer back to this section for 
the answers to commonly asked questions. 

This section covers the capabilities and 
limitations of MacDraw. · 

This section contains the answers to questions you will get 
regarding the limits of MacDraw. 

SUPPORTING MACDRAW 



18 Resources 

• Resources 

• MacDraw, the owner's manual, Apple Computer, Inc. 

• AppleLink'™. If you have access to AppleLink, check it 
regularly for additonal information about MacDraw. 

• Becoming a Mac Artist, by Vahe Guzelimian, 
Compute! Publications, Inc. 

• Macintosh publications, such as Macworld, MACazine, 
Macintosh Connection, and A+ (Check these regularly for 
additional information and techniques for using MacDraw.) 

Apple does not endorse any of the third-party products mentioned in this module. There are included only to make the 
reader aware of their availability. 

Apple and the Apple logo are registered trademarks of Apple Computer, Inc. AppleLink, AppleTalk, lmageWriter, 
LaserWriter, MacDraw, and MacWrite are trademarks of Apple Computer, Inc. Macintosh is a trademark of Mcintosh 
Laboratory, Inc. and is being used with express permission of its owner. Helvetica and Times are trademarks of Allied 
Corporation, and are used by Apple Computer, Inc. under license. Apple does not endorse any of the third-party products 
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2 Overview 

•Overview 

This module covers a variety of information and techniques for 
supporting MacProject™ software users. It includes a 
summary of the key benefits of MacProject, useful techniques 
for creating, viewing, and modifying your project schedule, the 
answers to commonly asked questions, and product 
specifications. 

Anyone who is supporting users of MacProject should 
complete this module. 

Prerequisites 

• Basic techniques for using the Macintosh™ computer, 
which include using the mouse and menus, opening and 
closing documents, and working with. text. These 
techniques can be learned by completing the Learning to 
Use Macintosh module from the Apple Support Training 
Library, or the Guided Tour of Macintosh, or by reading 
Chapters 1 and 2 of Macintosh, the owner's manual. 

• How to use MacProject. Check the Apple Support Training c / 

Reference Catalog (which is on AppleLink™) for resources 
you can use to learn MacProject. 
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II Materials 

Objectives 3 

• Use all the features of MacProject and state the function of 
each of the menu commands. 

• Answer user-level questions about how to use MacProject. 

• State the product specifications for MacProject. 

• Troubleshoot erroneous project schedules. 

To complete this module, you will need: 

• Macintosh 128K, Macintosh 512K, or Macintosh XL 

• MacProject application disk 

• MacProject, the owner's manual 
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• Introduction 

What is· Project 
Management ? 

PERT and CPM 

Project Management 
Theories 

It's systematically keeping track of all aspects 
of a project. 

Many people are involved in project management today and 
don't even know it. Anyone who has ever built a house, or a 
hotel, or an oil rig, is a project manager. Anyone who has 
helped a company go public, or managed the development and 
release of a new product, is a project manager. 

Project management is applicable to any job that has a definite 
beginning and completion poirtt, and involves a series of steps. 

MacProject is an application that helps a project manager plan a 
project, allocate resources, budget costs, track progress and the 
load on resources, plan cash flow, and, most importantly, 
quickly see the effect of a change on all of these things. 

Here are brief descriptions of two very 
important project management techniques. 

Two tried and true project-management techniques are PERT 
(Project Evaluation and Review Technique) and CPM (Critical 
Path Method). PERT uses boxes to represent individual tasks, 
which combine to make up the entire project schedule. The 
boxes are connected by lines to indicate which tasks must be 
preceed by others and which tasks can be performed 
independently. 

CPM identifies the individual tasks that must be finished on 
time if the entire project is to finish on time. These are called 
critical tasks, and all critical tasks throughout a PERT chart 
form the chart's critical path (hence Critical Path Method). 

MacProject uses both of these techniques. However, it's not in 
the scope of this module to describe them in any more detail. 

Read recommended books and articles to 
learn the theory of PERT and CMP. 

If you want to learn more about the theory of PERT charts and 
CPM, or about some actual examples of using these techniques 
in project management, there's a list of recommended reading 
in the Resources section on the last page of this module. 
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Introduction 5 

Prepare yourself to answer questions about 
project management and MacProject. 

This module assumes you already know how to use 
MacProject If this is not the case, use the materials referenced 
in the Support Training Reference Catalog. 

Just knowing how to use the product is not enough if you're 
going to be supporting other users. The goal of this module is 
to make you a MacProject expert. 

This module includes a discussion of the benefits of 
MacProject, so that you can help people decide if they need it. 
There's a section covering techniques for creating and 
modifying project schedules.· There's also a 
question-and-answer section, and hints to help you 
troubleshoot project schedules. 
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II MacProject Benefits 

Overview 

MacProject Benefits 

These are the key benefits of MacProject. 

In addition to questions about how to use a product, you may 
also get requests for prcxluct recommendations. This section 
briefly lists the key benefits of MacProject to help you make 
appropriate recommendations and to help users decide whether 
MacProject is the program they need. 

Plan and Manage Projects Better. Improve your 
planning, understanding, and control of entire projects and 
project elements. 

Choose the Best of Several Options. Test different 
scenarios to see the impact of changes in resources and time 
schedules. 

Anticipate Problems. Plan ahead and resolve potential 
problems before they arise. 

Manage Resources. Schedule and allocate resources, in 
addition to scheduling tasks. 

Control Costs. Estimate and control· costs and cash flow. 

Identify and Manage Critical Tasks. MacProject 
automatically calculates the critical path and slack time (float). 

Track Progress. Track the project and easily update the 
chart to reflect unforeseen changes. 

Easy to Use. MacProject is easy to learn and use because of 
its interactive nature and its graphical representation of 
information. 

Integrated With Other Applications. Easily create 
powerful reports and perform cost analyses by integrating 
MacProject with other Macintosh applications. You can move 
tables of information from MacProject into spreadsheet, 
data-base, business graphics, and word-processing programs. 
MacProject also allows you to move all or part of the schedule 
chart or timelines into graphics or word-processing programs. 

Proven Techniques. MacProject is based on PERT and 
CMP, which are proven project-management techniques 
(although, you don't have to know them to use MacProject). 
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f 11 MacProject Menus 

Read the Manual 

( 

Read about the MacProject menu commands. 

If you're going to be able to help others use MacProject, you 
must know the function of every MacProject menu command. 
In learning to use MacProject, you used most of the menu 
commands, but probably not all. 

Read the MacProject Menus section of Chapter 4 of 
MacProject, the owner's manual, to ensure you understand the 
function of every menu command. Continue with this module 
when you have finished reading the manual. 
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• Useful Techniques 

Overview 

Have MacProject Available 

The next three sections explain techniques to 
help you get the most out of MacProject. 

Reading a manual and doing some practice exercises is only 
part of learning to use an application. Beyond the basics, there 
are many techniques for producing higher-quality work-and 
doing it more efficiently. The next three sections describe 
many of the techniques that will help you become more 
productive on MacProject more quickly. 

Creating Your Project Schedule will help you create your chart 
more quickly and will decrease the need for revising the layout 
of your project schedule. 

Viewing the Information You Have Entered describes several 
ways to display all of the information you have entered into 
your chart. 

Working with Your Project Schedule describes techniques that 
will help you use MacProject to make decisions and effectively 
manage your project. 

At the end of the module, there are some resources you should 
check for information on how to get the most out of your 
Macintosh and MacProject. There is also a list of suggested 
reading in case you want to learn more about the background, 
theory, or application of PERT and Critical Path Management 
techniques. 

Practice exercises are not included, but you're 
encouraged to try each technique. 

In the next three sections, and for the remainder of the module, 
you are not directed to complete specific practice exercises. 
However, it would be valuable for you to have a Macintosh 
equipped with MacProject available as you read the module so 
you can try the various techniques as you read about them. 
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Use the Manual 

Useful Techniques 9 

Icons Indicate techniques you may already 
know. 

Some of the techniques covered in the remainder of this module 
were already covered in the Guided Tour of MacProject. These 
techniques are identified by an icon in the margin, like the one 
to the left The techniques are repeated in this module because 
they're particularly useful or important enough to deserve 
another mention. 

If you have questions that are not answered 
here, check the manual. 

MacProject, the owner's manual, is your most complete 
resource regarding MacProject. It explains the basic theory of 
project management, how to use all of the menu commands, 
how to get started, and many techniques to help you get the 
most out of MacProject. There is also a very good foldout at 
the end of the first chapter of the MacProject manual that 
reviews all of the components of a project schedule chart. Have 
the manual handy and refer to it if you have questions that are 
not addressed in this· course. 

The Using the Manual section later in this module has you look 
in the manual for answers to typical questions, to be sure you 
can use the manual as a reference tool. 
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Command Key Use It to Invoke menu commands. 

Using the Command key is a technique you can use with all 
Macintosh applications and in all phases of creating, viewing, 
and working with your project schedule. 

Use the Command key in combination with the appropriate 
letter to invoke many of the menu commands. Here's a 
summary of the the menu commands that have Command key 
equivalents. 

Undo xz Plain TeHt XP 
Cut XH Bold XB 
Copy xc lto/ic XI 
Paste XU Underline XU 
Duplicate XO mmnanm@ XO 
Select Rll XR "[j)e:Jc!J©l!lJ XS 

Change to Milestone XM 
Show Task Info XT 
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( II Creating Your Project Schedule 

Starting from Scratch 

( 

( 

Set up the basic structure of your project, then 
fill In the details. 

1. Estimate how many pages your schedule will take and 
choose Set Chart Size from the Layout menu to set the 
number of pages accordingly. Give yourself plenty of 
room to work-though, you can always add more pages 
later. 

2. Start creating your schedule in the middle of the chart. 
You may end up having to add as many tasks to the left of 
where you start as you add to the right. If you later want 
to reposition your project schedule, it's easy to do while 
viewing the entire chart. 

3. Draw one task box, and then duplicate it several times so 
you have a pool of task boxes to draw on. (This makes 
all of your task boxes the same size, so your document 
looks neater and more attractive.) 

Or use the third technique under Duplicating Task Boxes 
(the next key point) to create additional task boxes with 
dependency lines. 

4. Position the task boxes where you want them and enter the 
task name into each. Don't enter other task information or 
dependency lines (the lines connecting the task boxes) 
yet 

5. Once your task boxes are in place, draw the dependency 
lines and fill in the task information. 

(Note: See the Steps in Creating a Project section of 
Chapter 2 of MacProject, the owner's manual, for some 
additional suggestions on creating your project schedule.) 
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Duplicating Task Boxes 

~ 
~ 

Grouping Tasks by 
Function and Time 

There are three ways to duplicate a task box: 

Copy and Paste. 

1. Select a task box. 
2. Choose Copy from the Edit menu. 
3. Click where you want to put the new task box. 
4. Choose Paste from the Edit menu. 
5. A box identical to the one you copied will be added to 

your schedule chart. 

Use the Duplicate command. 

1. Select a task box. 
2. Choose Duplicate. 
3. You'll get a box exactly the same size as the original, 

which you can then move anywhere on the schedule. 
The name of the original task, or any other information 
associated with it, is not included in the duplicate. 

Click and Drag technique. 

1. Position the pointer inside a task box. 
2. Hold the mouse button down and move the pointer out 

of the task box as if you were going to draw a 
dependency line. 

3. Continue to hold the mouse button down and move the 
pointer to the desired location for the new task box. 

4. Release the mouse button. 
5. You'll get a task box exactly the same size as the 

original, and a dependency line will have been drawn 
to connect the two tasks. 

This makes it easier to see the tasks to be 
completed by each group. 

• If you have several major groups working on the same 
project (for example, Sales, Marketing, and Training) and 
they all have independent tasks, group all the tasks for each 
department together. For example, the top of your page 
could have all the tasks for which Sales is responsible, 
while the middle is for Marketing, and the bottom is for 
Training. 

• Use page breaks as major time divisions; for example, have 
one page represent a month or a quarter. 

• Add annotations to label the different groups or the different 
time segments. 
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• Combining these two techniques will help you see who is 
doing what at any given time. 

Jan Feb Mar 

Sales 

Marketing 

Training 

What are milestones and where do you use 
them? 

Here are several important facts to remember about milestones. 

• Milestones are visual cues marking significant places or 
events in the project. 

• Milestones are used to indicate the start and completion 
of the project 

• They can represent a key goal in the middle of a project, 
showing the completion of several tasks or aspects of the 
project. 

• The names of milestones are normally be in the past tense 
(for example, "Materials Purchased" or "Plan Approved"). 

• Milestones can also function as comments, reminders, or 
alert indicators. 

• Milestones don't usually have a duration, but they often 
have a cost or income. 

• When dates are displayed, milestones include the year. 

• In the schedule chart, milestones are rounded rectangles. In 
the timelines, milestones are indicated by diamonds. 

• Milestones make a project schedule easier to read and 
understand. (See the example on the next page.) 
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Making Room for 
New Tasks 

A project schedule without milestones: 

Visit 
Locations 

Arrange 
Financing 

Investigate 
Building in 
the Area 

Investigate 
Zoning Laws 

Prepare 
Offer 

This chart is very confusing. The following chart shows the 
same tasks, but with a milestone in the middle. Notice how 
much easier it is to read. 

The same project schedule with a milestone: 

Investigate 
Building in 

Visit the Area 
Locations 

.,,- D 'd ""\ Investigate ec1 eon ~ 
)... Location ""'-- Zoning Laws 

"""' Arrange 
Financing Prepare 

Offer 

In one step, you can move everything to the 
right of a particular task box. 

Move a task box or milestone far enough to the right to make 
room for the new tasks. Be sure it at least partly overlaps one 
of its dependent tasks to the right of its original position. All 
the tasks linked to, and to the right of, the task you moved will 
be moved the same distance. 
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Multiple payments can be much more 
expensive than single payments. 

Use single payment if you want to pay a resource only once for 
all tasks worked on during a single unit of time. For example, 
a person may be scheduled to work on more than one task in a 
single day, but he's still going to be paid for only one day's 
work. Choose Single Accrual Method for that resource. 

Use multiple payments to pay a single resource each time it's 
assigned to a task during a single unit of time. For example, if 
the resource is a trucking company, you'll have to pay for 
every truck that you hire, which is determined by how many 
tasks involve shipment of materials on that day. Choose 
Multiple Accrual Method for that resource. 

Use text to annotate your chart. 

Include in your project schedule any notes and reminders about 
important events that may affect your project You can enter 
text anywhere on the schedule chart. 

Annotation 
Text 

! 
Be sure Dave's 
back in town 

Decide on 
Location 
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Setting Dates Set the Earliest Start, Latest Finish, or other 
key dates in your project. 

• Set the Earliest Start date of the start milestone (or leftmost 
task) to determine the project's earliest possible completion 
date (the Earliest Finish date on the final milestone or task). 

• Set the Latest Finish date of the final milestone (or 
rightmost task) to see when you must start the project in 
order to finish it on time (the Latest Start date of the start 
milestone or task). 

• Set the date of a key task or milestone that you know must 
be completed by, or that can't be started until, a certain date. 

To set a date, select the task or milestone and then choose either 
Set Earliest Start or Set Latest Finish from the Dates 
menu. You'll get the dialog box shown below. 

Set Start Date: 
@ 

~/02/86 @ 09:00 

Set Clear ( Cancel ) 

Click on the digit you want to change, and then either type the 
new number or click on the up or down arrow to increment or 
decrement the digit, respectively. (For the remainder of this 
module, the dates you specifically set are called "fixed dates.") 

All fixed dates are underlined on the schedule chart and they 
override any dates MacProject calculates. Other dates are 
calculated on the basis of the dates you have set. 

If you want to clear a date you set previously, to allow 
MacProject to calculate the date for you, select the milestone or 
task, choose Set Earliest Start or Set Latest Finish, and 
click Clear. 

Don't set too many dates. 

Setting too many dates may cause confusing results. Set only 
the dates you know are fixed, and allow MacProject to calculate 
the other dates and determine the best possible schedule. 
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( II Viewing the Information You Have Entered 

Moving Around in a 
Large Schedule 

~ 
~ 

Using the Keyboard to 
Display Task Information 

Indicate where on the chart you want to work: 

1. Choose Show Entire Chart from Layout menu. 
2. Move dotted rectangle to the area you want to work on. 
3. Click outside the chart. Your document will now display 

the portion of the chart that was inside the dotted rectangle. 

s File Edit Chart Task 

Portion of chart to be 
displayed upon 
returning to normal 
size. 

Dotes 

From this reduced view, you can also move the 
entire chart on the page. 

Just press the mouse button while pointing to any part of the 
chart outside the dotted rectangle and move the chart where you 
want it. You might do this to create room near one part of the 
chart, or to prevent a task from crossing a page break (which 
makes it hard to read when printed). 

Use the Tab key and the Return key. 

1. Select a task and press the Tab key to open the Task 
Information window. 

2. Press Tab again to move to the next field in the Task 
Information window. When you get to the last field, press 
Tab again to go back to the first field. 

3. Press Return to select the next task on the right of the 
task currently selected. The newly selected task does not 
have to be dependent upon the original task. The Task 
Information window doesn't have to be open in order to 
use the Return key to move between tasks. 

SUPPORTING MACPROJECT 



18 Viewing the information You Have Entered 

Viewing Task Information 
with Time-Line Charts. 

Moving Between Two 
MacProject Documents 

4. The schedule will automatically scroll to bring newly 
selected tasks fully into view. 

5. When you get to the last task or milestone in the schedule, 
press Return again to select the first task or milestone in the 
schedule. 

You can view task information while any one 
of the time-line charts is displayed. 

The Task Information window stays visible if you select one of 
the time-line charts, but you can't use Return to move between 
tasks. When you click on a task in a time-line chart to display 
its task information, the time-line window covers most of the 
Task Information window. You should move the time-line 
window down the screen so that both windows are visible at 
the same time. (See the previous comment about using the Tab 
and Return keys to display the task information from the 
Schedule chart.) 

Use the Document Directory dialog box. 

If you have a MacProject document open and you want to 
open a different MacProject document, you could choose Quit 
from the File menu and then open the other document from the 
Finder. But there is a faster way. 

1. Choose Close from the File menu or click in the close 
box. 

2. Choose Open from the File menu. A list of all the 
MacProject documents on that disk will be presented in the 
Document Directory dialog box, as shown below. 

Aduertising Pion 
Documentotio ... ( Open ttJ Hard Disk 
New Building 

[ Eject ) 

Cancel ) ( Driue ) 
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3. If you want to open a document on another disk, either 
click Drive to look at the documents on the disk inserted 
in the other drive, or click Eject and insert the disk 
containing the document you want. 

4. Open the document Click once on the name of the 
document to select it and then click Open, or double-click 
on the name of the document. 
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II Working with Your Project Schedule 

Calculating Dates 
Backwards 

Tracking the History 
of a Project 

Tracking Your Progress 

Use this technique if you are working toward 
a fixed deadline you must meet. 

1. Select the last task or milestone. 
2. Choose Set Latest Finish from the Dates menu. 
3. Set the Lastest Finish date to the date by which you must 

finish the project. All the Finish Dates will be calculated 
based on the date you entered. 

4. The Latest Start date of the first task will be the date by 
which you must begin in order to finish on time. 

To see the dates, choose Show Dates from the Dates menu 
and display the Latest Start date (in the lower left corner) and 
the Latest Finish date (in the top right comer). 

Keep copies of each version of the project 
schedule. 

• Add annotations when you make major changes. 
• Freeze and date the schedule at key points during the 

project. Then duplicate the document before going on to 
make revisions and continuing to track the project. 

• Accumulate schedules from each critical phase of the 
project. 

Tracking your progress manually works best. 

1. Print your schedule chart. 
2. If it's several pages long, tape the pages together. 
3. As you complete each task, highlight the task box with a 

color pen. You '11 be able to see your progress at a glance. 
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Too Long 
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Try "What if?" scenarios to see what must be 
done to finish the project on time. 

If your project is taking too long and you want to see what it 
would take to finish earlier, choose Calendar from the Dates 
menu. You'll get the clock and calendar, shown below, which 
you can change to reflect how many hours per day and how 
many days per week are being spent on the project. 

12 Noon 
Calendar Range : 1 985-1 987 

OK 
~====t Click in the black t===l 

area to add hours 
to the work day. 

Click on black 
days to add them 
to the work week. 

Do one of the following and see how much sooner you could 
finish the project: 

• Increase the number of hours worked each day. 
• Increase the number of days worked each week .. 

Be sure to adjust costs (for example, are extra hours per day, 
or days per week, paid as overtime?). MacProject doesn't 
automatically adjust for overtime, so you'll have to account for 
such changes manually. 
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Changing the Calendar 
Halfway Through a Project 

Splitting Someone's Time 
Between Tasks 

How can you make a change that affects only 
part of the project? 

What if halfway through a project you realize you need to 
speed things up to get the project done on time? If you change 
the calendar to see what would happen if everyone started 
working 10-hour days, it would change the calendar for the 
entire project, not just the part that's yet to be completed. So, 
you would pick up an unrealistically large amount of time. To 
change the calendar for only the unfinished part of the project: 

1. Remove all of the dependency lines linking the part yet to 
be completed to the part that has already been completed 
(select the dependency line and choose Cut). 

2. Add a new start milestone (or task) where you removed the 
dependency lines. 

3. Connect the milestone to the first task(s) of the portion yet 
to be completed. 

4. Set the starting date of the milestone (choose Set Starting 
Date). 

5. Make the desired change to the calendar. 

6. Ignore the dates for tasks that have already been completed 
(the part to the left of your new start milestone). Tasks to 
the right will show the effect of the calendar change and 
will show a new finish date. 

Enter the amount of time spent on each task. 

If you have a person working on two tasks at once, MacProject 
will assume that the person can do two things at once, which 
may be impossible. 

To ensure that you have truly accounted for all the time each 
person will need to complete his assigned tasks, do the 
following: 

1. Be sure the time scale is set to the increment appropriate for 
how you're going to schedule each person's time. For 
example, if someone has three tasks to complete in two 
days, set the time scale to hours. 

2. For each task the person is working on, enter the amount 
of time he will be working on that particular task. 
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What if most of your project is in days, but 
you want to schedule part of it in hours? 

1. In the schedule chart, enter a single task for the entire 
portion of the project that will be scheduled in hours. 

2. Create a new project schedule chart that divides the one 
task into its component parts, scheduled in hours. 

3. Enter the total duration of the Hours chart as the duration, 
in days, of the single task in the Days chart (see the 
example below). 

Scheduled 
in days 

Scheduled 
in hours 

This technique works for any two units of time, not just days 
and hours. For example, if your main schedule chart is 
scheduled in months, you can create a subordinate chart in 
weeks or days. 

(Note: You can't link two charts. If the Hours schedule 
changes, you must update the Days schedule manually.) 
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II Questions and Answers 

Overview 

Slack Time 

These are the questions most commonly asked 
by MacProject users, and the correct answers. 

You should now know how to use MacProject, as well as 
many of the techniques that most users take months to 
discover. But as a support person, you'll also be called upon 
to answer other users' questions about the program. This 
section is a summary of the most commonly asked questions 
about using MacProject. 

This material does not go into technical detail about the 
product It only explains what most users will need to know in 
order to use it. 

What's "slack time"? 

Slack time is the amount of extra time you have available to 
finish a particular task. In other words, it's how late that task 
can be without affecting the rest of the project. It's calculated 
by figuring the number of days between the Early Start date 
and the Late Finish date, and then subtracting the duration of 
the task. In other words, slack time is the difference between 
the Latest Finish and Earliest Finish dates. 

Duration 

Earliest Start-. •Earliest Finish a t Slack Time 

Latest Start Latest Finish 
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For example, if the dates are as shown below, and the task has 
a duration of 15 days, you'll have 5 days of slack time. 
(Remember that weekends don't count.) 

Duration 
15 days 

1/2 ~ • 1/23 

~ i Slack Tilne 
L=-_J + 5 days 

1/7 1/30 

When printing to an Image Writer™ printer, I get a message 
saying my disk is full. How do I print the document? 

You need free space on the startup disk equal to approximately 
twice the size of the document you want to print, so you will 
need to create more room on the startup disk. 

Here are a few suggestions for creating more room on your 
disk and some work-arounds for this problem. 

• Move the document you are trying to print onto a data disk 
and then remove it from the startup disk. 

• If you are on a one-drive system, close the document and 
remove as much as possible from the startup disk-all you 
need is the System, Finder, and Image Writer files, and 
MacProject itself. Remove documents, fonts, and desk 
accessories, if necessary. 

• On a two-drive system, copy the application to the same 
disk you moved your document to and remove it from the 
startup disk. This will free up additional room on the 
startup disk for the print file. 

• Print the document from a hard disk. 

• Print the document one page at a time. 

(See the Managing Macintosh Files module for more 
information about creating additional room on your disk.) 
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Using Quarterly 
Time Lines 

Displaying Information 
Around Task Boxes 

Avoiding Overlapping 
Task Boxes 

When I display the time line by quarters, the time divisions are 
not every three months. Why not? 

This is a problem with MacProject. The time divisions are 
every twelve weeks, not every three months. So, by the end of 
four quarters you're four weeks short of a full year. 

How do I display the information I want around a task box? 

You can display only one item at each of the four comers of the 
task box. Choose Show Dates from the Dates menu to see 
what can be displayed at each comer of the task box (see the 
screen below). All of the information about a task can be 
displayed somewhere around the task. Choose Resource at 
more than one comer if you have more than one resource 
working on any particular task. A different resource, up to a 
total of four, will be displayed at each comer. 

0 Duration 
O Resource O Resource 
O Enrliest Stnrt O Enrliest Finish 

B 
0 lntest Stnrt 
0 FiKed Cost 
0 Resource 

O Lntest Finish 
O FiKed Income 
0 Resource 

OK 
( Cancel ) 

How do I prevent information from different task boxes from 
overlapping? 

Try one of the following: 

• Choose a smaller type size. This will change the type 
for all the tasks and milestones, but not for annotations. 

• Make your entire document larger (choose Show Chart 
Size from the Layout menu) and spread out your task 
boxes. 
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What does it mean when an individual date is displayed in 
bold? 

5/14 5/14 

Decide 
on Location 

A bold date indicates that the date is theoretically impossible to 
meet. This is because you have more than one fixed date and 
the tasks between the fixed dates take longer to complete than 
you have allowed. Check all fixed dates in your schedule and 
make any necessary changes. 

My total expenses are higher than what I think they should be. 
What might cause this? 

Check the payment method for each resource. Resources that 
are people are usually set to Single Accrual Method. A 
multiple accrual means that if a person is scheduled for more 
than one task at a time, he is getting paid more than once for a 
single day's work. This could inflate your estimated costs. 
(See the comment titled "Single vs. Multiple Payment" in the 
Creating Your Project Schedule section of this module.) 

There are two different types of highlighting around task 
boxes. What does each mean? 

Critical Task 
Unachievable 

Task 

The two types of highlighting around task boxes are for critical 
and unachievable tasks. These may be present when you have 
negative slack time. Remember, slack time is the amount of 
extra time you have available to finish a particular task. 
Negative slack time means that the tasks between two fixed 
dates take longer than you have allowed. Therefore, you can't 
possibly finish on time. 

For example, let's say you set the Earliest Start date for one 
task to February 1, and the Earliest Start date for a subsequent 
task for March L If the intervening tasks take 25 days, you 
will have negative slack time. It's theoretically impossible to 
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finish 25 days work in the 20 days that are available. You need 
to revise your schedule to eliminate the negative slack time. 

• Critical Tasks. These boxes are highlighted on all sides. 
Critical tasks are those that have the least amount of slack 
time in the entire project (usually equal to, but never greater 
than zero). These tasks need close attention to be sure they 
don't fall behind schedule. 

• Unachievable Tasks. These boxes are highlighted on 
vertical sides only. These are tasks with slack time less than 
or equal to zero, but greater than the slack time of the tasks 
along the critical path. An unachievable task would have to 
be started before its earliest start dat.e to keep the project on 
schedule. 

You'll only get unachievable tasks if you have more than 
one fixed date in your project. 

Example of crltlcal and unachievable tasks. 

Duration I Critical task 

613 30 ~ 

Earliest 
Start date 

I 
~ 0 

Decide on 
Location 

Investigate 
Building in 

the Area 
7/1 

25 

Investigate 
Zoning Laws 

613 15 

Non-critical task----1 Prepare Offer 

7/1 

Unachievable task 

Present 
Off er 

0 

1llfil 

I 
Latest 

Finish date 

The "Investigate Building in the Area" task is critical because it 
has the longest duration. The "Investigate Zoning Laws" task 
is unachievable because it has a shorter duration than the critical 
task, but it would still have to start before its earliest start date 
if it's to be finished on time. Its slack time is negative because 
its duration is longer than the number of days between the 
Earliest Start date and the Latest Finish date, which have been 
specifically set. 

To eliminate the unachievable task, change the fixed dates or 
change the duration of the task so that it's possible for it to be 
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completed on or before the Latest Finish date. You should use 
the same techniques to also eliminate the negative slack time in 
the critical t.ask. 

What does it mean when there are question marks where the 
dates should be? 

10112 ?? 
Investigate 
Building in 
the Area 

The dates of your project go beyond the calendar range set for 
the project. To correct this, do the following: 

1. Choose Calendar from the Dates menu. 
2. Widen the range for the project by increasing the Calendar 

Range (the range can be up to 10 years). 

How can I schedul.e more than one project on the same 
document? 

You can have more than one st.art milestone in the same project 
schedule and thereby have two independent schedule charts in 
one document. But your resources will be scheduled as if for 
one big project. To completely separate the projects, create 
separate documents or give your resources two different 
names, such as DA VIDl and DA VID2. 
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Moving Information Into 
Other Appllcatlons 

How do I move something from MacProject into another 
application? 

To move something from your project schedule to another 
document, use the same technique you would use to move 
anything between any two documents: 

1. Select what you want to move. 
2. Copy it. 
3. Open the second document (preferrable using the 

Switcher). 
4. Indicate where you want to add the information. 
5. Choose Paste. 

Use standard techniques to select all or part of any MacProject 
chart or table. (For specific selection techniques see the section 
on Selecting in Chapter 2 of the MacProject owner's manual.) 

What integration is possible? 

There are two types of information in MacProject: 

• Graphics: Schedule Chart, Resource Timeline, and Task 
Timeline; and 

• Tables: Task Cost Entry, Resource Cost Entry, Cash 
Flow Table, and Project Table. 

Refer to the table below for what types of information can be 
moved from MacProject into other Macintosh applications. 

Pasted into 
This Am>lication 
MacDraw'™ 
MacPaint™ 

MacProject 

Mac Terminal'™ 

Mac Write'™ 

Spreadsheets 
Data bases 

Limits/Comments 
No limits 
Tables and graphics; limited to one 
screenful at a time 
Schedule Chart only; keeps task info 
and dates 
Tables (columns separated by Tabs); 
complete files transferred using the 
XModem protocol 
Tables and graphics; limited to width of 
1 vertical page; if moving a table, set 
Tabs in Mac Write to separate columns 
Tables only 
Tables only if data base can accept a 
series of fields separated by Tabs and 
Returns 
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The only information you can paste into MacProject is: 

• Small selections of text (a few words), which can be pasted 
into a task box, the Task Cost Entry table, or the Resource 
Cost Entry table. 

• All or part of another Schedule Chart. 
• ThinkTank outlines and headings (that can then be expanded 

into full project schedules.) 

Refer to MacProject, the owner's manual, for more information 
about moving information between applications. (Look in the 
index under "Copying to another application.") 

When I try to move my schedule chart into another MacProject 
document or into a MacDraw document, I get a message saying 
that my document is too big to move. How can I move it? 

Use the Shift-click or the selection box to move the chart piece 
by piece. 

Why does my system crash when I copy the Project Table? 

MacProject will crash if a task name is longer than 63 
characters and you copy the Project Table. You'll have to 
restart your Macintosh and you 11 lose all changes since you 
b1st saved the document. There is no solution, so-don't do it! 

Why is it that when I print the Schedule Chart on the 
LaserWriter™ printer, the dates are printed in the wrong type 
style, usually hollow type? 

This is a bug in MacProject. To work around it, paste the 
entire project schedule into MacDraw and print it from there. 
Or, print the document on an Image Writer. 
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• Troubleshooting Techniques 

Overview 

Show Entire Chart 

Here are some techniques to help you solve 
complex problems. 

This section provides some general techniques to help you 
figure out why a particular schedule doesn't work the way it 
should. Problems may manifest themselves as bold dates or 
unachievable tasks, which indicate theoretically impossible 
dates and negative slack time, or as unrealistic beginning dates, 
completion dates, or expenses. 

Does the chart look "normal"? 

The first step is to choose Show Entire Chart from the 
Layout menu. Does the chart look "normal" ? In other 
words, does anything jump out at you as being obviously 
wrong or out of place? Here are some specific things to look 
for: 

• Are there orphans (tasks with no predecessors or 
successors)? If so, connect them to the rest of the chart, or 
remove them. 

• Are all the tasks connected? If not, add any necessary 
dependency lines. 

• Are there any fixed (underlined) dates? Use fixed dates 
only when you know the date is fixed. If you include too 
many fixed dates, the schedule becomes confusing, and 
problems may arise. 

• Are there any bold dates? If so, this date is theoretically 
impossible to meet and you should change it . 

Only fixed dates, which are normally underlined, will 
appear in bold type. A bold date indicates a fixed date 
which is impossible to keep. Dates that aren't set are. 
automatically calculated by MacProject, which won't 
calculate a date that's impossible to meet. 

• Are there any unachievable tasks? If so, the schedule as it 
currently stands is theoretically impossible. Check fixed 
dates and durations and revise the schedule as necessary. 
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Display All Dates 

Find Cause of 
Impossible Dates 
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Dates help you understand what's really 
happening. 

You can get a much better idea of what is happening and where 
problems may lie by displaying all the dates. It helps you 
understand why. a particular task is critical or unachievable. 
You can see which dates are set and where the negative slack 
time-which may be causing the problems-is occuring. 

Check all the fixed dates to find the one that's 
causing the problem. 

1. For all fixed dates, write the date as an annotation next to 
the task. 

2. Clear all fixed dates to allow MacProject to calculate the 
dates on its own. If there are no fixed dates, there will 
not be any bold dates or unachievable tasks. 

3. Reset the dates one by one. You will then be able to see 
the effect of each fixed date, and determine which one is 
causing the problem. 
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• Using the Manual 

Overview This section offers practice in finding specific 
information in the manual. 

Often you will be asked a question that you can't answer 
immediately. You should know where to find the answer and 
how to find it quickly. In order to do this, you must be 
familiar with the various manuals (and other documentation) 
that contain information about MacProject. 

This section gives you a chance to familiarize yourself with the 
MacProject manual by finding the answers to specific 
questions. 

Use the table of contents and the index. 

This section will ask questions similar to those you can expect 
to get from users. Use the manual's table of contents and 
index to locate the information, then write down the answer 
and where you found it. 

When you're finished, check the Feedback section, which will 
give both the answer and the chapter and section in which it 
was found. (Specific page numbers won't be given because 
they might change with manual revisions.) 
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Practice 

Use the Manual to 
Answer These Questions 

Using the Manual 35 

How are the Fixed Dates identified on the 
Schedule Chart? 

How do you set the size of your chart ? 

What are the various time intervals available 
for time lines? 
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Feedback 

Use the Manual to 
Answer These Questions 

How are the Fixed Dates identified on the 
Schedule Chart? 

Fixed Dates are underlined. Dates calculated by MacProject are 
shown in plain type. 

The answer can be found in the Setting Dates section of 
Chapter 2. 

How do you set the size of your chart ? 

Choose Set Chart Size from the Layout menu. 

The answer can be found in two places (you only need to have 
identified one of them): It's in the Making a Chart a Larger 
Size section of Chapter 2 and in the Layout Menu section of 
Chapter4. 

What are the various time intervals available 
for time lines? 

1 minute, 30 minutes, 1 hour, 1 day, 1 week, 2 weeks, 
1 month, 1 quarter. 

The answer is in the Dates Menu section of Chapter 4. 
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<:n II MacProject Specifications 

Overview 

Specifications 

( 

This section covers the capabilities and 
limitations of MacProject. 

In addition to the questions addressed in the last section, you'll 
be asked many questions regarding the capabilities or 
limitations of MacProject. (For example, How many pages? 
Total number of tasks? and so forth.) This section details the 
specifications for MacProject to enable you to answer these 
questions. 

Capacity. 200 tasks on a Macintosh 128K; 2000 tasks on a 
Macintosh 512K or Macintosh XL. 

Number of Resources. Maximum of 6 per task; 50 per 
project. 

Size of Document. Maximum size: 94"x48" (up to 54 
pages). 

Number of Holidays. Unlimited. 

Time Span. Project can span up to 10 years. 

Task Box Title. Maximum of 255 characters (technically). 
Practically, the limit is 63 characters. (See the comment titled 
"System Crashes When Copying Project Table" in the 
Questions and Answers section of this.module.) 

Fonts. Each annotation limited to one font, size, and style. 
You can work around this by clicking the mouse button to start 
a new annotation. 

Number of Different Fonts. There is no limit to the 
number of different fonts and type styles you can have in the 
annocation portions of a document (all of the task boxes are 
always in the same font). However, there is a limit to the 
number of fonts that will fit in the Font menu. 

On a Macintosh 128K or Macintosh 512K, the names of only 
20 fonts can be seen in the menu. If you have more fonts than 
that, some will run off the bottom of the screen and will not be 
selectable. On a Macintosh XL you can have up to 22 fonts in 
the Font menu. (See the Supporting the Font/DA Mover 
module from the Apple Support Training Library for more 
information about adding and removing fonts.) 
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II Review 

How to Use MacProject 

MacProject Benefits 

Advanced Techniques 

Questions and Answers 

Troubleshooting 
Techniques 

MacProject Specifications 

Use existing MacProject training materials to 
learn how to use the application. 

Knowing the key benefits will make it easier to 
make appropriate recommendations. 

• Plan and manage projects better. 
• Choose the best of several option. 
• Anticipate problems. 
• Manage resources. 
• Control costs. 
• Identify and manage critical tasks. 
• Track progress. 
• It's easy to learn and use. 
• It's integrated with other Macintosh applications. 
• It uses proven project management techniques (PERT and 

CPM). 

These will help you become more productive 
with MacProject more quickly. 

Refer back to them and distribute them to others so they, too, 
can become more efficient MacProject users. 

These are the questions you can expect to 
get from users of MacProject. 

Explanations and the answers are included so you can quickly 
help users with their problems. Refer back to this section for 
the answers to commonly asked questions. 

These will help you find the solution when 
something is wrong with a project schedule. 

This section covers the capabilities and 
limitations of MacProject. 

A lot of user questions concern the capabilities of MacProject. 
This section contains the answers to this type of question. 
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• MacProject, the owner's manual, Apple Computer, Inc. 

• Macintosh Software Selling Guide (Distributed in May 
1985) 

• Macworld (Read the July/August 1984 issue for 
additional MacProject hints and techniques. Other 
publications such as A+, Macintosh Connection, and 
MACazine often contain helpful information about using 
Macintosh and MacProject.) 

• AppleLink (If you have access to AppleLink, check it 
regularly for additional information about MacProject.) 

The following resources are recommended if you want 
information on the theory of project management, PERT, and 
CPM. 

BOOKS: 

• PERTICPM, As Easy As ABC, by John Mulvaney 
(Published by Management Planning and Control Systems) 

• Managing High Technology Programs and Projects, by 
Russell D. Archibald [Published by Wylie Interscience 
Books, (ISBN - 047103308-1)] 

MAGAZINE ARTICLES: 

• "Hard-Hat Management: Two On-Site Tools," by Richard 
Parry, Interface Age magazine, Februrary 1981 (This 
provides a basic definition of PERT and CPM.) 

• "When the Objective Is Efficient Project Management," by 
Kevin Strehlo, Personal Computing, January 1984 (This 
article defines the key concepts, and discusses the 
limitations, of PERT and CPM.) 

• "PERT For Monthly Financiaf Closing," by Alvert P. 
Ameiss and Warren A. Thompson, Management Adviser, 
January-February 1974 (Using PERT charts to prepare 
financial statements.) 

• "Bringing Order to Project Jumble," by Elisabeth Horwitt, 
Business Computer Systems, December 1983 (This 
article describes how personal computers can be useful 
when scheduling projects. It briefly discusses the 
theories of PERT and CMP.) 
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2 Overview 

II Overview 

Read this module to learn how to support the Mac Write™ 
software. The module includes key Mac Write benefits, how to. 
work with graphics, information on advanced techniques, the 
solutions to commonly asked questions, and product 
specifications. 

Anyone who is supporting people who use Mac Write should 
complete this module. 

For information regarding using Mac Write with the Apple® 
LaserWriter™ printer, see the Using the LaserWriter module 
from the Apple Support Training Library. 

Prerequisites 

• Basic techniques for using the Macintosh™ computer such 
as how to use the mouse and menus, how to open and close 
documents, and how to work with text. You can learn these 
by completing the Learning to Use Macintosh module or the 
Guided Tour of Macintosh, or by reading Chapters 1 and 2 
of Macintosh, the owner's manual. 

• Knowledge of how to use Mac Write, which can be acquired 
by completing the Guided Tour of Mac Write, or by reading 
Chapters 1and2 of MacWrite, the owner's manual. 

APPLE SUPPORT TRAINING LIBRARY 



( 11 Objectives 

11 Materials 

( 

( 

Objectives 3 

• Use all the features of Mac Write, including the use of 
special keys; adding graphics; working with rulers, and 
headers and footers; and other useful techniques. 

• State the function of each of the menu commands. 

• State the product specifications for Mac Write. 

• Answer user-level questions about how to use Mac Write. 

To complete this module, you will need: 

• Macintosh 128K, Macintosh 512K, or Macintosh XL 

• Mac Write disk 

• MacWrite, the owner's manual 

SUPPORTING MACWRITE 
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1111 MacWrite Benefits 

Overview 

MacWrite Benefits 

These are the key benefits of MacWrite. 

In addition to getting questions about how to use a product, 
you may also get requests for product recommendations. This 
section briefly lists the key benefits of Mac Write. In other 
words, why should someone use Mac Write over any other 
word processor? 

Enhance a document's impact. Use the many typefaces 
and styles to produce a professional-quality document. 

Include information from other applications. Easily 
incorporate graphics, spreadsheet data, and information 
obtained from other computers. 

View your document on the screen as it will appear 
on paper. This eliminates the need to print drafts. 

Easily create and edit your work. The consistent user 
interface of Macintosh applications makes it easy to create and 
edit your work, so you can concentrate on content. 

High-quality output. Use Mac Write with the LaserWriter 
to produce publication-quality text. 
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( 11 Using the Manual 

Overview This section offers practice in finding specific 
information in the manual. 

Often, you'll be asked a question that you can't answer 
immediately. If you don't know the answer, the next best 
thing is to know where to find it-and how to find it quickly. In 
order to be able to do this, you must be familiar with the 
various manuals (and other documentation) that contain the 
answers. 

This section gives you a chance to f arniliarize yourself with the 
Mac Write manual by finding the answers to specific questions. 

Use the table of contents and the index. 

This section will ask questions similar to those you can expect 
to get from users. Use the table of contents and the index to 
locate the information in the manual, then write down the 
answer and where you found it. 

When you're finished, check the Feedback section, which will 
give both the answer and the chapter and section in which it 
was found. (Specific page numbers won't be given because 
they might change with manual revisions.) 
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Practice 

Use the Manual to 
Answer These Questions 

Using the Manual 7 

How do I select a ruler so that I can remove it? 

How do I begin a document with a page 
number other than 1? 

What does the Title Page command in the 
Format menu do, and how do I turn it off? 
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Feedback 

Use the Manual to 
Answer these Questions 

How do I select a ruler so that I can remove it? 

Click anywhere on the inch scale of the ruler. To remove it, 
press Backspace or choose Cut from the Edit menu. 

The answer is in the Editing Tasks section of Chapter 2. 

How do I begin a document with a page 
number other than 1? 

Choose Set Page # from the Format menu. 

The answer is in the Changing the Format section of Chapter 2. 

What does the Title Page command in the 
Format menu do, and how do I turn it off? 

The Title Page command causes the header and footer not to 
appear on the first page of a document. When you choose this 
option, a check mark will appear next to it in the menu, 
indicating that it's in effect. To tum it off, choose it again. 

The first ha1f of the answer is in several places in the manual. 
But the second ha1f only appears once. You can find the entire 
answer in the Menu Bar section of Chapter 3. 
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(- II Integrating MacWrite with Other Applications 

Overview 

How To ... 

Pasting Into MacWrite 

( 

What's possible, and how is it done? 

One of the key benefits of the Macintosh is being able to copy 
and paste information from one application to another. For 
example, you can often make a Mac Write document more 
meaningful by including a drawing from MacPaintTM or 
MacDraw TM. 

This section begins with a reminder of how to move 
information from one document to another. A description of 
what integration is possible between Mac Write and other 
Macintosh applications follows. 

Use Copy and Paste. 

To move information between any two documents, do the 
following: 

1. Select what you want to move. 
2. Copy it. 
3. Open the second document. 
4. Indicate where you want to add the information. 
5. Choose Paste. 

(Note: Your ability to do this will depend on what types of 
information each application is able to handle.) 

Here's a brief summary of what can be pasted 
into MacWrite from other applications. 

Mac Write can accept text, tables, and graphics as long as they 
fit within its margins. Here's some additional information you 
should know regarding pasting information into Mac Write. 

MacDraw. You can paste any MacDraw drawing into 
Mac Write. If the graphic is larger than the margins, it shrinks 
to fit. If it's smaller than the margins, it appears left justified. 
(See the next section of this module for more information about 
pasting graphics into Mac Write.) 
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MacPaint. You can paste any MacPaint picture into , 
Mac Write. If the graphic is larger than the margins, it shrinks 
to fit. If it's smaller than the margins, it appears left justified. 
Text is printed as bit-mapped graphics, not as text. (See the 
next section of this module for more information about pasting 
graphics into Mac Write.) 

MacProject™. You can paste any ofMacProject's tables 
into Mac Write. Columns are separated by tabs and each line 
ends with a Return character. Be sure you set one tab for each 
column. Once in Mac Write, the information is treated like any 
other text. 

MacTerrrilnal™. You can paste anything from MacTerminal 
into Mac Write. It's pasted as text and assumes the font and 
type style of the existing text into which it is pasted. If you 
copy a table of information from MacTerminal using the Copy 
Table command, columns within the table are separated by 
tabs when pasted into Mac Write. 

Mac Write. Anything pasted into Mac Write from another 
Mac Write document appears just as it did in the original 
document. It keeps its font and type-style information, 
although it's subject to the margins set by the ruler in the 
receiving document unless you copy and paste a ruler with the 
text. You can also copy graphics that were previously pasted 
into Mac Write and paste them into another Mac Write 
document. 

Spreadsheets. You can paste any information from a 
spreadsheet into Mac Write. But if the information doesn't fit 
within the Mac Write margins, each line will wrap around onto 
a second line (so it won't look like it did in the spreadsheet). 
Columns are separated by tabs, and there's a Return character 
at the end of every line. 

Data bases. You can paste any data-base information into 
MacWrite, as long as the fields are separated by tabs and there 
is a Return character at the end of every record when you copy 
it to the Clipboard. The information will appear in Mac Write as 
a table, but, if it doesn't fit within the Mac Write margins, each 
line will wrap around onto a second line. 
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Pasting MacWrite Data 
into Other Applications 

Integrating MacWrite with Other Applications 11 

Here's a summary of the information that can 
be pasted into other applications. 

You can paste MacWrite information into any application that 
can handle text. Here's some specific information regarding 
each application. 

MacDraw. Mac Write text can be pasted into MacDraw either 
as "paragraph" text (will wordwrap at the end of the line) as 
"caption" text (will appear on one line and pages will be added 
to the right as needed to accommodate the text). (See the 
Supporting MacDraw module from the Apple Support Training 
Library for more information about working with paragraph 
and caption text.) You can also copy graphics (originally from 
any application) that were previously pasted into Mac Write and 
paste them into MacDraw. If the graphics originated in 
MacDraw, they will be pasted in as MacDraw graphics, and 
can be edited. You can't edit any other graphics. 

MacPaint. By default, all text will be pasted into a rectangle 
in the middle of the screen that's approximately 4 inches wide 
and as long as necessary. If you draw a selection rectangle 
before choosing Paste, the text will word wrap within the 
rectangle until you get to the bottom of the selection rectangle. 
Any text that doesn't fit is lost, so be sure your rectangle is 
large enough. You can also copy any graphics that were 
previously pasted into Mac Write and paste them into MacPaint. 
You can then edit the drawing, just as you edit any MacPaint 
drawing. 

MacProject. You can only paste very small amounts of text 
into MacProject-whatever will fit into one of the data-entry 
tables. 

MacTerminal. You can paste any text from Mac Write into 
MacTerminal, but all font and type-style information is lost. 
Graphics that have been pasted into Mac Write can't be pasted 
into MacTerminal. If a Mac Write document is saved as Text 
Only, it can be opened directly from Mac Terminal. 

Mac Write. You can copy anything, including graphics, from 
a Mac Write document and paste it_ into another Mac Write 
document. 

Spreadsheets. You can only copy small amounts of text 
from Mac Write and paste it into individual cells in a 
spreadsheet. You can't paste graphics from Mac Write into a 
spreadsheet. 

Data bases. You can only copy small amounts of text from 
Mac Write and paste it into individual cells in a data base. You 
can't paste graphics from Mac Write into a data base. 
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• Adding Graphics 

Overview 

How to Add Graphics 
to Your Document 

This section covers techniques for adding 
MacPaint and MacDraw graphics. 

Copying and pasting information is a consistent and easy 
feature of all Macintosh applications, and one you should 
already be familiar with. But, there are a few specifics about 
including graphics in a word-processing document that require 
further explanation. 

This section covers how to move graphics, from either 
MacPaint or MacDraw into Mac Write, how to determine where 
the graphics appear, and how to move or resize your graphics 
once you've moved them. 

Use Copy and Paste. 

To move a drawing from either MacDraw or MacPaint into 
Mac Write, use the standard copy-and-paste technique-<;opy it 
from one document and then paste it into another. 

In MacDraw, use any standard selection technique. In 
MacPaint, the lasso is recommended, because it eliminates any 
white space around the drawing. 

Set the margins before pasting. 

When you paste a drawing into Mac Write, it will appear at the 
left margin (the black triangle), not at the left indent (the 
arrow). If the drawing doesn't fit within the margins, it will 
automatically shrink to fit The effect is the same as when you 
shrink a drawing in MacPaint. In the example below, the first 
graphic is the original, and the second is what the graphic looks 
like when it has been pasted into a Mac Write document whose 
margins are too close together. 

Original Graphic 

MacWrite 
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The Same Graphic Pasted into a Document 
with Narrow Margins 

rt6cfl1int N6cWrite 

:..---= ~---j 
~11111111111 

Another effect of margins that are too narrow is that text pasted 
in from MacDraw, usually as part of an organization chart or 
flow chart, will appear OK on the screen, but words will 
overlap when the document is printed. 

If your margins are too confining, widen them and then repaste 
the graphic. 

To move or resize a drawing, select it and 
use the handles. 

Once you've pasted the drawing into your Mac Write document, 
you can move it and resize it. First, select it by clicking on any 
part of the drawing. The drawing will be surrounded by a thin 
line with three handles across the bottom, as shown below. 

i "[==J "'~]~c-o-p1-'£JL. .... -P-a_s..,te--;wn ,. 
~11111111111 

~ 

"''------Ha~dles _______ / 
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Dealing with Distortion 

If the drawing is smaller than the space between the margins, 
you can move it horizontally by following these steps: 

1. Point to any edge of the drawing. 
2. Hold down the mouse button. 
3. Move the drawing right or left to the desired location. 
4. Release the mouse button. 

You can resize the drawing vertically and horizontally at the 
same time by grabbing either of the outside handles. To resize 
the drawing vertically only, use the middle handle. 

You can't add text next to a drawing. 

If you want text to the right or left of your drawing, add it 
while you are in MacDraw or MacPaint, and then copy and 
paste the text with the drawing. You can't add text next to a 
drawing once it has been pasted into Mac Write. 

(Note: For a consistent look, use the same font in the drawing 
that you use in the remainder of your document.) 

The only way to change a drawing, or text within a drawing, 
once it has been pasted into Mac Write, is to edit it in MacDraw 
or MacPaint and then repaste it into Mac Write. 

To remove a drawing, select it and choose Cut. 

When you select the drawing, the border and handles will 
return. Then choose Cut or press Backspace. You can select 
and cut graphics at the same time you remove text. 

Your MacPaint image may appear distorted. 

Sometimes, when you paste a MacPaint drawing into 
Mac Write, it appears slightly distorted. It may still print 
normally, however. So, always start by trying to print the 
document. 

If it doesn't print normally, choose Tall Adjusted from the 
Page Layout window. This should correct the distortion, 
but it will also slightly widen the text part of the document. 
The effect will vary with type styles, sizes, and fonts. 
Experiment to see what works best. 

A drawing might also be distorted because it has been resized 
or shrunk to fit within narrow margins. Be sure your margins 
allow enough room, and use the handles to resize the 
document. 

APPLE SUPPORT TRAINING LIBRARY 



Useful Techniques 15 

( II Useful Techniques 

Overview 

Have MacWrite Available 

Two Versions of MacWrite 

This section covers techniques to help you get 
the most out of MacWrite. 

Reading a manual and doing practice exercises is only part of 
learning to use an application. Beyond these basics, there are 
many techniques for producing higher quality work-and 
doing it more efficiently. 

This section describes many of those techniques, so you can 
become more productive on Mac Write more quickly. Also, at 
the end of the module, there is a list of resources you should 
check regularly for more information on how to get the most 
out of your Macintosh and Mac Write. 

Practice exercises are not included, but you 
are encouraged to try each technique. 

Since specific practice exercises aren't included in this module, 
it may be useful to have a Macintosh equipped with Mac Write 
available as you read this section so you can try the various 
techniques as you read about them. 

Most of the techniques described in this 
section apply to both versions of MacWrite. 

Mac Write is currently available in two versions, 2.2 and 4.5. 
Any differences in how these techniques are implemented are 
noted. If you aren't sure which version you have, start up 
Mac Write and choose About MacWrite from the Apple 
menu. (See the Mac Write Specifications section of this module 
for more information about the two versions of Mac Write.) 

If you're using Version 2.2, upgrade to the 
more powerful Version 4.5. 

MacWrite Version 4.5 has some distinct advantages over 
Version 2.2, which are listed in the Specifications section of 
this module. While you're at it, also update your Finder to the 
latest version, if you haven't already done so. (See the 
Suporting the Macintosh Finder module from the Apple 
Support Training Library for specific differences between 
Finder 1.0 and Finder 4.1. Ask your dealer or Apple support 
representative about upgrading your software.) 

SUPPORTING MACWRITE 



16 Useful Techniques 

Command Key 
Equivalents 

Enter and Return Keys 

Use the Command key to invoke menu 
commands. 

You can use the Command key in combination with the 
appropriate letter key to implement many of the menu 
commands. Many people find this is faster than reaching for 
the mouse, especially in an application like Mac Write, which is 
very keyboard oriented. 

Here is a summary of the menu commands that have Command 
key equivalents. 

Undo Typing xz Plain TeHt XP 
Cut XH Bold XB 
Copy xc Jlolic XI 
Paste XU Underline XU 

mrnoanm@ XO 

"lll~CilC!J[!JJ XS 
(Yer4.5 only) Superscript XH 

Align Left XN Subscript XL 

Align Center XM 
Align Right XR [Yer4.5 only) 
Justify XJ Find NeHt XF 
Use Ruler XO Goto Page# XG 

Use Enter of Return to accept preset buttons in 
windows. 

Many dialog boxes have a choice of buttons for you to push 
(OK, Cancel, Open, and so forth). One of them is usually 
highlighted with a bold border (for example, the Yes button in 
the Close window below). 
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Keeping Words Together 

Moving Between Two 
MacWrite Documents 

Usefule Techniques 17 

Saue changes before closing? 

n Yes > 
( No ) ( Cancel ) 

This is the preset button. You can save time by pressing the 
Enter or Return key to accept the preset, rather than using the 
mouse to click on Yes. 

Use the Option key to prevent words from 
being separated by the end of a line. 

Many times there are two words that you want to appear right 
next to each other, but they land at the end of a line and 
therefore get separated, for example, a date like March 15, 
1986. (See!?!) 

To keep two words together, hold down the Option key as you 
type the space. Instead of being separated by the end of the 
line, the words will both appear at the beginning of the next 
line. 

Use the Document Directory dialog box. 

If you have a MacWrite document open, and you want to open 
a different Mac Write document, you could choose Quit from 
the File menu and then open the second document from the 
Finder. But the following way is faster: 

1. Choose Close from the File menu or click the close box. 
2. Choose Open from the File menu. 

You11 get the Document Directory dialog box, which contains 
a list of all the Mac Write documents on that disk. 
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Screen Shots 

[ Open "J Data Disk 

;~;;~;~ec~t 11111! [ Eject ] 
mtro to Mac O ... i!i!i! 
letter mm ( Cancel Drlue J 
Mac Office mo ... 

The name of the disk whose contents are displayed is in the 
top, right corner of the window. If you want to open a 
document on another disk, either click Drive to look at the 
documents stored on the disk inserted in the other drive, or 
click Eject to eject the disk whose name appears above the 
Eject button, and then insert the disk containing the document 
you want. 

Double-click on the name of the document you want to open, 
or select it and click Open (as shown in the above screen 
shot). If the name of the document doesn't fit in the space 
provided, three dots will be added to the end of what does fit. 

The documents are listed in alphabetical order. If you have a 
long list of documents, you can quickly jump to the part of the 
alphabet under which your document is listed by typing the 
first letter of the name of your document. For example, if you 
are looking for the document titled "Sales Meeting Notes," type 
the letter S and the first document beginning with the letter S 
will jump to the top of the list. Or you can scroll through the 
Document Directory the same way you scroll through any 
window. 

There are several options for printing the 
current contents of the screen. 

By typing the correct combination of keys, you can save the 
screen as a MacPaint document or print it on an Image Writer™ 
printer connected to the Printer port. By saving or printing the 
contents of the screen, you're creating what is called a "screen 
shot." (You can't print the contents of the screen directly to the 
LaserWriter. You must save it as a MacPaint document and 
then print it by running MacPaint.) 
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Select Large . 
Amounts of Text 

Quick Ways to Delete 
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Use the following keystrokes to create a screen shot: 

Keystrokes 
Cornmand-Shift-3 
Cornmand-Shift-4 
Command-Shift-Caps Lock-4 

Effect 
Save screen as a MacPaint file. 
Print the active window. 
Print the entire screen. 

The commands are the same for the Macintosh XL. But, on 
the Macintosh XL, printing the entire screen is impractical 
because the right-hand 2 inches wrap around and overlap the 
left side of the screen shot, obscuring what was a!read there. 

Double-click to open icons, and to select 
single words and groups of words. 

• To open any icon, point to it and double-click the mouse 
button. This is the same as selecting the icon and choosing 
Open from the File menu. 

• To select a single word, double-click anywhere on it. 

• To select text in word increments (instead of letter 
increments), do the following: 

• Point anywhere in the middle of the first word you 
want to select. 

• Double-click and hold the mouse button down on the 
second click. 

• Move to the end of the group of words you want to 
select. 

The resulting selection will consist of only complete words. 

Use Shift-click to select large blocks of text. 

1. Click mouse button at the beginning or the end of the text 
you want to select. 

2. Scroll to the other end of the text you want to select 
3. Hold down the Shift key and click the mouse button again. 

Everything between the two mouse clicks will be selected. 

Use the Backspace key. 

If you want to get rid of some text permanently, select it and 
press Backspace. You will not be able to paste the text, but 
you can recover it by choosing Undo Typing before clicking 
the mouse button. 
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Use Command-Backspace 
to Recover Text 

Page Breaks 

Undo/Redo 

Or hold down the Enter key as you select text. 

Another quick way to delete text is to hold down the Enter key 
as you select the text. As soon as you release the mouse 
button, the text will be deleted. You can also select the text 
first and then press the Enter key to delete it, just as you would 
press the Backspace key. You can recover the text by choosing 
Undo Typing before clicking the mouse button. 

Command-Backspace will replace text you 
backspaced over. 

If you use the Backspace key to delete text a letter at a time, 
you can replace the text by holding down the Command key 
and continuing to press Backspace. The letters you deleted will 
be replaced one at a time. However, this technique won't work 
if you select the text and then press the Backspace key to delete 
it. 

How to delete a page break. 

1. Select it by clicking anywhere between where the text ends 
and the end of the page. 

2. Choose Cut or press Backspace. 

These commands enable you to experiment 
and recover from mistakes. 

The Undo command enables you to easily recover from 
mistakes, and to experiment without the fear of permanently 
losing information. You can choose Undo to reverse the 
effect of your last action as long as you haven't clicked the 
mouse button. Undo is always the first command in the Edit 
menu, and it changes depending on the last action taken. 

For example, if you had just cut some text, the command 
would be Undo Cut. If you had just typed something, the 
command would be Undo Typing. 

Anytime you choose the Undo command, it immediately 
changes to Redo. Redo reverses the effect of the Undo, as 
long as you have not pressed the mouse button again. The 
second word of the command stays the same. For example, 
Undo Cut changes to Redo Cut. 
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Undo Typing removes text you just typed. 

Choose Undo Typing to remove everything you have typed 
since you last clicked the mouse button. If you first selected 
some text and then typed over it, the text that was removed will 
be replaced. Choose Redo Typing to put back the text that 
was removed when you chose Undo Typing. 

Here's a lot of information about rulers and 
how to use them. 

In Mac Write, you use rulers to set up the format of your 
document: margins, line spacing, tabs, and justification. 
Anytime you want to change the format of part of your 
document, you insert another ruler. Each ruler affects all of the 
text until the next ruler. 

The next several items concern different aspects of using 
rulers. (Refer to MacWrite, the owner's manual, for additional 
basic information about using rulers.) 

To add a ruler, choose Insert Ruler or use 
Copy and Paste. 

To insert a ruler, position the insertion point where you want to 
add it and choose Insert Ruler from the Format menu. A 
ruler identical to the ruler currently affecting that part of your 
document will be added and all of the text affected by that ruler 
will be checked to be sure it conforms to the new ruler. If 
you're working with a long document, this checking process 
may take up to 30 seconds. When you make any change to the 
new ruler (for example, moving a margin or inserting a tab) the 
format of the affected text will be changed immediately. 

You can also copy and paste rulers the same way you copy and 
paste anything else: 

1. Select the ruler by clicking on the numbered portion of it. 
2. Choose Copy. 
3. Click where you want to add the ruler. 
4. Choose Paste. · 

The affected text will be reformatted immediately. This is a 
good way to add a preformatted ruler that's different from the 
one that would be added if you chose Insert Ruler. 
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Ruler Symbols 

Hint: If you're inserting two rulers, insert the 
second one first. 

Many times you'll write your document and then go back and 
adjust the format. If you want to change the format of one 
short section and then return to the original format, you will 
have to insert two rulers. Insert the second ruler first and be 
prepared to wait a bit while Mac Write checks the formatting 
down to the next ruler. Then when you insert the first one (the 
ruler you will use to change the format of the short section) the 
wait will be very short because there is not much text until the 
next ruler. 

Here's an explanation of the symbols on the 
ruler and how to use them. 

There are two left-margin indicators on every ruler. 

• The one with the arrow is called the "left indent." It 
incidates the left margin for the first line of every paragraph. 

• The black triangle is the "left margin," which indicates the 
margin for the subsequent lines of a paragraph. 

Use the mouse to change either margin indicator. 

Left Mergin Left Indent Decimal Tab Tab Stop Rig ht Margin 

.. k_ .. 1 ....... 1.y. ......... 1.? ...... 1.. ...... L ...... 1 ......... l.~ ...... 1 ....... .1 ......... 1 ... zl.4 ... 1 ........ l.. . .1. ••• 1 ....... .1.~ ...... 1 ... 2:! ........ .L ....... ..1.9 ..... 1 ....... .1 ........ 1 ........ ~._? ...... 1. 

~ ~ o 6 i1nes11nch II II I 11 I I 11 11 I 
The house stood onaslighttisejust on the edge orthevillage. It stood on its O'wf'landlooked out 

civet· a. bl eek sprea.d of East Country fennla.n d. Not a.remmabl e house by any means -it 'YIFJ!:, about t'w'enty 
}1ears old, sq ual:tish, squarish, made of btick, and had f our'windo'w'S set in the front of a.size and proportion 
'w'hic h more cir I ess exactly failed to please the eye. 

If you move the left margin to the right of the left indent, it also 
will be treated as a tab stop. Press the Tab key to start a new 
paragraph at the left margin of the remainder of the paragraph . 

..1 ..... 1 ........ f ........ L ...... l.? .... ;i:. .. • ... l.. ...... 1 ......... l.~ ...... 1 ........ L ........ 1 ........ 1.:\. ... 1 ........ l.. ....... 1 ....... .L? ..... l.. .... ;!: ...... 1 ........ ,1~ ..... 1 ........ L ....... 1 ....... .L? ..... 1 ... 

~ GEi o 6 1 i n es / i n ch II II I I I I II ii I I I I I I 
I Tab 

"M. seven o'clock on Tuesde.ymoming Authur didn't feel very good. 
He 'w'Ok e up bl eerily, got up, 'w'a.n d ere d bl eerily round his room, 
opened a •windo'w', sa'w'a bulldozer, found his slippers, and stomped 
off to the bathroom to 'w'i.'1.S h. 
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You can set a tab to the left of the left indent, but not to the left 
of the left margin. In other words, the left margin is always the 
first tab stop. 

Tabs can be as close as 3/16 of an inch to the left margin, but 
no closer. Tabs can be as close 1/16 of an inch to the left 
indent. 

Display the right end of the ruler. 

When you open a Mac Write document, you can only see 6-118 
inches of your document (from 1inchto7-1/8 inches). If you 
want to move your right margin beyond 7-118 inches, do the 
following: 

1. Move the entire document to the left. Part of it will go off 
the screen. 

2. Use the size box to enlarge the window to the right, which 
will expose more of the ruler. 

3. Move the right margin to the desired location. The 
maximum right margin is 8 inches. 

4. Shrink the document before you move it back to the right, 
or you won't be able to see the scroll bars. 

What's the difference? 

You cannot cut or delete the ruler at the beginning of a 
document. You can, however, insert additional rulers each 
time you want to change the format throughout your document. 

If you want to see your document as it will print (without 
rulers) choose Hide Rulers from the Format menu. The 
rulers will no longer be visible, but the format of the text won't 
change. 

If you want to get rid of one particular ruler, select it by 
clicking on the numbered portion, and choose Cut or press 
Backspace. The ruler will be removed from the document, and 
the text that was formatted according to that ruler will follow 
the format of the preceding ruler in the document. 
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Centering Text 

Columns 

Use the ruler or the Format menu. 

There are two ways to center text automatically: 

• Click the centered text icon on the ruler (shown below). All 
the text until the next ruler will be centered. 

l.? ..... J. ... .1. ... L . .1. ... J. ........ l.9 ..... J. ........ L .. .1. ... J. ... .1. •• .l_? ... 

~~~-

• Click anywhere in the paragraph to be centered and press 
Command-Mor choose Align Center from the Format 
menu to center one paragraph-this works well for 
headings. (Note: This is new in Version 4.5.) 

The other alignment options in the ruler shown above are, from 
left to right, flush-left, center, flush-right, and fully justified. 

Use tabs to set up columns. 

There's no automatic column capability in Mac Write. The best 
way to create columns of information is by using tabs. You 
can have either flush-left columns or columns that line up on 
decimals, both of which are shown below . 

.. ~ .. 1 ........ L ..... J. ...... ~~ ..... 1 ........ L ... :t: .... ..1.~ ..... 1 ...... ~ ...... .L ........ L:L.J. ......... L ..... J. ....... .L? ..... J. ...... :.;k ....... J. ......... 1.9 ..... 1 ........ .1 ........ .i ....... .l_? ..... l... 

~ ~ D 6 lines/inch I 11 11 I I 11 11 11 I 
Here are my exp ens es for my recent trip, broken d O'w'n by date and m eeJ. If you have questions, pl es.s e 
contact me. 

Date 
7117 

7118 

Meal 
Lunch 
Dinner 
B'fs.st 
Lunch 

Location 
The J and L 
Talbot's 
Hotel Coffee Shop 
42nd Street 

.Amount 
25.67 
63.50 
8.25 

31.35 

You can also use decimal tabs for flush-right columns, as long 
as the information doesn't contain decimals or periods. 

In Mac Write, you can't select information by column. The text 
is basically a series of lines that are formatted the same way. 
(See Mac Write, the owner's manual, for more information 
about entering and editing columns.) 
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Here's a quick way to go to a specific page. 

Mac Write Version 4.5 offers a new command in the Search 
menu, Goto Page #. It enables you to go quickly to any 
page within your document without using the scroll bar. If you 
don't want to have to reach for the mouse, you can use the 
Goto Page# command entirely from the keyboard. The 
keystrokes are: 

1. Command-G 
2. <page number> 
3. Enter or Return 

The top of the page entered will be displayed in the MacWrite 
window. In Version 4.5, the page number is displayed in the 
scroll box, so you can easily scroll to a specific page. 

Change the type style of the page number and 
other icons. 

The following three icons are available in the header and footer 
windows: 

~ Page Number 

~ Date 

~ Time 

To include one of them in your header or footer, use the mouse 
to drag the icon to the desired location. The icons aren't 
affected by returns or spaces. If you want to move one of the 
icons within the header or footer, always use the mouse. 

By default, the icons are printed in 12 point Geneva. If you try 
to change the font or type style, you may notice that you can't 
select the icons the way you would normally select text. 

Here is how to change the font or type sty le of the page 
number, date, or time icon: 

1. Open the footer or the header. 
2. Select the entire header or footer, including blank lines. 
3. Choose the desired font, size, and type style. 
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Using Version 4.5 on a 
One-Drive System 

Helpful Hints 

If you want to include text in a different font, type size, or style 
than the icons, first use this technique to change the entire 
header or footer to the type style you want for the page 
number, date, or time. Then make the desired changes to the 
text. 

Keep your document and MacWrite on the 
same disk. 

With MacWrite Version 2.2, you can keep your documents on 
one disk and the Mac Write application on another disk, even 
when working on a one-drive system. When you want to edit 
a document, load it into memory, eject the data. disk, and keep 
the Mac Write disk in the drive. As you edit your document, 
changes are stored in memory. When you're finished, you just 
reinsert the data disk and save your revised document. 

But remember that Mac Write version 4.5 is disk based, which 
means that both the application and the disk file that holds your 
document are continually being accessed. If you have your 
documents on one disk and the Mac Write application on 
another disk, you'll be constantly swapping disks. Therefore, 
you should keep the document you're working on and the 
application on the same disk. 

Also keep in mind that this will limit the potential size of your 
document. The actual amount of space available will depend 
on the number of fonts and desk accessories on your disk. 

Here are several suggestions to make using 
MacWrite easier and more productive. 

Copy and Paste; don't Cut and Paste. 

As you move text either between documents or within a 
document, always copy the text as the first step instead of 
cutting it. You can easily go back and delete the original text 
once the move has been completed, and you will greatly 
decrease the risk of losing the text completely. 

Mark your location with a special character to 
facilitate returning there. 

Frequently, when you work on a long document, you need to 
jump away from where you are currently working. An easy 
way to return to exactly where you left off is to use a rare or 
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unique character to mark the location (for example, @, ®, t, or 
&). When you want to return to that location, just use the 
Find command in the Search menu to find the unique 
character. 

Confirm all Search and Replace commands. 

One of the options in the window that opens when you choose 
Change from the Search menu is Change All. This can be 
a dangerous command, especially if you are searching for 
partial words. For example, if you want to replace all instances 
of "man" with "person," the word "manipulate" will become 
"personipulate." To avoid this problem, confirm every 
successful search by choosing either Change then Find or 
Find Next from the Change window. 

Split large documents into smaller ones. 

If you are working on a very large document (longer than 40 
pages) Mac Write will start to slow down and it will become 
harder to write or edit your document. To keep Mac Write 
operating at its peak speed, break large documents into smaller 
documents. 

When you finish, you can either use Copy and Paste to put 
the parts together again, or use the Set Page # command 
(Version 4.5 only) to start each section with the appropriate 
page number. 
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11 Questions and Answers 

Overview 

Large Documents on 
Macintosh XL 

Document Size 

Here are the questions most commonly asked 
by MacWrite users, and the correct answers. 

You should now know how to use Mac Write, as well as many 
of the techniques that most users take months to discover. But 
as a support person, you '11 also be called upon to answer 
questions about the program. This section is a summary of the 
most commonly asked questions about using Mac Write. 

This material does not go into great technical detail. It only 
explains what most users will need to know in order to use 
Mac Write. 

I'm working on a very large document on the Macintosh XL 
(more than 50 pages) and MacWrite is functioning very slowly. 
It's easy to get ahead of the screen while I'm typing. How can 
I speed it up? 

• Create and edit the document on a disk and then save it or 
back it up onto the hard disk. 

• Even when there's plenty of disk space, removing as 
many documents from the hard disk as possible seems to 
speed up Mac Write. 

• Using a lot of rulers in Mac Write will slow it down. So, 
add the rulers after entering all of the text. 

• Split the document into several smaller documents. 

How can/ tell how large my document is? 

If you're in the Finder, use the View menu to display the 
contents of your disk by name or size. Included in the listing is 
the approximate size of your document. 

If the document is open, choose About Mac Write from the 
Apple menu. The window that appears (shown on the next 
page) will include the size of your document (in this case, 
UK). Notice that the version number (4.5) is also mentioned 
in this window. 
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Encore Sy stems: --
MacWrite, the Macintosh Word Processor 

Written by Randy Wigginton, Ed Ruder, and 
Don Breuner of Encore Systems. 

Version 4.5, April 4, 1985. 

Document occupies 11 Kon disk, 
with 264K remaining. Saving the 
document may change these values. 

© 1985 Encore Systems 
© t 985 Apple Computer Inc. 

Note: This is not necessarily the same for all applications. It 
depends on what the software developers chose to put in the 
"About ... " window. 

There may be a small discrepancy between the size displayed in 
the Finder and in the "About ... " window because of the way 
the Finder allocates space on the disk. 

When I use an ImageWriter, especially when I'm printing a 
long document, I often get a message saying that my disk is 
full and my document can't be printed. How can I print my 
document? 

Here are several solutions. Try the one that seems most 
appropriate for your situation. 

• Print only selected pages. 

• Move the document onto a data disk and then remove it 
from the startup disk. Then print it from the data disk. 

• Close the document and remove as much as possible from 
the startup disk-all you need are the System and Finder 
files, the Image Writer driver, and Mac Write itself. Remove 
documents, fonts, and desk accessories, if necessary. You 
need free room on the startup disk greater than the size of 
the document that you are trying to print. (See the 
Managing Macintosh Files module for more information 
about creating additional room on your disk.) 
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Can't Save Document 

Can't Open Document 

• On a two-drive system, copy the application file to a 
data disk to allow more room for the print file on the 
startup disk. 

• Copy part of the document and paste it into a new 
document. Print each new document, one at a time. 

• Print the document from a hard disk. 

When I try to save my document, I get a message telling me the 
disk isfull. How can/ save the document? 

Mac Write Version 2.2 is a memory-based application. That is, 
your document resides entirely in memory as you are working 
on it. Therefore, it's possible to create a document larger than 
what you have room to save on your disk. If you get a "Disk 
Full" message, there are too many other documents on the disk 
to which you are trying to save the document. 

Save the document to a blank disk. To do this: 

1. Choose Save As. 
2. Click Eject. 
3. Insert a blank disk. 
4. Click Save. 

This situation won't happen with Mac Write Version 4.5 
because your data is constantly updated on the disk. If your 
document gets too large, you will get a message saying that 
there is no more room on the disk. You will not lose any . 
information or get into the situation described above. (This is a 
good reason to upgrade to Version 4.5.) 

I can't open the icon for a docwnent I already created and 
saved. How can/ recover the docwnent? 

• Try a later version of Mac Write (a document created with 
Version 4.5 can't be opened with Version 2.2). 

• Copy the document onto a blank data disk. 
• See the Fundamentals of the Macintosh Operating System 

module for more information about recovering lost 
documents. 
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When I first save a document, one of the options in the Save 
window is Text Only. What is this option for? 

The Text Only option saves your document as an ASCII text 
file, without any of the normal Mac Write formatting 
information and without graphics. Use this command if you 
are going to send the document to another computer via 
MacTerminal (see the Using MacTerminal module) or if you 
want to move the document into another application that 
doesn't support the Mac Write format (for example, a 
programming language). Saving a document as a text-only file 
will not affect the original Mac Write document You11 end up 
with two documents: the original and the text-only document. 

Documents received via MacTerminal or AppleLlnkTM will 
initially be text-only documents. If you want to open a 
text-only document that was not originally created in MacWrite, 
open Mac Write, close the Untitled document, and choose 
Open from the File menu. All text-only documents will be 
included in the Document Directory. Upon opening a text-only 
file, a Mac Write document will be created and you will end up 
with two documents: a text-only document and a Mac Write 
document. 

When I open a text-only document, I get this message: "Should 
carriage returns signify a new paragraph or a line break?" How 
should I respond? 

Mac Write has word-wrap capability. So, if the application that 
originally created the document put carriage returns at the end 
of every line, you want to ignore them because Mac Write will 
take care of wrapping the text to the next line. Therefore, 
choose for a carriage return to signify Line Breaks. 
Mac Write will then ignore single carriage returns, and keep one 
if it sees two returns in a row, which signify the end of a 
paragraph. 

If the application that originally crated the document had 
automatic word wrapping (MacTerminal, MacWrite, 
AppleLlnk), carriage returns will only have been inserted at the 
end of paragraphs. Therefore, you want to keep all the carriage 
returns, so choose Paragraphs. 
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Lost Formatting 

Text Disappears 

Tall vs. Tall Adjusted 

I have a blank line between two paragraphs that have different 
formats. When I select the blank line and delete it, I lose the 
formatting of the second paragraph. What happened? 

Rulers are stored with the return character at the end of the line 
preceding the first paragraph of the new format. (Remember 
that the first paragraph may be a blank line.) If you select the 
whole line and delete it (either by pressing Backspace or by 
choosing Cut), you are deleting the ruler, too. 

However, you can't delete a ruler by backspacing over it. If 
you try to backspace over a ruler, the Backspace key will 
simply have no effect. So, to delete that blank line, backspace 
over it instead of selecting it and deleting it. 

Periodically, some text disappears while I'm editing my 
document. Why? 

When text is selected (highlighted), pressing any key replaces 
the selected text with what you type. When text disappears, it 
is probably because you selected some text and then 
accidentally touched the keyboard. 

Choose Undo Typing from the Edit menu before clicking 
the mouse button to recover your lost text. 

What's the difference between choosing Tall and 
Tall Adjusted from the Page Setup window? 

Use the Tall option to print the majority of your Mac Write 
documents. The Tall Adjusted option is for printing 
graphics whose relative spacing and proportions are critical. 
The net result is that Tall Adjusted widens the graphics by 
about 12 percent. The graphics still look OK when using Tall. 
And text still looks OK when using Tall Adjusted, although 
it's a bit wide. 

The Tall and Tall Adjusted options are only available when 
you're using a LaserWriter printer. 
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What is the Reduction option in the Page Setup window for? 

If you are printing to an Image Writer, and you click on 50% 
Reduction, the document will shrink by that amount both 
horizontally and vertically. Therefore, it will be printed at a 
quarter of its original size. 

If you are printing to a LaserWriter, you can enter any 
percentage of reduction from 25 percent (document will be 
printed as 25 percent of its original size in each dimension) to 
400 percent (four times the original size in each dimension). 

With Mac Write, though, if you try to print a document larger 
than the original (greater than 100 percent) nothing to the right 
of the original page will print, because Mac Write can't print 
anything wider than one page. (See the Using the LaserWriter 
module from the Apple Support Training Library for more 
information regarding printing with the LaserWriter.) 

Why do I get garbage when I print my MacWrite Version 2.2 
docwnent on a wide carriage ImageWriter? 

Be sure you have the correct printer resource on your startup 
disk. The file you need is called Image Writer 15 and is usually 
in the System Folder. If you have the Image Writer 15 
resource, you can print to either Image Writer. The original 
Image Writer resource can only print to the standard 
Image Writer. 

You can find the Image Writer 15 file on the MacWrite Version 
4.5 and MacProject application disks. Also, when you use the 
La.serWriter Installation disk, it will put the Image Writer 15 
file on your startup disk. (See the Using the LaserWriter 
module for information about using the Installation disk.) 

How do I print to a daisy wheel printer? 

Use the Mac Daisywheel Connection program available from 
Assimilation.Process. This is an application that reads 
Macintosh documents and converts them into the appropriate 
format for a large variety of letter-quality printers. Contact 
Assimilation, Inc. in Los Gatos, California. 
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Spelling Checkers 

Outlined Type Sizes 

Temporary Files when 
Using the Switcher 

Does a spelling checker actually do anything to my document, 
and does it add size limitations? 

There are several spelling checkers available for the Macintosh, 
which are listed below. Contact the appropriate vendors for 
specific information about the characteristics of their programs. 

Product Name 
Hayden-Speller 
MacSpell+ 
Mac Spell Right 

Developer 
Hayden Software Co., Lowell, Mass. 
Creighton Development, Irvine, Calif. 
Assimilation, Inc., Los Gatos, Calif. 

Why are some type sizes in the Style menu in outlined text and 
others in regular text? 

Type sizes that appear in outlined text have actual font files 
associated with them; they are the sizes that will look best on 
the screen and when printed. The sizes that are in regular type 
are interpolated from the existing font files; they don't look as 
good on the screen or when printed. 

Font sizes that 
are interpolated 

ID IPIDDIDtl 
1 o Point 
U ~ lP@DIDtl --~ Font sizes for which 
14 Point there are font files 

U ffi IPIDDmtl 
~!(} IPmDmtl 

1 am running MacWrite and the Finder under the Switcher™. 
When I switch into the Finder, I notice three new files in the 
System/older: "Undo File," "New File," and "Scrap File." 
What are these files for? 

These are temporary files created by Mac Write; They will not 
be visible upon quitting the Switcher. 

The Undo File enables you to use the Undo/Redo commands to 
reverse many of your actions. The New File is your working 
file and contains all of the changes you have made to your 
document. This makes it possible to not save your changes 
upon closing a document. 

The Scrap File is used for copying and pasting information 
within the Mac Write document. It doesn't alter font and type 
style information, which is reformatted when the information is 
placed on the Clipboard, so pasting information back into 
MacWrite is faster. / ~, 
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If you suffer a system crash or if you abnormally exit the 
Switcher, you may also see these files upon restarting your 
Macintosh. Throw them away and empty the Trash before you 
run Mac Write again. You can't use the New File to recover 
your unsaved changes. 

What is the effect of clicking 6 lines/inch on a MacWrite 
ruler? (This is a new feature in Version 45.) 

The 6 lines/inch option is an alternative to the three 
line-spacing options in the ruler. Regardless of font or size, 
there will be six lines of text per inch, both on the screen and 
when you print it. (As a point of comparison, 12-point, 
single-spaced, Geneva has about 5 lines per inch.) 

The 6 lines/inch option is useful for printing on standard 
printed forms and labels, or for designing forms that are 
consistent with those proportions. You can still use single- (6 
printed lines/inch), space-and-a-half (4 printed lines/inch), or 
double-spacing (3 printed lines/inch). 

Some fonts may appear slightly chopped off, especially if you 
single-space large type sizes, superscripts, or subscripts. 
However, the problem often disappears when you print the 
document. 

How do I convert my MacWrite Version 2.2 documents to 
MacWrite45, and what are the consequences? 

1. Make a backup of your disk, just in case something goes 
wrong. 

2. If your documents are on a startup disk that includes 
Mac Write Version 2.2, throw away the System folder and 
MacWrite Version 2.2. 

3. Start up from aMacWrite Version 4.5 disk. 
4. Open the document to be converted. You'll get a message 

saying that the document is being converted, and that it will 
open as an Untitled document. 

5. Save the document and give it a new name. You'll now 
have both the original Version 2.2 document, and the 
new, Version 4.5 document. 

6. Throw away the old version (if you don't plan to use it 
ever again). 

Once a document has been converted, you will not be able to 
open it again with Mac Write Version 2.2. 

SUPPORTING MACWRITE 
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Overview 

Maximum Document Size 
MacWrite Version 2.2 

This section covers MacWrlte's capabilities 
and limitations. 

In addition to the questions addressed in the last section, you 
will receive many questions regarding the capabilities or 
limitations of Mac Write. For example, how many pages can it 
handle? and, how wide are the margins? This section will 
enable you to answer such questions. 

There are two versions of MacWrite. 

Mac Write Version 2.2 is memory based, which means that 
your entire document resides in memory while you are working 
on it. Therefore, the size of your document is limited by the 
amount of available memory. 

Mac Write Version 4.5, released in Spring 1985, is disk based, 
which means that your document resides on the disk while you 
are working on it. Therefore, the size of your document is 
limited by the amount of space available on the disk and not by 
available memory. 

Except where noted, the specifications shown here are the same 
for both versions of Mac Write. 

On a Macintosh 128K, 20 double-spaced 
pages. 

With Mac Write Version 2.2, the maximum size of a document 
is based on how much information fits in memory. On a 
Macintosh 128K, it is greater than 27,000 characters, or 
approximately 5,000 words. That equals about 10 
single-spaced pages, using a 12-point font. 

On Macintosh 512K, 80 double-spaced pages. 

With Mac Write Version 2.2, the maximum size of a document 
that can be created on a Macintosh 512K is approximately 
20,000 words, or 40 single-spaced pages. 

Capacity depends on fonts and graphics. 

The more fonts, type styles, and graphics there are in your 
document, the fewer pages there are available. ' 
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Maximum Document Size 
MacWrite Version 4.5 

Page Sizes 

Margins 

MacWrite Specifications 37 

The size of a document depends on the 
amount of disk space, not memory. 

The total size of a document is determined by three things: 

• Total number of return characters. (You can have up to 500 
carriage returns per document on a Macintosh 128K, and up 
to 2,047 carriage returns per document on a Macintosh 
512K.) 

• The amount of disk space available. 
• Maximum of 250 pages per document. 

You can print in either landscape or portrait 
orientation on 8-1/2x11-inch or 8-1/2x14-inch. 

If you choose to print in landscape mode, the maximum right 
margin is still 8 inches. 

Number of lines of text per page. 

All these figures are based on 12-point, single-spaced text, and 
they include space taken by headers and footers. 

• Image Writer fonts: 45 lines/page. 
• Helvetica: 52 lines/page. 
• Times: 60 lines/page. 

Here are the limits for your margins. 

• Minimum left margin: 1 inch 
• Maximum right margin: 8 inches (regardless of paper size or 

orientation) 
• Margins cannot be within 2 inches of each other 
• Margins cannot be within 3/16 of an inch of a tab 

Ruler Specifications. 

• Minimum space between Tabs: 3/16 of an inch 
• Smallest visible increment: 1/8 of an inch 
• Smallest actual increment: 1116 of an inch 
• Maximum number of Tabs per ruler: 10 
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Visible Area 

Headers and Footers 

Number of Different Fonts 

How much of a document can you see at a 
time? 

• Macintosh 128KorMacintosh512K: 6-118 inches 
• Macintosh XL: 7-114 inches 
• Minimum size of a window: 2-114 inches 

Headers and footers can each have up to six 
paragraphs of text and graphics. 

Headers and footers can have up to just over 3 inches of 
information in them, or about one third of a page. This is also 
the maximum size of the header and footer windows, and since 
you can't scroll through them, it's quite clear when your header 
or footer is too large. 

If your header or footer becomes too large, you will get a 
message to that effect when you close the header or footer 
window or click in the main document window. 

You can also have graphics in your header or footer. Each 
drawing counts as one paragraph and can be as large as the 
entire header or footer. · 

In MacWrite Version 2.2, if you use draft mode to print a 
document that has more than three lines of text in the header or 
footer, a dialog box appears after each header or footer of your 
document is printed. The dialog box states: "The printer is not 

_ responding-check the printer switches, cables, etc.,-click 
OK to continue or CANCEL to quit." The printer continues 
printing and the buttons in the dialog box have no effect 

There's no limit on the number of fonts and 
type styles you can have in a single document. 

However, there is a limit to the number of fonts that will fit in 
the Font menu. On a Macintosh 128K or Macintosh 512K, 
the names of only 20 fonts can be seen in the menu. If you 
have more fonts than that, some will run off the bottom of the 
screen and will not be selectable. On a Macintosh XL, you can 
have up to 22 fonts in the Font menu. (See the Supporting the 
Font/DA Mover module from the Apple Support Training 
Library for more information about adding and removing 
fonts.) 

APPLE SUPPORT TRAINING LIBRARY 



( New Features in 
Version 4.5 

MacWrite Specifications 39 

Here is a summary of the new features of 
MacWrite Version 4.5. 

• Disk-based (Version 2.2 is memory-based) 
• Can handle larger documents 
• Find Next command in Search menu 
• Goto Page # command in Search menu 
• Set Page #command in Format menu 
• Alignment commands in Format menu 
• Page numbers displayed in scroll box 
• 6 lines/inch option in rulers 
• Reduced printing 
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•Review 

MacWrite Benefits 

How to Use MacWrite 

Advanced Techniques 

Common Questions 
and Solutions 

MacWrite Specifications 

Here are the key benefits of MacWrite to help 
with basic product comparisons. 

• Enhance a document's impact 
• Include information from other applications. 
• View your document as it will print. 
• Consistent user interface. 
• High-quality output 

Use existing MacWrite training materials to 
learn how to use the application. 

These will help you become more productive 
with MacWrite more quickly. 

Refer back to them and distribute them to others so they, too, 
can become more efficient Mac Write users. 

These are the questions you can expect to 
get from users of MacWrite. 

Explanations and solutions are included so you can quickly 
help users with their problems. Refer back to this section for 
the answers to commonly asked questions. 

This section covers MacWrite's capabilities 
and limitations. 

A lot of questions are asked regarding the limits of Mac Write. 
This section contains the answers. 
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• MacWrite, the owner's manual, Apple Computer, Inc. 

• AppleLink (If you have access to AppleLink, check it 
regularly for additional information about Mac Write.) 

• MacWrite application training course, Apple Computer, Inc. 

• Macintosh publications (Read the July/August, 1984 issue 
of Macworld and other Macintosh publications such as 
MACazine, Macintosh Connection, and A+ for additional 
Mac Write hints and techniques.) 

Apple and the Apple logo are registered trademarks of Apple Computer, Inc. AppleLink, ImageWriter, LaserWriter, 
MacDraw, MacPaint, MacProject, MacTerminal, MacWrite, and Switcher are trademarks of Apple Computer, Inc. 
Macintosh is a trademark of Mcintosh Laboratory, Inc. and is being used with express permission of its owner. Mac 
Daisywheel Connection and MacSpell Right are trademarks of Assimilation, Inc. MacSpell+ is a trademark of Creighton 
Development, Inc. llayden:Speller is a trademark of Hayden Software Company, Inc. 
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2 Overview 

II Overview 

Data communications is one of the most popular personal 
computer applications today, especially in the office 
environment. MacTerminal™ is the data communications 
application available from Apple for the Macintosh™ computer 
and is a vital link in the data communications chain. 

This module covers the capabilities of Mac Terminal and how to 
use the application to communicate with other computers. 
You'll have an opportunity to connect two Macintosh 
computers and use MacTerminal to transfer information 
between them, including moving Mac Write™ and Microsoft 
Excel information. You will also learn how to connect a 
Macintosh to an Apple® Il computer and to a public 
information service. 

Anyone who will be using MacTerminal should complete 
everything up to and including the Connecting a Macintosh to 
an Apple Il section. Anyone who is supporting other users of 
MacTerminal should complete the entire module; 

Prerequisites 

• Ability to use a Macintosh, which includes using the mouse 
and menus, opening and closing documents, and entering 
text. This can be learned by completing the Learn to Use 
Macintosh module or the Guided Tour of Macintosh, or by 
reading Chapters 1 and 2 of Macintosh, the owner's 
manual. 

• Knowledge of data communications terminology, which is 
covered in the Data Communications Terms module and in 
the Data Communications Primer in the Apple Support 
Programs binder. 

Data communications terminology is also covered in John 
Stanley's Basic Data Communications course on Apple 
products, which is available from: 

John Stanley Training Programs 
208 Charter Oaks Circle 
Los Gatos, CA 95030 
(408) 374-1235 
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Objectives 3 

• List the MacTerminal settings for communicating with the 
following: 

Another Macintosh 
An Apple II 
A public information service 

• Be able to describe the function of every MacTerminal menu 
command. 

• Use the appropriate cable to connect two Macintosh 
computers, correctly configure MacTerminal, and transfer 
information-including a Macintosh disk file- between the 
two computers. 

• Be able to answer commonly asked questions about 
Mac Terminal. 

To complete this module, you will need: 

• Two Macintosh computers (128K, 512K, or XL) 

• Macintosh-to-Macintosh cable or 
Macintosh-to-Macintosh XL cable 

• MacTerminal, the owner's manual. 

• Two MacTerminal application disks 

• One Mac Write application disk 

If available, the following are recommended: 

• External disk drives for both Macintosh computers 

• Access to a public information service such as The Source 
or CompuServe 

• Excel Program Disk 

USING MACTERMJNAL 
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II About MacTerminal 

Overview 

Data Communications 
and Networking 

MacTerminal's Capabilities 

MacTerminal is the data communications 
program for Macintosh. 

Every computer needs special software in order to 
communicate electronically with other computers. This special 
software is called data communications software, and 
MacTerminal is Apple's data communications program for the 
Macintosh. 

This section describes the capabilities of MacTerminal and the 
main uses of data communications software. Later in the 
module, you'll learn how to use MacTerminal to actually 
implement each of the capabilities described. 

Here are the definitions of terms used In 
this module. 

The terms data communications and networking are definied 
many different ways, depending on who you are talking to and 
the environment you're working in. These are the definitions 
that will be used for the duration of this module. 

• Data communications is a temporary connection between 
two computers for the purpose of transferring information 
between them. Once the information has been transferred, 
the communications link is severed. 

• Networki.ng is a permanent wiring-together of many 
computers, partly for the purpose of exchanging 
information, and also to share high-performance (and 
expensive) accessory products such as high-speed printers 
and large-capacity disk drives. 

If you want more information on Apple's networking 
solutions, read the Using the LaserWriter module from the 
Apple Support Training Library. 

MacTerminal enables communication between 
computers. 

MacTerminal enables the exchange of information between 
computers, either via a direct connection or through a modem. 
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Three Main Uses of Data 
Communications Software 

About MacTerminal 5 

MacTerminal can send complete Macintosh 
files. 

You can use MacTerminal to send any Macintosh file to another 
Macintosh, either directly or via a mainframe. A file is any 
Macintosh document or code file, such as a MacProject™ 
document, or the MacProject application itself. 

MacTerminal runs on the desktop with other 
Macintosh applications. 

MacTerminal is fully integrated with other Macintosh 
applications, so you can copy information from other 
applications and paste it into MacTerminal-and vice versa. 

1. Communicate with mainframes. 

The mainframe with which you want to communicate can be 
your in-house business computer, or one located across the 
country-and it can be made by any of a variety of 
manufacturers. MacTerminal can emulate TTY; DEC VTlOO, 
and DEC VT52 terminals. It can also be used in conjuction 
with a protocol converter such as AppleLine™ or the Apple 
Cluster Controller to emulate an IBM 3278 Model 2 terminal. 
(Note: The Apple Cluster Controller is available only in the 
United States.) 

Though MacTerminal can't emulate every specialized terminal, 
it can communicate with many different kinds of host 
computers by using asynchronous ASCII communications 
protocols. 

2. Access information services and public 
data bases. 

MacTerminal can be used with a modem to access a large 
variety of information services and public data bases, including 
the Dow Jones News/Retrieval, The Source, and CompuServe. 

3. Exchange information with other 
microcomputers. 

MacTerminal can be used to communicate, either directly or via 
a modem, with another microcomputer that's also running data 
communications software. 
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What Are Some Actual 
Applications? 

Two Versions of 
Mac Terminal 

MacTermlnal can be used to: 

• Download data from a mainframe and paste it into another 
Macintosh application. 

• Access a mainframe-based electronic-mail network or 
bulletin board. ·· 

• Upload Macintosh text documents to a mainframe-based 
typesetter. 

• Send Macintosh documents across the country in minutes 
(instead of the days it would take via the regular mail). 

• Share information between different kinds of computers. 

This module and the Using MacTerminal with/BM Computers 
module will describe the specific solutions for many of the 
applications described a,bove. , 

There's a new version of MacTerminal and an 
update to the manual. 

MacTerminal Version 2.0 was released in fall 1985. 
The new version: 

• Provides new file transfer options. 
• Supports the 25th line (status line) on AppleLine. 
• Unilaterally filters the file transfer character (Control-\) from 

text-file transfers and from keyboard actions when in 
IBM 3278/AppleLlne mode. 

• Optimizes use of memory in Macintosh 512K. 
• Supports new products, including new ROMs and 

double-sided disk drives. 
• Includes an option to scroll information off the screen, 

instead of erasing it, when a Oear Screen command is 
received. 

• Provides an expanded international character set. 
• Fixes several problems in Version 1.1, including not being 

able to use the Wait for Call command. 

A new manual (p/n 030-1179-A) was releaseed with 
MacTerminal Version 1.1 starting in June 1985. The main 
difference between it and the previous manual is new 
information on the addition of international character sets to the 
Character Set Settings. 

The documentation for MacTerminal Version 2.0 consists of 
the new manual plus an update. In other words, there's no , ·"· 
new manual specifically for Version 2.0. If you need the 
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update, contact your Apple support representative. The new 
features of Version 2.0 are also described in the Specifications 
section of the Supporting MacTerminal module from the Apple 
Support Training Library. 

If you don't have the new manual and/or the new software, 
what you read in your manual and what you see on your screen 
may be slightly different from what you read in this module. 
You are encouraged to upgrade to Version 2.0 of the software, 
and to buy the new version of the manual. However, you can 
complete this module with the original manual and software. 

Everything you type appears in the window. 

There are two ways to receive information using MacTerminal: 
(1) You can receive complete files, which will be represented 
as icons, and whose contents won't be entered into your 
MacTerminal document but will be saved on your disk (see the 
Transferring Files section of this module for more 
information); and (2), you can receive text right into your 
MacTerminal document. 

Once information appears in the Mac Terminal window, it's 
there to stay. Unlike other Macintosh applications, you can't 
cut anything out of a MacTerminal document-you can only 
copy information to be pasted elsewhere. 

Everything you type or paste, and anything you receive into the 
MacTerminal window, appears at the end of the current 
contents of the document. You can't add text in the middle of 
what you already have, because the content of the MacTerminal 
window is actually a record of your communications session, 
and any additional data transfer would naturally occur after 
everything that has already transpired. 

Like all Macintosh applications, if there's more information in 
your document than will fit on the screen, you can scroll 
through the entire contents of the document. Because of this, 
you can receive large amounts of information very quickly, and 
then later scroll through it to read it at a leisurely pace. 

When you save the document, everything that has appeared in 
the window will be saved. The next time you open the 
document, it will be just as you left it, and information entered 
or received will be added to the end of what's already there. 
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MacTerminal Disk 

Three ways to erase Information. 

There are three ways to erase information that's been entered or 
received into a MacTerminal document: 

• Close the document without saving the changes. 
Everything that has been added since the document was 
opened or last saved will be erased 

• Choose Clear Lines Off Top from the Commands 
menu. This will erase everything except the last 23 lines of 
information in the document (the capacity of one full-size 
window). 

• Choose Don't Record Lines Off Top from the 
Commands menu. This will erase everything that scrolls 
off the top of the screen. 

Erasing the entire contents of a document. 

If you want to erase the current contents of a document: 

1. Choose Clear Lines Off Top. 
2. Change the Line Width to 132 Characters. 
3. Change the Line Width back to 80 Characters. 

Another way to create an empty MacTerminal document is to 
open a new document (see below) and then configure it as you 
did the original. 

The MacTerminal disk provides the application 
and several preconfigured documents. 

In addition to startup information, the MacTerminal disk 
contains the application plus six preconfigured documents. 
Each is an empty document that is set up to communicate with 
or through a particular system or device .. 
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If you open the MacTerminal application icon, shown at left, 
you'll get an untitled document that you'll need to configure for 
the system with which you're going to establish a connection. 

Use the preconfigured documents as templates. If you open 
one of them, you should either not save your changes when 
you close it, or else choose Save as to save the document 
under a different name. Or, you can make a duplicate of the 
template before you begin. Then, any time you want to use 
template, it won't be cluttered with remnants of previous data 
communications sessions. You can also create your own 
templates for other systems with which you regularly 
communicate. 

In the MacTerminal Setting section of this module, always 
open the MacTerminal application icon instead of one of the 
templates. This will help to ensure that you understand each of 
the configurations taught in that section. Then, later on, you 
can use the templates to save time that would otherwise be 
spent configuring the document. 
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II MacTerminal Menu Commands 

Overview 

Menu Commands 

In this section, you will learn about all of the 
MacTerminal menu commands. 

MacTerminal has a wide range of features that you should learn 
about and be able to implement as needed. Learning the 
function of each of the menu commands will tell you a lot about 
MacTerminal's wide range of capabilities. It's also the first 
step toward actually learning how to use MacTerminal. 

In the next section, you'll have a chance to put some of the 
commands to use. 

The function of each menu command is 
explained in the manual. 

This and other sections of this module refer you to 
MacTerminal, the owner's manual. Take the time to read the 
manual, not only to learn the information, but also to become 
familiar with it as a valuable reference tool. 

Read Chapter 3 of the MacTerminal manual. It explains the 
function of every menu command, grouped by menu. 

Continue with this module when you have finished reading 
Chapter3. 
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( 11 Terminal Settings 

Overview 

( 

Terminal Settings 

( 

This section describes terminal settings for the 
most common uses of MacTerminal. 

MacTerminal has the flexibility to communicate with a wide 
range of computers, each of which expects to receive 
information in a particular format. Before you can correctly 
configure MacTerminal to communicate with a specific 
mainframe, microcomputer, or pubiic information service, you 
need to know the correct terminal and compatibility settings. 

This section describes the settings that are appropriate for the 
computers with which you'll be communicating most 
frequently. The configurations discussed will enable you to 
connect to: 

• A Macintosh (128K, 512K, or XL) 
• An Apple Ile or Apple Ile 
• Most public information services 

A practice exercise is provided at the end of the section to 
ensure that you know how to configure MacTerminal in each of 
these situations. 

The various terminal settings are explained in 
the manual. 

The Settings menu contains the commands used for 
configuring MacTerminal to communicate with a particular 
computer. 

A detailed explanation of each of the settings is included in 
MacTerminal, the owner's manual. It explains all of the 
options for configuring your Macintosh as a terminal and for 
sending and receiving information. (You should already have 
read about the Settings menu in Chapter 3 of the 
MacTerminal manual.) · 
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To Connect to 
Another Macintosh 

To Connect to 
an Apple II 

To Connect to 
Public Data Bases 

The manual explains the terminal settings 
used for connecting to another Macintosh. 

When you want to connect two Macintosh computers, 
configure them identically. This will enable both systems to 
send and receive information. If you want to connect to a 
Macintosh XL that's running LisaTerminal™, configure 
MacTerminal in exactly the same way as you would to connect 
to another Macintosh running MacTerminal. 

Read the Communicating With Another Macintosh section in 
Chapter 2 of MacTerminal, the owner's manual, to learn how 
to configure MacTenninal to communicate with another 
Macintosh. Continue with this module when you have finished 
reading the manual. 

Configure MacTerminal as you would to 
communicate with another Macintosh. 

Access II (on either the Apple Ile or Apple Ile) and 
MacTerminal have very similar capabilities and features. 
Configure both programs in the same way as you configured 
MacTerminal to communicate with another Macintosh. 

Use the asynchronous ASCII protocol to 
access a public information service. 

When you create a new MacTerminal document, it's preset to 
communicate with most public information services, though, 
depending on the modem you're using, you may have to 
change the baud rate. The next two screen shots show the 
terminal settings and compatibility settings·of a MacTerminal 
document configured to communicate with a public information 
service through an Apple Modem 1200. 

Terminal Settings 

Termlnol 

Mode 

Cursor Shope 

Choracter Set 

Line Width 

Protocol conu 

181 on Line 

® UTIOO 0TIY 

@)RNSI 

®Underline 

® United States 

® 80 Columns 

0 111>1>11~1.irl(~ 

O Locol Echo 

0 IBM 3278 

QUT52 

O Block 

O United Kingdom 

O 132 Columns 

Q [ 1Us1 <!I" C1lr 

D Status Lights 

181 Ruto Repeat D Ruto Wraparound D New Line 

D Repeot Ctrls O rrm1-.purnnt 
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Compatibility Settings 

Baud Rate O 50 075 0 110 0134.5 

0 150 0200 0300 0600 

® 1200 01800 02000 02400 

03600 0 4800 09600 0 19200 

Bits per Character 0 7 Bits ® 8 Bits 

Parity 0 Euen O Odd ®None 

Htindshalce O HOn/HOff ®None 

Connection ®Modem O Rnother Computer 

I ,... .,• J r;=;;:-i 
Connection Port ® I~ J O l~J I 0 (ctincel~ 

Why certain settings were chosen-and why 
others may be changed. 

Why choose VTlOO rather than TTY? TTY (teletype) 
ignores many commands from the remote computer that 
VTlOO can respond to. TTY responds only to returns, tabs, 
backspaces, and line feeds; it ignores control characters and 
escape sequences. 

Why choose ANSI (American National Standards Institute) 
rather than VT52? VT52 provides a set of cursor-control 
functions that isn't normally available. Use VT52 if the 
computer you are communicating with supports it; use ANSI 
whenever VT52 isn't available. 

The Cursor Shape and Line Width settings are a matter of 
personal preference. 

Change the Baud Rate setting to 300 if you're using a 
300-baud modem. 

The Handshake setting is None because XOn/XOff isn't 
needed when the baud rate is 1200 or lower. 
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Practice 

Mark Appropriate Settings Configure MacTerminal to communicate with 
the computer indicated. 

On the facing page are four pairs of screen shots, each 
consisting of a Terminal Settings window and a Compatibility 
Settings window. Mark the appropriate settings for each data 
communications situation. If it would be helpful, refer to the 
manual or to any portion of this module. 

When you have finished, check your answer against the 
Feedback section that follows this exercise. 
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Another Macintosh 

Terminol Settings 

Terminol 0 UT100 OTTY 

Mode 0RNSI 

Cursor Shope O Underline 

Chorocter Set O United Stotes 

Line Width O 80 Columns 

Protocol Conu O Rppleline 

D On Line D locol Echo 

Terminal Settings 15 

Configure MacTerminal to connect directly to 
another Macintosh (not through a modem). 

Compotibility Settings 

0 IBM 327B Boud Rote 050 075 0110 0134.5 

0UT52 0150 0200 0300 0600 

O Block 
01200 01BOO 02000 02400 

03600 04BOO 09600 019200 
O United Kingdom 

Bits per Chorocter 0 7 Bits 0 8 Bits 
0 132 Columns 

Pority OEuen 00dd ONone 
0 Cluster Ctlr 

Hondshoke 0 HOn/HOff ONone 
D Stetus Lights 

Connection 0Modem O Another Computer 
D Rulo Repeot D Rulo Wreporound D New Line 

01%] 0(8] D Repeet Ctrls D Tronsporent 

Public Data Bases 

Terminol Settings 

Terminol 0UT1DO 0TTY 

Mode 0ANSI 

Cursor Shepe OUnderline 

Cherecter Set O United Stetes 

Line Width 080 Columns 

Protocol Conu 0 Rppleline 

D On Line D local Echo 

D Auto Repeet D Auto Wraparound 

D Repeet Ctrls D Transparent 

0 (c11nce1) 
Connection Port 

0 

Configure MacTerminal to communicate via a 
modem with a public data base or information 
service. 

Compotibility Settings 

0 IBM 3278 Beud Rete 050 075 0110 0134.5 

0UT52 0150 0200 0300 0600 

OBlock 
01200 01800 02000 02400 

03600 04800 09600 019200 
O United Kingdom 

Bits per Cheracter 0 7 Bits 08 Bits 
0 132 Columns 

Parity OEuen 00dd ONone 
O Cluster Ctlr 

Hendshake 0 HOn/HOff ONone 

(cencel) 

D Status lights 
Connection OModem O Another Computer 

ONew line 

01%] 0(8] 0 (cancel) 
Connection Port 

0 (cancet) 
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Feedback 

Check Your Answers Check your answers against those shown 
here. 

In the Terminal Settings, the Cursor Shape and Line Width 
options can be set either way. In the screen shots on the next 
two pages, they are set the way they are most often used. But 
their actual setting is left to your personal preference. 

If there are discrepancies that you don't understand, reread the 
section of the manual that pertains to that feature. If you still 
have questions, check with a colleague, the course manager, 
your Apple support representative, or anyone else who is 
familiar with MacTerminal or data communications in general 
(such as your data-processing manager). 
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Another Macintosh 

Termin11I Settings 

Terminal ® UT100 0 TTY 

Mode @RNSI 

Cursor Shape ®Underline 

Character Set ®United states 

Line Width ® 80 Columns 

Protocol Con11 0 ii1>1Jiei.irm 

t8l On Line 181 Loc11I Echo 

Terminal Settings 17 

Configure MacTerminal to connect directly to 
another Macintosh (not through a modem}. 

0 IBM 3278 

0DT52 

0Block 

0 United Kingdom 

0 132 Columns 

0 i: iusfo1· t:iir 

D Status Lights 

Comp11tibility Settings 

Baud R11te 050 075 

0150 0200 

01200 01800 

03600 04800 

Bits per Character 01 Bits 

Parity OEuen 00dd 

Handshake 0 HOn/HOff 

0110 0134.5 

0300 0600 

02000 02400 

®9600 019200 

®8 Bits 

®None 

®None 

t8l Ruto Repeat 

D Repent Ctrls 

181 Ruto Wrap11round t8l New Line 
Connection O Modem ® Rnother Computer 

Connection Port ® l~I O l~I ~ Ir::::;) 

~~ 

Sometimes you'll use a different baud rate. 

Since you are connected directly, you can use 9600 baud. If 
you were connected through a modem, you would set the baud 
rate to that of the modem (usually 300 or 1200 baud). 

You would normally use the XModem protocol. 

When communicating with another Macintosh, you would 
normally use the XModem protocol. (XModem is available in 
the File Transfer Settings window, which isn't shown.) The 
XModem protocol performs error checking as the information 
is sent, therefore greatly decreasing the chance of erroneous 
data being received. (For more information on the XModem 
protocol, see the Transferring Files section of this module). 

XOn/XOff controls the flow of information so that the 
receiving buffer doesn't overflow. This is one way of 
ensuring error-free data transmission. Since the XModem 
protocol also ensures error-free data, you don't need to use 
XOn/XOff flow control when using XModem. 

The preceeding screen shots assume XModem is on. 
Therefore, the Handshake setting is None. If you choose not 
to use the XModem protocol, change the setting to XOn/XOff 
if the baud rate is greater than 1200. 
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Feedback (cont'd) 

Public Data Bases 

Terminal Settings 

Terminal @UTIOO 0TTY 

Mode @RNSI 

cursor Shape @Underline 

Character set @United States 

Line Width @80 Columns 

Protocol Con11 0 H!>t>ll~l.ine 

181 On Line 0 Local Echo 

Configure MacTerminal to communicate via a 
modem with a public data base or information 
service. 

Compatibility Settings 

0 IBM 3278 Baud Rate O 50 075 0110 0134.5 

0UT52 0150 0200 0300 0600 

0Block 
@ 1200 01800 02000 02400 
03600 04800 09600 0 19200 

O United Kingdom 
Bits per Character 01 Bits @8 Bits 

O 132 Columns 
Parity OEuen QOdd @None 

0 [ IUS1 er CHI' 
Handshake 0 HOn/HOff @None 

O Status Lights 
Connection @Modem 0 Rnother Computer 

181 Auto Repeat 0 Auto Wraparound O New Line 

@[%] o~ D Repeat Ctrls 0 lnm~pon~nt ~ (cancel} 
Connection Port 

~ (cancel} 

Some settings may vary. 

Pcirity and Handshake settings can vary from one information 
service to another. Check the user's manual for the service 
you're using to see which settings you should use. 

What if you use the wrong settings? 

If the settings are wrong, a variety of things can happen. You 
may see nothing on your screen, or random characters, or a 
combination of the two. Check the Feedback section for the 
practice exercise in which you actually connect to an 
information service, (later in this module), and the Question 
and Answer section in the Supporting MacTerminal module, 
for solutions to specific problems. 

(Note: You can use the same settings for protocol converters 
that you use for public data bases.) 
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Configure MacTerminal to communicate with 
another Macintosh. 

You have read about the MacTerminal menu commands and 
you now know the correct terminal settings for communicating 
with another Macintosh. Now it's time to put this knowledge 
to work. 

Do the followng steps as they are described: 

1. Start up your Macintosh using the MacTerminal disk. 
2. Open the MacTerminal disk icon. 
3. Open the MacTerminal application icon (shown at left) to 

create a new document. 
4. Enter the correct terminal and compatibility settings for 

communicating with another Macintosh. 
5. Leave the MacTerminal document open when you've 

finished. 

When you have finished, check your work against the feedback 
on the next page. 
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Feedback 

Configure MacTerminal 

Terminal Settings 

Terminal @UT100 om 
Mode @RNSI 

Cursor Shape ®Underline 

Character Set ® United States 

Line Width @80 Columns 

Protocol Conu 0 lll)llh~l.in<~ 

181 On Line 181 Local Echo 

Configure MacTerminal to communicate with 
another Macintosh. 

After opening a new MacTerminal document, you should have 
chosen Terminal and Compatibility from the Settings 
menu, and entered the correct settings. 

To check your work, do the following: 

1. Choose Terminal from the Settings menu. 
2. Check your settings against the Terminal Settings window 

shown below. 
3. Click on OK to close the Terminal Settings window. 
4. Choose Compatibility from the Settings menu. 
5. Check your settings against the Compatibility Settings 

window shown below. 

Compatibility Settings 

0 IBM 3278 Bttud Rate 0 50 075 0110 0134.5 

OUT52 0150 0200 0300 0600 

0Block 
01200 01800 02000 02400 

03600 04800 ®9600 019200 
0 United Kingdom 

Bits per Character 07 Bits ® B Bits 
O 132 Columns 

Parity OEuen QOdd ®None 
O c lus101· cor 

Handshake 0 HOn/HOff ®None 
0 Status Lights 

Connection OModem ®Another Computer 
181 Ruto Repeat 181 Ruto Wr11p11round 181 New Line 

@[%] o~ 0 Repeat Ctrls 0 fl"<tr1~1>1iren t ~ (cancel) 
connection Port 

0 (cancel) 

If your settings are different than those shown, do one of the 
following to be sure you understand the steps you should 
follow, and why each setting is appropriate: 

• Reread the Terminal Settings section of this module. 
• Read the section about menus in the MacTerminal manual. 
• Check with a colleague, your course manager, or your 

Apple support representative. 
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II Connecting to Other Computers 

Overview 

Two Options for 
Connection 

Direct-Connect Cable 

Understanding some basic concepts will help 
make connecting to another computer easy. 

Regardless of which computer you are going to connect to, 
there are some basic concepts that always apply. This section 
discusses how to connect to another computer, which 
computers vou can communicate with, and some basic rules 
that make the process easy. 

You can connect either directly or through a 
phone line. 

Most data communications functions are accomplished through 
the telephone system, using a modem. However, if the 
computer you want to communicate with is close to your 
computer, you can establish a direct connection between the 
two computers, using the appropriate cable. (The maximum 
distance over which this is possible depends on the cable 
vendor's specifications and the baud rate that you want to use.) 

If you connect directly (as opposed to through a phone line), 
you can usually send and receive information faster and with 
fewer errors. You also eliminate the need for a modem at each 
end. The key benefit of a modem is that it allows you to 
communicate over very long distances through a system that is 
already in place and easily accessible-the phone system. 

Use a serial communications cable. 

Serial cables are used to connect a Macintosh to a large variety 
of devices--0ther computer, modems, printers, and so forth. 
However, each cable is different. The cable used for a direct 
connection must be configured such that one computer's 
transmit line connects with the other computer's receive line, 
and vice versa. (Modem cables are discussed later in this 
module.) 

The pinouts for the Macintosh 9-pin serial ports are listed in the 
Pinouts section of the Supporting MacTerminal module. To 
build a custom cable, you also need to know the pinouts for the 
other computer. 
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Connect via a Modem 

Apple makes a Macintosh-to-Macintosh cable. 

If you want to temporarily connect a Macintosh to another 
Macintosh for data communications purposes, be sure to use 
the appropriate cable (p/n 590-0200). It's included with the 
Macintosh 68000 Development System (order from Macintosh 
Products price list, p/n M0534). You can also use a Macintosh 
modem cable (p/n 590-0197) if you cut off (clip) Pin 6 at each 
end. Once you do this, however, you will no longer be able to 
use the cable as a modem cable. 

If you want to connect a Macintosh to a Macintosh XL or an 
Apple Ile, use the Macintosh Image Writer™ cable 
(p/n 590-0169). 

(Note: Part numbers are included here for identification 
purposes only. You may or may not be able to order each 
cable independently. Check Apple's service parts price list.) 

If you need to build your own cable, see the table in the 
Pinouts section of the Supporting MacTenninal module for 
specifications. 

Use a modem to connect two computers 
through the telephone system. 

If the computer you want to communicate with is not close 
enough to be directly connected by a cable, use a modem to 
connect the computers through telephone lines. A modem is a 
hardware device that connects to both your computer and the 
phone line, and enables your computer to use the existing 
.phone system to exchange information with other computers. 

A modem takes computer information and translates it into 
telephone signals. At the receiving end, the modem translates 
the telephone signals into digital information that can be 
understood by a computer. This translation process is called 
"MOdulation/DEModulation," hence the name modem. 

There are three Apple modems. 

Apple currently manufactures the Apple Modem 300, which is 
a 300-baud modem that fits under a desktop telephone, and the 
Apple Personal Modem, which is a 300/1200-baud modem 
designed to plug directly into a wall outlet. Until October 
1985, Apple also made the Apple Modem 1200, which is a 
300/1200-baud "under the phone" modem-now replaced by 
the Apple Personal Modem. The modems can be used with 
any Apple computer, but be sure to get the appropriate modem 
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Accessory Kit, which includes the correct cable and manual, 
for the computer you're using. (There's a different Accessory 
Kit for each computer.) 

On the back of the Apple Modem 300 and Apple Modem 1200, 
there are three switches. Check the table below for the correct 
settings when using the modem with MacTerminal. Refer to 
the owner's manual that came with the modem for more 
information about the switch settings. 

Power Cable 
Connector 

(WI) BD. 
Telephone 

Jacks 

Apple Modem 300 
Apple Modem 1200 

Cable 
Connector Switches 

Switch 1 
Down 
Down 

Switch 2 
Either 

Up 

On-Off 
Switch 

Switch 3 
Up 
Up 

If you want to use the Apple Modem 1200 at 300 baud, just set 
the baud rate of your MacTerminal document to 300. You 
don't need to change anything on the modem itself. 

There aren't any switches on the Apple Personal Modem. 

You can also use third-party modems. 

You can use any third-party modem with Macintosh as long as 
it's 212A-Type compatible (for 1200-baud modems), or 
Bell-103 compatible (for 300-baud modems). 

Be sure you have the appropriate cable: Use the pinouts in the 
Supponing MacTerminal module, along with similar 
information for the modem you are using to determine what 
kind of cable you should purchase or build. 

Some modems are called smart modems because they can 
understand a variety of commands sent from the computer. 
(All three Apple modems are smart modems.) As you choose 
different MacTerminal menu options, specific commands are 
sent to the modem. For example, when you choose Dial from 
the Phone menu, the code "A TDT" followed by the phone 
number is sent to the modem (AT= Attention; DT = Dial, 
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Modem Cable 

Which Computers Can 
You Communicate with? 

Touch Tone). You could accomplish the same thing manually , 
by typing the appropriate code-MacTerminal saves you that 
work. 

The modem you are using may not use the same set of 
commands, in which case you won't be able to use the 
MacTerminal menus. But you can always communicate with a 
smart modem by typing the appropriate commands from the 
keyboard. Check the owner's manual for the modem you are 
using or just experiment to see whether the modem understands 
the MacTerminal commands. 

Apple manufactures modem cables, but you 
can also build your own. 

When connecting a Macintosh to an Apple Modem 300 or 
Apple Modem 1200, you can either use Apple's modem cable 
(p/n 590-0197) or build one according to the table in the 
Pinouts section of the Supporting MacTerminal module. The 
cable for connecting a Macintosh to an Apple modem is the 
same as the Macintosh-to-Macintosh cable, except that Pin 6 
should be wired straight through. 

When connecting to an Apple Personal Modem, always use the 
connector that comes in the modem Accessory Kit. The 
connector on the Apple Personal Modem is an 8-pin 
mini-circular jack. The cable has the corresponding circular 
connector on one end and either a DB-9 connector (for 
Macintosh 128K and Macintosh 512K) or a DB-25 connector 
(for Macintosh XL and Apple Ile) on the other. 

You can communicate with microcomputers, 
minicomputers, and mainframes. 

As stated earlier, MacTerminal can emulate DEC VT52 and 
VTlOO terminals, as well as IBM 3278 Model 2 terminals (in 
conjunction with AppleLine or the Apple Cluster Controller). 
In addition, you can use MacTerminal with third-party protocol 
converters to communicate with many other mainframes. If a 
protocol converter isn't available for the particular mainframe 
you are connecting to, you can often still communicate as a 
dumb terminal, using asynchronous ASCII. This is usually the 
way MacTerminal connects to a public information service or 
data base. 

APPLE SUPPORT TRAINING LIBRARY 



( 

( 

Check Protocol and 
Terminal Settings 

Connecting to Other Computers 25 

To learn more about information services, read the Connecting 
to a Public Information Service section of this module. For 
more information regarding connecting to IBM computers, see 
the Using MacTerminal with IBM Computers module from the 
Apple Support Training Library. 

For more information on which computers you can 
communicate with, and how to do it, see the data 
communications information in the References section of the 
Apple Support Programs binder. It includes a list of what's 
available and methods for connecting to a large variety of 
minicomputers and mainframes. Also, if you have access to 
AppleLink™, check the Tech Support news icon and the 
Technical Info library. 

The key to communicating with another 
computer Is to have identical terminal settings. 

The key to communicating with another computer is the same 
as it is when you are trying to talk to another person: You must 
be speaking the same language. Applying this to the data 
communications world, the two computers must be using the 
same baud rate, parity, and so forth. 

This is a complete list of all the settings that must match in 
order for you to establish a working connection between two 
computers: 

Baud rate 
Terminal type (VTlOO, TIY, etc.) 
Bits per character 
Parity 
Handshake (XOn/XOff, None) 

These are some other settings that affect how the information 
appears on your screen, but that don't prohibit you from 
making the connection: 

Cursor shape 
Line width (80 or 132 characters) 
Local echo (simplex, half duplex, full duplex) 
Auto wraparound 
Automatic line feed 

If you are not sure how to configure Mac Terminal, contact the 
technical support person for the computer you are trying to 
communicate with, and ask about these settings. 
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Helpful Hint Create a MacTerminal document for each of 
the different computers you communicate with. 

If you use Mac Terminal to communicate with a variety of 
different computers, set up a MacTerminal document for each 
one. Then, when you want to connect to a particular computer, 
you can just open the appropriate document and you're all set 
to go. When you finish the session, either don't save the 
changes, or choose Save As to save the document under a 
different name. That way, your original document won't get 
filled up with old information, and will always be ready to go. 

Your MacTerminal disk came with MacTerminal documents 
configured for communicating to another Macintosh, to public 
information services, via AppleLine, and to the Apple Cluster 
Controller. You may want to add documents for 
communicating with your in-house mainframe, or with specific 
information services such as Dow Jones News/Retrieval, The 
Source, or CompuServe. 
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( 11 Transferring Files 

( 

Overview 

Two Ways to Send and 
Receive Information 

How and why would you use MacTerminal's 
file transfer capabilities? 

Sending text through MacTerminal sends text, nothing more. 
What if you want to send someone a Mac Write document 
complete with formatting and type styles? Or a MacDraw™ 
document? You can't send either of these via MacTerminal as 
text, but you can send tliem as complete files. 

This section begins with an explanation of the two ways to 
send information: 

• On-line conununication, in which text is entered and 
received into the MacTerminal window; and 

• File transfer, in which entire files and documents are sent. 

You will get a chance to try both ways of sending and receiving 
information in the Connecting to Another Macintosh section of 
this module. The remainder of this section details the file 
transfer capabilities of Mac Terminal, and how to send and 
receive complete files. 

1. Enter and receive information directly in the 
MacTerminal window. 

One way to send information to another computer is to 
establish the connection and then simply enter the information 
into the MacTerminal window, either by typing it or by pasting 
it in from another document. As soon as the information 
appears in the window, it is sent to the other computer. 

In the same way, information sent by the other computer 
appears in your MacTerminal window, along with whatever 
you enter. This is the only place the information appears. So, 
if you want to save it, you must copy it and paste it into another 
document, or save the MacTerminal document itself. 

This back-and-forth, interactive dialog is often called on-line 
communication. 

2. Send and receive complete files. 

The alternative is to send or receive complete files, all at once, 
without any interaction or dialog. This is called file transfer 
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XModem Protocol 

and is made possible by the XModem protocol, which will be 
described shortly. 

There are two types of files you can send using the file-transfer 
capabilities of MacTerminal: text files and disk files. Text files 
are documents that contain only text-they don't have any 
format or type-style information associated with them. Text 
files include MacTerminal documents, AppleLink documents, 
and documents saved using Text Only. Disk files include 
everything on a disk-documents, systems files, code files, 
and text files. 

If you are receiving text, it will always appear in the 
MacTerminal window-regardless of whether it's sent via 
on-line communication or file transfer. (In other words, ASCII 
text is always received in the window.) When you receive a 
disk file (for example, one sent using MacTerminal's file 
transfer capabilities), nothing will appear in the MacTerminal 
window, but a new icon will be added to your disk. 

XModem Is a protocol that enables you to send 
and receive Macintosh disk files. 

Choosing File Transfer from the Settings menu offers you 
a choice of five different file transfer options (as shown below 
for MacTerminal Version 2.0). The first option is for 
transferring text, and the other four options are variations of the 
XModem protocol, and are used for sending complete files. 
The only options in MacTerminal Version 1.1 are XModem 
and Text, and the window looks slightly different. Check the 
MacTerminal manual to see what it looks like. 

(Note: If you don't know which version of Mac Terminal you 
have, open any MacTerminal document and choose About 
MacTerminal from the Apple menu.) 

File Transfer Settings 

Settings for P11sting or Sending TeHt: 

Del11y Between Chars ~ 60ths Second 

Del11y Between Lines ~ 60ths Second 

1:81 Word Wrap Outgoing TeHt 

Settings for s11ulng lines off top: 

1:81 Retain Line Bre11ks 

D Saue Screens Before Clearing 
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The XModem protocol enables MacTerminal to send and 
receive data in an uninterpreted binary form, and to perform 
error checking on each block of characters it sends or receives. 
The XModem protocol sends 128-character blocks of data and 
calculates a "checksum" as the data is received. (A checksum is 
the sum of the numerical value of all of the characters in a 
block. It's used to verify that the information was sent 
correctly.) After the entire block has been received, the 
checksum is sent back to the sending system, which verifies 
that it's correct. If the checksum is correct, the block of data 
was sent without error, and the next block is sent. If the 
checksum is incorrect, the block is retransmitted. 

(Note: The XModem protocol is equivalent to the 
"MODEM7" and the "Ward Christensen" protocols.) 

Here's a brief description of each of the five options available 
in the File Transfer Settings window. Read the MacTerminal 
manual update for more information about these options. 

• Text. For sending text files to any computer that doesn't 
support the XModem protocol. The Text option sends and 
receives files as ASCII characters. Most Macintosh 
applications give you the option of saving a document either 
with its formatting and graphics, or as text only (which 
saves only the text itself, but not the formatting or type-style 
information). 

• MacBinary. For exchanging Macintosh files with another 
Macintosh or any other system that supports the XModem 
protocol, such as CompuServe. 

• XModem Text. For exchanging text files with 
non-Macintosh systems that support the XModem protocol. 
Line feeds and returns are adjusted to achieve proper word 
wrapping at the end of each line. 

• MacTerminal 1.1. For exchanging Macintosh files with 
another Macintosh that's running either MacTermnal 
Version 1.1 or another utility that's compatible with 
MacTerminal Version 1.1. 

• Straight XModem. For sending (not receiving) 
Macintosh text files to a non-Macintosh system without 
translating the data in any way (as opposed to XModem 
Text). 

MacTerminal isn't the only program that uses the XModem 
protocol. Other computers with other communications 
software can also send and receive data using this protocol. 
Use it whenever you can, since it allows MacTerminal to 
transfer entire documents (including fonts, type sizes and 
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Sending Files 

styles, and graphics) and code files (such as applications) 
without error. 

If the computer you're communicating with doesn't support the 
XModem protocol, you can only send text information from 
Mac Terminal. 

When and how to use XModem and Text. 

As described above, you can use either the XModem protocol 
or the Text protocol to transfer files. But when should you use 
each, and what are the results in each case? This section 
describes the results of using the XModem and Text features 
ofMacTerminal Version 2.0 when sending and receiving files. 
(If you're still using Version 1.1, the commands are very 
similar. Check the Mac Terminal manual.) 

Sending a file using XModem. 

Use this to send files to another Macintosh and to any other 
computer that supports the XModem protocol. 

To send a file to any computer that supports XModem 
(including another Macintosh), do the following: 

1. Choose the appropriate XModem option. (See the Four 
"Real World" Situations at the end of this section, or the 
Specifications section of the Supporting MacTerminal 
module for a description of what's available.) 

2. Be sure the other system is running the appropriate data 
communications software and that it's correctly configured 
to communicate with your Macintosh. If you can't 
personally check the other system (for example, it's across 
the country), call the person who's waiting to receive the 
information and ask him to check it. 

3. Choose Send File from the File menu. You'll get a list 
of all files on the startup disk, including documents, 
system files, and code files. 

5. If there's a disk in the external drive, click Drive to 
display its contents. 

6. Select the document you want to send. 

7. Click Send. 

You'll get a window indicating the progress of the file transfer, 
but nothing will appear in your MacTerminal window. 
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Sending a file using the Text option. 

Remember that with the Text option, you can only send text 
documents. You can't send graphics, and any formatting 
information will be lost. Use this option only when the 
receiving computer doesn't support the XModem protocol. 

To send a text file to a computer that doesn't support XModem, 
do the following: 

1. Select Text in the File Transfer Settings window. 

2. Be sure that the other system is running the appropriate 
data communications software and that it's correctly 
configured to communicate with your Macintosh. If you 
can't personally check the other system (for example, it's 
across the country), ask the person who's waiting for the 
information to check. 

3. Choose Send File from the File menu. You'll get a list 
of all text documents that are on the startup disk. 

4. Click Drive to display the text documents that are stored 
on either the disk that's inserted into the external drive or 
on an available hard disk. 

5. Select the document you want to send. 

6. Click Send. 

The entire document will now be sent. All of the text will 
appear in your MacTenninal window, just as if you had typed 
it or pasted it in from another document. 

There are four situations in which you will 
receive information using MacTerminal. 

You can receive: 

• A Macintosh file from any computer system (including 
Macintosh) that supports XModem. 

• A Text file from a computer other than a Macintosh that 
supports XModem. 

• A code file from a computer other than a Macintosh that 
supports XModem. 

• Text from a computer other than a Macintosh that doesn't 
support XModem. 

This section describes how to use MacTerminal to receive 
information in each of these situations. 
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D 
Blank Page Icon 

Receiving a Macintosh file. 

Use the XModem protocol to receive a Macintosh file from any 
other computer that supports the XModem protocol. Inherent 
in this statement is the fact that the other system must support 
Macintosh files. 

To receive a Macintosh file from any other system, do the 
following: 

1. Select MacBinary in the File Transfer Settings window. 

2. Choose Receive File. Macintosh will wait 1 112 minutes 
for the file to be sent. 

3. If you are connected via a modem, choose Wait For Call 
from the Phone menu. 

You'll get a window indicating the progress of the file transfer, 
but nothing will appear in your MacTerminal window. When 
you quit MacTerminal, you'll see an icon identical to the 
original icon on the sending system. You can open it if you 
have the appropriate application. 

Receiving a text file. 

To receive a text file from a computer other than a Macintosh 
that supports XModem, do the following: 

1. Choose XModem Text in the File Transfer Settings 
window. 

2. Choose Receive File from the File menu. You'll be 
asked to enter a name for the file that's about to be created. 
Your Macintosh will wait for the file for 1 1/2 minutes after 
you click Receive. 

3. If you are connected via a modem, choose Wait For Call 
from the Phone menu. 

You'll get a window indicating the progress of the file transfer, 
but nothing will appear in your MacTerminal window. When 
you quit MacTerminal, you'll see a Blank Page icon (shown at 
left) representing the file you just received. To open the file, 
open the Mac Write application icon, close the untitled 
document, and then use the Open command. 

Receiving a non-Macintosh code file. 

To receive a file that isn't a text file or a Macintosh file (for 
example, a code file or a data file containing non-text 
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information), from a computer other than a Macintosh that 
supports XModem, do the following: 

1. Choose Straight XModem in the File Transfer Settings 
window. 

2. Choose Receive File from the File menu. You'll be 
asked to enter a name for the file that's about to be created. 
Your Macintosh will wait for the file for 1 1/2 minutes after 
you click Receive. 

3. If you are connected via a modem, choose Wait For Call 
from the Phone menu. 

You'll get a window indicating the progress of the file transfer, 
but nothing will appear in your MacTerminal window. When 
you quit MacTerminal, you'll see a Blank Page icon (shown at 
left) representing the file you just received. You can open it if 
you have the appropriate utility, or you can store it and later 
forward it using Straight XModem without ever opening it. 
If you can open the file using any Macintosh application, then 
you should have used the MacBinary option to transfer it. 

Receiving a file using the Text option. 

If you indicate Text in the File Transfer Settings, the Receive 
File command in the File menu will be dimmed. You can 
use the Text option to send a file, or to receive text directly into 
your MacTerminal window during an on-line communication 
session, (which you can then copy and paste into another 
document). But you can't receive a text file directly to disk 
using the Receive File command. 
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Summary Refer to this chart for the effects of XModem 
and Text on sending and receiving files. 

Send a File Receive a File 
XModem Who: To a Macintosh and 

any other system that 
supports XModem. 

From a Macintosh and 
any other system that 
supports XModem. 

Text 

How: Choose Send File. 
Select document and 
click Send. 

Result: Nothing appears in 
window. 

Who: 

How: 

Any system that doesn't 
support XModem. 

Choose Send File. 
Select document and 
click Send. 

Result: Text appears in 
MacTerminal window. 
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Receive File. 

Nothing in window; icon 
appears in Finder. 

This option not 
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receive only text, not 
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When should you use XModem, and when 
should you use Text? 

If you're running MacTerminal, there are four possibilities for 
sending and receiving files. (See the diagram below; your 
Macintosh is the one in the middle.) This section will explain 
when you would use one of the XModem options and when 
you would use the Text option in each of the situations 
described. 

Macintosh 

Not a 
Macintosh 

running 
MacTerminal 

Receiving a file from another Macintosh. 

Macintosh 

Not a 
Macintosh 

Always use XModem. That way you '11 preserve the formatting 
and type styles that are in the original, and you'll be able to 
receive graphics. In Version 1.1, the Macintosh sending the 
file will automatically arrange for your Macintosh to receive it 
as long as you have a MacTerminal document open. (You 
don't have to choose Receive File; all you have to do is be 
sure MacTerminal is correctly configured and then wait for the 
file to arrive.) When you're using MacTerminal Version 2.0, 
you must choose Receive File. 
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Based on which versions of Mac Terminal are running on the 
sending and receiving systems, choose XModem and the 
appropriate file transfer setting from the table below. (Use this 
table when you are sending or receiving information.) 

Scn~r R~civer ChQQSC This QiltiQn 
20 20 MacTerminal for Remote System 
1.1 1.1 MacBinary 

1.1} 
If you're using Ver 2.0, 

20 choose: MacTerminal 1.1. 
1.1 2.0 If you're using Ver 1.1, 

choose MacTerminal. 

Sending a file to another Macintosh. 

Always use XModem and be sure the receiving Macintosh is 
also using XModem. Choose Send File from the File menu, 
select the file you want to send, and click Send. 

Based on which version of MacTerminal is running on each 
system, configure the systems the same way as described 
earlier for receiving a file from another Macintosh. 

Receiving a file from a computer other than a 
Macintosh. 

Always use XModem if the other computer supports it. 
Depending on the situation, choose the appropriate settings in 
the File Transfer Settings window: 

Situation 
MacTerminal 1.1 
MacTerminal 2.0; receiving 

a Macintosh file 
MacTenninal 2.0; receiving 

a non-Macintosh text file 
MacTerminal 2.0; receiving 

a non-Macintosh code file 

Choose These Options 
XModem and Other 

MacBinary 

XModemText 

Straight XModem 

Then choose Receive File. MacTerminal will wait for about 
1 1/2 minutes to receive the file. 

If the remote system does not support the XModem protocol, 
choose Text in the File Transfer Settings window. Remember 
that the Receive File command won't be available. The text 
will appear in the MacTerminal window just as if someone at 
the other end were typing it. 
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Sending a file to a computer other than a 
Macintosh. 

Always use XModem if the receiving computer supports it. 
Depending on the situation, choose the appropriate settings in 
the File Transfer Settings window: 

Version 
1.1 
2.0 

2.0 

Receivin1: System 
Any non-Macintosh 
Supports Macintosh 
file system t 
Doesn't support 
Macintosh file system 

Choose These Options 
XModem and Other 

MacBinary 
Text file: XModem Text 
Code file: Straight XModem 

t For example, CompuServe can store Macintosh documents and 
applications that you can download to your Macintosh. 

Then choose Send File from the File menu. Select the file 
you want to send, and click Send. You'll get a window 
indicating the progress of the file transfer, but nothing will 
appear in your MacTerminal window. 

If you are sending a file to a computer that doesn't support the 
XModem protocol, you can send only text files. Remember, 
text files include MacTerminal documents, AppleLink 
documents, and documents saved using the Text Only 
option. Select Text and Other in the File Transfer Settings 
window and then choose Send File from the File menu. 
From the list of text files presented, select the file you want to 
send and click Send. 

The file will be sent and the text will appear in the MacTerminal 
window just as if you had copied it and pasted it into 
MacTerminal. 
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Summary Always use XModem if possible. 

Macintosh: Use 
XModem for everything. 

Not a 
Macintosh 

Use XModem, if available; 
Otherwise, use Text. 

running 
MacTerminal 

Macintosh: Use 
XModem for everything. 

Nata 
Macintosh 

Use XModem, if available; 
Otherwise, use Text. 

Because error checking is built into the XModem protocol, use 
it whenever possible to transfer entire files. In MacTenninal 
Version 2.0, be sure to use the appropriate XModem option. 
Use the Text option only if the XModem protocol isn't 
available. 
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( II Connecting to Another Macintosh 

Overview 

Connecting the Cable 

( 

Practice what you have learned so far. 

This section gives you a chance to practice using many of the 
MacTerminal features that you've learned. You'll connect two 
Macintoshes and use MacTerminal to send information between 
them. 

(Note: The part numbers provided in this section are only to 
help you identify the correct parts. You can't necessarily order 
the parts from Apple except as part of another product. Check 
the service parts price list for availability of individual items.) 

Why is this important? 

You may be wondering, "Why should I connect two 
Macintoshes with cables and go through all the trouble of using 
MacTerminal when I could just carry my disk over to the other 
system, instead?" 

The answer is that this is the best way to practice using 
MacTerminal, because you immediately see the results of what 
you're doing. You may never again need to connect two 
Macintosh computers directly, but you probably will need to 
transfer information to another Macintosh (or some other 
computer) over the phone line using a modem. Doing that, and 
understanding what you are doing, will be much easier after 
completing this exercise. 

You need the right cable to connect the two 
Macintoshes. 

To connect two Macintosh computers, you need a serial cable 
with a male DB-9 connector at each end. Apple manufactures 
a cable for just this purpose (pin 590-0200). The 
Macintosh-to-Macintosh cable is included with the Macintosh 
68000 Development System; you can also use the Macintosh 
modem cable if you clip Pin 6 at each end. 

You need a different cable if you are 
connecting a Macintosh to a Macintosh XL. 

You can also connect a Macintosh to a Macintosh XL. 
Information can be transferred between the two systems in 
either of two ways: by running Mac Terminal on both, or by 
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Practice 

Practice Using 
Mac Terminal 

running MacTerminal on the Macintosh and LisaTerminal on 
the Macintosh XL. 

The Macintosh XL's serial ports have different connectors than 
the Macintosh's, so vou need a different cable. The cable 
should be a serial cable with a male DB-9 connector at one end 
and a male DB-25 connector at the other. The cable that comes 
in the Image Writer Accessory Kit for the Macintosh works 
perfectly (pin 590-0169). 

Attach the cable to either serial port. 

MacTerminal allows you to indicate which port (Printer or 
Modem ) you are communicating through. It doesn't matter 
which one you connect the cable to. In most cases, the Printer 
port will be used either for an Image Writer or for AppleTalk™, 
in which case it will be easier to attach the cable to the Modem 
port. 

If both ports already have cables attached, tum the Macintosh 
off, disconnect one of the cables, attach the serial cable, and 
then tum the Macintosh back on. 

Connect two Macintoshes and send 
information between them. 

Perform each step as it's described. You can do this exercise 
with any two Macintosh computers. The instructions assume 
you're using MacTerminal Version 2.0. If you're using 
Version 1.1, the actual commands you use may be different 
from those mentioned in this exercise. If you use a Macintosh 
XL, use Mac Works™ to run MacTerminal (rather than using 
Lisa Terminal). · 

In this exercise, you will connect two Macintosh computers, 
communicate on-line via MacTerminal, and then use the 
XModem protocol to send a Macintosh document from one 
system to the other. 

If you have problems, check your MacTerminal settings and be 
sure you are using the correct cable. If you still have 
problems, check the Feedback section or ask a colleague, your 
course manager, or your Apple support representative for help. 
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Set up the hardware and send some 
information. 

1. Attach the correct cable to both Macintosh computers. 

2. Earlier in this module, you learned the correct terminal and 
compatibility settings for communicating with another 
Macintosh. You also learned which menu commands you 
should use to correctly configure your Macintosh. 

Now use both of these skills to start up your Macintosh, 
open a MacTerminal document, and set up the document 
to communicate with another Macintosh. (If it would help, 
refer to earlier parts of this module.) Continue when 
MacTerminal is running and correctly configured on the 
first Macintosh. 

3. Start up MacTerminal on the second Macintosh, and set up 
your document in exactly the same way that you did on the 
first Macintosh. Continue when MacTerminal is running 
and correctly configured on the second Macintosh. 

4. Check to be sure both MacTerminal documents are on line. 

5. Now you are connected and ready to go. Anything you 
type in one MacTerminal document will automatically 
appear in the other. 

Type something into one of the MacTerminal documents to 
see how it works. Everything is being transmitted-via 
the serial cable-to the other Macintosh, which is 
configured to receive the information. 

Information can go both ways, but only one way at a time. 
Type something on the other Macintosh, too. 

Continue when you are satisfied that everything is working as 
it should, and you've finished sending information between the 
two Macintosh computers. Leave the documents open for the 
next exercise. 

Send any Macintosh file to another Macintosh. 

You can send any document created by any Macintosh 
application; the document will retain all of its formatting and 
type-style information. 

In this part of the exercise, you will send a Mac Write document 
to another Macintosh (the instructions assume you're using 
MacTerminal Version 2.0). 
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Practice (cont'd) 

Indicate which file transfer method you're 
using. 

On the Macintosh you will be using to send the file, do the 
following: 

1. Choose File Transfer from the Settings menu. 
2. Click on MacBinary. Leave the other settings set to their 

defaults. 

Prepare the receiving Macintosh. 

Now you're ready to send the file, so the receiving Macintosh 
must be prepared to receive it: 

1. Open a MacTerminal document (if one isn't already open). 
2. Set MacBinary in the File Transfer Settings window. 

The MacTerminal document on the receiving Macintosh 
doesn't have to be on line, that is, On-Line in the terminal 
settings doesn't need to be on, but the document does need 
to be open. 

3. Choose Receive File from the File menu. MacTerminal 
will wait 1 112 minutes to receive a file. 

Send a disk file. 

Be sure you have a Mac Write document to send, and the 
Mac Write application (so you'll be able to open the document 
to confirm that it was sent correctly). 

1. Choose Send File from the File menu. All the 
documents available for you to send will be listed. 

2. Select the name of the Mac Write document you want to 
send from the dialog box. . 

3. Click Send. Watch both screens to see what 
happens. 

Continue when you have finished sending a disk file. 

Check your work. 

Now, go to the receiving Macintosh and quit MacTerminal. 
Check to see how the document has been received: On the 
startup disk, there will be a Mac Write document icon identical 
to that of the original document; insert the Mac Write disk in the 
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external drive, and open the document to confirm that it has 
arrived intact. 

Get ready for the next exercise. 

In the next exercise, you will send the same document, using 
the Text file transfer protocol instead of the XModem protocol. 
In order to do this, you must save the document you just 
transferred; it must be saved as a text-only document. 

1. Choose Save as from the File menu. 
2. Enter a different name for the document. 
3. Click on Texi Only. 
4. Click Save. 

You will now have a text-only document, represented by the 
icon shown at the left, in addition to the original Mac Write 
document. 

If you have trouble, check your settings 
against those listed earlier in this module. 

You should end up with a MacTerminal document, with 
information that you typed, on each system. You should also 
have a document that was sent via XModem on one of the 
Macintosh computers. If you don't have these three 
documents, reread the practice to see what you missed. 

If MacTerminal didn't work as described, check your settings 
and the cable you used. The correct settings are shown in the 
Terminal Settings section of this module. 

If you still have problems, check the cable part number (which 
is on one of the connectors) against the part numbers 
mentioned earlier in this section. Also, check the cable 
connections to be sure that they're secure. 

You can also ask a colleague, the course manager, or your 
Apple support representative for assistance. 
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Practice 

Send a Text File 

Start Up MacTerminal 
and Send the File. 

Send a file using Text instead of XModem. 

This exercise will give you an opportunity to see the difference 
between using XModem and Text when sending a file. You 
already used the XModem protocol to send a document, which 
arrived looking exactly like the original-complete with the 
correct type styles and formatting. This time, send a file using 
the Text option and notice what the information looks like 
when it arrives. 

You can send text files only, such as documents saved using 
text only, MacTerminal documents, or Apple Link documents. 
The system that was previously the receiving system-the 
system on which you just saved the document as text 
only-will be the sender in this exercse. Do each step as it's 
described to send the document. 

Set the file transfer method. 

After starting up MacTerminal, you must indicate the file 
transfer method you are using. On both Macintosh computers, 
do the following: 

1. Choose File Transfer from the Settings menu. 
2. Click on Text. 

Leave the other settings set to their defaults. The receiving 
Macintosh does not have to be on line. 

Send the file. 

To send a file, go to the sending Macintosh and do the 
following: 

1. Choose Send File from the File menu. All text 
documents will be listed. 

2. Select the name of the text-only document. 
3. Click Send. 

Check your work. 

The text will be entered into the window of the sending 
Macintosh and will be sent at the same time to the other system, 
where it will also appear in the window. Notice the difference 
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between the appearance of this document and the appearance of 
the previous document that you sent using XModem. There is 
no specific type style, size, or font information associated with 
the text. You can, however, copy the information out of 
MacTerminal, paste it into a Mac Write document, and add 
formatting. 

Do this exercise to see the results of incorrect 
terminal settings. 

Be sure both systems are on line, then change va.ti.ous settings 
(shown below), one at a time, and type some information into 
one of the MacTerminal documents. Notice the results. After 
each experiment, change the option being tested back to its 
original setting. This practice could be very valuable if you 
ever need to help others figure out why their information is not 
being received correctly. 

Do This 
Turn off Local Echo 

Turn off New Line 

Turn off 
Auto Wraparound 

Change Line Width to 
132 Columns 

Change Sending Baud 
Rate to 4800 

USING MACTERMINAL 

Watch for This 
Nothing appears when you type. 
Text still appears on receiving 
system. 

When you press Return, you start 
at the beginning of the same line 
instead of beginning on a new line. 
Text is OK on receiving system. 

Letters pile up at the end of the first 
line. Words don't wrap onto the 
next line. Text is OK on receiving 
system. 

Type size is the same, but 132 
characters will fit on first line 
before text is wrapped onto 
next line. Use the scroll bar to 
view the rest of the window. Text 
still displayed in 80 columns on 
receiving system. 

Paste several paragraphs of text. 
Text is OK on sending system. 
Receiving system displays garbage. 
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Practice (cont'd) 

Do This 
Change Bits per 
Character to 7 

Change Parity to Odd 
on sending system and 
to Even on receiving 
system 

Change Handshake 
toXOn/XOff 

Watch for This 
Text is OK when typed. When 
pasted, receiving system displays 
garbage. 

Text is OK in sending system. 
Appears as gray blocks on 
receiving system. 

Text is sent OK at low speeds. 
At 9600 or 19,200 baud, receiving 
system displays garbage. 

Change all the settings back and close both 
documents. 

Be sure all of the options are set back to the correct settings for 
connecting to another Macintosh. You'll be using both 
documents again, later in the module. 

Here's a chance to practice clearing out the contents of a 
document. On the sending system, do the following: 

1. Choose Clear Lines Off Top from the Commands 
menu. 

2. Change the Line Width to 132 Columns. 
3. Change the Line Width back to 80 Columns. 
4. Choose Quit from the File menu. 
5. When asked if you want to save this document, click Yes. 
6. Enter a name and click Save. 

On the receiving system, do the following: 

1. Choose Clear Lines Off Top. 
2. Change the Line Width to 132 Columns. 
3. Change the Line Width back to 80 Columns. 
4. Click in the close box to close the window. 
5. When asked if you want to save this document, click Yes. 
6. Enter a name and click Save. 
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If you have trouble, check your settings 
against those listed earlier in this module. 

Before you cleared out its contents, the MacTerminal document 
on your receiving Macintosh should have contained, in addition 
to whatever was previously there, the contents of the text-only 
document If the text-only document never arrived, reread the 
section and check your work. 

If you can't find anything wrong with your settings, cables, 
connections, or the procedure you followed, ask a colleague, 
your course manager, or your Apple support representative for 
help. 
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II Integrating MacTerminal with Other Applications . 

Overview 

Receive Text and 
Numbers From Anywhere 

What information can be moved between 
applications and how Is it done? 

One of the key benefits of the Macintosh is being able to copy 
and paste information from one application to another. For 
example, you can make a Mac Write document more meaningful 
by including a table from a spreadsheet or data-base 
application. 

If you want to send or receive entire Macintosh documents, use 
the XModem protocol. But, if you want to send just part of a 
document, copy it and paste it into the MacTerminal window. 

This section explains what information can be moved between 
MacTerminal and other Macintosh applications, and describes 
the actual process of moving information from one document to 
another. 

MacDraw MacDraw 

MacPaint 

Mac Write 

Spreadshee 

Datab.ase Database 

MacTermlnal can receive text copied from any 
application. 

MacTerminal understands only numbers and text. Therefore, 
you can't paste graphics of any kind into a MacTerminal 
document. You can, however, paste text or numerical data 
from any application. 

In addition to the Apple applications shown in the diagram, you 
can also copy information from data bases and spreadsheets 
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and paste it into MacTerminal. However, you'll lose all 
formatting, fonts, and type styles when you paste anything into 
Mac Terminal. 

Paste information from MacTerminal into any 
application that can handle text. 

You can copy information from a MacTerminal document either 
as text or as a table of data. You can then paste the information 
into any document that can handle text, or you can paste 
numeric data into either a data base or a spreadsheet as numeric 
data, not just as plain text. 

Here is the procedure for moving information 
to or from a MacTerminal document. 

The basic technique is the same for all Macintosh applications. 
The only variation for MacTerminal is its ability to copy 
information either as text or as a table of data. 

1. Select the information you want to move. 

2. Choose Copy from the Edit menu. If you want to copy a 
table of numeric information from MacTerminal, choose 
Copy Table. When you choose Copy Table, columns 
are separated by tabs, and a return is inserted at the end of 
each line. 

3. Close the MacTerminal document and open the document 
into which you want to paste the information. 

4. Select where in the document you want to put the 
information. 

5. Choose Paste. 

You can't cut information from MacTerminal. 

With other applications you can choose either Copy or Cut 
before you paste the information elsewhere. But with 
MacTerminal, only Copy is available. Once information is in 
a MacTerminal document, it's there to stay, unless you erase 
the lines off the top of the screen or choose not to save changes 
when you close the document. 
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Specific Applications Each application has special considerations. 

MacDraw. Though you can't paste graphics into 
MacTenninal, you can move the text portion of your MacDraw 
document into it, and you can move text from MacTepninal 
into MacDraw. (Remember, you can exchange entire MacDraw 
files with another Macintosh using MacTenninal's XModem 
protocol.) 

MacPaint™. You can't paste text from MacPaint into 
MacTenninal because MacPaint is a bit-mapped application and 
there is no way to select the text and copy it as such. You can, 
however, paste text from MacTerminal into MacPaint. 

MacProject. You can exchange information with any of 
MacProjects data tables, but you can't copy anything from the 
schedule chart or any of the time lines. 

MacTerminal. Everything from one MacTerminal document 
can be copied and pasted into any other MacTerminal 
document. 

MacWrite. Any text from MacWrite can be copied and pasted 
into MacTerminal. But graphics that have been pasted into a 
Mac Write document can't be moved into MacTerminal. 
Everything from Mac Terminal can be pasted into Mac Write. 

Spreadsheets. Any spreadsheet data can be copied and 
pasted into MacTerminal. Information from MacTerminal can 
be copied either as text or as a table of numeric data and pasted 
into a spreadsheet If you're copying text, you can copy and 
paste only one line at a time. If you 're copying a table of data, 
you can copy and paste any amount of information. 

Data bases. Text information from data bases can be copied 
and pasted into MacTerminal. Information from MacTerminal 
can be copied and pasted into data bases, one field at a time. If 
you can move between fields of the data base using the Tab and 
Return keys, you can copy information from MacTerminal as a 
table of data and paste it into the data base. 
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Move MacWrite Data 
via MacTerminal 
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Overview of the exercise. 

In this exercise, you'll copy information from a Mac Write 
document and paste it into MacTerminal to send it to the other 
Macintosh. Then you'll copy it from MacTerminal and paste it 
into another Mac Write document on the receiving Macintosh. 

Copy information from MacWrite and paste it 
into MacTerminal. 

1. 

2. 

3. 
4. 

5. 
6. 

7. 

8. 

On the receiving Macintosh, open the MacTerminal 
document you saved earlier. 
On the sending Macintosh, insert a Mac Write disk into the 
internal drive. If you have an external drive, insert a 
MacTerminal disk into it. 
Start up your Macintosh. 
Open an existing Mac Write document or open a new 
Mac Write document and enter some text. 
Copy some information from the Mac Write document. 
QuitMacWrite. (If you have a one-drive system, eject the 
Mac Write disk and insert a MacTerminal disk.) 
Open the MacTerminal document (for connecting to 
another Macintosh), that you saved earlier. 
Choose Paste. 

The information will be pasted into the frrst MacTerminal 
document and will immediately be sent to the other Macintosh. 
Continue when you have finished pasting Mac Write 
information into MacTerminal and the information has 
successfully been sent to the other Macintosh. 

Copy information from MacTerminal and paste 
it into MacWrite. 

Once the Mac Write information has been received, do the 
following to move the information from the MacTerminal 
window on the receiving Macintosh into a Mac Write document. 

1. 
2. 
3. 

4. 

5. 

Copy the desired information. 
Quit Mac Terminal. 
If you have a one-drive system, eject the Mac Terminal disk 
and insert a Mac Write disk. 
Create a new Mac Write document by opening the 
application icon. 
Choose Paste. 
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Practice (cont'd) 

Feedback 

Move MacWrite Data 
via MacTerminal 

When you have successfully copied information from 
MacTerminal and pasted it into Mac Write, do the following: 

1. On the receiving system, quit Mac Write and eject the disk. 
2. On the sending system, quit MacTerminal and eject the 

disk. 

A review, and what to do If you have problems. 

You should have copied information from Mac Write, and 
pasted it into MacTerminal, which should have sent it to the 
other Macintosh. Then, you should have copied the 
information from MacTerminal and pasted it into another 
MacWrite document on the receiving Macintosh. If you didn't 
do each of these steps, reread the practice exercise and 
complete the step(s) you missed. 

The text you received and then pasted into Mac Write may have 
lost its formatting (depending on how the rulers are set in the 
new Mac Write document), and will have lost type styles and 
sizes. But the basic information, the actual characters, should 
be the same. 

If the MacTerminal-to-MacTerminal part of the exercise didn't 
work, check the settings, which should be the same as they 
were for the earlier practice exercise (when you typed 
information into MacTerminal). 

If you don't see anything in the MacTerminal window aft.er 
choosing Paste, check to be sure Local Echo is on. 

If you still have problems or questions, ask a colleague, your 
course manager, or your Apple support representative for help. 
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Practice 

Move Excel Information 
via MacTerminal 
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Overview of the exercise. 

Excel is a combined spreadsheet, graphics, and data-base 
application available from Microsoft In this practice exercise, 
you '11 copy information from an Excel document and paste it 
into a MacTerminal document to send it to the other Macintosh. 
On the receiving end, you'll copy it from ~facTerminal and 
paste it into another Excel document 

You need an external drive on both systems to complete this 
exercise. 

Copy information from Excel and paste it 
into MacTerminal. 

1. Be sure the receiving MacTerminal document is still open 
and on line. 

2. Insert a MacTerminal disk into the internal drive and the 
Excel Program Disk into the external drive. 

3. Start up your Macintosh. 
4. Open an Excel spreadsheet document and enter some data 

(you can use the data shown below, or a subset of it, if 
you wish). Formulas are not transferred via MacTerminal, 
so there is no point in entering them during this exercise. 

----------------· --

5. Copy all of the information you entered. 
6. Quit Excel. Don't save your changes. 
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Practice (cont'd) 

7. If you get a "Disk is too full" message, you can ignore it. 
It means there is no room for the Resume Excel document 
on the Excel Program Disk. The Clipboard is still intact on 
the MacTerminal disk. 

8. If you have only one copy of Excel, eject it now so you 
can use it on the receiving Macintosh. 

9. Open the Mac Terminal document you used earlier for 
communicating with another Macintosh. 

10. Choose Paste. 

The information will be pasted into the first MacTerminal 
document, as.shown below, and will immediately be sent to the 
other Macintosh. 

MacTermlnal ~-- ---~---
Reg i c;,;,· "A' •..... ' .... 21':f.-.49 .... :2:2"."95 .... !S:f:3 ...... ·13·:22 .... ii9"."36 ........ ' ............................... . 
Region B 78.37 74.19 39.77 70.'dS 67.81 
Region C 68.23 1111.12 90.6 111.53 23. 72 
Region O 18.59 97.96 20. 14 40. 79 61.04 
Reg lo" E Q9.09 45. 11 79.89 67 .53 94. 19 
Region F 58.82 15. 14 1.43 8.34 61. 16 
Raglon Cl 5.96 84.72 SS.51 ?0.5 23.97 
Region H 8.44 34.83 33.01 94.39 10.41 
Region I 1.23 13.79 71.4 4.43 B3.3G 
R•o; I on J 61. 12 1s.0e. 49. es 44. 1:17 27. e 

When you have successfully pasted information from Excel 
into MacTerminal and watched it being sent to the other 
Macintosh, quit MacTerminal and continue with this exercise. 

Copy information from MacTerminal and paste 
it into Excel. 

Once the information you pasted into the MacTerminal 
document has been received by the other Macintosh, do the 
following to move the information into an Excel document. 

1. The information you pasted into MacTerminal should be 
visible in the MacTerminal window that's open on the 
receiving Macintosh. If it's not, repeat the sending 
process. 

2. Select all of the information and choose Copy Table. 
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I~ 
3. Quit MacTerminal. Don't save changes. 
4. Insert the Excel Program Disk into the external drive. 
5. Open an Excel spreadsheet document. 
6. Choose Paste. The new Excel document should look just 

like the original from which you copied the information. 
7. Quit Excel. 

Continue when you have successfully copied information from 
MacTerminal and pasted it into an Excel document. 
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Feedback 

Move Excel Information 
via MacTerminal 

A Review and what to do If you have problems. 

You should have copied information from Excel and pasted it 
into MacTerminal, which should have sent it to the other 
Macintosh. On the receiving end, you should have copied it 
from MacTerminal and pasted it into another Excel document. 
If you didn't do each of these steps, reread the practice exercise 
and complete the step(s) you missed. 

If the MacTerminal-to-MacTerminal part of the exercise didn't 
work, check the settings, which should be the same as they 
were for the earlier practice exercise (when you pasted 
Mac Write information into MacTerminal). 

If you don't see anything in the MacTerminal window after 
choosing Paste, check to be sure Local Echo is on. 

If you have a label that is part text and part number, separated 
by a space (for example, "Region 3"), the number portion of 
the label may be put in a separate cell in Excel. To avoid this 
problem, either use letters or omit the space. It's not worth 
redoing the exercise just to fix that problem, but be aware of it 
in the future. 

If you still have problems or questions, ask a colleague, your 
course manager, or your Apple support representative for help. 
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( • Connecting to an Apple II 

Overview 

( 

Learn how to use MacTerminal to communicate 
with an Apple II. 

This section describes how to connect an Apple IT Plus, 
Apple Ile, or Apple Ile to a Macintosh and then send 
information from one to the other. 

Using MacTerminal to connect to an Apple Il is basically the 
same as using it to connect to another Macintosh. You can 
communicate between the two systems either through a modem 
or via a direct connection. Just be sure you configure the two 
systems in the same way, and be sure to use the correct cable if 
you are connecting the two systems directly. 

If, after reading this section, you want more information about 
using Access Il on an Apple Il, read the Using Access II 
module from the Apple Support Training Library. 

Configure the two systems. 

Set up MacTerminal in exactly the same way that you would if 
you were communicating with another Macintosh. Access II 
does support the XModem protocol, so you can use it for file 
transfer. Or, once you establish a connection, you can enter 
information into the MacTerminal window. 

Access IT is a data communications program for the Apple Il. 
It provides the same functionality that MacTerminal does for 
Macintosh. It has the same terminal, compatibility, and file 
transfer options, but the way you specify the settings you want 
is slightly different As with any system with which you want 
to communicate, make its configuration the same as that of 
Mac Terminal. 

If you are connecting through a modem, be sure to enter the 
phone number in addition to the terminal, compatibility, and 
file transfer settings. 

Make the hardware connection. 

The Apple IT Plus and Apple Ile do not have built-in 
connectors. If you want to connect directly to a Macintosh, 
you need to insert a Super Serial Card into Slot 2. Be sure the 
jumper block on the Super Serial Card is pointing to 
TERMINAL. Then use the Macintosh Image Writer cable (pin 
590-0169) to connect the Macintosh modem port to the Super 
Serial Card. 
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The Apple Ile has a modem (serial) port built in. Use the 
Apple Ile mod.em cable (p/n 590-0192) to connect the modem 
port on the Apple Ile to the Modem port on the Macintosh. 

Establish the communications connection. 

You're now set up and ready to go. Be sure both systems are 
on line and dial the phone number if you are using a modem. 
Once you've established the connection, you can enter 
information into either MacTerminal or Access II and it will 
immediately be communicated to the other system, just as it is 
when you have two Macintoshes connected. Or, you can 
transfer a file using the XModem protocol. 

If you transfer a file, be sure the receiving system has a 
program or utility that will enable you to open that file. For 
example, you can send a MacPaint file using the XModem 
protocol, but it won't do you any good if you can't open the 
document on the Apple II. 
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(" 11 Connecting to a Public Information Service 

Overview 

What Are They? 

(' 

This section describes the services available 
and how to access them. 

One area of the data communications world that is dramatically 
increasing in popularity is the use of personal computers to 
access what are commonly called "public information services" 
or "public data bases." This section will describe what these 
services are and how you can use Macintosh and ~facTerminal 
to access them. 

If you, or a colleague, have access to a public information 
service, this section will also give you an opportunity to 
practice using Macintosh and MacTerminal to gain access to the 
service. 

Public data bases offer a wide range of 
information and services. 

A public information service, or public data base, is a 
mainframe containing information, tended by someone who's 
responsible for maintaining that information. Anyone who has 
a personal computer, a modem, data communications software, 
and an account with the service, can access the information. 
Generally, you're charged either by how long you're connected 

· to the service, or by how much information you access. Many 
services will bill charges directly to your major credit card. 

The information available varies almost as widely as the books 
available in your community library. Here's a short sample of 
what you can find in public information services: 

• Stock quotes 
• Historical and financial data on public companies 
• Worldwide news 
• Airline flight schedules 
• Home banking 
• Home shopping 
• Results of current medical research 
• Information on special interests and hobbies 
• Demographic and sales-potential information 
• Electronic mail 
• Games 
• Freeware (free computer software) 
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CompuServe, The Source, and Dow Jones News/Retrieval are 
a few of the largest and most popular services available. 
Hundreds of others are also available, many specializing in one 
particular field, such as aviation, psychology, world politics, 
or sports. Local computer users' groups often maintain their 
own data bases, or "bulletin boards," containing answers to 
common questions or hints and tips on using your computer. 

Once you discover what's available, and how easy the services 
are to access, the amount of information at your fingertips is 
virtually unlimited. 

How to access the Information. 

The first step in accessing one of these services is getting an 
account, if orie's necessary, and then finding out the service's 
local phone number and sign-on procedure (get this 
information from the people who maintain the service). 

Now you're ready to sign on. At this point, just read through 
the procedure. If you have access to a service, or if you know 
someone else who does, you will have a chance in a moment to 
practice the procedure outlined here. 

1. Start up and configure MacTerminal. 
2. Dial the service's local phone number. 
3. Follow the sign-on ("log-on") procedure. 
4. You should now be in the system. Check the service's 

user's guide for the correct procedure for accessing the 
information that's available. 

5. When you have finished, use the designated procedure to 
sign off ("log off'). 

6; At this point, you can scroll back through the MacTerminal 
document and copy any information you received. 

7. QuitMacTerminal. 
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Practice 

Access a Public 
Information Service 
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Practice using MacTerminal to communicate 
with a public information service or data base. 

If you (or a colleague) have access to one of these services, here 
is a chance for you to practice using MacTerminal to make the 
connection. Even if you can't practice now, you can refer back 
to this section when you need a reminder of the procedure. 

1. Connect your modem to the phone line and your 
Macintosh. 

2. Start up MacTerminal and configure it as described earlier. 
Set the baud rate to the speed of your modem, and check 
the service's user's guide for specific settings, such as 
parity, handshake, number of bits per character, and auto 
wraparound or line feed. 

3. Use the Phone menu to enter the phone number. (The 
people who maintain the service will provide you with the 
phone number you should call. It's usually a local call.) 

4. Use the Phone menu to dial the phone number. After the 
number is dialed, you should hear one or two rings and 
then a very high-pitched tone. This tone is provided by the 
modem answering the phone and is called the "carrier." 
You will next hear a number of high-pitched tones mixed 
together, followed by silence. This is your modem making 
the connection. (Some modems allow you to adjust the 
volume of what you hear.) 

5. Follow the sign-on procedure as outlined by the people 
who maintain the service. (Sometimes, after you hear the 
phone answered, you will have to press Return or the 
space bar to get the first prompt.) 

6. Follow the instructions in the service's user's guide to 
access the available information. 

7. When you've finished, use the designated procedure to 
sign off. (Each service has its own procedure.) 

8. At this point, you can scroll back through the entire 
communication session and copy any information that you 
want to paste into another document. 

9. Quit MacTerminal. 
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Feedback 

Access a Public 
Information Service 

Be sure all of your settings are correct. 

If you have trouble connecting to the information service, here 
are a few things to check: 

• Is MacTenninal configured as the service's user's guide 
says it should be? 

• Is the baud rate set to that of the modem? If it's 1200 baud, 
can the service handle 1200 baud? 

• Is the modem connected correctly (using the correct cable, 
and connected to the correct port)? Is it connected to the 
phone line? 

• Is the phone answered after you dial? If not, are you dialing 
the correct number? If you are in an office where you need 
to dial a digit to get an outside line, be sure to include that 
digit in the phone number that you set MacTenninal to dial. 
(Separate it from the rest of the phone number by a comma. 
This will cause MacTerminal to pause for a second while 
waiting for a dial tone.) 

If what you see on the screen is garbage, check the various 
possible solutions in the Question and Answer section of the 
Supporting MacTerminal module. 

If, after checking both the list above and the Questions and 
Answers section, you still can't connect to the information 
service, check with a colleague, the course manager, or your 
Apple support representative. 
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MacTerminal's Capabilities 

Three Main Uses 

MacTerminal Menus 

Terminal Settings 
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Use Mac Terminal to ... 

• Communicate with other computers. 

• Send any Macintosh file to another computer. 

• Copy and paste information between MacTerminal and other 
applications. 

1. To communicate with mainframes. 

MacTerminal can emulate DEC VTlOO and DEC VT52 
terminals. MacTerminal can also communicate with IBM 
mainframes, using AppleLine or the Apple Cluster Controller, 
and with many other mainframes using asynchronous ASCII 
communications protocols. 

2. To access public information services. 

MacTerminal can be used with a modem to tap into large 
amounts of information through services such as Dow Jones 
News/Retrieval, CompuServe, and The Source. 

3. To connect to other microcomputers. 

MacTerminal can be used to communicate with other 
microcomputers, such as another Macintosh or an Apple II, 
either through a modem or via direct connection. 

Chapter 3 of MacTerminal, the owner's manual 
contains a description of each menu command. 

The manual also contains explanations of 
terminal settings and compatibility settings. 

MacTerminal, the owner's manual, contains the correct settings 
for three of the most common uses of Mac Terminal: 
connecting to an IBM mainframe through AppleLine or the 
Apple Cluster Controller, connecting to another Macintosh, and 
accessing a public data base. 
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Connecting to Other 
Computers 

Disk Files and Text Files 

Refer to the manual or to this module if you have questions 
about how to configure your MacTerminal document. 

You can connect directly using an RS-232 
cable. 

To directly connect your Macintosh to another computer, be 
sure to use the correct cable. (Apple makes a cable specifically 
for connecting one Macintosh to another.) Use standard 
RS-232 cables or build custom cables to connect to other 
computers. 

You can also connect via a modem. 

You can use one of Apple's modems or third-party modems 
that are 212A-Type compatible (1200-baud modems) or 
Bell-103 compatible (300-baud modems). 

As long as your settings are correct, you can 
connect to most other computers. 

Using the MacTerminal terminal-emulation capabilities or 
asynchronous ASCII mode, you can communicate with many 
other computers-microcomputers, minicomputers, and 
mainframes. The key is to be sure that the two computers are 
"talking the same language." 

Two ways to send and receive information. 

You can either enter and receive information directly in the 
MacTerminal window, or you can send complete Macintosh 
disk files. If you send disk files, the information sent is not 
limited to text, and it doesn't appear in the MacTerminal 
window. 

XModem is a protocol that enables you to send 
and receive disk files. 

Use XModem whenever possible to exchange information with 
other Macintosh computers or with other computers that 
support the XModem protocol. The alternative is to send and 
receive files as text files, which produces the same result as 
entering the information directly into the MacTerminal window. 
Use Text when you are exchanging files with a computer that 
doesn't support the XModem protocol. 
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Macintosh 

Connecting to an Apple II 

Connecting to a Public 
Information Service 

Review 65 

Be sure you have the correct cable. 

You need an RS-232 serial cable, with a male DB-9 connector 
at each end, to connect two Macintoshes. Use the 
Macintosh-to-Macintosh cable that comes with the Macintosh 
68000 Development System, or use a Macintosh modem cable 
that has Pin 6 clipped. You can attach the cable to either the 
Printer port or the Modem port, because MacTerminal allows 
you to indicate which port you are using. 

Send information either way. 

Once each Macintosh is running MacTerminal and each is 
correctly configured, whatever you enter into one MacTerminal 
document will immediately appear in the second as well. Both 
systems can send and receive, but not at the same time. 

Integration with other Macintosh applications. 

You can copy information from other Macintosh documents 
and paste it into the MacTerminal document to send it to 
another Macintosh. Then you can copy the information from 
the MacTerminal document and paste it into other Macintosh 
applications, either as text or as tables of numerical data. 

Configure MacTerminal in the same way as if 
you were communicating with a Macintosh. 

To connect a Macintosh to an Apple II Plus, Apple Ile, or 
Apple Ile, use Access II on your Apple II and configure it in 
the same way as you did MacTerminal. Use a Macintosh 
Image Writer cable to connect your Macintosh to an 
Apple II Plus or Apple Ile. Use the Apple Ile modem cable to 
connect Macintosh to an Apple Ile. You could also connect 
both systems to modems and communicate through a phone 
line. 

You can easily access a large variety of 
information. 

Use MacTerminal to access hundreds of general or 
special-interest public information services, data bases, and 
bulletin boards. All you need is a Macintosh, MacTerminal, a 
modem, and an account with the people (or company) who 
maintain the service. 

USING MACTERMINAL 



66 Resources 

II Resources 

• MacTerminal, the owner's manual, Apple Computer, Inc. 

• MacTerminal Update (which has been included with 
MacTerminal since January 1986 and is available from 
your Apple support representative) 

• Apple Support Programs binder 

• AppleLine User's Guide, Apple Computer, Inc. 

• Apple Cluster Controller and AppleLine Sales Reference 
Guide, Apple Computer, Inc. 

• John Stanley Data Communications Workshop 

• AppleLink (If you have access to AppleLink, check it 
regularly for additional data communications information, 
particularly the Technical Info library.) 

• Data Communication Terms module from the Apple Support 
Training Library 

• Using MacTerminal With IBM Computers module from the 
Apple Support Training Library 

• Supporting MacTerminal module from the Apple Support 
Training Library 

Apple and the Apple logo are registered trademarks of Apple Computer, Inc. AppleLine, AppleLink, AppleTalk, 
lmageWriter, MacDraw, MacPaint, MacProject, MacTerminal, MacWorks, and MacWrite are trademarks of Apple Computer, 
Inc. Macintosh is a trademark of Mcintosh Laboratory, Inc. and is being used with express permission of its owner. 
CompuServe is a registered trademark of CompuServe Corp., an H&R Block company. DEC, VT52, and VT JOO are 
trademarks of Digital Equipment Corporation. Dow Jones News/Retrieval is a registered trademark of Dow Jones & 
Company, Inc. IBM is a registered trademark of International Business Machines Corporation. Microsoft is a registered 
trademark of Microsoft Corporation. The Source is a service mark of Source Telecomputing Corp., a subsidiary of the 
Reader's Digest Association, lnc. 
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2 Overview 

•1 Overview 

Approximately 65 percent of the mainframes in the United 
States are made by IBM. Between 30 percent and 40 percent 
of the personal computers sold in the U.S. through ref.ail stores 
are made by IBM. This module decribes many of the 
components of the IBM world and where Apple@ products fit 
in. You will learn how to use the MacTerminal™ application in 
conjunction with other Apple products to emulate an IBM 
terminal, and how to communicate with an IBM PC. 

Anyone who is using MacTerminal to communicate with IBM 
computers, or supporting such users, should complete this 
module. · 

Prerequisites 

• Knowledge of data communications terminology, which can 
be acquired by completing the Data Communications Terms 
module from the Apple Support Training Library or the Data 
Communications Primer (which is in the Apple Support 
Programs binder). 

• Ability to use MacTerminal. This can be acquired by 
completing the Using MacTerminal module from the Apple 
Support Training Library, after completing its prerequisites. 
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Objectives 3 

• Identify the main components of an IBM installation. 

• Describe the function of AppleLine™ and the Apple Cluster 
Controller. 

• List the MacTerminal settings used for communicating with 
the following: 

The AppleLine Supervisor 
An IBM mainframe through AppleLine 
An IBM mainframe through an Apple Cluster Controller 

• Use MacTerminal to enable a Macintosh™ computer to 
emulate an IBM 3278-2 terminal. 

• Answer questions about Macintosh-to-IBM communications. 

• Learn the specifications and pinouts for AppleLine and the 
Apple Cluster Controller, which will enable you to answer 
user questions. 

To complete this module, you will need: 

• A Macintosh 128K, Macintosh 512K, or Macintosh XL 

• MacTerminal, the owner's manual 

• MacTerminal Version 2.0 application software 

• An AppleLine with power cord, Loop-Back Connector, 
and Gender Changer Connector 

• A serial cable to connect a Macintosh to the AppleLine 

• AppleLine User's Manual. 

If available, the following are recommended: 

• An external disk drive 

• Access to an IBM mainframe 
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IBM Computer Components 

Cluster Controller 

CPU (Host) 3274,3276 

360, 370,303x, 308x, 309x 

Cluster Controller 

7171 

~Asyn~ Modem 
-r-

I~ 

Terminal 

3101 

J 
Terminal 

3101 

CPU 

System 34,36,38 

Terminal 

3278 

Front-End Controller 
(Communications Controller) 

3704,3705,3725 1--

_.__ 
(Sync -

~~ ~Sync Modem 
Modem T -r---r-

Cluster Controller 

3708 

CPU 
43xx 

Terminal Terminal 

3101 3101 

Terminal 

5251,5291 

Cluster Controller 

Terminal 

3278 

Cluster Controller 

3274,3276 

Terminal Terminal 

3278 3278 

Cluster Controller 

3274,3276 

Terminal 

3278 

Terminal 

5251,5291 

Terminal 

3278 

5251 Model 12, 5294 ...._ _ ___. Terminal 

5251,5291 

Only those IBM components that Apple products can emulate or communicate with are shown. 
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The IBM World 5 

It's important to understand the components of 
an IBM installation. 

On the facing page is a diagram showing the relationships 
among many of the most common IBM computer components. 
Before you can understand how Apple products fit into this 
structure, you should know something about each of these 
IBM components. 

Mainframes 

A mainframe (or host computer) is the central computer you 
ultimately want to connect to. It contains, or manages, the 
information you want to access. 

You can use MacTerminal with AppleLine or an Apple Cluster 
Controller to talk to the following IBM mainframes: 

360 
370 
43xx 
303x 
308x 
309x 

You can also communicate with System 34s, System 36s, and 
System 38s ("System 3x" in the diagram) using MacTerminal 
and a third-party protocol converter. Renex, PCI, Perle, and 
Wall Data, among others, have products that enable you to 
connect your Macintosh to one of the System 3x computers. 

Terminals 

A terminal is the device that enables a user to communicate with 
the mainframe via a video display and keyboard. 

A Macintosh that's running MacTerminal, in conjunction with 
AppleLine, can emulate an IBM 3278 Model 2 terminal 
(3278-2). A Macintosh running MacTerminal can also emulate 
an IBM 3101 terminal. 
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Cluster controllers 

A cluster controller fits between the mainframe and the 
tenninals to help the mainframe manage what information is 
sent to which terminal, and in what order. Several terminals 
can connect to a single cluster controller. Without the cluster 
controller, the mainframe would not be able to keep track of as 
many terminals without some performance degradation. 

You can connect AppleLine to IBM 3274 and 3276 Cluster 
Controllers. Or you can connect your Macintosh directly to an 
Apple Cluster Controller, which acts like the following IBM 
cluster controllers: 

3271 
3274 
3276 

You can also use Macintosh running MacTenninal to connect 
directly to the following IBM cluster controllers: 

3708 
7171 

Front-end processors 

A front end processor, or communications controller, is 
another component that helps the mainframe manage terminals 
and information. Front-end processors poll terminals, allocate 
resources, and manage the communications channel to the 
mainframe. Without a front-end processor, you would not be 
able to access the host from a remote location, and the 
processing speed of the mainframe could decrease 
considerably. 

You can connect AppleLine to the following IBM front-end 
processors: 

3704 
3705 
3725 

For additional information, see the Support 
Programs binder. 

If you want to know more about IBM computer components, 
and how they interrelate, read the data communications 
information in the References Section of the Support Programs 
binder. The binder also includes a list of recommended 
reading. 
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Overview 

Apple Line 

:( 

Apple Products 7 

Apple has two products that enable you to 
communicate with IBM mainframes. 

In most IBM installations, you can't communicate with the 
mainframe using MacTerminal alone. You need something to 
translate the information from the format that Macintosh 
understands to a format that can be understood by the IBM 
system. 

AppleLine and the Apple Cluster Controller enable a Macintosh 
to act as a terminal communicating with an IBM mainframe. 
This section briefly describes them. 

Appleline is an asynchronous ASCII-to-IBM 
3278-2 protocol converter. 

A protocol converter is a piece of hardware that receives 
information in one format, converts it, and transmits it in the 
new format Protocol converters are usually designed to 
emulate specific terminals that work with a specific mainframe 
or family of mainframes. 

AppleLine is a protocol converter that receives asynchronous 
ASCII data from Macintosh and converts it into the format 
generated by an IBM 3278-2 terminal. AppleLine enables your 
Macintosh, running MacTerminal, to emulate an IBM 3278-2 
terminal. Said another way, Macintosh plus Mac Terminal plus 
AppleLine replaces an IBM 3278-2 terminal. Information 
appears on the Macintosh screen just as it would appear on a 
3278 screen. 

Macintosh connects to AppleLine either directly (via RS-232 
cable), or through a modem. You need one AppleLine per 
Macintosh. AppleLine always connects directly to an IBM 
cluster controller or front-end processor 

Additional information about Appleline is 
available. 

If you want to know more about AppleLine and its 
specifications and features, a good description, written by 
Adrian Mello, appeared in the July/ August 1984 issue of 
Macworld. The article has also been entered into the 
AppleLink™ Technical Info library. 
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Apple Cluster Controller 

You can also check the data communications information in the 
References section of the Apple Support Programs binder, and , 
read the appropriate section of the workbook that goes with the 
Apple segment of John Stanley's "Basic Telecommunications: 
Apple Video Workshop." The materials for the self-paced 
video training are available from John Stanley Training 
Programs in Los Gatos, California. 

The ACC is functionally the same as an IBM 
3274 Cluster Controller. 

A cluster controller is the link between terminals and the 
mainframe. The Apple Cluster Controller (ACC) performs the 
same function as an IBM 3274 Cluster Controller-it enables 
several terminal to access one mainframe. 

There are four different Apple Cluster Controllers. The 
differences have to do with how many terminals the ACC 
supports and which protocol it uses. 

• 3 ports, Bisync 
• 7 ports, Bisync 
• 3 ports, SNA/SDLC 
• 7 ports, SNA/SDLC 

Bisync, or BSC (Binary Synchronous Communication), is a 
character-oriented synchronous protocol. It can handle only a 
limited number of devices and cluster controllers (several 
thousand) and is generally used on older networks. 

SNAISDLC (System Network Architecture/Synchronous 
Data Link Control) is a bit-oriented synchronous protocol. It 
has a hierarchical structure and can handle millions of devices. 
It is the current standard for IBM networks. 

With the ACC, you don't need to use AppleLine. You can 
connect your Macintosh to the Apple Cluster Controller either 
directly (via RS-232 cable), or through an asynchronous 
modem. 

Additional information about the Apple Cluster 
Controller is available. 

If you want more information about the Apple Cluster 
Controller, check the data communications information in the 
References section of the Apple Support Programs binder. 

Also read the appropriate section of the workbook that goes 
with the Apple segment of John Stanley's "Basic 
Telecommunications: Apple Video Workshop." The materials 
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Appleline or ACC? 

Apple Products in 
an IBM World 

Apple Products 9 

for the self-paced video training are available from John 
Stanley Training Programs. 

When do you use Appleline and when do you 
use an ACC? 

Use AppleLine when you already have an IBM cluster 
controller in place (assuming that it has ports available). If 
there isn't an IBM cluster controller in place, or if all of its 
ports are already taken, use an Apple Cluster Controller. 

Sales studies have shown that more people buy AppleLines and 
connect them to existing cluster controllers than buy ACCs. 

How do Appleline and the ACC fit into the 
IBM world described earlier? 

On the next page is a diagram similar to the IBM Computer 
Components diagram earlier in this module. In this diagram, 
however, Macintosh (running MacTerminal), Apple II (running 
Access II), AppleLine, and the Apple Cluster Controller, have 
been substituted for IBM products wherever possible. 

Refer to this diagram to see how Apple products fit into an 
IBM world. 

USING MACTERMINAL WITH IBM COMPUTERS 





( 

Cluster Controller 

7171 

A sync 
Modem 

0 

0 

CPU 

System 3x 

Third-Party 
Protocol 

Converter 

0 

Apple Products 11 

Apple Products in an IBM World 
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(" 

MacTerminal Keyboard Equivalents ""'-··' 

for 3278 Terminal Emulation 

IBM K~)!S Apple line l::lfl~ Egub£, ~ l::lfl~ Eguiv, 
Keypad Menu Options 
PF1 Eel 1831 Eel 1831 
PF2 Ec2 1832 Ec2 1832 
PF3 Ec3 1833 Ec3 1833 
PF4 Ec4 1834 Ec4 1834 
PF5 Ec5 1835 Ec5 1835 
PF6 Ec6 1836 Ec6 1836 
PF7 Ec7 1837 Ec7 1837 
PF8 Ec8 1838 Ec8 1838 
PF9 Ec9 1839 Ec9 1839 
PF10 EcO 1830 Ec:O 1830 
PF11 Ee- 1B20 Ee- 1B20 
PF12 Ee= 1830 Ee= 1B20 
PF13 Ee! 1B21 EcQ 1B51 
PF14 Ee@ 1840 EcW 1B57 
PF15 Ee# 1B23 EcE 1845 
PF16 Ee$ 1824 EcR 1852 
PF17 Ee% 1B25 EcT 1854 
PF18 Ee" 185E EcV 1859 
PF19 Ee& 1B26 EcU 1B55 
PF20 Ee* 1B2A Eel 1849 
PF21 Ee( 1B28 EcO 184F 
PF22 Ee) 1B29 EcP 1850 
PF23 Ee_ 185F EcF 1846 
PF24 Ee+ 1B28 EcG 1847 
PA1 Ee[ 1858 EcZ 185A .,_ 
PA2 Ee] 1850 EcX 1858 
ATTN ©A 01 Shift-Enter 0000. 
PRINT ©P 10 EcV 1856 
HOME ei 1C ©A 01 
ERASE EOF ©F 06 ex 18 
DELETE ©Backspace 7F ©T 14 
ERASE INPUT ©L oc ©R 12 
INSERT ©) 10 ev 19 
RESET ©R 12 E,e@A 1801 
SVSREQ ©B 02 Ee; 183B 
CLEAR ©E 05 EcM 1840 

Other Keys on the 3278 Keyboard 
CURSORSEL ©I) 04 n/a n/a 
!DENT ©V 16 n/a nla 
TEST ©T 15 n/a n/a 
OEVCNCL ©X 18 n/a n/a 
TAB Tab 09 Tabor©I 09 
BACK TAB ©K OB ©O OF 
NEWLINE Return t OD eJ or Return OA 
ENTER Enter ODOA Enter OD 
DUP ©U 15 eN OE 
FIELD MARK ©Y 19 ew 17 
UPARROW EcOA 1B4F41 Ec[A 1B5841 
DOWN ARROW EcOB 184F42 Ec(Bor©D 1B5842 
RIGHT ARROW EcOC 1B4F43 Ec(C . 185843 
LEFT ARROW EcOD 1B4F44 Ec(Dor©H 185844 

Note: Ee= Escape Key(~); ©=Control Key (Command) /' -...._, 

• A least half a second of zeros (Hex 00); this is also called a Break. 
t Available in Mac Terminal Version 2.0 only. \'--~/ 
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( II The IBM 3278 Keyboard 

Overview 

Use Special Keys 

MacTerminal provides the functions of all of 
the special keys on a 3278 keyboard. 

The IBM 3278-2 terminal has quite a variety of special-function 
keys, command keys, and arrow keys, in addition to the 
standard keyboard (as shown below). While emulating an 
IBM 3278-2 terminal through either AppleLine or an ACC, you 
have access to all of these special keys. 

This section describes how Macintosh is able to emulate the 
function of all of the keys on the 3278 keyboard. 

Macintosh uses the Escape and Control keys 
to provide the features of the 3278 keyboard. 

One way to emulate all of the 3278 keys is by combining the 
Escape and Control keys with other keys on the Macintosh 
keyboard (The Tilde key-top left comer of the Macintosh 
keyboard-is the Escape key, and the Command key-next to 
the spacebar- is the Control key.) A chart that shows which 
Macintosh keys are used to emulate each of the 3278 keys is 
shown on the facing page. (This information is also listed on a 
quick reference card that's included in the back of the 
AppleLine User's Manual.) 
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14 The IBM 3278 Keyboard 

Use the Mouse Use the mouse and the Keypad menu instead 
of the Escape and Control keys. 

When you open the Keypad menu, you'll have access to 
many of the special keys that are on the 3278 keyboard. Use 
the mouse to "press" the key you want. 

You can also use the mouse, instead of the 
arrow keys, to control the cursor. 

The 3278 keyboard has arrow keys to control the cursor on the 
screen. On the Macintosh XL, there are cursor keys on the 
numeric keypad. On any of the Macintosh models, you can 
hold down the Option key and the mouse pointer will change 
into four arrows (as shown at the left). Use the mouse to 
indicate where you want the cursor, and then, while still 
holding down the Option key, click the mouse button to 
actually move the cursor to that position. 
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( II Terminal Settings 

Overview 

Terminal Settings 

( 

This section describes terminal settings for the 
most common MacTerminal uses. 

MacTerminal has the flexibility needed to communicate with a 
wide range of computers, each of which expects to receive 
information in a particular format Before you can correctly 
configure MacTerminal to communicate with a specific 
mainframe, you need to know the correct terniinal and 
compatibility settings. 

This section describes the settings that are appropriate for the 
computers with which you will be communicating most often. 
The configurations discussed in this section are for connecting 
a Macintosh to the following systems: 

• The AppleLine Supervisor 
• An IBM mainframe, through AppleLine 
• An IBM mainframe, through an Apple Cluster Controller 

At the end of the section is a practice exercise that will help to 
ensure that you know how to configure MacTerminal for each 
of these situations. 

The various terminal settings are explained in 
the manual. 

When using AppleLine, there are two sets of communications 
settings to consider: 

• The MacTerminal settings, which control how MacTerminal 
communicates with AppleLine. They are displayed by 
choosing the appropriate command from the Settings 
menu. If it would be helpful, review the section in Chapter 
3 of the MacTerminal manual that describes the Settings 
menu. 

• The AppleLine Supervisor settings, which control how the 
AppleLine communicates with MacTerminal. The 
Supervisor settings can be displayed by choosing the 
appropriate option from the Supervisor's main menu that's 
displayed in the MacTerminal window. (The Supervisor is 
described in more detail in the next section.) 

When using an Apple Cluster Controller, you only need to be 
concerned with the MacTerminal settings. 
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16 Terminal Settings 

Terminal Settings for 
an IBM Mainframe 

Practice 

Check Appropriate Settings 

Read the manual to learn the terminal settings 
for connecting to an IBM mainframe. 

Read all of Appendices C and D of MacTerminal, the owner's 
manual, to learn how to configure MacTerrninal to 
communicate with an IBM mainframe through AppleLine and 
through the Apple Cluster Controller. Appendix. C describes 
how to use MacTerminal to run the Supervisor program, which 
enables you to configure AppleLine, and how to connect to a 
mainframe through AppleLine. Appendix. D explains how to 
use the Apple Cluster Controller. Just read the appendices-

, don't start up MacTerminal (even though the manual instructs 
you to do so). You '11 have a chance later in this module to 
practice doing what the manual describes. 

Continue with this module when you have finished reading 
Appendices C and D. 

Configure MacTerminal to communicate with 
the computer indicated. 

On the next page, there are two pairs of screen shots, each 
consisting of a Terminal Settings window and a Compatibility 
Settings window. Mark the appropriate settings for each data 
communications situation. If it would be helpful, refer to the 
manual. 

When you've finished; check your answers by reading the 
feedback that follows this exercise. 
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IBM with Appleline Configure MacTerminal to communicate with 
an IBM mainframe through Appleline. 

Terminol Settings 

Terminal 

Mode 

Cursor Shope 

Choracter Set 

line Wid:h 

Protocol Conu 

0 On Line 

0 Rulo Repeat 

0 Repeat Ctrls 

0 UTIOO 0TTY 

QRNSI 

0 Underline 

O United States 

080 Columns 

0 Rppleline 

0 Locol Echo 

(Note: You are not running the AppleLine Supervisor 
program. Mark the appropriate settings for using AppleLine to 
connect to an IBM mainframe.) 

Compatibility Settings 

OIBM 3278 Baud Rate 050 075 0110 0134.5 

QUT52 0150 0200 0300 0600 

0Block 
01200 01800 02000 02400 

03600 04800 09600 019200 
0 United Kingdom 

Bits per Chorocter O 1 Bits O 8 Bits 
O 132 Columns 

Parity O Euen O Odd O None 
0 Cluster CUr 

Handshake O KOn/KOff O None 
0 Status Lights 

Connection O Modem O flnother Computer 
0 Ruto Wraparound O New Line 

Connection Port O l<?bl O l~I In;;] r;::=:;i O Transparent @ (cancel) 
~~ 

IBM with ACC Configure MacTerminal to communicate with 
an IBM mainframe via an Apple Cluster 
Controller. 

Terminal Settings 

Terminal 

Mode 

Cursor Shape 

Character Set 

line Width 

Protocol Conu 

0 On Line 

0 fluto Repeat 

0 Repeat Ctrls 

ounoo 0TTY 

0RNSI 

O Underline 

0 United States 

0 80 Coll,1mns 

O Rppleline 

O Local Echo 

Assume that your Macintosh is connected directly to the Apple 
Cluster Controller-not through a modem. 

compatlbillty Settings 

OIBM 3278 Baud Rate 050 075 0110 0134.5 

0UT52 0150 0200 0300 0600 

0Block 
01200 01800 02000 02400 

03600 04800 09600 019200 
O United Kingdom 

Bits per Choracter 01 Bits 08 Bits 
O 132 Columns 

Parity OEuen OOdd ONone 
0 Cluster CUr 

Handshake OKOn/KOff ONone 
O Status Lights 

Connection OModem O flnother Computer 
O Ruto Wraparound 0 New Line 

01%] 0[81 0 Transparent 0 (cancel) 
Connection Port 

~ (cancel) 
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18 Terminal Settings 

Feedback 

Check Your Answers Check your answers against those shown on 
the next two pages. 

In the Terminal Settings window, Cursor Shape can be set 
either way. In the screen shots on the next two pages, it's set 
the way it is most often used; the actual setting is left to your 
personal preference. 

If there are discrepancies that you don't understand, reread the 
section of the manual that pertains to that feature of 
Mac Terminal. If you still have questions, check with a 
colleague, the course manager, your Apple support 
representative, or anyone else who is familiar with 
MacTerminal or data communications in general (such as your 
data-processing manager). 
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Termlnol Settings 

Terminal 0 UT100 OTIY 

Mode @l\i'i~) 

Cursor Shope @Underline 

Chorocter Set @ !Jnitt~lf Sl<tl<!~ 

line Width @HO Coh1mn~ 

Protocol Conu @Appleline 

~On Line 0 l.01:<11 E:l:llo 

Terminal Settings 19 

Configure MacTerminal to communicate with 
an IBM mainframe through Appleline. 

Comp11tibility Settings 

®IBM 3278 Baud Rate 0 SO 07S 0110 0 134.S 

ou·r52 0 ISO 0200 0300 0600 

0 1200 0 !BOO 02000 02400 
OBlock 

03600 04800 @9600 0 19200 
O 1Jnltt~1! l::lngdmn 

Bits per Character @7 Bits 0 B Bits 
0 I ~2 C<tlumn~ 

Parity @Euen 00dd ONone 
O Cluster Ctlr 

Handshake @HOn/HOff ONone 
0 ~totus Ugh ts 

Connection OModem @Another Computer 
~Auto Repeot O nu to UJm1>1Hound ~Neu• l.ine 

@~ o~ O Repeat Ctrls O rrm1~1>•~ri~n t ~ (cancel) 
Connection Port 

~ 

Your choice of the Baud Rate setting may be 
different. 

(cancel) 

If your Macintosh is connected directly to AppleLine, set the 
baud rate to 9600. If you are communicating with AppleLine 
through a modem, set the baud rate to 1200. 

There are different configurations for 
Supervisor mode and User mode. 

The main differences in how you configure your MacTerminal 
document when running the Supervisor program versus 
signing on as a user and communicating with an IBM 
mainframe, are as follows: 

Supervisor 
User 

Terminal 
VTlOO 
3278 

New Line 
OFF 
ON 
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Feedback (cont'd) 

IBM with ACC 

Terminol Settings 

Terminol 0 UTIOO 0TTY 

Mode @l\NSI 

Cursor Shape @Underline 

Charocter Set @ IJnitl.'d S1a1<J~ 

line Width @HO Cohmm~ 

Protocol Con11 0 Appleline 

t8J On line D l.1>c<1I !:cho 

Configure MacTerminal to communicate with 
an IBM mainframe via an Apple Cluster 
Controller. 

Compatibility Settings 

@IBM 3278 Baud Rate 0 50 075 0110 0134.5 

01m;2 0150 0200 0300 0600 

01200 0 1800 02000 02400 
O Block 

03600 04800 @9600 0 19200 
O !Jnih~d Kingdom Bits per Character @7 Bits O a Bits 
0 1 ·u C<1lmnn~ 

Pority @ E11en 00dd ONone 
@ Cluster Ctlr 

Hondsholce @ HOn/HOff 0None 
D Stntus Ugh ts Connection OModem @ Another Computer 

t8J Auto Repeot t8J nu to 11Jrn1>11rouiul D N<nv I.int.> 

@[%1 o~ D Repeot Ctrls D l'rmaptm~nt 0 (conce1) 
connection Port 

0 (conce1) 

The Baud Rate setting may vary. 

The baud rate is set to 9600 because Macintosh is directly 
connected to the Apple Cluster Controller. If Macintosh were 
connected via a modem, the baud rate would be set to that of 
the modern, usually 1200. 
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( 11 Appleline Supervisor 

( 

Overview 

Two Steps to 
Using Appleline 

This section describes the Supervisor and 
other aspects of using Appleline. 

Without the Supervisor, you wouldn't be able to use AppleLine 
to communicate with IBM mainframes. Therefore, it's very 
important that you understand what the Supervisor does and 
when to use it. This section describes the basic purpose of the 
Supervisor, the two steps to using AppleLine, and the 
difference between configuring Mac Terminal as a VTl 00 to 
communicate with the Supervisor, and configuring 
MacTerminal as a 3278 terminal for communicating with an 
IBM mainframe through the AppleLine. 

1. Run the Supervisor to configure Appleline. 

Just as you can configure MacTerminal in a variety of ways, 
you can configure AppleLine to communicate with a variety of 
terminals, (for example, a Macintosh that's running 
MacTerminal). The Supervisor is a program that resides in 
AppleLine and enables you to configure it to communicate with 
the terminal you're using. 

The first step in using AppleLine to connect a Macintosh to an 
IBM mainframe is to use the Supervisor to configure 
AppleLine for communicating with the Macintosh. (AppleLine 
already knows how to communicate with the mainframe.) 
Configure MacTerminal as a VTlOO terminal to run the 
Supervisor. This means establishing a local connection 
between the Macintosh and the AppleLine. You don't need to 
be connected to a mainframe to use the Supervisor. 

2. Use the Appleline to communicate with a 
mainframe. 

After running the Supervisor, the next step is to use AppleLine 
as a protocol converter to connect to an IBM mainframe. 

Configure MacTerminal to emulate an IBM 3278 terminal. 
Information from Macintosh will be sent to AppleLine, which 
will translate it into a format that the mainframe can understand. 
Then AppleLine will send the information on to the 327x 
Cluster Controller that's connected to the mainframe (see the 
IBM Computer Components diagram, earlier in the module, for 
a reminder of how these components work together). 

USING MACTERMINAL WITH IBM COMPUTERS 



22 Appleline Supervisor 

Cluster Controller that's connected to the mainframe (see the 
IBM Computer Components diagram, earlier in the module, for 
a reminder of how these components work together). 

Why must MacTerminal be configured first as a 
VT100, then as a 3278? 

As you read earlier, when using the AppleLine Supervisor you 
should configure MacTerminal as a VTlOO terminal. But when 
communicating with a mainframe through AppleLine, you 
should configure MacTerminal as a 3278 terminal. You may 
be wondering why you need to use the different settings and 
what the differences between them are. 

AppleLlne can be used with many types of terminals, so the 
Supervisor needs to be able to communicate with as many 
terminals as possible. Therefore, it supports a very basic 
protocol that most terminals can emulate, VTlOO. 

You can also use the VTlOO protocol when you want to 
communicate with a mainframe, but you won't have easy 
access to the 3278 terminal's various special keys. You'll have 
to use the Escape and Command keys to enter the appropriate 
codes. The MacTerminal 3278 terminal-emulation mode 
provides 3278 keyboard mapping, and changes the Keypad 
menu to conform to the various special keys available on a 
3278 terminal. The actual communication between 
MacTerminal and the AppleLine is still basically in VTlOO 
protocol. The 3278 terminal-emulation mode just makes it 
easier to access the various special keys that are on a 3278 
keyboard. 

For more information on the Supervisor, refer to the AppleLine · 
User's Guide. 
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( II Practice Using Appleline 

Overview 

( 

(-

This section gives you an opportunity to use 
Apple line. 

When you first use AppleLine to connect to an IBM 
mainframe, the normal series of events is the following: 

1. Run the Supervisor program to configure AppleLine for 
communicating with a Macintosh. 

2. Set the MacTerminal terminal type to IBM 3278. 
3. Connect to the mainframe (through AppleLine). 

Subsequently, you only need to do steps 2 and 3, unless you 
want to change the Supervisor's terminal settings or 
passwords. 

In this exercise, you will: 

1. Set up your AppleLine. 
2. Run the Supervisor program and change the AppleLine 

terminal settings and passwords. 
3. Use AppleLine to emulate a 3278-2 terminal. (If you don't 

have an IBM 3274 Cluster Controller, skip this part.) 
4. Use the Loop-Back Connector to reset the AppleLine 

terminal settings and passwords to their default settings. 

Complete each step as it's described. If you need help, refer to 
this module, the MacTerminal manual, or the AppleLine User's 
Gui.de. If you need help connecting to the IBM mainframe, 
check with your company's data processing manager, or 
another authorized person who is experienced using the 
system. If you need assistance with any of the Apple products, 
ask a colleague, your course manager, or your Apple support 
representative. 
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Practice 

Set Up and Use 
Apple line 

Set Up Appleline 

In this exercise you will set up and use 
Apple line. 

You'll begin this practice by connecting AppleLine to your 
Macintosh. Then you'll run the Supervisor program and adjust 
its communications settings. If you have access to an IBM 
3274 Cluster Controller and an appropriate mainframe, you 
will also have a chance to use AppleLine to communicate with 
the mainframe. Finally, you will reset all of the Supervisor 
settings using the Loop-Back Connector. 

If you have problems at any time during this exercise, check 
the Feedback section that immediately follows. 

Be sure you have all the equipment you need. 

(Note: You have already read about this procedure in the 
manual. Some of what you read is repeated here to guarantee 
that you understand the steps involved and are able to set up 
and use the AppleLine correctly.) 

Included with AppleLine, you should have: 

• Transformer/power cable 
• Gender Changer Connector 
• Loop-Back Connector 

You'll also need a cable to connect AppleLine to your 
Macintosh, and the appropriate cable to connect the AppleLine 
to the IBM 3274. To connect to the Macintosh you need a 
standard RS-232 serial cable. The Macintosh ImageWriter™ 
cable (pin 590-0169) is recommended. To connect to the 3274 
you need a coaxial cable with a BNC connector on the 
AppleLine end. 

(Note: See Appendix B in the AppleLine User's Manual for 
more information about cables.) 

Connect the cables. 

1. Plug the power cord into the socket marked "24v AC" on 
the back of AppleLine. Don't turn it on yet. 
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Start Up MacTerminal 

Run the Appleline 
Supervisor Program 

2. 

3. 

4. 
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Plug the transformer into a 11 Ov socket Use the screw 
that came with the transformer to ground and firmly attach 
the transformer to the socket. 

Connect the serial cable to AppleLine and to the modem 
connector on the Macintosh. 

Attach the cable that is connected to the IBM 3274 
Cluster Controller (if you have one) to the BNC connector. 

Don't turn AppleLine on yet. 

Start up your Macintosh from your 
MacTerminal disk. 

Be sure to use MacTerminal Version 2.0. Otherwise, the 
commands you should enter and the sequence of events may be 
different from those shown here. 

1. Open the AppleLine Supervisor document that's on the 
Mac Terminal disk. (If you do not have the original 
MacTerminal disk, open the MacTerminal application icon 
to create a new Mac Terminal document.) 

2. Check the settings. The correct terminal and compatibility 
settings for communicating with the AppleLine Supervisor 
were shown earlier in this module. Open the Terminal 
Settings and Compatibility Settings windows to be sure 
they are correct, and make any necessary changes. 
Specifically, be sure the document is on line. If you think 
it would help, refer to the MacTerminal manual. 

Use the Supervisor to check the Appleline 
settings and to change the passwords. 

The Supervisor is only for communicating between the 
Macintosh and AppleLlne. It doesn't affect how Macintosh 
communicates with the mainframe. 

1. Turn on AppleLine. (The switch is on the right side, 
near the front) Wait for the yellow and green lights to 
flash alternately. 

2. Press Return in response to the message on your screen. 
If you don't see anything on your screen, press Enter (or 
any letter key) on your keyboard. 
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Practice (cont'd) 

3. When asked for the password, type Apples. If the 
password is not "Apples," skip ahead to the Reset 
Terminal Settings section of this exercise and do what is 
necessary to reset the passwords. Then return to this 
exercise. 

4. Type A to display the current AppleLine terminal settings. 

5. The terminal settings are fine as they are, but if you want to 
see how to change them, type B from the AppleLine main 
menu. (These settings are for communicating with the 
Macintosh, so if you change them you must be sure that 
MacTerminal is configured the same way.) 

6. AppleLine has five passwords-one to run the Supervisor 
and four user passwords. Type C from the AppleLine 
main menu to change any of the passwords. 

7. Type A to change the first user password. Enter the 
password you want, and press Return to accept the default 
response (Yes) to the confirmation question. 

Warning: Don't change the Supervisor password to make it 
the same as one of the user passwords, or you won't be able to 
run the Supervisor. Also, don't change one of the user 
passwords to Apples-which is currently the Supervisor 
password. 

8. Type F to return to the main menu. 

9. Type D to quit the Supervisor. You can to save any 
changes that you made, to either the settings or the 
passwords. 

10. Quit Mac Terminal. If you wait more than a couple of 
seconds before turning off the Macintosh, the initial log-on 
screen will be redisplayed. It's okay to quit MacTerminal 
at this time. 
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Use Appleline to connect to an IBM mainframe 
through an IBM 3274 Cluster Controller. 

If you're not going to connect to a mainframe, just read 
through this part of the practice exercise, and then continue 
following the instructions beginning with the Reset Terminal 
Settings heading. 

1. On the released MacTerminal disk, there is a document 
named AppleLine that's already configured to communicate 
through AppleLine to an IBM mainframe. If you do 
not have the actual MacTerminal release disk, open a new 
MacTerminal document. 

2. Earlier in this module, you learned the correct terminal and 
compatibility settings for using AppleLine to connect to an 
IBM mainframe. Check the settings of the document you 
just opened to be sure they are correct. (If it would help, 
refer to this module or to the MacTerminal manual.) 

3. Turn AppleLine off, then on again. This will configure 
it according to the settings entered via the Supervisor. 

4. Turn on the IBM 3274 Cluster Controller. 

5. Place your MacTerminal document on line, if you have 
not already done so. 

6. Press Return in response to the message on the screen. 

7. Enter the password. Use any one of the four user 
passwords, which are Applel, Apple2, Apple3, and 
Apple4 (unless you changed them when you were in the 
Supervisor). 

8. The next thing you will see is the initial screen sent from 
the IBM mainframe, which is different for every system. 
It will appear exactly as it would appear on an IBM 3278-2 
terminal. (Note: If you see "XO." on the screen, it 
means wait.) 

9. Follow the appropriate procedure to log on to the 
mainframe. 

10. You can now access the mainframe exactly as you would if 
you were using at a 3278-2 terminal. 

11. After you finish your communications session, log off 
the mainframe. 

12. QuitMacTerminal. 
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Practice (cont'd) 

Reset Terminal Settings 

Northern 
Technologie~ 

Use the Loop-Back Connector to reset the 
terminal settings and passwords. 

The AppleLine communication settings and passwords, as set 
by the Supervisor program, are stored in AppleLine. The 
Loop-Back Connector changes these settings and passwords 
back to their default settings, which are listed in Chapter 3 of 
the AppleLine User's Manual. The Loop-Back Connector is 
the small white plastic connector, similar to the one shown at 
the left. 

There are two situations in which you might need to use the 
Loop-Back Connector. 

• You change the terminal settings and then forget what they 
are. Remember that the settings are for communicating with 
MacTerminal, so if you forget the correct settings you won't 
be able to correctly configure MacTerminal to communicate 
with AppleLine. 

• You forget your password or you change the Supervisor 
password so that it is the same as one of the user 
passwords, which prevents you from running the 
Supervisor. 

Complete each step of the Loop-Back test as it's described. 

Perform the Loop-Back test. 

1. Turn your AppleLine off. 
2. Unplug (from the back of AppleLine), the serial cable 

that connects AppleLine to the Macintosh. 
3. Connect the Loop-Back Connector to the DB-25 connector 

that's on the back of the AppleLine. 
4. Turn AppleLine's power switch on. Wait until the 

yellow light starts blinking. 
5. Remove the Loop-Back Connector (with the power on). 
6. Wait five seconds. 
7. Don't turn the power off. 

You're now ready to reconnect the cable that runs to the 
Macintosh. All of the settings and passwords have been reset 
to their defaults. 
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Apple line 

Practice Using AppleLine 29 

Check Supervisor settings. 

1. Reconnect the cable leading to the Macintosh (while 
AppleLine is still on). 

2. Follow the same procedure you used earlier to run the 
AppleLine Supervisor program. (Be sure to tum 
AppleLine back on.) If it would help, refer back to that 
part of the practice exercise. 

3. Display the Supervisor terminal settings by typing A in 
response to the Supervisor main menu. The settings 
should have the default values listed in Chapter 3 of the 
AppleLine User's Guide. 

4. Type D to quit the Supervisor. 
5. Quit MacTerminal. 

Summary of Practice exercise. 

You should have done he following: 

• Set up AppleLine and connected it to a Macintosh. 
• Run the Supervisor program via MacTerminal, and 

displayed (and possibly changed) terminal settings and 
passwords. 

• Connected to an IBM mainframe via MacTerminal and 
AppleLine (if you had access to a mainframe). 

• Used the Loop-Back Connector to reset the AppleLine 
settings and passwords. 

• Rerun the Supervisor to see the results of the Loop-Back 
test. 

All Appleline settings should be set to their 
defaults. 

The last thing you did was to use the Loop-Back Connector to 
return the AppleLine settings to their default values. If you had 
some problems along the way, here are some possible 
solutions and where to look for help. If the suggestions below 
don't help, check with a colleague, your course manager, or 
your Apple support representative. 
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Feedback (cont'd) 

Set up Applellne and run MacTermlnal. 

If you had troubles setting up AppleLine, check the AppleLine 
User's Manual. If you had problems connecting AppleLine to 
the Macintosh, or if you're not sure you configured 
MacTenninal correctly, reread the Practice Using AppleLine 
section in this module, or Appendix C of the Mac Terminal 
manual. 

Run the Supervisor·program. 

• Read Chapter 3 of the AppleLine User's Manual for more 
information on using the Supervisor. 

• Be sure MacTenninal's terminal and compatibility settings 
are configured in the same way as the Supervisor's. If you 
couldn't get into the Supervisor because the settings were 
wrong, use the Loop-Back Connector to reset the 
Supervisor to its default terminal settings. Then be sure 
Mac Terminal is configured the same way. 

Connect to a mainframe. 

• Confirm that you're connected to the IBM 3274 correctly, 
and that you know the log-on procedure for getting into the 
mainframe. 

• Check Appendix C of the MacTerminal manual to be sure 
that MacTenninal is configured correctly for connecting to 
an IBM through AppleLine. 

Use the Loop-Back Connector. 

Review Chapter 4 of the AppleLine User's Manual if you 
would like more information about running the Loop-Back test. 
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(- II Communicating with an IBM PC 

( 

(~ 

Use MacTerminal 
in Async ASCII 

Communicate with a comparably configured 
program on an IBM PC. 

You can use your Macintosh with MacTerminal to 
communicate with an IBM PC by using the same techniques 
you use to communicate with many other computers for which 
you don't have a terminal emulator. You need to configure 
MacTerminal to communicate in asynchronous ASCII, and be 
sure that MacTerminal and the program running on the PC are 
"talking the same language" (in other words, that they are 
using the same data communications settings). You can 
C')JUlect either directly (be sure that you have the appropriate 
serial cable) or through a modem. 

You can use XModem if the software running on the PC also 
supports the XModem protocol and if you have the appropriate 
software to open the file you transfer. 

Hayes SmartCom II is a data communications program that 
runs on the IBM PC and is compatible with the Hayes 
SmartModem. It has auto-dial and auto-answer capabilities and 
works well for communicating with MacTerminal. 

The following are some other data communications programs 
that enable communications between a Macintosh and an 
IBM PC: 

• Crosstalk XVI from Microstuf. 
• MacLink from Data Viz (file translation: 

Wordstar <->Mac Write; 123 <->Multi.plan; 
Multimate <-> MacWrite). 

• Mite from Microft Labs. 
• PC to MAC and BACK from dilithium Software. 
• SmartTerm from Persoft, Inc. (VTlOO emulation). 
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II Questions and Answers 

Overview 

Check for Terminal Type 

Appleline Passwords 

Here are the questions commonly asked by 
MacTerminal users, and the correct answers. 

You now know how to use MacTerminal with IBM computers. 
But as a support person, you will also be called upon to answer 
end users' questions about AppleLine, the Apple Cluster 
Controller, and using MacTerminal to communicate with IBM 
computers. 

This section is a summary of the most commonly asked 
questions, and the correct answers. This material does not go 
into technical detail beyond what most users need to know in 
order to use the product. 

How do I check for the terminal type when connected to the 
Apple Cluster Controller? 

There are two aspects to this question: 

(1) When you connect to the Apple Cluster Controller, there is 
a banner across the top of the window that tells you the 
terminal type, among other information. The terminal type 
should be VTlOO/ ANSI. If at any time you want to redisplay 
this banner, press Escape Command-S. (Remember, the 
Tilde key (-) is the Escape key.) 

(2) A switch setting on the Apple Cluster Controller printed 
circuit board determines the base brand "family" of the 
terminal. To display the base brand, press Escape 
Command-B. The value displayed for a VTlOO-type 
terminal should be OC. 

How can I get into the Supervisor if I forget my AppleLine 
password? 

Use the Loop-Back Connector to reset the AppleLine to its 
default passwords. It will reset the terminal settings to their 
defaults, too. (See the Practice exercise in the Connecting to an 
IBM Computer section of this module, or the AppleLine User's 
Manual, for detailed instructions on how to use the Loop-Back 
Connector.) 
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When I'm using the AppleLine, what does the message "X( )" 
mean? 

It means to wait, just as if you saw the wristwatch while 
running other Macintosh software. 

Does AppleLine replace 3278 Model 4 and Model 5 terminals? 

No. AppleLine replaces 3278 Model 2 terminals. If you want 
to replace a 3278 Model 4 or Model 5 terminal with a 
Macintosh and AppleLine, you must reconfigure the host to 
recognize that node as a 3278 Model 2 terminal. 

I'm using the Switcher™ to run MacTerminal along with other 
applications, and/ am currently using MacTerminal and 
AppleLine to connect to a host computer. What happens when 
I switch to another application? 

AppleLine keeps the session active even if the MacTerminal 
document is not active. It will continue to be active until it gets 
a signal from MacTerminal to end the session. If information 
is being downloaded from the host, AppleLine will hold the 
information in its buffer. If its buffer fills up, it will use the 
buffer in the 3274. When that fills up, it signals the host to 
stop transmitting information. 

When you reactivate the MacTerminal document, all of the 
information stored in the AppleLine buffer and the 3274 buffer 
is downloaded into the MacTerminal document, and AppleLine 
signals the host to start transmitting again. 

No information is lost while MacTerminal is inactive, that is, 
while you have switched to another application. 

MacTerminal Version 2.0 will scroll the screen contents off the 
top of the screen when a clear screen command is received (in 
Version 1.1, the contents of the screen are lost). Can the 
contents of the screen be printed automatically when a clear 
screen command is received, in addition to or instead of 
scrolling the information off the top of the screen? 

The basic ability is there, but the specific software to do it has 
not been written. In the meantime, everything is saved in your 
MacTerminal document, so print the document when you have 
finished the data communications session. 
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Appleline Passwords 

Appleline ROM Versions 

Why are there four user passwords when you can only use 
AppleLine with one Macintosh? 

Though only one user can use AppleLine at a time, up to four 
users can share access to one AppleLine via modems. Four 
passwords are available so that four different users can each 
have their own password for using the same AppleLine. Then, 
if one user loses the right to access the host, his password can 
be canceled or changed without affecting the other three users. 

What is the current version of the AppleLine RO Ms, and how 
do/find out what I have? 

There are two parts to the version number. The current version 
is Version 22 with 3.30. To check which ROMs you have, do 
the following: 

1. Find the first part of the version number on the initial 
AppleLine screen (the one that asks you to press Return to 
continue). On the top line, you will see "Vx.x" next to the 
date. The "x.x" is the first part of the version number 
(currently it's "V2.2"). 

2. Once you're into AppleLine, press Escape Control-B to 
display the contents of all of the registers. In the third and 
fourth columns, near the bottom, you'll notice 
"REV.LOW" and "REV.HI." These two registers contain 
the other half of the version number, which consists of 
REV.HI followed by a decimal point followed by 
REV.LOW. For example, if REV.HI is "03" and 
REV .LOW is "30", the second part of the version number 
is "3.30." 
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(- II Appleline and ACC Specifications 

Overview 

Appleline 

,-

This section lists the specifications for 
Appleline and the Apple Cluster Controller. 

This information is provided to help you answer users' 
questions. 

Terminal Types 

Access 3270 
Access III (VTlOO Emulation) 
Lisa Terminal 
Mac Terminal 

Apple Interface Options 

ASCII code 
7 or 8 data bits 
1 or 2 stop bits 
Odd, even, mark, space, or no parity 

Apple Interface Data Rates 

45.5 to 19200 baud 

Buffer Capacities 

Command: 15 characters 
Screen: 3840 characters 
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Apple Cluster Controller 

Pin outs 

fin 
1 
2 
3 
4 
5 
6 
7 
8 
9-11 
12 
13-19 
20 
21 
22 
23-25 

~ 
SNG 
TXD 
RCD 
RTS 
CTS 
DSR 
GND 
DCD 
NC 
CH 
NC 
DTR 
NC 
CE 
NC 

Function 
Shield ground 
Transmitted data 
Received data 
Request to send 
Clear to send 
Data set ready 
Signal ground 
Data carrier detect 
No connection 
Data signal rate selector 
No connection 
Data terminal ready 
No connection 
Ring indicator 
No connection 

Additional pinout information is given in the AppleLink 
Technical Info library. 

Protocols 

• SNNSDLC (System Network Architecture/Synchronous 
Data Link Control) 

• BSC (Binary Synchronous Communication) 

Cluster Controllers Emulated 

• SNNSDLC: IBM 3274, 3276 Model 12 
• BSC: IBM 3276 Model 2 

Devices Emulated 

• Terminals: 
SNA/SDLC: IBM 3278-2 
BSC: IBM 3277 

• Printer: 3287-1 

Transmission Speed 

Up to 9600 bps 

Interface 

• Asynchronous: 7-bit ASCII, Full duplex 
• Synchronous: 8-bit EBCDIC 
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Apple Systems Supported 

• Macintosh 128K, Macintosh 512K, Macintosh XL 
• Apple ID 
• Apple II, II Plus, Ile, or Ile (not recommended) 

Terminal Software Supported 

• Macintosh: MacTenninal 
• Macintosh XL: MacTerminal or LisaTerminal 
• Apple ID: Access III or Access 3270 
• Apple II: Access II 

Pin outs 

Pin ~ Function 
1 SNG Shield ground 
2 TX Transmit data 
3 RX Receive data 
4 RTS Request to send 
5 CTS Clear to send 
6 DSR Data set ready 
7 GND Signal ground 
8 DCD Data canier detect 
9-19 NC No connection 
20 D'IR Data terminal ready 
21-25 NC No connection 

Additional pinout information is given in the AppleLink 
Technical Info library. 

Use Applellnk to get more information. 

You can find more information regarding the Apple Cluster 
Controller in the AppleLink Technical Info library. Search for 
"Cluster and Specifications." 
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•Review 

The IBM World 

Apple Products 

The IBM 3278 Keyboard 

Terminal Settings 

First you must understand the IBM world. 

Refer to the diagram at the beginning of this module, or see the 
information in the Apple Support Programs binder, for an 
overview of the types of products you will find in a typical 
IBM computer installation. Once you are familiar with an IBM 
installation, you can see where Apple products fit in. 

Appleline and the Apple Cluster Controller 
allow access to IBM mainframes. 

AppleLine connects a single Macintosh to an IBM 3274176 
Cluster Controller either directly or through a modem. The 
Apple Cluster Controller is functionally identical to an IBM 
3274176 Cluster Controller. You can connect your Macintosh 
directly to the ACC, which then can be connected to the IBM 
mainframe either directly or through a synchronous modem. 

MacTermlnal can emulate all of the keys on 
the 3278 keyboard. 

The IBM 3278-2 terminal keyboard has many specialized and 
general-purpose function keys. MacTenninal uses the 
Keypad menu and the Command and Escape keys to emulate 
all of the functions of the 3278 keyboard. Refer to the table 
earlier in this module for the specific keyboard mapping and 
hexadecimal equivalents. 

MacTerminal, the owner's manual, contains 
terminal settings and compatibility settings. 

The MacTerminal manual contains the correct settings for 
running the AppleLine Supervisor program and for connecting 
to an IBM mainframe through AppleLine or through the ACC. 
Refer to the manual or to this module if you have questions 
about how to configure your MacTerminal document. 
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Review 39 

Step-by-step instructions for using the 
Supervisor and connecting to a mainframe. 

This section provides a guided practice exercise for using the 
AppleLine Supervisor program and for connecting to an IBM 
mainframe through AppleLine. 

Use third-party software running on the PC 
to communicate with MacTerminal. 

Configure MacTerminal in the same way you would if you 
were communicating with any microcomputer. Connect either 
directly or through a modem, and be sure the two programs are 
configured identically. 

Refer to this section for answers to commonly 
asked questions about using MacTerminal. 

You should also check AppleLink periodically for new 
information regarding MacTerminal and communicating with 
IBM computers. 

This section lists the capabilities and 
limitations of Appleline and the ACC. 

This information will help you answers questions you'll get 
regarding the capabilites of AppleLine and the Apple Cluster 
Controller. 
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• Resources 

• MacTermin.al, the owner's manual, Apple Computer, Inc. 

• Apple Support Programs binder 

• AppleLine User's Guide, Apple Computer, Inc. 

• Data Communications Technical Procedures binder, 
Volume 1 

• Apple Cluster Controller and AppleLine Sales Reference 
Guide, Apple Computer, Inc. 

• Apple Systems Fact Book, Apple Computer, Inc. 

• AppleLink (If you have access to AppleLink, check it 
regularly-particularly the Technical Info library-for 
additional data communications information. 

• Supporting MacTermin.al module in the Apple Support 
Training Library. 

Apple Computer does not endorse the third-party products mentioned in this module. They're included here because Apple 
wants you to be aware of their availability. Contact the developer or a retail dealer for more information. 

Apple, the Apple logo, and Lisa are registered trademarks of Apple Computer, Inc. AppleLine, AppleLink, ImageWriter, 
MacTerminal, and Switcher are trademarks of Apple Computer, Inc. Macintosh is a trademark of Mcintosh Laboratory, 
Inc. and is being used with express permission of its owner. IBM is a registered trademark of International Business 
Machines Corporation. MacLink is a trademark of Data Viz, Inc. MITE is a trademark of Microft Labs, Inc. PC to MAC 
and BACK is a trademark of dilithium Press. Smartcom II is a trademark of Hayes Microcomputer Products, Inc. 
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2 Overview 

•Overview 

This module includes a variety of information that will prepare 
you for supporting end users ofMacTerminal™.software. 
There's an opportunity to familiarize yourself with the manual, 
which contains a broad spectrum of information about the 
program. Much of the module consists of answers to 
commonly asked questions and important facts and tips about 
using MacTerminal. There are also sections that contain 
MacTerminal specifications and hardware pinouts. 

Anyone who will be supporting end users of Mac Terminal 
should complete the entire module. 

Prerequisites 

• Knowledge of data communications terminology. This can 
be acquired by completing the Data Communications Terms 
module from the Apple Support Training Library. 

• Experience using MacTerminal and knowledge of its 
capabilities and features, which can be acquired by 
completing the Using MacTerminal module from the Apple 
Support Training Library. 
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Objectives 3 

• Answer common end-user questions about MacTerminal 
either from memory or by looking up the answer in any 
available resource, including this module and the manual. 

• Learn MacTerminal specifications and Macintosh™ pinouts 
in order to be able to answer additional user questions or to 
build a custom cable. 

To complete this module, you will need: 

• MacTerminal, the owner's manual 
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II Questions and Answers 

Overview 

Special Keys 

Line Feeds 

Here are the answers to many of the questions 
you may get about using MacTerminal. 

This section contains the answers to questions you can expect 
to get about using MacTerminal. Additional information will 
periodically be made available, primarily through AppleLink™. 
Check AppleLink regularly, or if you don't have access to it, 
ask your Apple® support representative. 

Which keys on the Macintosh keyboard are equivalent to the 
Escape key and the Control key? 

This was mentioned in the manual, but is worth repeating. The 
Command key on the Macintosh keyboard, immediately to the 
left of the space bar, is equivalent to the Control key on other 
keyboards. The Tilde(-) key, in the top left comer of the 
keyboard, is equivalent to the Escape key on other keyboards. 
(Type Command-Shift-- to produce the Tilde character. Hold 
down just the Command key to produce the accent.) 

Why do I receive all the text on one line? 

When you are receiving information into MacTerminal or the 
LisaTerminal™ software, it's the job of the sending device to 
provide line feeds after carriage returns. For example, when 
you're using your Macintosh computer to send text to another 
Macintosh, you must select New Line on the sending system 
or the user on the other end will receive all the incoming text 
overwritten on one line. 

If you are sending information from Lisa Terminal to 
MacTerminal, set Auto New Line in LisaTerminal to On to 
send a line feed after a carriage return. If you are sending 
information to Access II on an Apple® II, set LF after CR. 

If you are sending an entire disk file, line feeds will be 
provided when you open that document. You only need to be 
sure line feeds are provided by the sending machine when the 
information is going directly into an open MacTerminal 
window. 
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Answerback Message 

Questions and Answers 5 

How do I backspace over a character in MacTerminal? 

The host you communicate with using MacTerminal may or 
may not support the methods of backspacing available to you 
on the Macintosh. Try typing Command-H to delete a 
character, or press Backspace to backspace the cursor so you 
can type over the last character. Or press Command-Backspace 
to backspace the cursor and remove the last character. 

If these methods don't work, consult the host's operating 
manual or ask someone familiar with the host system. 

How do I send graphics via MacTerminal? 

Mac Terminal supports full transfer of graphics from one 
Macintosh another using the XModem protocol. 
Macintosh-to-mainframe-to-Macintosh also works, as long as 
the mainframe supports the XModem protocol and acts only as 
a passive storage medium (doesn't change the information). 
Sometimes this is called "store and forward." 

(Note: For more information about XModem, check the 
MacTerminal manual, and the Disk Files and Text Files section 
of the Using MacTerminal module.) 

MacTerminal also supports VTlOO graphics. 

What is the Answerback Message, and how do I use it? 

The Answerback Message is any string of characters that can 
be transmitted to the computer to which you are connected. 
Traditionally, it's used to allow your terminal to identify itself 
to the host computer. There are two ways for the message to 
be sent: 

• Upon receiving Command-E, MacTerminal will transmit 
the Answerback Message. Command-Eis a standard 
VTlOO convention for a host to request the Answerback 
Message. 

• Type Command-Enter to request that MacTerminal send 
your Answerback Message to whomever you're 
connected to. 
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Auto Answer 

You may use the Answerback Message to respond to routine '<-./ 
prompts, such as the log-on prompt. Enter the response into 
the Answerback Message dialog box (choose Answerback 
Message from Settings menu), and then when you receive 
the prompt from the host, type Command-Enter to send the 
reply. 

To enter a carriage return in your message, type ""M'' 
(CARET-M). For example "Hello"MAccess 3"MPasswol'.d" 
will be interpreted as: 

Hello 
Access 3 
Password 

How do I get MacTermiflal to answer the phone? 

Apple modems and MacTerminal will automatically answer any 
incoming call as long as your MacTerminal document is open. 
So to get MacTerminal to auto answer, don't do anything! 

In MacTerminal Version 1.1, the Wait for Call command in 
the Phone menu doesn't work, so don't use it. Actually if 
you do use it, it prevents your Apple modem from answering. 
This has been fixed in MacTerminal Version 2.0. 

The same software problem that prevents you from using Wait 
for Call in Version 1.1 also causes the Number of Rings 
Before Answer command in the Phone Settings dialog 
box to be ignored This also has been fixed in MacTerminal 
Version 2.0. 

When you're using Version 1.1 and you want to change the 
number of rings before your Apple or Hayes modem answers 
the phone, run MacTerminal and type ATSO=n, where n is the 
number of rings between .1 and 255 (don't set it to 0 or the 
modem won't answer). 

If you're using a 1200-baud Hayes modem, be sure Switch 5 
is in the up (open) position if you want the modem to answer 
automatically. 
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Questions and Answers 7 

I received a text file via MacT erminal and now I want to open 
it as a MacWrite™ document. I get a message asking if 
carriage returns should signify paragraphs or line breaks. 
Which should I choose? 

There are a several ways you may end up with text documents 
that you want to open as Mac Write documents. 

• Documents saved as text only. 
• All MacTerminal documents, which includes those into 

which you have received text from other computers. 
• Documents saved from AppleLink. 
• Text documents that were sent to another Macintosh using 

MacTerminal's XModem protocol. 

To open any of the text documents mentioned above as 
Mac Write documents, do the following: 

1. Open the Mac Write application icon. 
2. Close the Untitled document. 
3. Choose Open, which lists all Mac Write and text 

documents. 
4. Select the document you want to open. 
5. Click Open. 

You will see the following message: 

Should a Carriage Return signify a new paragraph or a line 
breBk? 

Paragraphs ) ( Line Breaks ) ( Cancel ) 

If the application that originally created the document put 
Return characters at the end of every line, you want to ignore 
them because MacWrite will take care of wrapping the text to 
the next line. Therefore, choose for Return characters to 
signify Line Breaks. Mac Write will then ignore single 
Return characters, only keeping one if it sees two Return 
characters in a row. For example, if you receive a document 
via XModem that was originally saved with a Return characters 
at the end of each line, choose Line Breaks. 

If the application that originally created the document had 
automatic word wrapping, Return characters will only have 
been inserted at the ends of paragraphs. Therefore, you would 
want to keep all the Return characters, so you would choose 
Paragraphs. For example, all MacTerminal documents only 
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XModem Sends 
Duplicate Text 

Non-Apple Modems 

Little Boxes 

Wrong Characters 

have Return characters at the end of paragraphs, so choose 
Paragraphs. 

You will see a similar message when you send a text file. If 
the system to which you're sending the file has word 
wrapping, specify for carriage returns to signify Paragraphs. 
Otherwise, choose Line Breaks. 

Why doesn't XModem work while XOn/XOff is set? 

The XModem protocol performs checksum error checking. It 
sends one block at at time, and if, upon receiving the block, the 
checksum matches, the block is declared OK, and the next 
block is sent. 

XOn/XOff controls the flow of information between the two 
systems. It queries to be sure both systms are ready, and then 
tells each system when to start and stop sending information. 
If both are on and an XOn/XOff handshake occurs while a 
block is being sent, the XModem checksum received at the end 
of the block will be incorrect. This situation generates a 
request to resend the block, which causes the receiver to 
receive duplicate text. 

Can I use MacTerminal with non-Apple modems? 

Yes. As long as 1200-baud modems are 212A Type 
compatible and 300-baud modems are Bell 103 compatible. 
(See the Connecting to Other Computers section of the Using 
MacTerminal module for more information on using non-Apple 
modems.) 

What does it mean when I see little rectangular boxes among 
the text? 

You have the parity set wrong. Check the parity of the system 
you are communicating with or just try other settings. Parity 
errors might also cause certain characters to be consistently 
wrong. 

What should I do if the words look like they are the right 
lengths, but the letters are wrong? 

Check the number of bits per character (either 7 or 8) and 
switch it to the other setting. , 
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Losing Characters 

Random Characters 

(~ 

Noisy Phone Line 

Back Brackets 
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Questions and Answers 9 

Most of the screen looks OK, then I get garbage for a while. 
Why? 

Check to be sure your baud rate is the same as that of the other 
system. If the baud rate is OK and it's above 1200, tum on 
XOn/XOff. 

Why are characters missing when I receive data? 

Information is being sent faster than you can receive it. Try 
any of the foliowing solutions. 

• Be sure the baud rate is the same on both systems. 
• Tum on XOn/XOff. 
• Slow down the baud rate on both systems. 
• Choose Don't Record Lines Off Top to speed up the 

Macintosh's ability to process incoming information. 

Why does the last block transferred contain random character 
when using XModem? 

The XModem protocol sends 128-character blocks. If the last 
block is not full, it will be filled with random characters. Just 
delete them from your file. 

I'm getting garbage that seems like it's the result of a noisy 
phone line, but the phone connection is fine. What should I 
tb? 

If you're using an Apple Modem 1200, check the middle 
switch. It's usually set in the UP position. Try switching it to 
DOWN. If this doesn't work, you may just have a bad line. 
So, hang up, wait a bit, and dial again. 

If you're using an Apple Modem 300, the noise may be caused 
by improper shielding against radio transmissions. There 
really is no solution other than using an Apple Modem1200 or 
the Apple Personal Modem. 

Why do I get intermittent back brackets (] ) ? 

These are usually caused by a noisy phone line. Hang up the 
phone, wait a bit, and then dial again. 
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Nothing On the Screen 

Double Characters 

Not Enough Room on Disk 

What should I do when the modem answers the phone, but 
nothing appears on my screen? 

First try pressing the Return key a couple of times. Some 
systems won't transmit until you do so. If that doesn't work, 
check the following: 

• baudrate 
• other terminal and compatibility settings 
• cable (the cable leading from the modem to your 

Macintosh may be bad) 
• cable connections. 

When/ type, nothing appears on the screen. Why? 

There are two ways for a character to be displayed on your 
screen. 

• Your Macintosh displays each character at the same time it 
sends it to the receiving system. 

• When the system receives a character, it echoes the 
character back to your Macintosh to confirm that the 
character was correctly received. The character is displayed 
when it's received by your Macintosh. 

If nothing appears on your screen when you type, then neither 
method is in effect To get your Macintosh to display what you 
type, tum on Local Echo. 

When I type, I get two of every character. Why? 

In this case, both methods for displaying characters on your 
screen are in effect (see previous answer)-the Macintosh is 
displaying every character on the screen, and the other system 
is echoing every character back to you. Tum off Local Echo 
to prevent your Macintosh from displaying what you type. 
You'll then only see the characters that are being echoed back 
from the receiving system. 

I get a message saying there's not enough room on my disk to 
save my document. How can/ save it? 

When you get this message, you've already lost some 
information, and there's no way to get it back except by having 
it retransmitted. To save what you do have, save the document 
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Questions and Answers 11 

to a new, blank disk. However, it's best to be prepared for 
these situations ahead of time. 

If you're planning to receive a large amount of information, put 
the MacTerminal document into which the information will be 
received on its own disk. All of your startup information and 
the MacTerminal application should be in one disk drive, and 
your data disk, with only one document on it, should be in the 
other drive. 

As I'm downloading a file, I get this message: "Insufficient 
disk space to read any more lines." Why do I get this and what 
should/ do? 

This only happens in Version 1.1. A new document is able to 
save far fewer lines than a previously created document. To 
avoid this situation, do the following: 

1. Open a new MacTerminal document. 
2. Set the phone, terminal, and compatibility settings. 
3. Close the document. 
4. Open the document again when you are ready to download 

the file. 

The document is no longer a new MacTerminal document, so it 
will be able to receive many more lines of information. To 
save time during subsequent data communications sessions, 
create a template of this document, and then duplicate it when 
needed. 

This problem has been fixed in MacTerminal Version 2.0. 

When I connect to a public information service, the first line of 
text is garbage. What should/ do? 

Type any letter or press Return. The mainframe will often use 
the character to detect your terminal speed and will conform to 
it. Typing a character accomplishes the same thing as sending 
the Autobaud message. 

Why do I get a telephone carrier error (beeping sound) with the 
Apple Modem 300? 

This happens on some phone lines when using tone dial. Use 
the pulse dial and it works OK (click on Pulse after choosing 
Phone Settings from the Phone menu). 
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II Using the Manual 

Overview This section gives you practice finding specific 
information in the manual. 

Many times you'll be asked a question that you can't answer 
immediately. In these cases, the next best thing is to know 
where to find the answer and how to find it quickly. In order 
to quickly find the answers you seek, you should be familiar 
with the various manuals (and other documentation) that 
contain the answers. 

This section gives you a chance to familiarize yourself with the 
MacTerminal manual by finding the answers to specific 
questions. 

Use the table of contents or the index. 

This section will ask questions similar to those you might 
might be asked when supporting MacTerminal users. Use the 
table of contents or the index to locate the information, and then 
write down the answer and where you found it. 

When you're finished, check the Feedback section, which will 
give the answer, and the chapter and section in which it was 
found. Specific page numbers won't be given because they 
inight change with manual revisions. 

The first question is a sample to be sure you know what's 
expected 
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Practice 

Sample 

Use the Manual to 
Answer These Questions 

Using the Manual 13 

When I choose Send File, which documents 
are listed when I've indicated Text, and when 
I've indicated one of the XModem transfer 
options? 

When you've indicated Text, only text files are listed; 
documents saved as text only, MacTerminal documents, and 
AppleLink documents. When you've indicated one of the four 
available XModem file transfer options, all files on a disk are 
listed; all documents, system files, code files, etc. 

The answer is found in the Sending Data to Another Computer 
section of Chapter 1. 

What do "Delay Between Chars" and "Delay 
Between Lines" in File Transfer Settings 
mean? ~~~~~~~~~~~~~~~~ 

What does EBCDIC stand for? 

How long can the Answerback Message be? 

How do you display and use cursor keys in 
VT100 terminal-emulation mode? 
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Feedback 

Use the Manual to 
Answer These Questions 

What do "Delay Between Chars" and "Delay 
Between Lines" in the File Transfer Settings 
mean? 

These commands enable you to slow down the transmission of 
information to be sure the receiving system gets it all. They're 
usually used with private systems (as opposed to public 
information systems) when you can't adjust the baud rate. 

The answer is in the Settings Menu section of Chapter 3. 

What does EBCDIC stand for? 

Extended Binary Coded Decimal Information Code. 

The answer is in the glossary. 

How long can the Answerback Message be? 

The Answerback Message can be 40 characters long. 

The answer is in the Settings Menu section of Chapter 3. 

How do you display and use cursor keys in 
VT100 terminal-emulation mode? 

Hold down the Command key while you open the Keypad 
menu. The cursor keys are in the top right comer of the 
keypad. Open the Keypad menu without the Command key 
to display the normal function keys that are in the locations 
shared by the cursor keys. 

The answer is in the Keypad Menu section of Chapter 3. 
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( • MacTerminal Specifications 

Overview 

Specifications 

( 

This section covers the capabilities and 
limitations of MacTerminal. 

In addition to the questions dealt with in the Questions and 
Answers section, you'll receive many questions regarding the 
capabilities and limitations of MacTerminal. For example, 
what baud rates are supported? or how many characters per 
line? This section details the specifications for MacTerminal 
that will enable you to answer these questions. 

This section also includes the differences between the original 
release of MacTerminal, Version 1.1, and the other official 
release, Version 2.0. 

Maximum size of a document is dependent 
upon available storage space. 

Maxixmum size of the Clipboard. 

32,000 characters, or approximately 16 pages of single-spaced 
text. 

Number of lines displayed in a window. 

• Version 1.1: 24 lines 
• Version 2.0: 25 lines with the AppleLine™ protocol 

converter; 24 lines without 

Terminal Emulated. 

• VT100NT52 
• TTY 
• ANSI 
• IBM 3278 (when used with AppleLine or the Apple Cluster 

Controller) 

Protocol converters supported under 
IBM 3278. 

• AppleLine 
• Apple Cluster Controller 
• Wall Data Cluster Controller (System 3x) 
• Irmaline 
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Version 1.1 vs 2.0 

Transmission Characteristics. 

• Speed: 50 to 19200 baud (see Compatibility Settings) 
• Asynchronous communications 
• Full- or half-duplex 

Terminal Settings. 

• Character sets: Graphics, US ASCII, UK ASCII, 
Norwegian, French, Spanish, German, Danish, 
French-Canadian, Italian, Swedish/Finnish E47, 
Swedish/Finnish D47 

• Line width: 80 or 132 characters 

Compatibility Settings. 

• Supports the Macintosh Modern port or Printer port 
• Bits per character: 7 or 8 
• Parity: Even, Odd, or None 
• Supports XOn/XOff flow control 

Protocol Specifications. 

The MacTerrninal protocol specifications are in the Mac-to-Mac 
File Transfer Protocol document that was mailed in 
February 1985. If you want a copy, ask your Apple support 
representative. 

Here are the new features of MacTerminal 
Version 2.0. 

• When using Text file transfer mode, you can choose Save 
Screens Before Clearing. This is intended primarily 
for use in IBM 3278 emulation where no text is ever 
scrolled off the top, hence none is captured for later use. 
This option will save the screen in the "lines off the top" 
area before clearing the screen. 

• There are now four XModern file transfer options: 
MacBinary, XModem Text, MacTerminal 1.1, and 
Straight XModem. 

MacBinary is for transferring Macintosh disk files 
between two Macintoshes, or for uploading and 
downloading Macintosh files to and from information 
utilities, public bulletin boards, and timesharing systems 
that support the XModem protocol. XModem Text is for 
transmitting text files. MacTerminal 1.1 is the same as 
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XModem in the earlier release of MacTerminal and is 
included only for compatibility with MacTerminal 1.1. 
Straight XModem is for sending a binary file to a 
non-Macintosh computer system. 

• 25th-line support will be added for IBM 3278 terminal 
emulation using AppleLine. 

• Additional LaserWriter™ printer support includes port 
arbitration protocols to prevent it from interfacing with the 
AppleTalk™ Personal Network, faster printing, the use of 
the fixed pitch Courier font, and better column alignment. 

• There's a new mapping for the Macintosh Numeric Keypad 
when in IBM 3278 emulation mode (see the Using 
MacTerminal with IBM Computers module). 

• The Keyboard command was added to the Settings 
menu. 

• Wait for Call has been fixed. 

• Number of Rings Before Answering has been fixed. 

• International character sets have been added 

• The Reset and Clear Lines Off Top commands can be 
invoked without the "Are You Sure?" alert if you hold 
down the Option key as you choose the menu command .. 

• Takes better advantage of additional memory in 
Macintosh 512K and Macintosh XL. 

• Supports new products including the new Macintosh ROMs 
and double-sided disks. 
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• Pinouts 

Overview 

Macintosh Serial Ports 

This section contains pinouts for Macintosh 
cables and serial ports. 

This section details the pinouts for the Macintosh serial ports, a 
Macintosh-to-Macintosh cable, the Macintosh modem cable, 
and a Macintosh-to-DEC cable. 

If you're going to build a custom cable, be sure you have the 
pin assignments for the device to which you are connecting, in 
addition to the pinouts for Macintosh. 

Check AppleLink for any pinouts not included in this section. 

Here are the pin assignments for the 
Macintosh serial ports. 

Pin 
1 
2 
3 t 
4 
5 
6 
7 
8 t 
9 

Name 
CGND 
+5V 
CGND 
TxD+' 
TxD­
+ 12V 
HSK 
RxD+ 
Rxd-

Description/Notes 
Chassis ground 
* 
Chassis ground 
Transmit Data line (RS-422 only) 
Transmit Data line 
* 
Handshake: CTS or TRxC ** 
Receive Data line (RS-422 only) 
Receive Data line 

* See Macintosh hardware documentation for 
power limits. 

t Pins 3 and 8 should be jumpered together. 
** HSK is an input-only line designed to accept an 

external device's DTR handshake signal or a 
high-speed data clock. 
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Macintosh-to-Macintosh cable. 

The table below shows the pin connections for connecting a 
Macintosh to another Macintosh. This cable is included in the 
68000 Development System (Apple Finished Goods Price List, 
pin M0524). 

Pin Pin 
1 <-----> 3 
5 <-----> 9 
7 <-----> 7 
9 <-----> 5 

Jumper Pins 3 and 8 together on both ends of the cable. You 
can achieve the same results by clipping Pin 6 of a Macintosh 
modem cable (p/n 590-0197), but then you won't be able to 
use that cable with a modem again. 

There are several variations on wiring Pins 1, 3, and 8, which 
are the ground wires. The configuration specified here is the 
one recommended by Apple technical support. But other 
configurations may also work. 

Standard Macintosh modem cable. 

The table below shows the pin assignment for the Macintosh 
modem cable (p/n 590-0197). 

M~into5h Mod~m 
1 <-----> 3 
5 <-----> 9 
6 <-----> 6 
7 <-----> 7 
9 <-----> 5 

Jumper Pins 3 and 8 together on both ends of the cable. 

There are several variations on wiring Pins 1, 3, and 8, which 
are the ground wires. The configuration specified here is the 
one recommended by Apple technical support. But other 
configurations may also work. 
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Apple Personal Modem. 

The location of each Pin in the 8-Pin DIN connector are shown 
below: 

5 3 

2 

The Pin assignments for the 8-Pin DIN connector are: 

Pin 
1 
2 
3 
4 
5 
6 
7 
8 
Shield 

~ 
DSR 
DTR 
RXD 
SGND 
TXD 
SGND 
OCD 
N.C. 
Shield 

Function 
Data Set Ready 
Data Terminal Ready 
Receive Data 
Signal Ground 
Transmit Data 
Signal Ground 
Data Carrier Detect 
Not Connected 
Chassis Ground 

Apple makes cable for connecting the Apple Personal Modem 
to each computer. The part numbers are: 

590-0331: Apple II, Apple II+, Apple Ile, Apple///, 
Macintosh XL 

590-0332: Apple Ile 
590-0333: Macintosh 128K, Macintosh512K 

Macintosh to non-Apple modemlhat has a 
DB-25 connector. 

Function DB-9 DB-25 Function 
1 <-----> 1 Chassis ground 
3,8 <-----> 7 Signal ground 

Transmit 5 <-----> 2 Transmit 
Handshake 7 <-----> 20 Data terminal ready 
Receive 9 <-----> 3 Receive 
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This configuration is for modems that identify themselves to 
the Macintosh as data communications equipment. If a modem 
identifies itself as a terminal, connect the Macintosh Pin 5 to the 
DB-25 Pin 3 and the Macintosh Pin 9 to the BD-25 Pin 2 
(switch the Transmit and Receive lines at the modem end.) 

These are the Pin assignments for a Macintosh Image Writer™ 
printer cable plus a modem eliminator cable, and it works for 
most non-Apple modems that have a DB-25 connector. If it 
doesn't work, use the first table in this section (Macintosh 
serial port pinouts) plus a similar table for the modem 
connector to design a custom cable. 

Macintosh-to-DEC direct connection. 

Use the table below to build a custom cable for directly 
c.:>nnecting a Macintosh to a DEC, in the place of a VTlOO 
terminal. 

Function 
Ground 
Transmit 
12V 

Im:2. 
3 

Clrto Send 
Receive 

5 
6 
7 
9 

DB-25 
<-----> 7 
<-----> 2 
<-----> 20 
<-----> 6 
<-----> 3 

Function 
Ground 
Receive 
Data terminal ready 
Data carrier detect 
Transmit 

Pinouts for connecting to IBM computers. 

The pinouts for connecting your Macintosh to an AppleLine, 
Apple Cluster Controller, and IBM PC are in the Using 
MacTerminal with IBM Computers module from the Apple 
Support Training Library. 
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II Review 

Questions and Answers 

Mac Terminal 
Specifications 

Pin outs 

Refer to the answers to commonly asked 
questions on MacTerminal as you need them. 

Refer to the information in the this section of the module as you 
need it. If you have access to AppleLink, look there for 
answers to specific questions, and check it periodically for new 
information regarding data communications and MacTerminal. 

This section covers MacTerminal capabilities 
and limitations. 

A lot of questions are regarding the limitations and capabilities 
of Mac Terminal. Refer to this section for the answers to these 
questions. 

Refer to this section for the pinouts for 
products used with MacTerminal. 

Additional pinout information can be found in other Apple 
Support Training Library modules and in the Technical Info · 
library on AppleLink. 
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• MacTerminal, the owner's manual, Apple Computer, Inc. 

• Apple Support Programs binder 

• John Stanley Data Communications Workshop t 

• AppleLink (If you have access to AppleLink, check it 
regularly for additional data communications information, 
particularly the Technical Info library.) 

• Data Communications Terms module from the Apple 
Support Training Library 

• Using MacTerminal module from the Apple Support 
Training Library 

• Using MacTerminal with IBM Computers module from the 
Apple Support Training Library 

• AppleLine User's Guide, Apple Computer, Inc. 

• Apple Cluster Controller and AppleLine Sales Reference 
Guide, Apple Computer, Inc. 

t For more information, contact: 
John Stanley Training Programs 
208 Charter Oaks Circle 
Los Gatos, CA 95030 
(408) 374-1235 

Apple and the Apple logo are registered trademarks of Apple Computer, Inc. AppleLine, AppleLink, AppleTalk 
LaserWriter, LisaTermi.na.l, MacTerminal, and MacWrite are trademarks of Apple Computer, Inc. Macintosh is a trademark 
of Mcintosh Laboratory, Inc. and is being used with express permission of its owner. DEC, VT52, and VT JOO are 
trademarks of Digital Equipment Corporation. IBM is a registered trademark of International Business Machines 
Corporation. 
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